Forensic Biology Protocols for Forensic STR Typing Approval Form

Section 1 General Guidelines for DNA Casework
Section 2 DNA Extraction (Manual and Magattract)
Section 3 Microcon YM100 DNA Concentration and Purification
Section 4 Estimation of DNA Quantity Using the RotorGene™
Section 5 PCR Amplification – Generation of Amplification Sheets
Section 6 PCR Amplification – Sample Preparation
Section 7 General Guidelines for Fluorescent STR Analysis
Section 8 STR Analysis on the ABI 3130xl Capillary Electrophoresis Genetic Analyzer
Section 9 STR Data Conversion and Archiving
Section 10 GeneScan Analysis
Section 11 Genotyper Analysis
Section 12 STR Results Interpretation
Section 13 Sample Comparisons
Section 14 Additional Interpretations of Y-STR Results and Complex Y-STR Results
Section 15 Population Frequencies for STR’s
Section 16 Paternity Analysis
Section 17 References
Section 18 DNA-VIEW For Paternity and Kinship Analysis
Section 19 Appendix

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
Section 1 General guidelines for DNA casework

- General guidelines for DNA casework
- Body fluid identification
- Laboratory organization
- Microfuge tube and pipet handling
- Sample handling
- DNA Extraction Guidelines
- Controls for PCR analysis
- Concordant analyses and “duplicate rule”
- Contamination Policy
- DNA storage
Section 2A  Manual DNA Extraction

Chelex DNA Extraction From Blood and Buccal Swabs
Chelex DNA Extraction from soft tissue (e.g. fetus samples)
Chelex DNA Extraction from epithelial cells
Non-differential Chelex DNA Extraction from Semen Stains or Swabs
Differential Chelex DNA Extraction from Semen Stains or Swabs
Chelex DNA Extraction From Hair
  Sample Preparation for Loose Hair
  Sample Preparation for Mounted Hair
  Chelex Extraction
Organic Extraction Procedure
  Sample Preparation
    Liquid/dry blood, bone marrow, oral swab and tissue
    Bone Preparation
    Sample milling with the SPEX Certiprep 6750 Freezer Mill
    Laser Microdissection
  Sample Incubation
    Sample Incubation for liquid blood, dry blood and bone marrow
    Sample Incubation for Bone
    Sample Incubation for Teeth
    Sample Incubation for Tissue and Paraffin Embedded Tissue
Phenol Chloroform and Microcon Clean up
Preparation of Phase Lock Gel (PLG) tubes
High Sensitivity DNA Extraction
  Personal Preparation
  Paperwork preparation
  Work Place Preparation
  Digestion
  Microcon 100 DNA concentration and purification
  Clean up
  Sample Storage

Section 2A  Manual DNA Extraction (Continued on Next Page)
Section 2A  Manual DNA Extraction (Continued)

Extraction of Exogenous DNA From Nails
  Personal Preparation
  Paperwork preparation
  Work Place Preparation
  Digestion
  Extraction
  Purification and Concentration
  Clean up
  Sample storage

Section 2B  MagAttract DNA Extraction

MagAttract DNA Extraction from Bloodstains and Buccal Swabs
MagAttract DNA Extraction from other Casework Samples
Section 3  Microcon YM100 DNA Concentration and Purification

Section 4  Estimation of DNA Quantity Using the RotorGene™

ALU-Based Quantitative Real Time PCR on the Rotorgene
  Paperwork Preparation
  Personal Preparation
  Workplace Preparation
  Sample Dilution
  Remove reagents for the master mix from the reagent freezer/refrigerator
  Standard Curve Preparation
  Sample Preparation
  Master Mix preparation
  Sample Addition
  Software Operation
  Clean Up
  Sample and Data Storage
  Analysis
  Report
  Value Calculation by Software
  Assay Interpretation
    Standards and Controls
    Sample Interpretation
  Creating a Rotorgene Summary Page
  File Protection and Paperwork Distribution
  References
Section 5  PCR Amplification – Generation of Amplification Sheets

Generation of Amplification Sheets
   HSC Team Amp Macro for paperwork preparation
   RG Amp Macro for Paperwork preparation
   MACRO X (RG AMP MACRO) for Paperwork Preparation
   RG Amp Macro HI (High Sensitivity samples) for Paperwork preparation
   RG Amp Macro PC (Property Crimes Samples) for Paperwork Preparation
   Aliquot Request and Amp Sheets for HCN evidence and exemplar samples only
   Saving Amp Sheets to the Network for Additional Samples

Section 6  PCR Amplification – Sample Preparation

Sample Preparation
   Personal Preparation
   Work Place Preparation
   Preparing DNA aliquots for amplification
   Sample and Amplification Set-up for Identifiler
      Samples and Controls
      Master Mix Preparation
      Reagent and Sample Aliquot
   Sample and Amplification Set-up for PowerPlex 16, Cofiler, Profiler Plus, YM1
      PowerPlex 16
      Cofiler and Profiler Plus
      Y STR multiplex YM1
      Master Mix and/or Master Mix Tube Preparation - PowerPlex16, Cofiler, Profiler Plus, YM1
      Reagent and Sample Aliquot - PowerPlex16, Cofiler, Profiler Plus, YM1
   Thermal Cycling - all amplification systems
      9700 Instructions
      Amplification Troubleshooting
Section 7  General Guidelines for Fluorescent STR Analysis

GENERAL GUIDELINES FOR FLUORESCENT STR ANALYSIS
Batch processing
Sample handling
Instrument and computer maintenance

Section 8  STR Analysis on the ABI 3130x/ Capillary Electrophoresis Genetic Analyzer

Personal Preparation
Workplace preparation
Setting Up A 3130x/ Run
Creating a Plate Record through Excel
3130Macro for HSC and Exemplar Teams
Macro for PC team: ID28 PC2130Macro1.2
3130x/ Sample Sheet and Plate Record Macro For High Sensitivity Team
Creating Plate Records Manually
Foundation Data Collection (Importing Plate Record)
Preparing and Running the DNA Samples
Mastermix and Sample Addition for Identifiler 28 Cycles for HSC and Exemplar Teams
Mastermix and Sample Addition for Identifiler 28 Cycles for High Sensitivity and Property Crime Teams
Mastermix and Sample Addition for Identifiler 31 for High Sensitivity Team
Mastermix and Sample Addition for Cofiler, Profiler Plus, and Y STR
Denature Chill - For All Systems After Sample Addition
Turning the Oven on and Setting the Temperature
Placing the Plate onto the Autosampler (Linking and Unlinking Plate)
Viewing the Run Schedule
Converting Run for GeneScan Analysis
Reinjecting Plates
Water Wash & POP Change
Cleanup Database Utility
Troubleshooting Guide
Section 9  STR Data Conversion and Archiving

STR DATA CONVERSION AND ARCHIVING
Converting Run for GeneScan Analysis
Archiving Converted Data and Sample Sheets
   For the HSC, PC, and Exemplar Teams
   For the High Sensitivity Team
Backup of Data

Section 10 GeneScan Analysis

GENESCAN ANALYSIS
   Access to GeneScan
   Analysis Settings
   Identifiler Analysis Parameters
   Cofiler and Profiler Plus Analysis Parameters
   YM1 Analysis Parameters
Analysis
   Analysis Troubleshooting

Section 11  Genotyper Analysis

Cofiler, Profiler Plus, YM1, and PowerPlex 16
   Evidence Sample Runs
   Exemplar Sample Runs
Identifiler
   Importing data and allele call assignment
   Modifying the allelic ladder category
   Viewing samples
   Editing of Genotyper files
   Click History
   Printing Samples
   Printing Genotyper Tables for Identifiler 28 samples
   Printing STR Tables for Identifiler 31 samples
Re-injection guidelines
   Multiplex Kit Troubleshooting

Back to Top
Section 12 STR Results Interpretation

Allele Calling Criteria
  Computer program processing steps for raw data
Manual Removal of Non Allelic Peaks
  Pull-up
  Shoulder
  Split peaks
  Stutter – 4bp smaller than the main allele
  Non specific artifacts
  Elevated baseline
  Spikes
  Dye Artifacts
  Spurious alleles or drop ins
  Removal of a range of alleles
Detection of Rare Alleles
Interpretation of STR Data
  Allele Table
  Electropherograms
Interpretation of controls
  Amplification Positive Control
  Extraction Negative and Amplification Negative Controls
Reporting Procedures
  Guidelines for Reporting Allelic Results
  Previously unreported rare alleles
Guidelines for interpretation of Results
  Non-Mixtures
  Mixtures of DNA
    General Mixtures
    Mixtures with different levels of starting DNA
      Very small additional allele peaks are detected at only a few loci
      Possible mixture components masked by -4bp stutter
    Partial Profiles: not all loci display allele peaks
      Degradation
      Detection limit
Guidelines for reporting samples amplified with Identifiler for 31 cycles
  LCN DNA Profile Production
  Profile Confirmation
Section 13  Sample Comparisons

Comparison of Samples Based on STR Results
  Reporting partial profiles
  Reporting previously unreported rare alleles
  Samples with High Background Levels
  Discrepancies for overlapping loci in different multiplex systems
  Profile Comparison and Statistical evaluation

Section 14  Additional Interpretations of Y-STR Results and Complex Y-STR Results

  Mixtures of male DNA
  General Mixtures
  Mixtures with different level of starting DNA
  Possible mixture component masked by -4bp stutter
  Partial Profiles
  Detection Of Previously Unreported Rare Alleles
  Samples with High Background Levels

Section 15  Population Frequencies for STR’s

  Autosomal STR’s
  Y STR’s

Section 17  References

  Extraction and Quantitation
  Fluorescent STR technology; methods and validations
  Genetic markers and theoretical background
  High Sensitivity Testing
  Kinship and Paternity testing

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.
Section 18 DNA-VIEW For Paternity and Kinship Analysis

DNA-VIEW For Paternity and Kinship Analysis
Creating a DNA-View Worksheet and Import Record
Importing profiles into DNA-View
Performing Paternity or Kinship Analysis
Troubleshooting DNA-View
  Printing problems
  Changing Language from Kinship to Paternity
  Deleting records from DNA-View
  Designating a subdirectory if the subdirectory field is blank
  Interpretation of DNA-View Report

Section 19 Appendix

YM1 Genotyper Categories Table for ABI 3130x/
Identifiler loci and approximate size range
Profiler Plus loci and approximate size range
Cofiler loci and approximate size ranges
Powerplex 16 loci and approximate size ranges
Genotyper Macro Filter functions

Back to Top
Body fluid identification

1. The general laboratory policy is to identify the stain type (i.e., blood, semen, or saliva) before individualization is attempted on serious cases such as sexual assaults, homicides, robberies, and assaults. However, circumstances may exist when this will not be possible. For example, on most property crime cases when a swab of an item is submitted for testing, the analyst will cut the swab directly for individualization rather than consuming the swab for body fluid identification.

2. A quantitation value greater than or equal to 0.1 pg/µL is indicative of the presence of human DNA. A positive screening test for blood followed by the detection of a real-time PCR quantitation value greater than or equal to 0.1 pg/µL is indicative of the presence of human blood.

3. High Copy Number (HCN) testing is performed when the samples have a quantitation value greater than or equal to 7.5 pg/µL for Cofiler and Profiler Plus (at least 150 pg per amp) and 20 pg/µL for Identifiler 28 cycles (at least 100 pg per amp). High Sensitivity testing can be performed if samples have a quantitation value of less than 7.5 pg/µL (or 20 pg/µL) and greater than 1 pg/µL.

Laboratory organization

1. To minimize the potential for carry-over contamination, the laboratory is organized so that the areas for DNA extraction, PCR set-up, and handling amplified DNA are physically isolated from each other. Each of the three areas is in a separate room.

2. Based on need, microcentrifuge tube racks have been placed in sample handling areas. These racks should only leave their designated area to transport samples to the next designated area. Immediately after transporting samples, the racks should be returned to their designated area.

3. Dedicated equipment such as pipettors should not leave their designated areas. Only the samples in designated racks should move between areas.
1. GENERAL GUIDELINES FOR DNA CASEWORK

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>2 OF 11</td>
</tr>
</tbody>
</table>

4. Analysts in each work area must wear appropriate personal protective equipment (PPE). All PPE shall be donned in the bio-vestibules.

In pre-amplification areas (e.g., evidence examination, DNA extraction, and/or PCR set-up) working analysts must wear the following:

a. Laboratory coat or Tyvex suit
b. Head covering
c. Long pants or long skirt (or Tyvex pants/suit if legs are bare)
d. Eye protection and mask covering nose and mouth (or face shield)
e. Double gloves
f. Closed-toe shoes

In post-amplification areas, working analysts must wear the following:

a. Laboratory coat or Tyvex suit
b. Long pants or long skirt (or Tyvex pants/suit if legs are bare)
c. Eye protection
d. Single gloves
e. Closed-toe shoes

Microcentrifuge tube and pipette handling

1. Avoid splashes and aerosols. Centrifuge all liquid to the bottom of a closed microcentrifuge tube before opening it.

2. Avoid touching the inside surface of the tube caps with pipetters, gloves, or lab coat sleeves.

3. Use the correct pipetter for the volume to be pipetted. For pipetters with a maximum volume of 20µL or over, the range begins at 10% of its maximum volume (i.e., a 100µL pipette can be used for volumes of 10-100µL). For pipetters with a maximum volume of 10µL or under, the range begins at 5% of its maximum volume (i.e., a 10µL pipette can be used for volumes of 0.5-10µL).
1. GENERAL GUIDELINES FOR DNA CASEWORK

4. Filter pipette tips must be used when pipetting DNA and they should be used, whenever possible, for other reagents. Use the appropriate size filter tips for the different pipetters; the tip of the pipette should never touch the filter.

5. Always change pipette tips between handling each sample.

6. Never “blow out” the last bit of sample from a pipette. Blowing out increases the potential for aerosols, this may contaminate a sample with DNA from other samples. The accuracy of liquid volume delivered is not critical enough to justify blowing out.

7. Discard pipette tips if they accidentally touch the bench paper or any other surface.

8. Wipe the outside of the pipette with 10% bleach solution followed by a 70% ethanol solution if the barrel goes inside a tube.

Sample handling

1. Samples that have not yet been amplified should never come in contact with equipment in the amplified DNA work area. Samples that have been amplified should never come in contact with equipment in the unamplified work area.

2. The DNA extraction and PCR setup of evidence samples should be performed at a separate time from the DNA extraction and PCR setup of exemplars. This precaution helps to prevent potential cross-contamination between evidence samples and exemplars.

3. Use disposable bench paper to prevent the accumulation of human DNA on permanent work surfaces. 10% bleach followed by 70% ethanol should always be used to decontaminate all work surfaces before and after each procedure.

4. Limit the quantity of samples handled in a single run to a manageable number. This precaution will reduce the risk of sample mix-up and the potential for sample-to-sample contamination.

5. Change gloves frequently to avoid sample-to-sample contamination. Change them whenever they might have been contaminated with DNA and whenever exiting a sample handling area.

6. Make sure worksheets and logbooks are completely filled out.
1. GENERAL GUIDELINES FOR DNA CASEWORK

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>4 OF 11</td>
</tr>
</tbody>
</table>

DNA Extraction Guidelines

Slightly different extraction procedures may be required for each type of specimen. Due to the varied nature of evidence samples, the user may need to modify procedures.

1. All tube set-ups must be witnessed prior to starting the extraction (NOTE: For differential extractions, the tube set-up should be witnessed after the incubation step.)

2. Use Kimwipes or a tube opener to open tubes containing samples; only one tube should be uncapped at a time.

3. When pouring or pipetting Chelex solutions, the resin beads must be distributed evenly in solution. This can be achieved by shaking or vortexing the tubes containing the Chelex stock solution before aliquoting.

4. For pipetting Chelex, the pipette tip used must have a relatively large bore – 1 mL pipette tips are adequate.

5. Be aware of small particles of fabric, which may cling to the outside of tubes.

6. Include an extraction negative control with each batch of extractions to demonstrate extraction integrity. The extraction negative control contains water in place of biological fluids or samples. For samples that will be amplified in Cofiler, Profiler Plus, or YM1, the associated extraction negative control should be re-quantified to confirm any quantitation value of 1.00 pg/µL or greater. For samples that will be amplified in Identifiler (28 or 31 cycles), the associated extraction negative should be re-quantified to confirm any quantitation value of 0.2 pg/µL or greater. The difference in value is due to the difference in the sensitivity of the test kit.

7. If a sample is found to contain less than 7.5 pg/µL of DNA, then the sample should not be amplified in Cofiler, Profiler Plus, or YM1. If a sample is found to contain less than 20 pg/µL of DNA, then the sample should not be amplified in Identifiler (28 cycles). It can be re-extracted, reported as containing insufficient DNA, concentrated using a Microcon-100 (see troubleshooting section), or possibly submitted for High Sensitivity testing. The interpreting analyst shall consult with a supervisor to determine how to proceed. Other DNA samples may also be concentrated and purified using a Microcon-100 if the DNA is suspected of being degraded or shows inhibition or background fluorescence during quantitation. Samples that are 1 pg/µL to 20 pg/µL may be submitted for high sensitivity testing with a supervisor’s permission.
8. After extraction, the tubes containing the unamplified DNA should be transferred to a box and stored in the appropriate refrigerator or freezer. The tubes should not be stored in the extraction racks.

9. All tubes must have the complete case number, sample identifier and IA initials on the side of the tube. This includes aliquots submitted for quantitation.

10. Extract tracking sheets are created for each case within an extraction set. Any aliquots subsequent to the first quantitation attempt should be recorded on this tracking sheet.

Controls for PCR analysis

The following controls must be processed alongside the sample analysis:

1. A positive control is a DNA sample where the STR alleles for the relevant STR loci are known. The positive control tests the success and the specificity of the amplification, and during the detection and analysis stage the correct allele calling by the software.

2. An extraction negative control consists of all reagents used in the extraction process and is necessary to detect DNA contamination of these reagents. For Cofiler and Profiler Plus, the absence of detectable DNA in one of these PCR multiplexes is sufficient to show the absence of contamination. However, if Identifiler (28 or 31 cycles) is to be used to amplify the samples, then the extraction negative control must be retested in that system since it is more sensitive. Note: Since the Y STR system only detects male DNA, one cannot infer from a clean Y STR extraction negative the absence of female DNA.

3. An amplification negative control consists of only amplification reagents without the addition of DNA, and is used to detect DNA contamination of the amplification reagents.

Failure of any of the controls does not automatically invalidate the test. Under certain circumstances it is acceptable to retest negative and positive controls. See STR results interpretation for rules on retesting of control samples.
Concordant analyses and “duplicate rule”

The general laboratory policy is to confirm DNA results either by having concordant DNA results within a case, or (for 28-cycle systems) by duplicating the DNA results with a separate aliquot, amplification, and electrophoresis plate. The most common situations are confirmation of a match or exclusion within a case and confirming DNA results when less than the optimal amount of DNA is amplified. Concordant and duplicate analyses are also used to detect sample mix-up and confirm the presence of DNA mixtures.

1. For evidence samples, the following guidelines apply:
   a. Identical DNA profiles among at least two items (two evidence samples or one evidence sample plus an exemplar) within a case are considered internally concordant results (“duplicate rule”).
   b. If a sample does not match any other sample in the case, it must be duplicated by amplification in the same or a second PCR system. If the only result was obtained using Y-STRs, this must be duplicated in the Y system.
   c. If after the first DNA analysis there is an indication that the sample consists of a mixture of DNA, several scenarios must be considered. Further analysis steps have to be decided based on the nature of each case. Consult with your supervisor if you encounter a situation that is not represented in the following examples:
      1) If all alleles in a mixture are consistent with coming from any of the known or unknown samples in the case, e.g. a victim and a semen source, no further concordance testing is needed. Further testing could be performed if needed (e.g., to obtain a CODIS profile).
      2) If two or more mixtures in a case are consistent with each other and display the same allele combinations, they are considered duplicated.
      3) If one or more alleles cannot be accounted for by other contributors in the case, the presence of the foreign component must be confirmed by amplification in either the same or a second PCR system.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
4) If there is only one sample in a case and this happens to be a mixed sample, the results need to be confirmed by amplification in either the same or a second PCR system depending on the need to type all 13 loci for CODIS.

5) Inconclusive samples that cannot be used for comparison do not require duplication.

d. Another reason for duplication is to confirm results when a **low amount of DNA is obtained from an evidence sample and/or** less than optimal amounts of DNA are amplified in Identifiler, to account for possible stochastic effects. Duplicate Identifiler 28 amplifications are required when there is less than 1000 pg of DNA in the total extraction volume (e.g., calculate total yield by multiplying DNA concentration by the 200 uL in a Chelex extraction); any duplicate amplification **done for this reason** should be performed as soon as possible after extraction to minimize loss of DNA in the extract.

e. Automatic duplications designed to streamline testing of any evidence samples is also permitted.

3. For exemplar samples, duplication is designed to rule out false exclusions based on sample mix-up, and also to streamline testing. Duplication must start with a second independent extraction, with the exemplar cut and submitted for extraction at a different time. The two resulting extracts must be aliquotted for amplification separately at different times, and aliquotted for electrophoresis separately and run on separate plates. If there is no additional exemplar material available for extraction, the duplication may begin at the amplification stage.

To streamline testing, all suspect and victim exemplars may be duplicated.

The following guidelines apply for required duplications:

a. If the DNA profile of a **victim’s exemplar** does not match any of the DNA profiles of evidence samples in the case, including mixtures, the victim’s exemplar must be duplicated to eliminate the possibility of an exemplar mix-up. This is because it is highly likely that an exemplar mix-up would generate a false exclusion.
1. GENERAL GUIDELINES FOR DNA CASEWORK

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>8 OF 11</td>
</tr>
</tbody>
</table>

b. Duplication of a victim’s DNA profile is not necessary in a negative case (no alleles detected in evidence samples).

c. Since duplicate exemplar analyses are performed to confirm the exclusion, a partial DNA profile (at least one complete loci) that demonstrates an exclusion is sufficient.

d. If the DNA profile of a victim’s exemplar matches any of the DNA profiles of evidence in the case, or is present in a mixture, the exemplar does not have to be duplicated. This is because it is highly unlikely that a sample mix-up would generate a false inclusion.

e. If the DNA profile of a suspect’s exemplar (or other non-victim elimination exemplar) does not match any of the DNA profiles in the case, or in the local database, the exemplar does not have to be duplicated. This is meant to streamline the process similar to convicted offender testing.

f. If the DNA profile of a suspect’s exemplar matches any of the DNA profiles in the case, or in the local database, the suspect’s exemplar has to be duplicated to eliminate the possibility of an exemplar mix-up. This is meant to streamline the process similar to convicted offender testing.

g. Pseudo exemplars do not have to be duplicated, regardless if the DNA profile matches any of the DNA profiles in the case.

3. For evidence samples or exemplar samples analyzed in DNA systems containing overlapping loci, the DNA results for the overlapping loci must be consistent. If no or partial results were obtained for some of the overlapping loci, this amplification is still valid if consistent results were obtained for at least one overlapping locus (Amelogenin is not considered an overlapping locus in this context). If the partial amplification confirms a match or an exclusion of an exemplar or another evidence sample, it does not have to be repeated.

4. Partial profiles can satisfy the duplication policy. Consistent DNA typing results from at least one overlapping locus in a different amplification (same DNA system or a different DNA system) is considered a concordant analysis.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
5. For Y-STR testing, the sample does not have to be reamplified if the internal duplication rule applies or if the Y-STR results are concordant with the autosomal results: confirming an exclusion or inclusion, confirming the presence of male DNA, confirming the number of semen donors. Based on the case scenario it might be necessary to reamplify in order to confirm the exact Y-STR allele calls. There might not be sufficient autosomal data to establish concordance.

Contamination Policy

Contamination is defined as the addition of DNA/biological fluid to evidence or controls subsequent to the crime. Sources of contamination could be first responders, EMT’s, crime scene technicians, MLI’s, ME’s, ADA’s, NYPD personnel, or laboratory personnel.

1. Medical treatment and decontamination of hazardous materials are the first priority. Steps should be taken to minimize contamination as much as possible.

2. The source of contamination should be identified so that samples can be properly interpreted. It may be possible to identify the source by:

   a. Examining other samples from the same batch for cross contamination.

   b. Examining samples from different batches, handled or processed at approximately the same time for possible cross contamination (such as from dirty equipment or surfaces).

   c. Processing elimination samples to look for contamination in the field or by laboratory personnel

Samples should be routinely compared to case specific elimination samples, personnel databases, and the local CODIS database for possible matches. Mixtures may have to be manually compared.

If a negative or positive control is contaminated all the associated samples are deemed inconclusive and their alleles are not listed in the report. The samples should be re-extracted or re-amplified, if possible.
### 1. GENERAL GUIDELINES FOR DNA CASEWORK

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>10 OF 11</td>
</tr>
</tbody>
</table>

3. If a clean result cannot be obtained or the sample cannot be repeated then the summary section of the reports should state "**The following sample(s) can not be used for comparison due to quality control reasons.**"

4. Once a contamination event has been discovered, the first step is to try to find an alternate sample.

   a. As appropriate, a new extraction, amplification, or electrophoresis of the same sample can serve as an alternate for the contaminated sample. For this type of alternate sample the contamination event is not noted in the report. However all case notes related to the contamination are retained in the case file for review by the quality assurance group, forensic biology staff, attorneys and outside experts. A form is inserted on the right side of the case file identifying the source of the contamination by name, if known, and stating which samples were contaminated.

   b. If there are other samples from the crime scene which would serve the same purpose, they could be used as an alternate sample. For example, in a blood trail or a blood spatter, another sample from the same source should be used. Another swab or underwear cutting should be used for a sexual assault. In this scenario, the contaminated sample should be listed in the summary section of the report as follows: "**The [sample] can not be used for comparison because it appears to contain DNA consistent with a [NYPD member, OCME [laboratory] member, medical responder] which is exogenous to the crime scene. Instead please see [alternate sample] for comparison**". No names for the possible source(s) of contamination are listed in the report. All case notes related to the contamination are retained in the case file for review by attorneys and their experts. A form is inserted on the right side of the case file identifying the source of the contamination by name, if known, and stating which samples were contaminated.

5. If an alternate sample can not be found then only samples with minor contamination as defined below can be interpreted. Samples with a major contaminant could lead to erroneous conclusions due to the masking effect of significant amounts of DNA.
1. GENERAL GUIDELINES FOR DNA CASEWORK

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>Version</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>11 OF 11</td>
</tr>
</tbody>
</table>

a. If a sample has a single source of DNA and this DNA appears to be a contaminant then the following should be listed in the summary section of the report: “The [sample] will not be used for comparison because it appears to contain DNA consistent with a {NYPD member, OCME [laboratory] member, medical responder} which is exogenous to the crime scene.” No names for the possible source(s) of contamination are listed in the report. All case notes related to the contamination are retained in the case file for review by the quality assurance group, forensic biology staff, attorneys and outside experts. A form is inserted on the right side of the case file identifying the source of the contamination by name and stating which samples were contaminated.

b. If a sample contains a mixture of DNA and ALL of the alleles from the contaminant appear in the mixture then the following should be listed in the summary section of the report: “The [sample] contains a mixture of DNA. The mixture is consistent with a {NYPD member, OCME [laboratory] member, medical responder} and at least [#] other individual(s).” The [sample] will not be used for comparison due to DNA exogenous to the crime scene being present in this sample.” No names for the possible source(s) of contamination are listed in the report. All case notes related to the contamination are retained in the case file for review by the quality assurance group, forensic biology staff, attorneys, and outside experts. A form is inserted on the right side of the case file identifying the source of the contamination by name and stating which samples were contaminated.

DNA storage

1. Store evidence and unamplified DNA in a separate refrigerator or freezer from the amplified DNA.

2. During analysis, all evidence, unamplified DNA, and amplified DNA should be stored refrigerated or frozen. Freezing is generally better for long term storage.

3. Amplified DNA is discarded after the Genotyper analysis is completed.

4. DNA extracts are retained refrigerated for a period of time, then frozen for long-term storage.

Revision History:
February 16, 2009 – Revised the requirements for duplication of samples (highlighted). See Approval Form.
CHELEX DNA EXTRACTION FROM BLOOD AND BUCCAL SWABS

Sample sizes for Chelex extraction should be approximately 3μL of liquid blood or saliva, 1/3 of a swab, or a 3x3mm cutting of a bloodstain.

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. **Do not extract both together.**

2. Have a witness confirm the order of the samples.

3. Pipette 1 mL of sterile deionized water into each of the tubes in the extraction rack.

4. Mix the tubes by inversion or vortexing.

5. Incubate in a shaker at room temperature for 15 to 30 minutes.

6. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

7. Carefully remove supernatant (all but 30 to 50 μL). If the sample is a bloodstain or swab, leave the substrate in the tube with pellet.

8. Add 175 μL of 5% Chelex (from a well-resuspended Chelex solution).

9. Incubate at 56°C for 15 to 30 minutes.

10. Vortex at high speed for 5 to 10 seconds.

11. Incubate at 100°C for 8 minutes using a screw-down rack.

12. Vortex at high speed for 5 to 10 seconds.

13. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

14. Pipet aliquots of neat and/or diluted extract into microcentrifuge tube for real-time PCR analysis to determine human DNA concentration (refer to Section 3 of the STR manual), when needed.

15. Store the extracts at 2 to 8°C or frozen.

16. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.
2. DNA EXTRACTION

2. DNA EXTRACTION

DATE EFFECTIVE: 06-09-2008
VERSION: 10.0
PAGE: 2 OF 49

FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

CHELEX DNA EXTRACTION FROM SOFT TISSUE (E.G., FETUS SAMPLES)

Sample sizes for this Chelex extraction should be approximately a 3x3mm cutting of tissue.

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. Do not extract both together. **Have a witness confirm the order of the samples.**

2. Pipette 1 mL of sterile deionized water into each of the tubes in the extraction rack.

3. Mix the tubes by inversion or vortexing.

4. Incubate at room temperature for 15 to 30 minutes. Mix occasionally by inversion or vortexing.

5. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

6. Carefully remove supernatant (all but 30 to 50 μL).

7. To each tube add: 200 μL of 5% Chelex (from a well-resuspended Chelex solution). 1 μL of 20 mg/mL Proteinase K

8. Mix using pipette tip.

9. Incubate at 56°C for 60 minutes.

10. Vortex at high speed for 5 to 10 seconds.

11. Incubate at 100°C for 8 minutes using a screw down rack.

12. Vortex at high speed for 5 to 10 seconds.

13. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

14. As needed, pipet aliquots of a 1/10 dilution and a 1/1000 dilution (using TE^-4) into microcentrifuge tube for real-time PCR Analysis to determine human DNA concentration (refer to Section 3 of the STR manual).

15. Store the extracts at 2 to 8°C or frozen.

16. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
CHELEX DNA EXTRACTION FROM EPITHELIAL CELLS
(AMYLASE POSITIVE STAINS OR SWABS, CIGARETTE BUTTS, SCRAPINGS)

Samples meant for this type of extraction should be placed on the “other evidence” or the Y-STR amylase worksheet. Exemplars of this type must be extracted separately from evidence samples.

Sample sizes for this Chelex extraction should be approximately a 5x5mm cutting or 50% of the scrapings recovered from an item.

1. Remove the extraction rack from the refrigerator.
2. Have a witness confirm the order of the samples.
3. To each tube add: 200 µL of 5% Chelex (from a well-resuspended Chelex solution). 1 µL of 20 mg/mL Proteinase K

(Note: For very large cuttings, the reaction can be scaled up to 4 times this amount. This must be indicated on the extraction sheet. Scaling up any higher requires permission from the supervisor and/or IA of the case. The final extract will need to be Microcon concentrated.)

4. Mix using pipette tip.
5. Incubate at 56°C for 60 minutes.
6. Vortex at high speed for 5 to 10 seconds.
7. Incubate at 100°C for 8 minutes using a screw down rack.
8. Vortex at high speed for 5 to 10 seconds.
9. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.
10. Pipet 5 µL neat and also a 1/100 dilution (using TE^-4) into a microcentrifuge tube for Real-Time PCR Analysis to determine human DNA concentration.
11. Store the remainder of the supernatant at 2 to 8°C or frozen.
2. DNA EXTRACTION

NON-DIFFERENTIAL CHELEX DNA EXTRACTION FROM SEMEN STAINS OR SWABS

NOTE: For very large cuttings 200 μL of Chelex might not be enough to provide enough suspension of the sample. The reaction can be scaled up and reconcentrated using Microcon concentrators.

Sample sizes for non-differential Chelex extractions depend on the circumstances of the case. Regularly 1/3 of a swab or a 3x3mm cutting of a stain should be used. For cases where semen is present but no sperm cells were detected, the sample size can be increased.

1. Remove the extraction rack from the refrigerator.
2. Have a witness confirm the order of the samples.
3. To each tube add: 200 μL of 5% Chelex (from a well-resuspended Chelex solution).
   1 μL of 20 mg/mL Proteinase K
   7 μL of 1 M DTT
4. Use the pipette tip when adding the DTT to thoroughly mix the contents of the tubes.
5. Incubate at 56°C for approximately 2 hours.
6. Vortex at high speed for 10 to 30 seconds.
7. Incubate at 100°C for 8 minutes using a screw down rack.
8. Vortex at high speed for 10 to 30 seconds.
9. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.
10. As needed, pipet aliquots of neat and 1/100 dilution (using TE\(^+\)) into microcentrifuge tube for real-time PCR Analysis to determine human DNA concentration (refer to Section 3 of the STR manual).
11. Store the extracts at 2 to 8°C or frozen.
12. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
DIFFERENTIAL CHELEX DNA EXTRACTION FROM SEMEN STAINS OR SWABS

Approximately 1/3 of a swab or a 3x3mm cutting of a stain should be used for this type of extraction.

1. Remove the extraction rack from the refrigerator.
2. Pipette 1 mL of PBS into each tube, including a tube for a sperm fraction extraction negative control, in the extraction rack.
3. Mix by inversion or vortexing
4. Incubate at room temperature overnight or for a minimum of 1 hour using a shaking platform.
5. Have a witness confirm the order of the samples.
6. Vortex or sonicate the substrate or swab for at least 2 minutes to agitate the cells off of the substrate or swab. At this point, label the extraction negative control with the date and time.
7. Label new tubes to hold the swab or substrate remains. Remove the swab or other substrate from the sample tube, one tube at a time, using sterile tweezers and close tube. Sterilize tweezers with 10% bleach, distilled water, and 70% ethanol before the removal of each sample. Store swab or substrate in a sterile labeled tube for the substrate remains fraction.
8. Spin in a microcentrifuge for 5 minutes at 10,000 to 15,000 x g.
9. Without disturbing the pellet, remove and discard all but 50 μL of the supernatant.
10. Resuspend the pellet in the remaining 50 μL by stirring with a sterile pipette tip.
11. To the approximately 50 μL of resuspended cell debris pellet, add 150 μL sterile deionized water (final volume of 200 μL).
12. Add 1 μL of 20 mg/mL Proteinase K. Vortex briefly to resuspend the pellet.
13. Incubate at 56°C for about 60 minutes to lyse epithelial cells, but for no more than 75 minutes, to minimize sperm lysis.
14. During the incubation step do the following:
   a. Label a new tube for each sample, including the epithelial cell extraction negative control. Mark each tube as an epithelial cell fraction.
   b. Add 50 μL of 20% Chelex (from a well-resuspended Chelex solution) to each epithelial cell fraction tube.
   c. Close tubes.

15. Spin the extract in a microcentrifuge at 10,000 to 15,000 x g for 5 minutes.

16. Add 150 μL of the supernatant from each sample and the extraction negative to its respective epithelial cell fraction sample tube. Store at 4°C or on ice until step 20.

17. Wash the sperm pellet with Digest Buffer as follows:
   a. Resuspend the pellet in 0.5 mL Digest Buffer.
   b. Vortex briefly to resuspend pellet.
   c. Spin in a microcentrifuge at 10,000 to 15,000 x g for 5 minutes.
   d. Remove all but 50 μL of the supernatant and discard the supernatant.
   e. Repeat steps a-d for a total of 5 times.

18. Wash the sperm pellet once with sterile dH₂O as follows:
   a. Resuspend the pellet in 1 mL sterile dH₂O.
   b. Vortex briefly to resuspend pellet.
   c. Spin in a microcentrifuge at 10,000 to 15,000 x g for 5 minutes.
   d. Remove all but 50 μL of the supernatant and discard the supernatant.

19. Resuspend the pellet by stirring with a sterile pipette tip.

20. To the approximately 50 μL resuspended sperm fraction and to the tubes containing the substrate remains and the sperm fraction extraction negative, add 150 μL of 5% Chelex, 1 μL of 20 mg/mL Proteinase K, and 7 μL of 1M DTT. Mix gently.

21. Vortex both the epithelial cell and sperm fractions. The following steps apply to all fractions.

22. Incubate at 56°C for approximately 60 minutes.
23. Vortex at high speed for 5 to 10 seconds.

24. Incubate at 100°C for 8 minutes using a screw down rack.

25. Vortex at high speed for 5 to 10 seconds.

26. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

27. As needed, pipet aliquots of neat and a 1/100 dilution (using TE^-4) into a microcentrifuge tube for real-time PCR to determine human DNA concentration (refer to Section 3 of the STR manual).

28. Store the extracts at 2 to 8°C or frozen.
2. DNA EXTRACTION

CHELEX DNA EXTRACTION FROM HAIR

Microscopic examination of hair by PD lab should be completed before attempts at DNA typing. If possible document state of root on photo. Be careful not to lose adhering sheath material prior to extraction.

Note: Prior to starting this protocol, consult with the Mitochondrial DNA Team for guidance.

A. Sample preparation for loose hairs:

1. Handling hair with clean forceps, examine the hair under a dissecting microscope for the presence of sheath material. The hair may be placed on a clean piece of white paper. Note possible presence of body fluid on hair.

2. Wash the hair containing sheath material to remove surface dirt and contaminants by immersing the hair in sterile, deionized water in a clean 15 or 50 mL Falcon tube.

3. Return the hair to the dissecting microscope. Use a clean scalpel to cut a 1 cm portion from the root end of the hair and place in a 1.5 mL microcentrifuge tube.

B. Sample preparation for mounted hairs:

1. Remove cover slip by placing slide in freezer for 10 minutes and afterwards removing cover with a razor blade or clean forceps. Alternatively the slide can be submerged in fresh Xylene for 1-2 minutes.

2. Add 10-20 μL of fresh Xylene to the embedded hair sample. Allow 10-20 seconds for Permount to dissolve, then tease out the hair sample with clean forceps. Check slide for tissue that was left behind.

3. Place hair on clean microscope slide and add more fresh Xylene to remove adhering Permount. Pipet off Xylene, add a few drops of water, repeat rinsing with water several times.

4. Put hair under dissecting microscope. Use a clean scalpel to cut a 1 cm portion from the root end of the hair and place in a 1.5 mL microcentrifuge tube.
2. DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>9 OF 49</td>
</tr>
</tbody>
</table>

If not immediately starting Chelex extraction, do not place wet hair in a 1.5 mL tube. Perform additional 99% Ethanol rinse and let hair dry before placing in tube.

Do not consume hair shaft. If possible leave at least 1cm for mtDNA typing.

C. Chelex extraction

1. To hair tubes add:
   
   100 µL of 5% Chelex (from a well-resuspended Chelex solution).
   1 µL of 20mg/mL Proteinase K.

   **Note:** Ensure that the hair is completely immersed in the Chelex solution before incubating.

2. Incubate at 56°C for at least 6 to 8 hours, or overnight.

3. Vortex at high speed for 5 to 10 seconds.

4. Incubate at 100°C for 8 minutes using a screw down rack.

   **Note:** Check that the hair is completely immersed in the Chelex solution before boiling.

5. Vortex at high speed for 5 to 10 seconds.

6. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

7. Pipet 5 µL neat and also a 1/10 dilution (using TE⁻⁴) into a microcentrifuge tube for Real-Time PCR Analysis to determine human DNA concentration.

8. Store the remainder of the extract at either 2 to 8°C or frozen.

9. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.
ORGANIC EXTRACTION PROCEDURE

A. Sample Preparation

**Liquid/dry blood, bone marrow, oral swab and tissue sample preparation**

Stained substrates and oral swabs should be cut into small pieces (3 x 3 mm). Tissues should be minced into small pieces in a weigh boat using a sterile scalpel or razor blade. Place samples in 1.5mL microcentrifuge tubes or conical tubes when appropriate. See table below for various sample types.

Proceed to Section B: Sample Incubation

<table>
<thead>
<tr>
<th>Sample type</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liquid blood</td>
<td>100 to 500 µL</td>
</tr>
<tr>
<td>Bone marrow</td>
<td>0.5 x 0.5 cm to 1.5 x 1.5 cm</td>
</tr>
<tr>
<td>Oral swab</td>
<td>1/3 to a whole swab</td>
</tr>
<tr>
<td>Blood stain</td>
<td>0.5 x 0.5 cm to 1.5 x 1.5 cm</td>
</tr>
<tr>
<td>Soft tissue</td>
<td>0.5 x 0.5 cm to 1.5 x 1.5 cm</td>
</tr>
<tr>
<td>Paraffin embedded tissue</td>
<td>0.3 x 0.3 cm to 1.0 x 1.0 cm</td>
</tr>
</tbody>
</table>

**Bone preparation**

Before extraction, a bone or tooth specimen should be cleaned entirely of soft tissue and dirt using a range of methods, such as scraping, rinsing and sonication. A combination of sterile scalpels, sterile toothbrushes and running water should be used to clean the specimen. For a sonication bath, the sample is placed in a conical tube and covered with a 5% Terg-a-zyme solution. For additional cleaning, the sonication step may be repeated multiple times by decanting the liquid and replacing with fresh Terg-a-zyme solution. After cleaning, the sample is usually rinsed with distilled water and dried using a 56°C incubator (drying time may vary from a few hours to overnight).

**Note:** Terg-a-zyme is an enzyme-active powdered detergent. A 5% solution should be made fresh prior to bone preparation and cleaning. Refer to Appendix A in the Quality Assurance Manual. Once prepared, the reagent will only be effective for up to 16 hours.
2. DNA EXTRACTION

1. Photograph bone or tooth sample after cleaning. Measure and weigh specimen prior to sampling.

2. If several bones are available, generally compact bone is preferred, such as humerus, femur, or tibia.

**WARNING**
Protective eyewear, lab coats, cut resistant gloves and HEPA-filtered facial masks should be worn when cutting bone. Avoid breathing bone dust. All cutting of bone must be done under a biological hood.

3. Using an autopsy saw or a Dremel tool equipped with a 409 or 420 cutting wheel, cut the bone specimen into approximately 5x5x5mm size pieces. Take enough cuttings for an end weight of approximately 2g. For older or compromised bones, several aliquots of 2g can be extracted and combined during the Microcon step. For tooth samples, the whole root should be taken. **Note:** The cut off wheel should be disposed of after each use and the Dremel and hood should be completely wiped down with bleach and ethanol.

4. Place bone cuttings in 50mL conical tubes labeled with the FB case number, ME#, PM item #, initials, and date.

5. Cover bone cuttings with 5% Terg-a-zyme solution and sonicate samples for 30-45 minutes. **Note:** Ensure water level in the sonicator is 1-2 inches from the top.

6. Decant the Terg-a-zyme and wash with distilled water until no detergent bubbles remain.

7. If necessary, repeat with fresh changes of 5% Terg-a-zyme and water washes until the dirt has been removed.

8. Place the clean cuttings in a weigh boat on a small Kim Wipe. Cover with another weigh boat. Label the weight boat with the FB case number, ME#, PM item #, initials, and date.

9. Seal with evidence tape.

10. Dry in a 56°C incubator for a few hours or overnight. After sufficient drying, weigh bone cuttings. **The bone sample must be completely dry before milling.**
Sample milling with the SPEX Certiprep 6750 Freezer Mill
All freezer mill parts that come into contact with bone specimens, such as the cylinders, metal end plugs and impactors, should be cleaned, dried and sterilized prior to use. See Step 20 for appropriate cleaning procedure.

1. Assemble specimen vials in the following order: metal bottom, plastic cylinder, impactor, and metal top.
2. Place under UV light for a minimum of 15 minutes.
3. Label metal bottoms with blue Sharpie ink with a case identifier.
4. Add bone cuttings to specimen vial around impactor using decontaminated forceps. Cover with metal top. Note: Shake specimen vial and ensure that the impactor can move back and forth.
5. Wipe down inside of mill with a wet paper towel. Do not use bleach or ethanol.
6. Plug in mill and switch ON.
7. Obtain liquid nitrogen from tank by filling transfer container. Be aware that the liquid nitrogen tank may be empty when the detector level reads anywhere from “¼” to “empty”.

**WARNING**
Liquid Nitrogen can be hazardous. Use cryogenic gloves, protective eyewear/face shield and lab coats when handling. Avoid liquid nitrogen splashes to face and hands.

8. Open the freezer mill lid. Add liquid nitrogen slowly into the mill up to the FILL LINE to avoid splashing and boiling over.
9. Place the specimen vial into the round chamber. If processing more than one bone sample it is possible to save pre-cooling time by placing up to two vials in the mesh container inside the mill.
10. Change cycle number to match total number of samples plus two (n + 2).
2. DNA EXTRACTION

11. Adjust mill settings as follows:

<table>
<thead>
<tr>
<th>Cycle</th>
<th>set to # of samples + 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>T1 (milling) 2.0 min</td>
</tr>
<tr>
<td></td>
<td>T2 (pause) 2.0 min</td>
</tr>
<tr>
<td></td>
<td>T3 (pre-cool) 15.0 min</td>
</tr>
<tr>
<td>Rate</td>
<td>Bones – 8-10</td>
</tr>
<tr>
<td></td>
<td>Teeth – 6-8</td>
</tr>
</tbody>
</table>

12. Close cover slowly to avoid any liquid nitrogen splashes and press RUN to start the mill. Pre-cooling will begin followed by the milling cycle.

13. During the 2-minute pause phase, it is now possible to open the mill and remove the finished sample using cryogenic gloves.

14. Place one of the pre-cooled specimens waiting in the dock in the round chamber.

15. If liquid nitrogen level is below the FILL LINE, refill. A loud noise during milling means that the liquid nitrogen level is low. If liquid nitrogen is not refilled, damage to the mill, mill parts, and cylinder can occur.

16. Close the lid and press RUN again. Repeat from Step 11 until all samples are processed.

17. Inspect each sample after removal from the mill. If sample is sufficiently pulverized, remove the metal top using the Spex Certi-Prep opening device.
   Note: Samples may be reinserted into the mill for additional grinding.

18. Using decontaminated tweezers, remove impactor from vial and submerge in 10% bleach.

19. Empty bone dust into labeled 50mL Falcon tube. Ensure complete dust transfer by tapping bottom of cylinder. Weigh bone dust and document.

20. Soak metal end parts and plastic cylinder in 10% Bleach.

21. When milling is complete, switch mill to OFF and unplug. Leave cover open for liquid nitrogen to evaporate. The next day, lower cover and place in storage until next use.
22. **Mill Parts - Clean Up:** Mill parts must be cleaned immediately after processing. If this is not possible, steps a-b must be completed before leaving overnight.
   a. Rinse off with 10% bleach.
   b. Soak all parts in 0.1% SDS.
   c. Brush parts with a new toothbrush to remove any residual bone dust.
   d. Rinse with water.
   e. Soak parts in 10% bleach and brush each part in bleach individually.
   f. Rinse with water.
   g. Separate the plastic cylinders from the metal parts.
   h. Rinse in 100% ethanol. **ONLY** the metal top, metal bottom, and compactor can be rinsed in 100% ethanol. **DO NOT** rinse the plastic cylinder in ethanol as it will cause the plastic cylinder to break.
   i. Use isopropanol to remove any identifying marks made with a Sharpie on the tops or bottoms of the cylinders.
   j. Dry and expose the parts to UV light for a minimum of 2 hours. The UV light in a biological hood or a StrataLinker can be used.

23. Proceed to Section B: Sample Incubation.

**Laser Microdissection**
This procedure can be used to separate maternal (decidual) tissue from fetal material (chorionic villi) in early stage abortions. The procedure can only be performed in cooperation with the OCME histology department and a trained pathologist. The instrument used, the PixCell® IIe Laser Capture Microdissection System (ARCTURUS Systems for Microgenomics, Carlsbad, CA), is owned by NYU Medical center and can only be operated by trained NYU staff.

1. **Initial processing**

   The product of conception (POC) can be received in different stages of preparation:

   a) POC scrapings in saline buffer:

   Remove tissue from liquid either by filtration or centrifugation:
   - Transfer liquid to 50mL falcon tube
   - Spin sample in a bench top Eppendorf or IEC Centra CL3R at 1000 RPM for 5 minutes
   - Discard liquid supernatant
2. DNA EXTRACTION

Submit sample to the Histology department for tissue processing according to the OCME Histology Procedure Manual section E. Then proceed as for b).

b) POC fixated and embedded in paraffin blocks:

Contact histology department and ask them to prepare microscope slides from the paraffin block using the following precautions:

- Use disposable blades for the microtome and discard after each case.
- Clean working surface on microtome by wiping with 10% bleach and alcohol before and after each case.
- Use individual floating chambers for each case
- Use uncharged microscope slides

The slides then should be stained with hematoxylin and eosin-phloxine (H&E technique) as described in the OCME Histology Procedure Manual. But again during the staining procedure separate sets of jars have to be used for each case.

c) Stained or unstained microscope slides from POC blocks:

If the slides are unstained, ask the histology department to stain them as described above. Otherwise proceed with the microdissection technique. **Attention:** for slides that were prepared by a histology laboratory outside of the OCME, foreign DNA not from the mother and the fetus might be present on the slide.

2. PixCell IIe Laser Capture Microdissection

The PixCell® IIe Laser Capture Microdissection System (LCM) utilizes a low-power infrared laser to melt a special thermoplastic film over the area of interest. Especially developed CapSure Caps that are coated with this thermoplastic film are placed on the tissue sample and are used to capture the cells of interest after the laser excitation. See the Arcturus instrument manual for a more detailed description.
A trained pathologist has to be present to distinguish decidual tissue from chorionic villi and operate the laser. After the slide has been placed on the microscope platform the pathologist will visually identify the area of interest, mark this area for the laser, and activate the laser. The laser setting is specified in the Arcturus instrument manual. The Forensic Biology Criminalist needs to be present during the complete procedure to maintain chain of custody of the evidence.

An area of chorionic villi and an area of maternal tissue should be collected on separate CapSure caps. The caps can be stored and transported in 50 ml Falcon tubes. A third unused CapSure cap should be extracted as an extraction negative control.

Use new scalpel and clean forceps to remove the film from the cap and transfer the film to a fresh 1.5mL reaction tube containing 500µL of organic extraction buffer, DTT, SDS and Proteinase K as described below.

**B. Sample Incubation**

1. Process an extraction negative with every batch of extractions.

2. Prepare the master mix in microcentrifuge tube or conical tube and mix thoroughly by swirling or vortexing *very briefly*.

### For liquid blood, dry blood and bone marrow samples:

<table>
<thead>
<tr>
<th></th>
<th>1 Sample</th>
<th>5 Samples</th>
<th>10 Samples</th>
<th>15 Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organic extraction buffer</strong></td>
<td>400 µL</td>
<td>2.0 mL</td>
<td>4.0 mL</td>
<td>6.0 mL</td>
</tr>
<tr>
<td><strong>20% SDS</strong></td>
<td>10µL</td>
<td>50 µL</td>
<td>100µL</td>
<td>150 µL</td>
</tr>
<tr>
<td><strong>Proteinase K (20 mg/mL)</strong></td>
<td>13.6 µL</td>
<td>68 µL</td>
<td>136 µL</td>
<td>204 µL</td>
</tr>
<tr>
<td><strong>Total Incubation Volume per sample:</strong></td>
<td><strong>400 µL</strong></td>
<td><strong>400 µL</strong></td>
<td><strong>400 µL</strong></td>
<td><strong>400 µL</strong></td>
</tr>
</tbody>
</table>
## 2. DNA EXTRACTION

<table>
<thead>
<tr>
<th>For bone samples:</th>
<th>Per bone (~2g dust)</th>
<th>1 sample (N+ 2)</th>
<th>3 samples (N+ 2)</th>
<th>5 samples (N+ 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organic Extraction Buffer</td>
<td>2370 µL</td>
<td>7.11 mL</td>
<td>11.85 mL</td>
<td>16.59 mL</td>
</tr>
<tr>
<td>20% SDS</td>
<td>300 µL</td>
<td>900 µL</td>
<td>1.5 mL</td>
<td>2.1 mL</td>
</tr>
<tr>
<td>0.39 M DTT</td>
<td>120 µL</td>
<td>360 µL</td>
<td>600 µL</td>
<td>840 µL</td>
</tr>
<tr>
<td>Proteinase K (20 mg/mL)</td>
<td>210 µL</td>
<td>630 µL</td>
<td>1.05 mL</td>
<td>1.47 mL</td>
</tr>
<tr>
<td>Total Incubation Volume per sample:</td>
<td>3000 µL</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>For teeth samples:</th>
<th>Per tooth</th>
<th>1 sample (N+ 2)</th>
<th>3 samples (N+ 2)</th>
<th>5 samples (N+ 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organic Extraction Buffer</td>
<td>790 µL</td>
<td>2.37 mL</td>
<td>3.95 mL</td>
<td>5.53 mL</td>
</tr>
<tr>
<td>20% SDS</td>
<td>100 µL</td>
<td>300 µL</td>
<td>500 µL</td>
<td>700 µL</td>
</tr>
<tr>
<td>0.39 M DTT</td>
<td>40 µL</td>
<td>120 µL</td>
<td>200 µL</td>
<td>280 µL</td>
</tr>
<tr>
<td>Proteinase K (20 mg/mL)</td>
<td>70 µL</td>
<td>210 µL</td>
<td>350 µL</td>
<td>490 µL</td>
</tr>
<tr>
<td>Total Incubation Volume per sample:</td>
<td>1000 µL</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>For tissues and paraffin embedded tissue (e.g. microdissection) samples:</th>
<th>Per tissue</th>
<th>1 sample (N+ 2)</th>
<th>3 samples (N+ 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organic extraction buffer</td>
<td>395 µL</td>
<td>1185 µL</td>
<td>1975 µL</td>
</tr>
<tr>
<td>20% SDS</td>
<td>50 µL</td>
<td>150 µL</td>
<td>250 µL</td>
</tr>
<tr>
<td>0.39 M DTT</td>
<td>20 µL</td>
<td>60 µL</td>
<td>100 µL</td>
</tr>
<tr>
<td>Proteinase K (20 mg/mL)</td>
<td>35 µL</td>
<td>105 µL</td>
<td>175 µL</td>
</tr>
<tr>
<td>Total Incubation Volume per sample:</td>
<td>500 µL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2. DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>18 OF 49</td>
</tr>
</tbody>
</table>

3. Add the appropriate incubation volume of master mix to each sample tube and neg tube. Vortex tubes briefly. Make certain the substrate, tissue, or swab is totally submerged. **Note: Reagent volumes may be adjusted in order to accommodate the size or nature of a particular sample.**

4. Place tubes in a shaking 56°C heat block and incubate overnight.

5. Proceed to Section C: Phenol Chloroform Extraction and Microcon® cleanup.

C. Phenol Chloroform and Microcon Clean up

**Set Up**
Remove the Phenol:Chloroform:Isoamyl Alcohol (25:24:1) (PCIA) from the refrigerator. Aliquot from the lower, clear organic layer. Unscrew cap and use a pipet to aliquot the desired amount.

Obtain organic waste jug for disposal of any tubes or pipette tips that come in contact with PCIA.

**WARNING**
Phenol Chloroform is toxic. Protective eyewear, mask, lab coat, and nitrile gloves should be worn when handling. All work must be conducted under a chemical fume hood.

See Section D for preparation of Phase Lock Gel (PLG) tubes.

*For samples possibly needing mtDNA or Low Copy Number DNA testing:* Place one Microcon® YM100 collection tube and one 1.5 mL microcentrifuge tube for each sample, including the extraction negative, in the StrataLinker for at least 15 minutes. **Note:** Irradiate multiple tubes (4-6) per bone sample to accommodate the total volume of incubation buffer.
Phenol-Chloroform and Microcon Clean-up

1. Vortex and centrifuge the incubated microcentrifuge tube samples at high speed for 1 minute. Vortex and centrifuge bone dust, incubated in 50 mL conical tubes, for 5-10 minutes at 1000 RPM in Eppendorf Centrifuge Model 5810.

2. Obtain and label one prepared Eppendorf Phase Lock Gel (PLG) tube per sample, including the extraction negative. PLG tubes make phase separation easier and are optional. Note: For bone samples, label as many tubes to accommodate the total volume of incubation buffer per sample. For example, if you incubated 2g of bone dust with 3 mL of incubation buffer, you will technically need 6 PLG tubes.

3. Centrifuge PLG tubes at maximum speed for 30 seconds.

4. Label Microcon® YM100 filters for each sample. Prepare the Microcon® YM100 concentrators by adding 100 μL of TE-4 to the filter side (top) of each concentrator. Set aside until step 11.

5. Add a volume of Phenol:Chloroform: Isoamyl Alcohol 25:24:1 (PCIA) to the PLG tube which is equal to the volume of incubation buffer (typically 400 μL) to be added from the sample. Note: When pipetting PCIA, you must penetrate the top buffer layer. Place used pipette tips in the organic waste bottle.

6. Have someone witness your sample tubes, PLG tubes, and Microcon® YM100 tubes.

7. Pipette the sample supernatant (typically 400 μL) to the PLG tube already containing PCIA. For bone dust samples, pipette several aliquots of the supernatant into multiple PLG tubes. Note: Do not disturb bone pellet.

8. Shake the PLG tube vigorously by hand or by inversion to form a milky colored emulsion. Note: Do NOT vortex the PLG tube.

9. Centrifuge samples for 2 minutes at maximum speed to achieve phase separation. (On Eppendorf Centrifuge Model 5415D, spin at 16.1 RCF or 13.2 RPM).
10. If the sample is discolored, contains particles in the aqueous phase, or contains a lot of fatty tissue, transfer the top layer (aqueous phase) and repeat Steps 7-9. 
   Note: The aqueous layer from bone and teeth will usually be discolored. Only repeat the phenol-chloroform clean-up steps if any dust or particles are present in the aqueous layer. If it is not necessary to repeat the clean-up step, go to Step 11.

11. Carefully transfer the aqueous phase (top layer) to the prepared Microcon® YM100 concentrator. Be careful not to let the pipette tip touch the gel. Note: Discard used PLG tubes into the organic waste bottle.

12. Spin the Microcon® YM100 concentrators for 15 minutes at 500 x g, which is approximately 2500 RPM. (On Eppendorf Centrifuge Model 5415D, spin at 0.6 RCF or 2600 RPM). Note: Ensure that all fluid has passed through filter. If it has not, spin for additional time, in 10-minute increments. If fluid still remains, collect sample and microcon again using new filter.

13. Discard the wash tubes and place the concentrators into a new collection tube.

14. Add 400 μL of TE-4 to the filter side of each Microcon® YM100 concentrator.

15. Spin again for 15 minutes at 500 x g, which is approximately 2500 RPM, for 15 minutes. Spin the Microcon® YM100 concentrators for 15 minutes at 500 x g, which is approximately 2500 RPM. (On Eppendorf Centrifuge Model 5415D, spin at 0.6 RCF or 2600 RPM). Note: Ensure that all fluid has passed through filter. If it has not, spin for additional time, in 10-minute increments. If fluid still remains, collect sample and microcon again using new filter.

16. Add 40 μL of TE-4 to the filter side of each Microcon® YM100 concentrator. 
   Note: For bone samples, add only 10-20 μL of TE-4 to each filter side to ensure smallest elution volume.

17. Invert sample reservoir and place into a new labeled collection tube. (For samples possibly needing mtDNA or Low Copy Number DNA testing, invert sample reservoirs into irradiated collection tubes). Spin at 1000 x g, which is approximately 3500 RPM, for 3 minutes. (On Eppendorf Centrifuge Model 5415D, spin at 1.2 RCF or 3600 RPM).
18. Measure the approximate volume recovered and record on the organic extraction worksheet. **Note:** Combine bone elutants before measuring volume.

19. Discard sample reservoir and adjust sample volume depending on the starting amount and expected DNA content as follows using TE⁻⁴. **Note:** Samples may be microcon’ed again to further concentrate low DNA content samples.

<table>
<thead>
<tr>
<th>Sample type</th>
<th>Final Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>High DNA content (Large amounts of blood, fresh tissue, bone marrow, oral swabs, and dried bloodstains)</td>
<td>400 µL</td>
</tr>
<tr>
<td>Medium DNA content (Small amounts of blood, fresh tissue, bone marrow, oral swabs, and dried bloodstains); differential lysis samples</td>
<td>200 µL</td>
</tr>
<tr>
<td>Low DNA content (Formalin fixed tissue, dried bone, teeth, samples from decomposed or degraded remains, some reference samples)</td>
<td>100 µL</td>
</tr>
</tbody>
</table>

20. Transfer samples to newly labeled 1.5mL microcentrifuge tubes for storage. *(For samples possibly needing mtDNA or Low Copy Number DNA testing, transfer samples to irradiated 1.5 mL microcentrifuge tubes).* Record the approximate final volume on the organic extraction worksheet.

21. As needed, pipet aliquots of neat and/or diluted extract into microcentrifuge tube for real-time PCR analysis to determine human DNA concentration (refer to Section 3 of the STR manual).

22. Store the extracts at 2 to 8°C or frozen.
23. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.

**NOTE:** For larger volumes, 15 ml PLG tubes may be prepared as well as Centricon\textsuperscript{®} YM100 concentrators (available in 2mL, 15mL and other sizes). For concentration, spin at 500x g and at 1000x g for recovery. Adjust RPM according to centrifuge used. Do not exceed 1000x g. Please be aware that using the larger PLG and the Centricon\textsuperscript{®} YM100 concentrators will require longer spin times.

**NOTE:** See Microcon\textsuperscript{®} troubleshooting as needed.

**D. Preparation of Phase Lock Gel (PLG) tubes**

The purchase of Phase Lock gel (PLG) Syringes Heavy is economical and more convenient than having to stock all possible tube sizes. The gel in the syringe can be added to different disposable tubes. Make sure the plasticware being used is resistant to phenol and chloroform.

1. Without putting pressure on the plunger, twist off the orange cap and discard. Attach the gray dispensing tip (supplied) to the syringe and tighten securely. (NOTE: Use of gray tip is optional for a smoother application of PLG. Less force is necessary when gray tip is NOT used.)

2. Apply firm pressure on the plunger to dispense PLG until it reaches the end of gray tip. Add heavy PLG based on Table below. NOTE: 325μL = 3.25 cc corresponds to 3 lines on the syringe

<table>
<thead>
<tr>
<th>Tube size</th>
<th>PLG heavy</th>
<th>Tube size</th>
<th>PLG heavy</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5mL</td>
<td>100μL</td>
<td>15mL</td>
<td>3mL</td>
</tr>
<tr>
<td>1.5mL</td>
<td>325μL</td>
<td>50mL</td>
<td>5mL</td>
</tr>
<tr>
<td>2.0mL</td>
<td>325μL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3. Pellet the PLG by spinning the tubes prior to use. See table below.

<table>
<thead>
<tr>
<th>Tube size</th>
<th>Centrifuge model</th>
<th>Speed</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5 to 2.0mL</td>
<td>Eppendorf 5415C</td>
<td>14 x 1000 RPM</td>
<td>30s</td>
</tr>
<tr>
<td></td>
<td>Eppendorf 5415D</td>
<td>13.2 x1000 RPM/16.1 x1000 RCF</td>
<td></td>
</tr>
<tr>
<td>15 and 50mL</td>
<td>Sigma 4-15 C</td>
<td>1500 RCF</td>
<td>2m</td>
</tr>
</tbody>
</table>
MAGATTRACT DNA EXTRACTION FROM BLOODSTAINS AND BUCCAL SWABS

Sample size for the extraction should be approximately 1/3 of a swab or a 3x3 mm cutting of the stain. This extraction is applicable to bloodstain and buccal swabs only, NOT cigarette butts.

All bloodstain and exemplar cuttings should be placed in 2.0mL screw cap sample tubes. All samples in 1.5mL Eppendorf tubes should be transferred to a 2.0mL screw cap sample tube prior to extraction.

Add samples to the appropriate M48 Sample Submission Sheet- exemplars or evidence. Include sample info, tube label, target date and IA initials. The analyst performing the extraction will assign sample rack position numbers.

A. Setting up M48 Spreadsheet and Saving Sample Name List

1. Collect the M48 Sample Submission Sheets for the extraction. On these sheets, assign each sample a sample rack position, remembering that the extraction negative will occupy Position 1 (and position 25, if extracting >24 samples). Also fill in the initials of the analyst performing the extraction and the extraction date(s) and time(s). This date and time will be used throughout the extraction.

2. Open the appropriate M48 spreadsheet, evidence (M48EV) or exemplar (M48EX) depending on your sample set.

2. Click the “Input Sample Names” tab and enter the sample names for the extraction, including the extraction negative(s), into the appropriate positions in column B.

3. Save this sheet by going to File → Save As and save the sheet to the “SampleName” folder on the desktop with “File Name:” in MMDDYY.HHMM format and “Save As Type:” set to CSV (Comma delimited)(*.csv). For instance an extraction performed at 2:20pm on May 23, 2006 would be saved, with date and time in military format, as 052306.1420.csv. This ensures proper data basing of sample sheets and report pages.

4. Click “Save”.

5. A window stating “The selected file type does not support workbooks that contain multiple sheets” will open. Click “OK”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
2. DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>25 OF 49</td>
</tr>
</tbody>
</table>

6. A second window asking “Do you want to keep the workbook in this format?” opens. Click “Yes”.

7. Click the Ext Sheet 24 or Ext Sheet 48 tab depending on the batch size of the extraction. For batches consisting of 24 or less samples, including the extraction negative, use Ext Sheet 24. For batches consisting of 25-48 samples, including the extraction negatives, use Ext Sheet 48.

8. Once the appropriate extraction sheet is open, finish the sheet by entering the tube label, target date, and IA initials for each sample.

9. Print the extraction sheet by going to File → Print. Verify the selected printer is correct and click “OK”.

10. Minimize the M48 spreadsheet (do not close Excel or hit the “X” in the upper right-hand corner!).

B. Sample Preparation and Incubation

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. Do not extract both together.

2. Wear appropriate lab gear for all handling of samples and reagents particularly when working over the robotic platform. This includes gloves, lab coat, and mask. Sample preparation should be performed under a hood.

3. Have a witness verify your samples.

4. For large runs, prepare master mix for N+2 samples as follows, vortex briefly, and add 200μL to each of the tubes in the extraction rack and the pre-prepared extraction negative tube. For smaller runs, you may add Proteinase K and G2 Buffer to each tube individually:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>1 sample</th>
<th>6 samples</th>
<th>12 samples</th>
<th>18 samples</th>
<th>24 samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digestion Buffer (Buffer G2)</td>
<td>190 μL</td>
<td>1520 μL</td>
<td>2660 μL</td>
<td>3800 μL</td>
<td>4940 μL</td>
</tr>
<tr>
<td>QIAgen Proteinase K</td>
<td>10 μL</td>
<td>80 μL</td>
<td>140 μL</td>
<td>200 μL</td>
<td>260 μL</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
5. Shake at 1000 rpm at 56°C for a minimum of 30 minutes.

C. **BioRobot M48 Software and Platform Set-Up**

2. Click the “Start” button. **Note: The door and container interlock must be closed to proceed.**
3. “F Trace MTL” protocol should be selected. If not, click on the arrow in the middle of the screen and then select “New Dev” → “gDNA” → and “F Trace MTL”.
4. Click on the “select” button and select “1.5 ml” for the size of the elution tubes.
5. Select the number of samples 6, 12, 18, 24, 30, 36, 42, or 48.
6. Set sample volume to 200 μL (cannot and should not change).
7. Set elution volume to 200 μL.
8. The next prompt asks to ensure the drop catcher is clean. In order to check this, click on “manual operation” and select “Drop Catcher Cleaning”. The arm of the robot will move to the front of the machine, and the drop catcher (a small plastic tray) will be right in front of you. Remove and clean with 70% ethanol. When the catcher is clean, replace the tray, close the door, and click “OK” in the window.
9. Make sure that the chute to the sharps container bin is clear for the tips to be discarded. Click “Next”.
2. DNA EXTRACTION

10. The software will calculate the number of tips necessary for the run. Place tips in the tip rack(s) if necessary. **When filling racks make sure that the pipette tips are correctly seated in the rack and flush with the robotic platform.** Tips are located in three racks. These racks may be filled one at a time, BUT you must fill a **whole rack** at a time. After a rack is filled, reset the tip rack by clicking on “Yes tip rack ...”, If no new tips are being added to the robot click “No”.

**NOTE:** When opening a new tip bag, ALL tips should be placed onto the robotic platform. Open tip bags should not be returned to the drawer. Racks may be used for tip storage. When adding tips, spilling into the next empty rack is OK, just do not **reset** the rack until it is **completely** full.

Tips needed for a run:

<table>
<thead>
<tr>
<th># Samples</th>
<th>6</th>
<th>12</th>
<th>18</th>
<th>24</th>
<th>30</th>
<th>36</th>
<th>42</th>
<th>48</th>
</tr>
</thead>
<tbody>
<tr>
<td># Tips</td>
<td>30</td>
<td>42</td>
<td>54</td>
<td>66</td>
<td>78</td>
<td>90</td>
<td>102</td>
<td>114</td>
</tr>
</tbody>
</table>

After you are finished, click “Next”.

11. Fill the reagent reservoirs as stated below. All reagents are stored in their respective plastic reservoirs in the metal rack, covered with Parafilm, **EXCEPT** the magnetic resin. The resin is stored between runs in its original stock bottle to prevent evaporation. Vortex the magnetic resin solution well, both in the stock bottle and in the reservoir, before adding it to the metal rack. **If you notice crystallization in any of the solutions, discard the solution, rinse the container out with distilled water, and start again with fresh reagent.**

12. Remove the Parafilm and lids from the reagents, and fill the reservoirs to the appropriate level using solutions from the working solution bottles using the same lot as labeled on the reservoir. **If not enough of the same lot of a solution remains, discard the remaining solution from the reservoir, rinse and re-label the reservoir with the new lot number.** When filling the reservoirs add approximately 10% to the volumes recommended below to account for the use of the large bore pipette tips:

**Note:** Do not forget that bottles of MW1 require the addition of ethanol prior to use. See bottle for confirmation of ethanol addition and instructions for preparation if needed.
2. DNA EXTRACTION

<table>
<thead>
<tr>
<th># of samples</th>
<th>Large reservoir Sterilized Water (mL)</th>
<th>Large reservoir Ethanol (mL)</th>
<th>Large reservoir Buffer MW1 (mL)</th>
<th>Large reservoir Buffer MTL (mL)</th>
<th>Small reservoir Buffer MW2 (mL)</th>
<th>Elution buffer (TE&lt;sub&gt;4&lt;/sub&gt;) (mL)</th>
<th>Small reservoir Magnetic Resin (mL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>10.0</td>
<td>11.8</td>
<td>7.2</td>
<td>5.9</td>
<td>3.5</td>
<td>2.5</td>
<td>1.5</td>
</tr>
<tr>
<td>12</td>
<td>18.4</td>
<td>22.6</td>
<td>12.9</td>
<td>10.3</td>
<td>5.9</td>
<td>3.7</td>
<td>1.7</td>
</tr>
<tr>
<td>18</td>
<td>26.9</td>
<td>33.4</td>
<td>18.6</td>
<td>14.7</td>
<td>8.4</td>
<td>4.9</td>
<td>1.9</td>
</tr>
<tr>
<td>24</td>
<td>35.3</td>
<td>44.2</td>
<td>24.3</td>
<td>19.0</td>
<td>10.8</td>
<td>6.1</td>
<td>2.1</td>
</tr>
<tr>
<td>30</td>
<td>43.7</td>
<td>55.0</td>
<td>30.0</td>
<td>23.4</td>
<td>13.3</td>
<td>7.3</td>
<td>2.3</td>
</tr>
<tr>
<td>36</td>
<td>52.2</td>
<td>65.8</td>
<td>35.7</td>
<td>27.8</td>
<td>15.7</td>
<td>8.5</td>
<td>2.5</td>
</tr>
<tr>
<td>42</td>
<td>60.6</td>
<td>76.6</td>
<td>41.4</td>
<td>32.1</td>
<td>18.2</td>
<td>9.7</td>
<td>2.7</td>
</tr>
<tr>
<td>48</td>
<td>69.0</td>
<td>87.4</td>
<td>47.0</td>
<td>36.5</td>
<td>20.6</td>
<td>10.9</td>
<td>2.9</td>
</tr>
</tbody>
</table>

Place each reservoir into the metal rack in the following locations. The plastic reservoirs only fit into the rack one way. Check the directions of the notches which should point into the robot:

<table>
<thead>
<tr>
<th>Size Container</th>
<th>Rack Position</th>
<th>Software Tag</th>
<th>Reagent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Container</td>
<td>L4</td>
<td>Rea_4</td>
<td>Sterilized Water</td>
</tr>
<tr>
<td>Large Container</td>
<td>L3</td>
<td>Rea_3</td>
<td>Ethanol (100%)</td>
</tr>
<tr>
<td>Large Container</td>
<td>L2</td>
<td>Rea_2</td>
<td>Wash Buffer 1 (Buffer MW1)</td>
</tr>
<tr>
<td>Large Container</td>
<td>L1</td>
<td>Rea_1</td>
<td>Lysis and Binding Buffer (Buffer MTL)</td>
</tr>
<tr>
<td>Small Container</td>
<td>S6</td>
<td>ReaS6</td>
<td>(empty)</td>
</tr>
<tr>
<td>Small Container</td>
<td>S5</td>
<td>ReaS5</td>
<td>(empty)</td>
</tr>
<tr>
<td>Small Container</td>
<td>S4</td>
<td>ReaS4</td>
<td>(empty)</td>
</tr>
</tbody>
</table>
2. DNA EXTRACTION

<table>
<thead>
<tr>
<th>Size Container</th>
<th>Rack Position</th>
<th>Software Tag</th>
<th>Reagent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Container</td>
<td>S3</td>
<td>ReaS3</td>
<td>Wash Buffer 2 (Buffer MW2)</td>
</tr>
<tr>
<td>Small Container</td>
<td>S2</td>
<td>ReaS2</td>
<td>Elution Buffer (TE⁻⁴)</td>
</tr>
<tr>
<td>Small Container</td>
<td>S1</td>
<td>ReaS1</td>
<td>Magnetic Particle Resin</td>
</tr>
</tbody>
</table>

13. Flip up the “container interlocks” and place the metal reservoir holder onto the left side of the robotic platform in the proper position. **DO NOT force the holder into place and be careful not to hit the robotic arm.** After correctly seating the metal holder, flip down the “container interlocks” and press “next”.

14. Click “Next” when you are prompted to write a memo.

15. Place the sample preparation trays on the robot. One tray for every 6 samples. Click “Next”.

16. Place empty, unlabeled 1.5mL elution tubes in the 65 degree (back) hot block, located on the right side of the robotic platform. Click “Next”.

17. Label 1.5 mL screw top tubes for final sample collection in the robot.

18. Place **labeled**, empty 1.5 mL sample collection tubes in the 8 degree (front) cold block for collection of final samples.

19. At this point, the samples should be near the end of the incubation period (From Section A, Step 5). Spin all tubes in a microcentrifuge for 1 minute at 10,000 to 15,000 x g.

20. Remove caps and place the samples for extraction on the robot. Discard the caps. **For empty positions, add a 2.0 mL sample tube filled with 200 uL of sterile water.**
21. Have a witness confirm the order and labels of both the sample tubes and the labeled 1.5 mL final sample collection tubes. The robot setup witness should also verify that all plastic-ware is in the correct position and correctly seated in the platform.

22. Click “Yes” when asked to input sample names.

D. Importing Sample Names

1. At the sample input page, click “Import”.

2. The Open window will appear. “Look in:” should automatically be set to a default of “SampleName”. If not, the correct pathway to the folder is My Computer\C:\Program Files\GenoM-48\Export\SampleName. (The SampleName folder on the desktop is a shortcut to this file.)

3. Select your sample name file and click “Open”. Verify that your sample names have imported correctly. Do not be concerned if a long sample name is not completely displayed in the small window available for each sample.

4. Manually type in the word “Blank” for all empty white fields.

5. Click “Next”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
E. Verifying Robot Set-Up and Starting the Purification

1. In addition to confirming the position of all plasticware and samples, check the following conditions before proceeding:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>All plasticware (tips, sample plates, tubes) is seated properly in the</td>
<td>✔</td>
</tr>
<tr>
<td>robotic platform</td>
<td></td>
</tr>
<tr>
<td>Metal reservoir rack is seated properly, UNDER the interlocks</td>
<td>✔</td>
</tr>
<tr>
<td>Interlocks are down</td>
<td>✔</td>
</tr>
<tr>
<td>Sample tubes, elution tubes and sample collection tubes have been</td>
<td>✔</td>
</tr>
<tr>
<td>added to the platform in multiples of 6 as follows:</td>
<td></td>
</tr>
<tr>
<td>Empty 1.5 mL tubes are filling empty positions for both sets of elution</td>
<td>✔</td>
</tr>
<tr>
<td>tubes in the cold and hot blocks</td>
<td></td>
</tr>
<tr>
<td>2.0 mL sample tubes filled with 200uL of sterile H2O are in empty positions</td>
<td>✔</td>
</tr>
<tr>
<td>of the sample rack</td>
<td></td>
</tr>
</tbody>
</table>

2. After confirming the position and set-up of the plastic-ware click “Confirm”.

3. Click “OK” after closing the door.

4. Click “Go” to start the extraction.

5. The screen will display the start time, remaining time, and the completion time. You are now free to complete other work until the extraction is complete.

6. It is advisable to monitor the extraction until the transfer of DNA sample from the sample tubes to the first row of sample plate wells to ensure proper mixing of magnetic resin and DNA sample.

7. At the end of the extraction, a results page will be displayed indicating the pass/fail status of each set of six samples. See Section F for instructions for printing out the report page.
2. DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>32 OF 49</td>
</tr>
</tbody>
</table>

F. Saving and Printing Extraction Report Page

1. At the results page click the “Export” button at the bottom center of the screen. The Save As window will appear. “Save In:” should be set to the “Report” folder on the desktop. This is a shortcut to the following larger pathway: My Computer\C:\Program Files\GenoM-48\Export\Report.

2. In “File Name:”, name the report in the format, MMDDYY.HHMM. Set “Save As Type:” to Report Files (*.csv). For instance an extraction performed at 4:30pm on 5/14/06 would be saved as 051406.1630.csv.

3. Click “Save”.

4. Maximize the M48 spreadsheet by clicking its icon on the bottom tool bar.

5. At the bottom of the spreadsheet, click the “Import Run Results” tab.

6. Highlight cell “A1” and in the pull-down menus go to Data → Get External Data → Import Text File…

7. In the Import Text File window select:
   - Look in: Report (For specific pathway refer to Section F Step 1)
   - Files of Type: All files
   - File Name: Select your extraction run results by date and time

8. Click “Import”.

9. In the Text import Window Step 1 of 3, check the following settings:
   - Original Data Type: Delimited
   - Start Import at Row: 1
   - File Origin: WINDOWS (ANSI)
The window should appear as below:

10. Click “Next”.

11. In Text Import Window Step 2 of 3, select the following:

**Delimiters:** Place a check by comma. Make sure no other options are checked.

**Text qualifier:** “

Verify that the settings and data preview corresponds to those in the window below:

12. Click “Next”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
13. In Text Import Window Step 3 of 3, select the following:

**Column Data Format**: General

The window should appear as below:

14. Click “Finish”.

15. In the Import Data window “Existing Worksheet” should be selected and the data input cell should read “=$AS$1”. See below:

16. Click “OK”. Data will import into spreadsheet.

17. Click on the “Report” tab and verify that the run data has correctly imported into the report page.

18. Manually enter the analyst’s initials and extraction date (MM/DD/YY) and time (HH:MM AM/PM) in the highlighted cells.
19. Print the run report page.

20. Close the spreadsheet by going to File → Exit. A window asking “Do you want to save changes you made to…?” Click “No”.

21. Proceed with clean-up and sterilization.

G. Post-Extraction Clean Up and UV Sterilization

1. Remove samples (from the 8 degree (front) cold block) from the robotic platform and cap with newly labeled screw caps.

2. Discard used pipette tips, sample tubes, and sample preparation plate(s). Remove reservoir rack.

3. Replace the lid on the magnetic resin reservoir and vortex remaining resin thoroughly. Transfer the Magnetic resin to the stock bottle immediately with a 1000uL pipette. Rinse the reagent container with de-ionized water followed by ethanol and store to dry.

4. Cover all other reagents and seal with Parafilm for storage. DON’T FORGET TO LABEL RESERVOIRS WITH THE LOT NUMBER OF THE REAGENT THEY CONTAIN.

5. Wipe down the robotic platform and waste chute with 70% ethanol. DO NOT USE SPRAY BOTTLES.

6. Click “Next”.

7. When prompted, “Do you want to perform a UV sterilization of the worktable?” click “Yes”.

8. Select 1 Hour for the time of “UV sterilization” then click “yes” to close the software upon completion.

9. As needed, pipet aliquots of neat and/or diluted extract into microcentrifuge tube for real-time PCR analysis to determine human DNA concentration (refer to Section 3 of the STR manual).
10. Store the extracts at 2 to 8°C or frozen.

11. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.

12. Submit the run report and extraction paperwork to the supervisor for review.

13. DON’T FORGET TO FILL OUT THE M48 USAGE LOG WITH THE TIME AND DATE OF THE EXTRACTION, USER INITIALS, AND ANY COMMENTS ARISING FROM THE RUN.

H. BioRobot M48 Platform Diagram

![BioRobot M48 Platform Diagram]

*Figure 1. Diagram of Robotic Platform of the QIAGEN BioRobot M48.*

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1-4)</td>
<td>(1-3)</td>
<td>(1-3)</td>
<td>(1-8)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **A (1-4)** Large Reagent Reservoir Positions
- **B (1-3)** Small Reagent Reservoir Positions
- **C (1-3)** Tube Racks 1, 2, and 3
- **D (1-8)** Sample Plate Holders
- **E** Hot Elution Block (65 degrees)
- **F** Cold Final Elution Block (8 degrees)
- **G (1-2)** Sample Tube Racks
- **H (1-2)** Waste Disposal Chute
I. Troubleshooting

<table>
<thead>
<tr>
<th>ERROR</th>
<th>CAUSE/REMEDY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resin/sample is being drawn up into pipette tips unequally</td>
<td><strong>Report problem to QA.</strong> Resin buffer has evaporated. O-rings are leaking and need service.</td>
</tr>
<tr>
<td>Crystallization around 1st row of wells in sample plate</td>
<td>Forgot to fill empty sample tubes with 200uL of sterile H2O.</td>
</tr>
<tr>
<td>BioRobot M48 cannot be switched on</td>
<td>BioRobot M48 is not receiving power. Check that the power cord is connected to the workstation and to the wall.</td>
</tr>
<tr>
<td>Computer cannot be switched on</td>
<td>Computer is not receiving power. Check that the power cord is connected to the computer and to the wall power outlet.</td>
</tr>
<tr>
<td>BioRobot M48 shows no movement when a protocol is started</td>
<td>BioRobot M48 is not switched on. Check that the BioRobot M48 is switched on.</td>
</tr>
<tr>
<td>BioRobot M48 shows abnormal movement when a protocol is started</td>
<td>The pipettor head may have lost its home position.</td>
</tr>
<tr>
<td>Aspirated liquid drips from disposable tips</td>
<td>Dripping is acceptable when ethanol is being handled. For other liquids: air is leaking from the syringe pump.</td>
</tr>
<tr>
<td></td>
<td><strong>Report problem to QA.</strong> O-rings require replacement or greasing.</td>
</tr>
<tr>
<td></td>
<td>If the problem persists, contact QIAGEN Technical Services</td>
</tr>
</tbody>
</table>
LOW COPY NUMBER DNA EXTRACTION

A. Personal Preparation

2. Don a mask, hair covering, lab coat, and gloves.
   a. Ensure that the cuffs of the lab coat completely cover arms.
   b. Lab coats may be re-worn in the pre-amp rooms only.

2. Do not enter room without appropriate personal protective equipment. Moreover, never touch any apparatus, bench etc with bare hands.

3. Remove gloves when answering the phone and touching door handles in order to maintain a DNA free glove.

B. Paperwork preparation

1. Refer to the High Sensitivity Submission Protocol to determine which samples are appropriate for this extraction procedure.

2. Extraction sets consist of 9 samples and one extraction negative. Additional extractions may continue sequentially during incubations.

3. In cell H1 of the appropriate extraction sheet (which can be found in the “Templates in Use” folder on the “Hi Sens data”), type in the name of the extraction assay as follows: “E” for extraction, month, day, and year, “period”, hour and minute. For example, E040905.1330.

4. Manually enter OR copy and paste the samples names into the appropriate extraction sheet. The worksheet will automatically calculate the requisite amount of reagents needed for the extraction.
C. Work Place Preparation

1. Apply 10% bleach followed by water and 70% Ethanol to the entire work surface, cap opener, and pipets.

2. Retrieve clean racks and cap openers, and irradiated microcentrifuge tubes, and irradiated water from storage. Arrange work place to minimize crossover.

    NOTE: Only use filter tips for pipetting.

3. Position gloves nearby with 10% Bleach/70% Ethanol/water in order to facilitate frequent outer glove changes and cleaning.

D. Digestion

1. Self-Witnessing Step: Confirm the sample names on the extraction sheet with the names on the sample tubes.

2. Prepare solution in an UV irradiated tube (1.5 mL, 2.0 mL Dolphin, or 15 mL).

3. Prepare the digestion buffer according to the calculated volumes on the extraction sheet. The volume for one sample is shown below.

<table>
<thead>
<tr>
<th>Stock Solution</th>
<th>Concentration</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.01% SDS</td>
<td>0.01% (0.0096%)</td>
<td>192 µL</td>
</tr>
<tr>
<td>Proteinase K 18 mg/mL</td>
<td>0.72 mg/mL</td>
<td>8 µL</td>
</tr>
</tbody>
</table>

4. Vortex solution well. Add 200 µL of the digestion buffer to each sample. Open only one sample tube at a time using the cap opener. Ensure that the swabs are submerged in the digestion fluid. If necessary, add an additional 200 µL of the digest buffer (including the Proteinase K) to the sample in order to submerge a large sample.
5. Record the temperatures of the heat shakers on the extraction worksheet. Temperatures must be within ± 3°C of the set temperature.

6. Incubate on the heat shaker at 56°C for 30 minutes with shaking at 1400 rpm.

7. Incubate on the heat shaker at 99°C for 10 minutes with no shaking (0 rpm).

8. After removing from the shaker, centrifuge the samples at full speed, briefly. Allow the samples to cool for a few minutes while preparing for next steps.

9. During the digestion period label the Microcon®, elution, and storage tubes in advance.

E. Purification and Concentration

1. Prepare Microcon® 100 tubes and label the membrane tube and filtrate tube cap. Use Microcon® 50 tubes as indicated, for example when degradation is suspected. Consult evidence exam schedule sheet or supervisor.

2. Witness step: Confirm the sample names on the extraction sheet with the names on the sample and Microcon® tubes.

3. Pre-coat the Microcon® membrane with a 1/1000 dilution of Poly A RNA prepared as follows in an irradiated microcentrifuge tube or 15 mL tube:

   a. Poly A RNA Preparation

      i. Make a 1/10 dilution of 1mg/mL of Poly A RNA as follows: add 2 µL of Poly A RNA to 18 µL of irradiated water and mix the solution well. This is a final concentration of 100µg/mL.

      ii. Using the 1/10 dilution, make a 1/100 dilution with 2 uL of 100ug/mL Poly A RNA in 198 uL of irradiated water and mix the solution well. The solution has a final concentration of 1 ng/uL.
iii. Add 1 µL of the 1ng/µL Poly A RNA solution to 199µL of water for each sample on the extraction sheet.

iv. Aliquot 200 µL of this Poly A RNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the extraction worksheet for calculated value.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>199 µL</td>
</tr>
<tr>
<td>Poly A RNA (1ng/µL)</td>
<td>1 µL</td>
</tr>
</tbody>
</table>

**NOTE:** For samples with 400 µL of digest solution, make a 20 µL solution of 1 µL of Poly A RNA (1 ng/µL) with 19 µL of water. Mix well and add this solution to the membrane. Ensure that the entirety of the membrane is covered. In this manner, all of the digest may be added to the Microcon® membrane for a total volume of 420 µL.
4. Filtration

a. Add the entirety of each extract to its pretreated Microcon® membrane. Aspirate all of the solution by placing the pipet within the swab. The sample tubes may be discarded.

b. Centrifuge the Microcon® tube at 2400 rpm for 15 minutes.

c. If indicated on the evidence examination schedule sheet or by a supervisor, or if the filtrate is not clear, perform a second wash step applying 400 µL of water onto the membrane and centrifuging again at 2400 rpm for 15 minutes. This process may be repeated, as necessary. Note the additional washes on the extraction sheet.

d. Visually inspect each Microcon® membrane tube. If it appears that more than 5 µL remains above the membrane, centrifuge that tube for 5 more minutes at 2400 rpm.

5. Elution

a. Open only one Microcon® tube and its fresh collection tube at a time.

b. Add 20 µL of irradiated water to the Microcon® and invert the Microcon® over the new collection tube. Avoid touching the membrane.

c. Centrifuge at 3400 rpm for 3 minutes.

d. Transfer the eluant to an irradiated and labeled 1.5 mL tube. Measure and record the approximate volume. The total volume should not exceed 30 uL and should not be less than 20 uL. Adjust the final volume to 20 uL (if less). Discard the Microcon® membrane.

e. If the eluant appears to be a dark color or is not clear, it may be necessary to purify the sample again. Prepare a fresh Microcon® tube and repeat steps 4-6.
F. Clean up

1. Wipe the entire work area surface and pipets with 10% bleach followed by Ethanol and water.

2. Soak and/or clean racks, pipets, the cap opener and other equipment that would not adequately cleaned with the Stratalinker with 10% bleach, water and 70% Ethanol.

3. Turn on the UV lamp in the hood for ten minutes; remember to turn off the light in order to preserve the bulb.

4. If necessary, replenish the microcentrifuge tube and Microcon® collection tube supply. Irradiate for 30 minutes. Do not irradiate the Microcon® membranes.

G. Sample Storage

1. Place samples in a cryobox in the DNA refrigerator in the appropriate extract storage box. Indicate on the extraction sheet and tracking sheet the storage location.

2. Place extraction sheet in the appropriate area and notify the rotation supervisor that the samples are ready for quantitation.
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

2. DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>44 OF 49</td>
</tr>
</tbody>
</table>

EXTRACTION OF EXOGEOUS DNA FROM NAILS

A. Personal Preparation

1. Don a mask, hair covering, lab coat, and gloves.
   a. Ensure that the cuffs of the lab coat completely cover arms.
   b. Lab coats may be re-worn in the pre-amp rooms only.

2. Do not enter room without appropriate attire. Moreover, never touch any apparatus, bench, etc with bare hands.

3. Remove gloves when answering the phone and touching door handles in order to maintain a DNA free glove.

B. Paperwork preparation

1. High Sensitivity extraction sets consist of 9 samples and one Extraction Negative. Additional extractions may continue sequentially during incubations.

2. In cell H1 of the appropriate nail extraction sheet (found for example in the “Templates in Use” folder on the Hi Sens Data or in the “Forms” folder on the FBIOLOGY_MAIN drive), type in the name of the extraction assay as follows: month (MM), day (DD), and year (YY), “period”, hour (HH) and minute (MM). For example, 040905.1330 for an extraction performed on April 9th, 2005 at 1:30pm. Save the sheet with “E” for extraction followed by the name of the extraction assay. For example, E040905.1330.

3. Manually enter OR copy and paste the sample names into the appropriate extraction sheet. The worksheet will automatically calculate the requisite amount of reagents needed for the extraction.
C. Work Place Preparation

1. Apply 10% bleach followed by water and 70% Ethanol to the entire work surface, cap opener, and pipets.

2. Retrieve clean racks and cap openers, and irradiated microcentrifuge tubes and irradiated water from storage or the Stratalinker. Arrange work place to minimize crossover.

NOTE: Only use filter tips for pipetting.

3. Position gloves nearby with bleach/Ethanol/water in order to facilitate frequent outer glove changes and cleaning.

D. Digestion

1. From evidence exam, each nail (or group of nails as dictated by the previous collection and storage of the evidence or a supervisor) should be placed in an irradiated tube.

2. Add 200 µL of irradiated 25 mM EDTA/PBS solution to each sample.

3. Sonicate the samples for one hour at room temperature.

4. Label a new set of irradiated microcentrifuge tubes with the sample identifiers.

5. Remove the supernatants from the samples and place in the labeled irradiated microcentrifuge tubes.
2. DNA EXTRACTION

E. Extraction

1. Prepare the digestion buffer according to the calculated volumes on the nail extraction sheet. The volumes for one sample are shown below:

<table>
<thead>
<tr>
<th>Stock Solution</th>
<th>Concentration</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0% SDS</td>
<td>1.0% (0.96%)</td>
<td>2.3 (2.25)</td>
</tr>
<tr>
<td>Proteinase K 18 mg/mL</td>
<td>0.72 mg/mL</td>
<td>9 µL</td>
</tr>
<tr>
<td>Irradiated water</td>
<td>N/A</td>
<td>13.7 µL</td>
</tr>
</tbody>
</table>

2. Prepare Microcon® 100 tubes and label the membrane tube and filtrate tube cap with the sample identifiers. (Use Microcon® 50 tubes as indicated, for example when degradation is suspected. Consult the evidence exam schedule sheet or a supervisor.) Prepare and label the Microcon® collection tubes, sample storage microcentrifuge tubes as well as post-sonication nail collection tubes. The identifier for the post sonication nail collection tubes should include “PS” as a suffix. For example, the post sonication tube for left nail ring finger could be “nail L4 PS”.

3. Witness step: Confirm the sample names on the extraction sheet with the names on all labeled tubes.

4. Vortex solution well. Add 25 µL of the nail digestion buffer to each sample. Open only one sample tube at a time using the cap opener.

5. Record the temperatures of the heat shakers on the extraction worksheet. Temperatures must be within ± 3°C of the set temperature.

6. Incubate on the heat shaker at 56ºC for 30 minutes with shaking at 1400 rpm.

7. Incubate on the heat shaker at 99ºC for 10 minutes with no shaking (0 rpm).
8. After removing from the shaker, centrifuge the samples at full speed, briefly. Allow the samples to cool for a few minutes while preparing for next steps.

9. During the digestion period remove the nails using clean tweezers and dry them in a hood. When dry, place the nails in the labeled, post-sonication nail collection tubes.

F. Purification and Concentration

1. Self-witness step: Confirm the sample names on the extraction sheet with the names on the sample and Microcon® tubes.

2. Pre-coat the Microcon® membrane with a 1/1000 dilution of Poly A RNA prepared as follows in an irradiated microcentrifuge tube or 15 mL tube:

   a. Poly A RNA Preparation

      i. Make a 1/10 dilution of 1mg/mL of Poly A RNA as follows: add 2 µL of Poly A RNA to 18 µL of irradiated water and mix the solution well. This is a final concentration of 100µg/mL.

      ii. Using the 1/10 dilution, make a 1/100 dilution with 2 uL of 100ug/mL Poly A RNA in 198 uL of irradiated water and mix the solution well. The solution has a final concentration of 1 ng/uL.

      iii. Add 1 uL of the 1ng/uL Poly A RNA solution to 199uL of water for each sample on the extraction sheet.

      iv. Aliquot 200 uL of this Poly A RNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the extraction worksheet for calculated value.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>199 µL</td>
</tr>
<tr>
<td>Poly A RNA (1ng/µL)</td>
<td>1 µL</td>
</tr>
</tbody>
</table>
NOTE: For samples with 400 µL of digest solution, make a 20 µL solution of 1 µL of Poly A RNA (1 ng/µL) with 19 µL of water. Mix well and add this solution to the membrane. Ensure that the entirety of the membrane is covered. In this manner, all of the digest may be added to the Microcon® membrane for a total volume of 420 µL.

3. Filtration

a. Add the entirety of each extract to its pretreated Microcon® membrane. Aspirate all of the solution by placing the pipet within the swab. The sample tubes may be discarded.

b. Centrifuge the Microcon® tube at 2400 rpm for 15 minutes.

c. Repeat this wash step two more times applying 400uL of water onto the membrane and centrifuging again at 2400 rpm for 15 minutes for a total of three washes to remove any residual EDTA.

d. Visually inspect each Microcon® membrane tube after the third wash. If it appears that more than 5 µL remains above the membrane, centrifuge that tube for 5 more minutes at 2400 rpm.

4. Elution

a. Open only one Microcon® tube and its fresh collection tube at a time.

b. Add 20 µL of irradiated water to the Microcon® and invert the Microcon® over the new collection tube. Avoid touching the membrane.

c. Centrifuge at 3400 rpm for 3 minutes.

d. Transfer the eluant to an irradiated and labeled 1.5 mL tube. Measure and record the approximate volume. The total volume should not exceed 30 uL and should not be less than 20 uL. Adjust the final volume to 20 uL (if necessary) with irradiated water. Discard the Microcon® membrane.

e. If the eluant appears to be a dark color or is not clear, it may be necessary to purify the sample again. Prepare a fresh Microcon® tube and repeat steps 4-6.
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

2. DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>49 OF 49</td>
</tr>
</tbody>
</table>

G. Clean up

1. Wipe the entire work area surface and pipets with 10% bleach followed by Ethanol and water.

2. Soak and/or clean racks, pipets, the cap opener and other equipment that would not adequately cleaned with the Stratalinker with 10% bleach, water and 70% Ethanol.

3. Turn on the UV lamp in the hood for ten minutes; remember to turn off the light in order to preserve the bulb.

4. If necessary, replenish the microcentrifuge tube and Microcon® collection tube supply. Irradiate for 30 minutes. Do not irradiate the Microcon® membranes.

H. Sample storage

1. Place samples including the post sonication nail collection tubes in a cryobox in the DNA refrigerator in the appropriate extract storage box. Indicate on the extraction sheet and tracking sheet the storage location.

2. Place extraction sheet in the appropriate area and notify the rotation supervisor that the samples are ready for quantitation.
CHELEX DNA EXTRACTION FROM BLOOD AND BUCCAL SWABS

Sample sizes for Chelex extraction should be approximately 3 μL of liquid blood or saliva, 1/3 of a swab, or a 3x3mm cutting of a bloodstain.

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. **Do not extract both together.**

2. Have a witness confirm the order of the samples.

3. Pipette 1 mL of sterile deionized water into each of the tubes in the extraction rack.

4. Mix the tubes by inversion or vortexing.

5. Incubate in a shaker at room temperature for 15 to 30 minutes.

6. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

7. Carefully remove supernatant (all but 30 to 50 μL). If the sample is a bloodstain or swab, leave the substrate in the tube with pellet.

8. Add 175 μL of 5% Chelex (from a well-resuspended Chelex solution).

9. Incubate at 56°C for 15 to 30 minutes.

10. Vortex at high speed for 5 to 10 seconds.

11. Incubate at 100°C for 8 minutes using a screw-down rack.

12. Vortex at high speed for 5 to 10 seconds.

13. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

14. Pipet aliquots of neat and/or diluted extract into microcentrifuge tube for real-time PCR analysis to determine human DNA concentration (refer to Section 3 of the STR manual), when needed.

15. Store the extracts at 2 to 8°C or frozen.

16. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.
CHELEX DNA EXTRACTION FROM SOFT TISSUE (E.G., FETUS SAMPLES)

Sample sizes for this Chelex extraction should be approximately a 3x3mm cutting of tissue.

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars. Do not extract both together. **Have a witness confirm the order of the samples.**

2. Pipette 1 mL of sterile deionized water into each of the tubes in the extraction rack.

3. Mix the tubes by inversion or vortexing.

4. Incubate at room temperature for 15 to 30 minutes. Mix occasionally by inversion or vortexing.

5. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

6. Carefully remove supernatant (all but 30 to 50 μL).

7. To each tube add: 200 μL of 5% Chelex (from a well-resuspended Chelex solution). 1 μL of 20 mg/mL Proteinase K

8. Mix using pipette tip.

9. Incubate at 56°C for 60 minutes.

10. Vortex at high speed for 5 to 10 seconds.

11. Incubate at 100°C for 8 minutes using a screw down rack.

12. Vortex at high speed for 5 to 10 seconds.

13. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

14. As needed, pipet aliquots of a 1/10 dilution and a 1/1000 dilution (using TE⁻⁴) into microcentrifuge tube for real-time PCR Analysis to determine human DNA concentration (refer to Section 3 of the STR manual).

15. Store the extracts at 2 to 8°C or frozen.

16. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.
CHELEX DNA EXTRACTION FROM EPITHELIAL CELLS
(AMYLASE POSITIVE STAINS OR SWABS, CIGARETTE BUTTS, SCRAPINGS)

Samples meant for this type of extraction should be placed on the “other evidence” or the Y-STR amylase worksheet. Exemplars of this type must be extracted separately from evidence samples.

Sample sizes for this Chelex extraction should be approximately a 5x5mm cutting or 50% of the scrapings recovered from an item.

1. Remove the extraction rack from the refrigerator.
2. Have a witness confirm the order of the samples.
3. To each tube add: 200 µL of 5% Chelex (from a well-resuspended Chelex solution). 1 µL of 20 mg/mL Proteinase K
   
   (Note: For very large cuttings, the reaction can be scaled up to 4 times this amount. This must be indicated on the extraction sheet. Scaling up any higher requires permission from the supervisor and/or IA of the case. The final extract will need to be Microcon concentrated.)
4. Mix using pipette tip.
5. Incubate at 56°C for 60 minutes.
6. Vortex at high speed for 5 to 10 seconds.
7. Incubate at 100°C for 8 minutes using a screw down rack.
8. Vortex at high speed for 5 to 10 seconds.
9. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.
10. Pipet 5 µL neat and also a 1/100 dilution (using TE(+)) into a microcentrifuge tube for Real-Time PCR Analysis to determine human DNA concentration.
11. Store the remainder of the supernatant at 2 to 8°C or frozen.
NON-DIFFERENTIAL CHELEX DNA EXTRACTION FROM SEMEN STAINS OR SWABS

NOTE: For very large cuttings 200 μL of Chelex might not be enough to provide enough suspension of the sample. The reaction can be scaled up and reconcentrated using Microcon concentrators.

Sample sizes for non-differential Chelex extractions depend on the circumstances of the case. Regularly 1/3 of a swab or a 3x3mm cutting of a stain should be used. For cases where semen is present but no sperm cells were detected, the sample size can be increased.

1. Remove the extraction rack from the refrigerator.
2. Have a witness confirm the order of the samples.
3. To each tube add: 200 μL of 5% Chelex (from a well-resuspended Chelex solution). 1 μL of 20 mg/mL Proteinase K 7 μL of 1 M DTT
4. Use the pipette tip when adding the DTT to thoroughly mix the contents of the tubes.
5. Incubate at 56°C for approximately 2 hours.
6. Vortex at high speed for 10 to 30 seconds.
7. Incubate at 100°C for 8 minutes using a screw down rack.
8. Vortex at high speed for 10 to 30 seconds.
9. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.
10. As needed, pipet aliquots of neat and 1/100 dilution (using TE⁺) into microcentrifuge tube for real-time PCR Analysis to determine human DNA concentration (refer to Section 3 of the STR manual).
11. Store the extracts at 2 to 8°C or frozen.
12. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.
DIFFERENTIAL CHELEX DNA EXTRACTION FROM SEMEN STAINS OR SWABS

Approximately 1/3 of a swab or a 3x3mm cutting of a stain should be used for this type of extraction.

1. Remove the extraction rack from the refrigerator.

2. Pipette 1 mL of PBS into each tube, including a tube for a sperm fraction extraction negative control, in the extraction rack.

3. Mix by inversion or vortexing

4. Incubate at room temperature overnight or for a minimum of 1 hour using a shaking platform.

5. Have a witness confirm the order of the samples.

6. Vortex or sonicate the substrate or swab for at least 2 minutes to agitate the cells off of the substrate or swab. At this point, label the extraction negative control with the date and time.

7. Label new tubes to hold the swab or substrate remains. Remove the swab or other substrate from the sample tube, one tube at a time, using sterile tweezers and close tube. Sterilize tweezers with 10% bleach, distilled water, and 70% ethanol before the removal of each sample. Store swab or substrate in a sterile labeled tube for the substrate remains fraction.

8. Spin in a microcentrifuge for 5 minutes at 10,000 to 15,000 x g.

9. Without disturbing the pellet, remove and discard all but 50 µL of the supernatant.

10. Resuspend the pellet in the remaining 50 µL by stirring with a sterile pipette tip.

11. To the approximately 50 µL of resuspended cell debris pellet, add 150 µL sterile deionized water (final volume of 200 µL).

12. Add 1 µL of 20 mg/mL Proteinase K. Vortex briefly to resuspend the pellet.

13. Incubate at 56°C for about 60 minutes to lyse epithelial cells, but for no more than 75 minutes, to minimize sperm lysis.
14. During the incubation step do the following:
   a. Label a new tube for each sample, including the epithelial cell extraction negative control. Mark each tube as an epithelial cell fraction.
   b. Add 50 µL of 20% Chelex (from a well-resuspended Chelex solution) to each epithelial cell fraction tube.
   c. Close tubes.

15. Spin the extract in a microcentrifuge at 10,000 to 15,000 x g for 5 minutes.

16. Add 150 µL of the supernatant from each sample and the extraction negative to its respective epithelial cell fraction sample tube. Store at 4°C or on ice until step 20.

17. Wash the sperm pellet with Digest Buffer as follows:
   a. Resuspend the pellet in 0.5 mL Digest Buffer.
   b. Vortex briefly to resuspend pellet.
   c. Spin in a microcentrifuge at 10,000 to 15,000 x g for 5 minutes.
   d. Remove all but 50 µL of the supernatant and discard the supernatant.
   e. Repeat steps a-d for a total of 5 times.

18. Wash the sperm pellet once with sterile dH₂O as follows:
   a. Resuspend the pellet in 1 mL sterile dH₂O.
   b. Vortex briefly to resuspend pellet.
   c. Spin in a microcentrifuge at 10,000 to 15,000 x g for 5 minutes.
   d. Remove all but 50 µL of the supernatant and discard the supernatant.

19. Resuspend the pellet by stirring with a sterile pipette tip.

20. To the approximately 50 µL resuspended sperm fraction and to the tubes containing the substrate remains and the sperm fraction extraction negative, add 150 µL of 5% Chelex, 1 µL of 20 mg/mL Proteinase K, and 7 µL of 1M DTT. Mix gently.

21. Vortex both the epithelial cell and sperm fractions. The following steps apply to all fractions.

22. Incubate at 56°C for approximately 60 minutes.
2A. MANUAL DNA EXTRACTION

23. Vortex at high speed for 5 to 10 seconds.
24. Incubate at 100°C for 8 minutes using a screw down rack.
25. Vortex at high speed for 5 to 10 seconds.
26. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.
27. As needed, pipet aliquots of neat and a 1/100 dilution (using TE-4) into a microcentrifuge tube for real-time PCR to determine human DNA concentration (refer to Section 3 of the STR manual).
28. Store the extracts at 2 to 8°C or frozen.
CHELEX DNA EXTRACTION FROM HAIR

Microscopic examination of hair by PD lab should be completed before attempts at DNA typing. If possible document state of root on photo. Be careful not to lose adhering sheath material prior to extraction.

**Note:** Prior to starting this protocol, consult with the Mitochondrial DNA Team for guidance.

A. **Sample preparation for loose hairs:**

1. Handling hair with clean forceps, examine the hair under a dissecting microscope for the presence of sheath material. The hair may be placed on a clean piece of white paper. Note possible presence of body fluid on hair.

2. Wash the hair containing sheath material to remove surface dirt and contaminants by immersing the hair in sterile, deionized water in a clean 15 or 50 mL Falcon tube.

3. Return the hair to the dissecting microscope. Use a clean scalpel to cut a 1 cm portion from the root end of the hair and place in a 1.5 mL microcentrifuge tube.

B. **Sample preparation for mounted hairs:**

1. Remove cover slip by placing slide in freezer for 10 minutes and afterwards removing cover with a razor blade or clean forceps. Alternatively the slide can be submerged in fresh Xylene for 1-2 minutes.

2. Add 10-20 μL of fresh Xylene to the embedded hair sample. Allow 10-20 seconds for Permount to dissolve, then tease out the hair sample with clean forceps. Check slide for tissue that was left behind.

3. Place hair on clean microscope slide and add more fresh Xylene to remove adhering Permount. Pipet off Xylene, add a few drops of water, repeat rinsing with water several times.

4. Put hair under dissecting microscope. Use a clean scalpel to cut a 1 cm portion from the root end of the hair and place in a 1.5 mL microcentrifuge tube.
If not immediately starting Chelex extraction, do not place wet hair in 1.5 mL tube. Perform additional 99% Ethanol rinse and let hair dry before placing in tube.

Do not consume hair shaft. If possible leave at least 1cm for mtDNA typing.

C. Chelex extraction

1. To hair tubes add:

   100 μL of 5% Chelex (from a well-resuspended Chelex solution).
   1 μL of 20mg/mL Proteinase K.

   **Note:** Ensure that the hair is completely immersed in the Chelex solution before incubating.

2. Incubate at 56°C for at least 6 to 8 hours, or overnight.

3. Vortex at high speed for 5 to 10 seconds.

4. Incubate at 100°C for 8 minutes using a screw down rack.

   **Note:** Check that the hair is completely immersed in the Chelex solution before boiling.

5. Vortex at high speed for 5 to 10 seconds.

6. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g.

7. Pipet 5 μL neat and also a 1/10 dilution (using TE⁻⁴) into a microcentrifuge tube for Real-Time PCR Analysis to determine human DNA concentration.

8. Store the remainder of the extract at either 2 to 8°C or frozen.

9. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.
ORGANIC EXTRACTION PROCEDURE

A. Sample Preparation

Liquid/dry blood, bone marrow, oral swab and tissue sample preparation
Stained substrates and oral swabs should be cut into small pieces (3 x 3 mm). Tissues should be minced into small pieces in a weigh boat using a sterile scalpel or razor blade. Place samples in 1.5mL microcentrifuge tubes or conical tubes when appropriate. See table below for various sample types.

Proceed to Section B: Sample Incubation

<table>
<thead>
<tr>
<th>Sample type</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liquid blood</td>
<td>100 to 500 µL</td>
</tr>
<tr>
<td>Bone marrow</td>
<td>0.5 x 0.5 cm to 1.5 x 1.5 cm</td>
</tr>
<tr>
<td>Oral swab</td>
<td>1/3 to a whole swab</td>
</tr>
<tr>
<td>Blood stain</td>
<td>0.5 x 0.5 cm to 1.5 x 1.5 cm</td>
</tr>
<tr>
<td>Soft tissue</td>
<td>0.5 x 0.5 cm to 1.5 x 1.5 cm</td>
</tr>
<tr>
<td>Paraffin embedded tissue</td>
<td>0.3 x 0.3 cm to 1.0 x 1.0 cm</td>
</tr>
</tbody>
</table>

Bone preparation
Before extraction, a bone or tooth specimen should be cleaned entirely of soft tissue and dirt using a range of methods, such as scraping, rinsing and sonication. A combination of sterile scalpels, sterile toothbrushes and running water should be used to clean the specimen. For a sonication bath, the sample is placed in a conical tube and covered with a 5% Terg-a-zyme solution. For additional cleaning, the sonication step may be repeated multiple times by decanting the liquid and replacing with fresh Terg-a-zyme solution. After cleaning, the sample is usually rinsed with distilled water and dried using a 56°C incubator (drying time may vary from a few hours to overnight).

Note: Terg-a-zyme is an enzyme-active powdered detergent. A 5% solution should be made fresh prior to bone preparation and cleaning. Refer to Appendix A in the Quality Assurance Manual. Once prepared, the reagent will only be effective for up to 16 hours.
1. Photograph bone or tooth sample after cleaning. Measure and weigh specimen prior to sampling.

2. If several bones are available, generally compact bone is preferred, such as humerus, femur, or tibia.

**WARNING**
Protective eyewear, lab coats, cut resistant gloves and HEPA-filtered facial masks should be worn when cutting bone. Avoid breathing bone dust. All cutting of bone must be done under a biological hood.

3. Using an autopsy saw or a Dremel tool equipped with a 409 or 420 cutting wheel, cut the bone specimen into approximately 5x5x5mm size pieces. Take enough cuttings for an end weight of approximately 2g. For older or compromised bones, several aliquots of 2g can be extracted and combined during the Microcon step. For tooth samples, the whole root should be taken. **Note: The cut off wheel should be disposed of after each use and the Dremel and hood should be completely wiped down with bleach and ethanol.**

4. Place bone cuttings in 50mL conical tubes labeled with the FB case number, ME#, PM item #, initials, and date.

5. Cover bone cuttings with 5% Terg-a-zyme solution and sonicate samples for 30-45 minutes. **Note: Ensure water level in the sonicator is 1-2 inches from the top.**

6. Decant the Terg-a-zyme and wash with distilled water until no detergent bubbles remain.

7. If necessary, repeat with fresh changes of 5% Terg-a-zyme and water washes until the dirt has been removed.

8. Place the clean cuttings in a weigh boat on a small Kim Wipe. Cover with another weigh boat. Label the weight boat with the FB case number, ME#, PM item #, initials, and date.

9. Seal with evidence tape.

10. Dry in a 56°C incubator for a few hours or overnight. After sufficient drying, weigh bone cuttings. **The bone sample must be completely dry before milling.**
Sample milling with the SPEX Certiprep 6750 Freezer Mill
All freezer mill parts that come into contact with bone specimens, such as the cylinders, metal end plugs and impactors, should be cleaned, dried and sterilized prior to use. See Step 20 for appropriate cleaning procedure.

1. Assemble specimen vials in the following order: metal bottom, plastic cylinder, impactor, and metal top.

2. Place under UV light for a minimum of 15 minutes.

3. Label metal bottoms with blue Sharpie ink with a case identifier.

4. Add bone cuttings to specimen vial around impactor using decontaminated forceps. Cover with metal top. Note: Shake specimen vial and ensure that the impactor can move back and forth.

5. Wipe down inside of mill with a wet paper towel. Do not use bleach or ethanol.

6. Plug in mill and switch ON.

7. Obtain liquid nitrogen from tank by filling transfer container. Be aware that the liquid nitrogen tank may be empty when the detector level reads anywhere from “¼” to “empty”.

**WARNING**
Liquid Nitrogen can be hazardous. Use cryogenic gloves, protective eyewear/face shield and lab coats when handling. Avoid liquid nitrogen splashes to face and hands.

8. Open the freezer mill lid. Add liquid nitrogen slowly into the mill up to the FILL LINE to avoid splashing and boiling over.

9. Place the specimen vial into the round chamber. If processing more than one bone sample it is possible to save pre-cooling time by placing up to two vials in the mesh container inside the mill.

10. Change cycle number to match total number of samples plus two (n + 2).
11. Adjust mill settings as follows:

<table>
<thead>
<tr>
<th>Cycle</th>
<th>set to # of samples + 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td></td>
</tr>
<tr>
<td>T1 (milling)</td>
<td>2.0 min</td>
</tr>
<tr>
<td>T2 (pause)</td>
<td>2.0 min</td>
</tr>
<tr>
<td>T3 (pre-cool)</td>
<td>15.0 min</td>
</tr>
<tr>
<td>Rate</td>
<td></td>
</tr>
<tr>
<td>Bones –</td>
<td>8-10</td>
</tr>
<tr>
<td>Teeth –</td>
<td>6-8</td>
</tr>
</tbody>
</table>

12. Close cover slowly to avoid any liquid nitrogen splashes and press RUN to start the mill. Pre-cooling will begin followed by the milling cycle.

13. During the 2-minute pause phase, it is now possible to open the mill and remove the finished sample using cryogenic gloves.

14. Place one of the pre-cooled specimens waiting in the dock in the round chamber.

15. If liquid nitrogen level is below the FILL LINE, refill. A loud noise during milling means that the liquid nitrogen level is low. If liquid nitrogen is not refilled, damage to the mill, mill parts, and cylinder can occur.

16. Close the lid and press RUN again. Repeat from Step 11 until all samples are processed.

17. Inspect each sample after removal from the mill. If sample is sufficiently pulverized, remove the metal top using the Spex Certi-Prep opening device. **Note:** Samples may be reinserted into the mill for additional grinding.

18. Using decontaminated tweezers, remove impactor from vial and submerge in 10% bleach.

19. Empty bone dust into labeled 50mL Falcon tube. Ensure complete dust transfer by tapping bottom of cylinder. Weigh bone dust and document.

20. Soak metal end parts and plastic cylinder in 10% Bleach.

21. When milling is complete, switch mill to OFF and unplug. Leave cover open for liquid nitrogen to evaporate. The next day, lower cover and place in storage until next use.
22. **Mill Parts - Clean Up:** Mill parts must be cleaned immediately after processing. If this is not possible, steps a-b must be completed before leaving overnight.
   a. Rinse off with 10% bleach.
   b. Soak all parts in 0.1% SDS.
   c. Brush parts with a new toothbrush to remove any residual bone dust.
   d. Rinse with water.
   e. Soak parts in 10% bleach and brush each part in bleach individually.
   f. Rinse with water.
   g. Separate the plastic cylinders from the metal parts.
   h. Rinse in 100% ethanol. **ONLY** the metal top, metal bottom, and compactor can be rinsed in 100% ethanol. **DO NOT** rinse the plastic cylinder in ethanol as it will cause the plastic cylinder to break.
   i. Use isopropanol to remove any identifying marks made with a Sharpie on the tops or bottoms of the cylinders.
   j. Dry and expose the parts to UV light for a minimum of 2 hours. The UV light in a biological hood or a StrataLinker can be used.

23. Proceed to Section B: Sample Incubation.

**Laser Microdissection**
This procedure can be used to separate maternal (decidual) tissue from fetal material (chorionic villi) in early stage abortions. The procedure can only be performed in cooperation with the OCME histology department and a trained pathologist. The instrument used, the PixCell® IIe Laser Capture Microdissection System (ARCTURUS Systems for Microgenomics, Carlsbad, CA), is owned by NYU Medical center and can only be operated by trained NYU staff.

1. Initial processing

The product of conception (POC) can be received in different stages of preparation:

   a) POC scrapings in saline buffer:

   Remove tissue from liquid either by filtration or centrifugation:
   - Transfer liquid to 50mL falcon tube
   - Spin sample in a bench top Eppendorf or IEC Centra CL3R at 1000 RPM for 5 minutes
   - Discard liquid supernatant
## 2A. MANUAL DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>15 OF 36</td>
</tr>
</tbody>
</table>

Submit sample to the Histology department for tissue processing according to the OCME Histology Procedure Manual section E. Then proceed as for b).

b) POC fixated and embedded in paraffin blocks:

Contact histology department and ask them to prepare microscope slides from the paraffin block using the following precautions:

- Use disposable blades for the microtome and discard after each case.
- Clean working surface on microtome by wiping with 10% bleach and alcohol before and after each case.
- Use individual floating chambers for each case
- Use uncharged microscope slides

The slides then should be stained with hematoxylin and eosin-phloxine (H&E technique) as described in the OCME Histology Procedure Manual. But again during the staining procedure separate sets of jars have to be used for each case.

c) Stained or unstained microscope slides from POC blocks:

If the slides are unstained, ask the histology department to stain them as described above. Otherwise proceed with the microdissection technique. **Attention:** for slides that were prepared by a histology laboratory outside of the OCME, foreign DNA not from the mother and the fetus might be present on the slide.

2. **PixCell IIe Laser Capture Microdissection**

The PixCell® IIe Laser Capture Microdissection System (LCM) utilizes a low-power infrared laser to melt a special thermoplastic film over the area of interest. Especially developed CapSure Caps that are coated with this thermoplastic film are placed on the tissue sample and are used to capture the cells of interest after the laser excitation. See the Arcturus instrument manual for a more detailed description.
A trained pathologist has to be present to distinguish decidual tissue from chorionic villi and operate the laser. After the slide has been placed on the microscope platform the pathologist will visually identify the area of interest, mark this area for the laser, and activate the laser. The laser setting is specified in the Arcturus instrument manual. The Forensic Biology Criminalist needs to be present during the complete procedure to maintain chain of custody of the evidence.

An area of chorionic villi and an area of maternal tissue should be collected on separate CapSure caps. The caps can be stored and transported in 50 ml Falcon tubes. A third unused CapSure cap should be extracted as an extraction negative control.

Use new scalpel and clean forceps to remove the film from the cap and transfer the film to a fresh 1.5mL reaction tube containing 500μL of organic extraction buffer, DTT, SDS and Proteinase K as described below.

**B. Sample Incubation**

1. Process an extraction negative with every batch of extractions.

2. Prepare the master mix in microcentrifuge tube or conical tube and mix thoroughly by swirling or vortexing very briefly.

For liquid blood, dry blood and bone marrow samples:

<table>
<thead>
<tr>
<th></th>
<th>1 Sample</th>
<th>5 Samples</th>
<th>10 Samples</th>
<th>15 Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organic extraction buffer</strong></td>
<td>400 μL</td>
<td>2.0 mL</td>
<td>4.0 mL</td>
<td>6.0 mL</td>
</tr>
<tr>
<td><strong>20% SDS</strong></td>
<td>10μL</td>
<td>50 μL</td>
<td>100 μL</td>
<td>150 μL</td>
</tr>
<tr>
<td><strong>Proteinase K (20 mg/mL)</strong></td>
<td>13.6 μL</td>
<td>68 μL</td>
<td>136 μL</td>
<td>204 μL</td>
</tr>
<tr>
<td><strong>Total Incubation Volume per sample:</strong></td>
<td>400 μL</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 2A. MANUAL DNA EXTRACTION

<table>
<thead>
<tr>
<th></th>
<th>Per bone (~2g dust)</th>
<th>1 sample (N+ 2)</th>
<th>3 samples (N+ 2)</th>
<th>5 samples (N+ 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organic Extraction Buffer</strong></td>
<td>2370 µL</td>
<td>7.11 mL</td>
<td>11.85 mL</td>
<td>16.59 mL</td>
</tr>
<tr>
<td><strong>20% SDS</strong></td>
<td>300 µL</td>
<td>900 µL</td>
<td>1.5 mL</td>
<td>2.1 mL</td>
</tr>
<tr>
<td><strong>0.39 M DTT</strong></td>
<td>120 µL</td>
<td>360 µL</td>
<td>600 µL</td>
<td>840 µL</td>
</tr>
<tr>
<td><strong>Proteinase K (20 mg/mL)</strong></td>
<td>210 µL</td>
<td>630 µL</td>
<td>1.05 mL</td>
<td>1.47 mL</td>
</tr>
</tbody>
</table>

Total Incubation Volume per sample: 3000 µL

### For teeth samples:

<table>
<thead>
<tr>
<th></th>
<th>Per tooth</th>
<th>1 sample (N+ 2)</th>
<th>3 samples (N+ 2)</th>
<th>5 samples (N+ 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organic Extraction Buffer</strong></td>
<td>790 µL</td>
<td>2.37 mL</td>
<td>3.95 mL</td>
<td>5.53 mL</td>
</tr>
<tr>
<td><strong>20% SDS</strong></td>
<td>100 µL</td>
<td>300 µL</td>
<td>500 µL</td>
<td>700 µL</td>
</tr>
<tr>
<td><strong>0.39 M DTT</strong></td>
<td>40 µL</td>
<td>120 µL</td>
<td>200 µL</td>
<td>280 µL</td>
</tr>
<tr>
<td><strong>Proteinase K (20 mg/mL)</strong></td>
<td>70 µL</td>
<td>210 µL</td>
<td>350 µL</td>
<td>490 µL</td>
</tr>
</tbody>
</table>

Total Incubation Volume per sample: 1000 µL

### For tissues and paraffin embedded tissue (e.g. microdissection) samples:

<table>
<thead>
<tr>
<th></th>
<th>Per tissue</th>
<th>1 sample (N+ 2)</th>
<th>3 samples (N+ 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organic Extraction Buffer</strong></td>
<td>395 µL</td>
<td>1185 µL</td>
<td>1975 µL</td>
</tr>
<tr>
<td><strong>20% SDS</strong></td>
<td>50 µL</td>
<td>150 µL</td>
<td>250 µL</td>
</tr>
<tr>
<td><strong>0.39 M DTT</strong></td>
<td>20 µL</td>
<td>60 µL</td>
<td>100 µL</td>
</tr>
<tr>
<td><strong>Proteinase K (20 mg/mL)</strong></td>
<td>35 µL</td>
<td>105 µL</td>
<td>175 µL</td>
</tr>
</tbody>
</table>

Total Incubation Volume per sample: 500 µL
2A. MANUAL DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>18 OF 36</td>
</tr>
</tbody>
</table>

3. Add the appropriate incubation volume of master mix to each sample tube and neg tube. Vortex tubes briefly. Make certain the substrate, tissue, or swab is totally submerged. **Note:** Reagent volumes may be adjusted in order to accommodate the size or nature of a particular sample.

4. Place tubes in a shaking 56°C heat block and incubate overnight.

5. Proceed to Section C: Phenol Chloroform Extraction and Microcon® cleanup.

C. Phenol Chloroform and Microcon Clean up

Set Up
Remove the Phenol:Chloroform:Isoamyl Alcohol (25:24:1) (PCIA) from the refrigerator. Aliquot from the lower, clear organic layer. Unscrew cap and use a pipet to aliquot the desired amount.

Obtain organic waste jug for disposal of any tubes or pipette tips that come in contact with PCIA.

**WARNING**
Phenol Chloroform is toxic. Protective eyewear, mask, lab coat, and nitrile gloves should be worn when handling. All work must be conducted under a chemical fume hood.

See Section D for preparation of Phase Lock Gel (PLG) tubes.

For samples possibly needing mtDNA or High Sensitivity DNA testing: Place one Microcon® YM100 collection tube and one 1.5 mL microcentrifuge tube for each sample, including the extraction negative, in the StrataLinker for at least 15 minutes. **Note:** Irradiate multiple tubes (4-6) per bone sample to accommodate the total volume of incubation buffer.
Phenol-Chloroform and Microcon Clean-up

1. Vortex and centrifuge the incubated microcentrifuge tube samples at high speed for 1 minute. Vortex and centrifuge bone dust, incubated in 50 mL conical tubes, for 5-10 minutes at 1000 RPM in Eppendorf Centrifuge Model 5810.

2. Obtain and label one prepared Eppendorf Phase Lock Gel (PLG) tube per sample, including the extraction negative. PLG tubes make phase separation easier and are optional. Note: For bone samples, label as many tubes to accommodate the total volume of incubation buffer per sample. For example, if you incubated 2g of bone dust with 3 mL of incubation buffer, you will technically need 6 PLG tubes.

3. Centrifuge PLG tubes at maximum speed for 30 seconds.

4. Label Microcon® YM100 filters for each sample. Prepare the Microcon® YM100 concentrators by adding 100 $\mu$L of TE-4 to the filter side (top) of each concentrator. Set aside until step 11.

5. Add a volume of Phenol:Chloroform:Isoamyl Alcohol 25:24:1 (PCIA) to the PLG tube which is equal to the volume of incubation buffer (typically 400 $\mu$L) to be added from the sample. Note: When pipetting PCIA, you must penetrate the top buffer layer. Place used pipette tips in the organic waste bottle.

6. Have someone witness your sample tubes, PLG tubes, and Microcon® YM100 tubes.

7. Pipette the sample supernatant (typically 400 $\mu$L) to the PLG tube already containing PCIA. For bone dust samples, pipette several aliquots of the supernatant into multiple PLG tubes. Note: Do not disturb bone pellet.

8. Shake the PLG tube vigorously by hand or by inversion to form a milky colored emulsion. Note: Do NOT vortex the PLG tube.

9. Centrifuge samples for 2 minutes at maximum speed to achieve phase separation. (On Eppendorf Centrifuge Model 5415D, spin at 16.1 RCF or 13.2 RPM).
10. If the sample is discolored, contains particles in the aqueous phase, or contains a lot of fatty tissue, transfer the top layer (aqueous phase) and repeat Steps 7-9. 
   Note: The aqueous layer from bone and teeth will usually be discolored. Only repeat the phenol-chloroform clean-up steps if any dust or particles are present in the aqueous layer. If it is not necessary to repeat the clean-up step, go to Step 11.

11. Carefully transfer the aqueous phase (top layer) to the prepared Microcon® YM100 concentrator. Be careful not to let the pipette tip touch the gel. 
   Note: Discard used PLG tubes into the organic waste bottle.

12. Spin the Microcon® YM100 concentrators for 15 minutes at 500 x g, which is approximately 2500 RPM. (On Eppendorf Centrifuge Model 5415D, spin at 0.6 RCF or 2600 RPM). 
   Note: Ensure that all fluid has passed through filter. If it has not, spin for additional time, in 10-minute increments. If fluid still remains, collect sample and microcon again using new filter.

13. Discard the wash tubes and place the concentrators into a new collection tube.

14. Add 400 μL of TE-4 to the filter side of each Microcon® YM100 concentrator.

15. Spin again for 15 minutes at 500 x g, which is approximately 2500 RPM, for 15 minutes. Spin the Microcon® YM100 concentrators for 15 minutes at 500 x g, which is approximately 2500 RPM. (On Eppendorf Centrifuge Model 5415D, spin at 0.6 RCF or 2600 RPM). 
   Note: Ensure that all fluid has passed through filter. If it has not, spin for additional time, in 10-minute increments. If fluid still remains, collect sample and microcon again using new filter.

16. Add 40 μL of TE-4 to the filter side of each Microcon® YM100 concentrator. 
   Note: For bone samples, add only 10-20 μL of TE-4 to each filter side to ensure smallest elution volume.

17. Invert sample reservoir and place into a new labeled collection tube. (For samples possibly needing mtDNA or High Sensitivity DNA testing, invert sample reservoirs into irradiated collection tubes). Spin at 1000 x g, which is approximately 3500 RPM, for 3 minutes. (On Eppendorf Centrifuge Model 5415D, spin at 1.2 RCF or 3600 RPM).
18. Measure the approximate volume recovered and record on the organic extraction worksheet. **Note: Combine bone elutants before measuring volume.**

19. Discard sample reservoir and adjust sample volume depending on the starting amount and expected DNA content as follows using TE-4. **Note: Samples may be microcon’ed again to further concentrate low DNA content samples.**

<table>
<thead>
<tr>
<th>Sample type</th>
<th>Final Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>High DNA content (Large amounts of blood, fresh tissue, bone marrow, oral swabs, and dried bloodstains)</td>
<td>400 μL</td>
</tr>
<tr>
<td>Medium DNA content (Small amounts of blood, fresh tissue, bone marrow, oral swabs, and dried bloodstains); differential lysis samples</td>
<td>200 μL</td>
</tr>
<tr>
<td>Low DNA content (Formalin fixed tissue, dried bone, teeth, samples from decomposed or degraded remains, some reference samples)</td>
<td>100 μL</td>
</tr>
</tbody>
</table>

20. Transfer samples to newly labeled 1.5mL microcentrifuge tubes for storage. *(For samples possibly needing mtDNA or High Sensitivity DNA testing, transfer samples to irradiated 1.5 mL microcentrifuge tubes).* Record the approximate final volume on the organic extraction worksheet.

21. As needed, pipet aliquots of neat and/or diluted extract into microcentrifuge tube for real-time PCR analysis to determine human DNA concentration (refer to Section 3 of the STR manual).

22. Store the extracts at 2 to 8°C or frozen.
23. Samples should be added to the next available Rotorgene Summary Sheet, saved to the appropriate folder on the network pertaining to your casework group.

NOTE: For larger volumes, 15 ml PLG tubes may be prepared as well as Centricon® YM100 concentrators (available in 2mL, 15mL and other sizes). For concentration, spin at 500x g and at 1000x g for recovery. Adjust RPM according to centrifuge used. Do not exceed 1000x g. Please be aware that using the larger PLG and the Centricon® YM100 concentrators will require longer spin times.

NOTE: See Microcon® troubleshooting as needed.

D. Preparation of Phase Lock Gel (PLG) tubes

The purchase of Phase Lock gel (PLG) Syringes Heavy is economical and more convenient than having to stock all possible tube sizes. The gel in the syringe can be added to different disposable tubes. Make sure the plasticware being used is resistant to phenol and chloroform.

1. Without putting pressure on the plunger, twist off the orange cap and discard. Attach the gray dispensing tip (supplied) to the syringe and tighten securely. (NOTE: Use of gray tip is optional for a smoother application of PLG. Less force is necessary when gray tip is NOT used.)

2. Apply firm pressure on the plunger to dispense PLG until it reaches the end of gray tip. Add heavy PLG based on Table below. NOTE: 325μL = 3.25 cc corresponds to 3 lines on the syringe

<table>
<thead>
<tr>
<th>Tube size</th>
<th>PLG heavy</th>
<th>Tube size</th>
<th>PLG heavy</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5mL</td>
<td>100μL</td>
<td>15mL</td>
<td>3mL</td>
</tr>
<tr>
<td>1.5mL</td>
<td>325μL</td>
<td>50mL</td>
<td>5mL</td>
</tr>
<tr>
<td>2.0mL</td>
<td>325μL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3. Pellet the PLG by spinning the tubes prior to use. See table below.

<table>
<thead>
<tr>
<th>Tube size</th>
<th>Centrifuge model</th>
<th>Speed</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5 to 2.0mL</td>
<td>Eppendorf 5415C, Eppendorf 5415D</td>
<td>14 x 1000 RPM, 13.2 x1000 RPM/16.1 x1000 RCF</td>
<td>30s</td>
</tr>
<tr>
<td>15 and 50mL</td>
<td>Sigma 4-15 C</td>
<td>1500 RCF</td>
<td>2m</td>
</tr>
</tbody>
</table>
HIGH SENSITIVITY DNA EXTRACTION

A. Personal Preparation

2. Don a mask, hair covering, lab coat, and gloves.
   a. Ensure that the cuffs of the lab coat completely cover arms.
   b. Lab coats may be re-worn in the pre-amp rooms only.

2. Do not enter room without appropriate personal protective equipment. Moreover, never touch any apparatus, bench etc with bare hands.

3. Remove gloves when answering the phone and touching door handles in order to maintain a DNA free glove.

B. Paperwork preparation

1. Refer to the High Sensitivity Submission Protocol to determine which samples are appropriate for this extraction procedure.

2. Extraction sets consist of 9 samples and one extraction negative. Additional extractions may continue sequentially during incubations.

3. In cell H1 of the appropriate extraction sheet, type in the name of the extraction assay as follows: “E” for extraction, month, day, and year, “period”, hour and minute. For example, E040905.1330. (Note: The HI Team extraction sheet can be found in the “HighSens_Data\Templates in Use” folder, and the PC Team extraction sheet can be found in the “Fbiology_Main\Forms\PC\Extraction” folder on the main drive.)

4. Manually enter OR copy and paste the samples names into the appropriate extraction sheet. The worksheet will automatically calculate the requisite amount of reagents needed for the extraction.
C. Work Place Preparation

1. Apply 10% bleach followed by water and 70% Ethanol to the entire work surface, cap opener, and pipets.

2. Retrieve clean racks and cap openers, and irradiated microcentrifuge tubes, and irradiated water from storage. **Arrange work place to minimize crossover.**

   **NOTE:** Only use filter tips for pipetting.

3. Position gloves nearby with 10% Bleach/70% Ethanol/water in order to facilitate frequent outer glove changes and cleaning.

D. Digestion

1. **Self-Witnessing Step:** Confirm the sample names on the extraction sheet with the names on the sample tubes.

2. Prepare solution in an UV irradiated tube (1.5 mL, 2.0 mL Dolphin, or 15 mL).

3. Prepare the digestion buffer according to the calculated volumes on the extraction sheet. The volume for one sample is shown below.

<table>
<thead>
<tr>
<th>Stock Solution</th>
<th>Concentration</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.05% SDS (or 0.01% SDS when using Poly A RNA at a later step)</td>
<td>0.05% (or 0.01%)</td>
<td>192 µL</td>
</tr>
<tr>
<td>Proteinase K 20 mg/mL</td>
<td>0.80 mg/mL</td>
<td>8 µL</td>
</tr>
</tbody>
</table>

4. Vortex solution well. Add **200 µL** of the digestion buffer to each sample. Open only one sample tube at a time using the cap opener. Ensure that the swabs are submerged in the digestion fluid. If necessary, add an additional 200 µL of the digest buffer (including the Proteinase K) to the sample in order to submerge a large sample.
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

2A. MANUAL DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>26 OF 36</td>
</tr>
</tbody>
</table>

5. Record the temperatures of the heat shakers on the extraction worksheet. Temperatures must be within ± 3°C of the set temperature.

6. Incubate on the heat shaker at 56°C for 30 minutes with shaking at 1400 rpm.

7. Incubate on the heat shaker at 99°C for 10 minutes with no shaking (0 rpm).

8. Place sample in cold block at 4°C for 10 minutes with no shaking (0 rpm).

9. After removing from the shaker, centrifuge the samples at full speed, briefly. Allow the samples to cool for a few minutes while preparing for next steps.

10. During the digestion period label the Microcon®, elution, and storage tubes in advance.

E. Purification and Concentration

1. Prepare Microcon® 100 tubes and label the membrane tube and filtrate tube cap. Use Microcon® 50 tubes as indicated, for example when degradation is suspected. Consult evidence exam schedule sheet or supervisor.

2. **Witness step:** Confirm the sample names on the extraction sheet with the names on the sample and Microcon® tubes.

3. Pre-coat the Microcon® membrane with Fish Sperm DNA or a 1/1000 dilution of Poly A RNA prepared as follows in an irradiated microcentrifuge tube or 15 mL tube:

   a. Fish Sperm DNA Preparation

      1. Add 1 uL of stock Fish Sperm DNA solution (1mg/mL) to 199uL of water for each sample on the extraction sheet.
ii. Aliquot 200 uL of this Fish Sperm DNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the extraction worksheet for calculated value.

b. Poly A RNA Preparation

i. Make a 1/10 dilution of 1mg/mL of Poly A RNA as follows: add 2 µL of Poly A RNA to 18 µL of irradiated water and mix the solution well. This is a final concentration of 100µg/mL.

ii. Using the 1/10 dilution, make a 1/100 dilution with 2 uL of 100ug/mL Poly A RNA in 198 uL of irradiated water and mix the solution well. The solution has a final concentration of 1 ng/uL.

iii. Add 1 uL of the 1ng/uL Poly A RNA solution to 199uL of water for each sample on the extraction sheet.

iv. Aliquot 200 uL of this Poly A RNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the extraction worksheet for calculated value.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>I sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>199 µL</td>
</tr>
<tr>
<td>Fish Sperm DNA (1mg/mL)</td>
<td>1 µL</td>
</tr>
<tr>
<td>or Poly A RNA (1ng/µL)</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: For samples with 400 µL of digest solution, make a 20 µL solution of 1 uL of Fish Sperm DNA (1mg/mL) or 1 µL of Poly A RNA (1 ng/µL) with 19 µL of water. Mix well and add this solution to the membrane. Ensure that the entirety of the membrane is covered. In this manner, all of the digest may be added to the Microcon® membrane for a total volume of 420 uL.
4. Filtration
   a. Add the entirety of each extract to its pretreated Microcon® membrane. Aspirate all of the solution by placing the pipet within the swab. The sample tubes may be discarded.
   b. Centrifuge the Microcon® tube at 2400 rpm for 15 minutes.
   c. If indicated on the evidence examination schedule sheet or by a supervisor, or if the filtrate is not clear, perform a second wash step applying 400 µL of water onto the membrane and centrifuging again at 2400 rpm for 15 minutes. This process may be repeated, as necessary. Note the additional washes on the extraction sheet.
   d. Visually inspect each Microcon® membrane tube. If it appears that more than 5 µL remains above the membrane, centrifuge that tube for 5 more minutes at 2400 rpm.

5. Elution
   a. Open only one Microcon® tube and its fresh collection tube at a time.
   b. Add 20 µL of irradiated water to the Microcon® and invert the Microcon® over the new collection tube. Avoid touching the membrane.
   c. Centrifuge at 3400 rpm for 3 minutes.
   d. Transfer the eluant to an irradiated and labeled 1.5 mL tube. Measure and record the approximate volume. The total volume should not exceed 30 uL and should not be less than 20 uL. Adjust the final volume to 20 uL (if less). Discard the Microcon® membrane.
   e. If the eluant appears to be a dark color or is not clear, it may be necessary to purify the sample again. Prepare a fresh Microcon® tube and repeat steps 4-6.
2A. MANUAL DNA EXTRACTION

F. Clean up

1. Wipe the entire work area surface and pipets with 10% bleach followed by Ethanol and water.

2. Soak and/or clean racks, pipets, the cap opener and other equipment that would not adequately cleaned with the Stratalinker with 10% bleach, water and 70% Ethanol.

3. Turn on the UV lamp in the hood for ten minutes; remember to turn off the light in order to preserve the bulb.

4. If necessary, replenish the microcentrifuge tube and Microcon® collection tube supply. Irradiate for 30 minutes. Do not irradiate the Microcon® membranes.

G. Sample Storage

1. Place samples in a cryobox in the DNA refrigerator in the appropriate extract storage box. Indicate on the extraction sheet and tracking sheet the storage location.

2. Place extraction sheet in the appropriate area and notify the rotation supervisor that the samples are ready for quantitation.
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

2A. MANUAL DNA EXTRACTION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>30 OF 36</td>
</tr>
</tbody>
</table>

EXTRACTION OF EXOGENOUS DNA FROM NAILS

A. Personal Preparation

1. Don a mask, hair covering, lab coat, and gloves.
   a. Ensure that the cuffs of the lab coat completely cover arms.
   b. Lab coats may be re-worn in the pre-amp rooms only.

2. Do not enter room without appropriate attire. Moreover, never touch any apparatus, bench, etc with bare hands.

3. Remove gloves when answering the phone and touching door handles in order to maintain a DNA free glove.

B. Paperwork preparation

1. High Sensitivity extraction sets consist of 9 samples and one Extraction Negative. Additional extractions may continue sequentially during incubations.

2. In cell H1 of the appropriate nail extraction sheet (found for example in the “Templates in Use” folder on the Hi Sens Data or in the “Forms” folder on the FBIOLOGY_MAIN drive), type in the name of the extraction assay as follows: month (MM), day (DD), and year (YY), “period”, hour (HH) and minute (MM). For example, 040905.1330 for an extraction performed on April 9th, 2005 at 1:30pm. Save the sheet with “E” for extraction followed by the name of the extraction assay. For example, E040905.1330.

3. Manually enter OR copy and paste the sample names into the appropriate extraction sheet. The worksheet will automatically calculate the requisite amount of reagents needed for the extraction.
C. **Work Place Preparation**

1. Apply 10% bleach followed by water and 70% Ethanol to the entire work surface, cap opener, and pipets.

2. Retrieve clean racks and cap openers, and irradiated microcentrifuge tubes and irradiated water from storage or the Stratalinker. **Arrange work place to minimize crossover.**

   NOTE: Only use filter tips for pipetting.

3. Position gloves nearby with bleach/Ethanol/water in order to facilitate frequent outer glove changes and cleaning.

D. **Digestion**

1. From evidence exam, each nail (or group of nails as dictated by the previous collection and storage of the evidence or a supervisor) should be placed in an irradiated tube.

2. Add 200 µL of irradiated 25 mM EDTA/PBS solution to each sample.

3. Sonicate the samples for one hour at room temperature.

4. Label a new set of irradiated microcentrifuge tubes with the sample identifiers.

5. Remove the supernatants from the samples and place in the labeled irradiated microcentrifuge tubes.
E. Extraction

1. Prepare the digestion buffer according to the calculated volumes on the nail extraction sheet. The volumes for one sample are shown below:

<table>
<thead>
<tr>
<th>Stock Solution</th>
<th>Concentration</th>
<th>1 sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0% SDS</td>
<td>1.0% (0.96%)</td>
<td>2.3 (2.25) µL</td>
</tr>
<tr>
<td>Proteinase K 20 mg/mL</td>
<td>0.80 mg/mL</td>
<td>9 µL</td>
</tr>
<tr>
<td>Irradiated water</td>
<td>N/A</td>
<td>13.7 µL</td>
</tr>
</tbody>
</table>

2. Prepare Microcon® 100 tubes and label the membrane tube and filtrate tube cap with the sample identifiers. (Use Microcon® 50 tubes as indicated, for example when degradation is suspected. Consult the evidence exam schedule sheet or a supervisor.) Prepare and label the Microcon® collection tubes, sample storage microcentrifuge tubes as well as post-sonication nail collection tubes. The identifier for the post sonication nail collection tubes should include “PS” as a suffix. For example, the post sonication tube for left nail ring finger could be “nail L4 PS”.

3. **Witness step:** Confirm the sample names on the extraction sheet with the names on all labeled tubes.

4. Vortex solution well. Add 25 µL of the nail digestion buffer to each sample. Open only one sample tube at a time using the cap opener.

5. Record the temperatures of the heat shakers on the extraction worksheet. Temperatures must be within ± 3°C of the set temperature.

6. Incubate on the heat shaker at 56°C for 30 minutes with shaking at 1400 rpm.

7. Incubate on the heat shaker at 99°C for 10 minutes with no shaking (0 rpm).
8. After removing from the shaker, centrifuge the samples at full speed, briefly. Allow the samples to cool for a few minutes while preparing for next steps.

9. During the digestion period remove the nails using clean tweezers and dry them in a hood. When dry, place the nails in the labeled, post-sonication nail collection tubes.

F. Purification and Concentration

1. Self-witness step: Confirm the sample names on the extraction sheet with the names on the sample and Microcon® tubes.

2. Pre-coat the Microcon® membrane with Fish Sperm DNA or a 1/1000 dilution of Poly A RNA prepared as follows in an irradiated microcentrifuge tube or 15 mL tube:

   a. Fish Sperm DNA Preparation

      i. Add 1 uL of stock Fish Sperm DNA solution (1mg/mL) to 199uL of water for each sample on the extraction sheet.

      ii. Aliquot 200 uL of this Fish Sperm DNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the extraction worksheet for calculated value.

   b. Poly A RNA Preparation

      i. Make a 1/10 dilution of 1mg/mL of Poly A RNA as follows: add 2 µL of Poly A RNA to 18 µL of irradiated water and mix the solution well. This is a final concentration of 100µg/mL.

      ii. Using the 1/10 dilution, make a 1/100 dilution with 2 uL of 100µg/mL Poly A RNA in 198 uL of irradiated water and mix the solution well. The solution has a final concentration of 1 ng/µL.

      iii. Add 1 uL of the 1ng/µL Poly A RNA solution to 199uL of water for each sample on the extraction sheet.
iv. Aliquot 200 µL of this Poly A RNA solution to each Microcon® tube. Avoid touching the membrane. The volume for one sample is shown below. Refer to the extraction worksheet for calculated value.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>I sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>199 µL</td>
</tr>
<tr>
<td>Fish Sperm DNA (1mg/mL) or Poly A RNA (1ng/µL)</td>
<td>1 µL</td>
</tr>
</tbody>
</table>

NOTE: For samples with 400 µL of digest solution, make a 20 µL solution of 1 µL of Fish Sperm DNA (1mg/mL) or 1 µL of Poly A RNA (1 ng/µL) with 19 µL of water. Mix well and add this solution to the membrane. Ensure that the entirety of the membrane is covered. In this manner, all of the digest may be added to the Microcon® membrane for a total volume of 420 µL.
3. Filtration
   a. Add the entirety of each extract to its pretreated Microcon® membrane. Aspirate all of the solution by placing the pipet within the swab. The sample tubes may be discarded.
   b. Centrifuge the Microcon® tube at 2400 rpm for 15 minutes.
   c. Repeat this wash step two more times applying 400µL of water onto the membrane and centrifuging again at 2400 rpm for 15 minutes for a total of three washes to remove any residual EDTA.
   d. Visually inspect each Microcon® membrane tube after the third wash. If it appears that more than 5 µL remains above the membrane, centrifuge that tube for 5 more minutes at 2400 rpm.

4. Elution
   a. Open only one Microcon® tube and its fresh collection tube at a time.
   b. Add 20 µL of irradiated water to the Microcon® and invert the Microcon® over the new collection tube. Avoid touching the membrane.
   c. Centrifuge at 3400 rpm for 3 minutes.
   d. Transfer the eluant to an irradiated and labeled 1.5 mL tube. Measure and record the approximate volume. The total volume should not exceed 30 uL and should not be less than 20 uL. Adjust the final volume to 20 uL (if necessary) with irradiated water. Discard the Microcon® membrane.
   e. If the eluant appears to be a dark color or is not clear, it may be necessary to purify the sample again. Prepare a fresh Microcon® tube and repeat steps 4-6.
G. Clean up

1. Wipe the entire work area surface and pipets with 10% bleach followed by Ethanol and water.

2. Soak and/or clean racks, pipets, the cap opener and other equipment that would not adequately cleaned with the Stratalinker with 10% bleach, water and 70% Ethanol.

3. Turn on the UV lamp in the hood for ten minutes; remember to turn off the light in order to preserve the bulb.

4. If necessary, replenish the microcentrifuge tube and Microcon® collection tube supply. Irradiate for 30 minutes. Do not irradiate the Microcon® membranes.

H. Sample storage

1. Place samples including the post sonication nail collection tubes in a cryobox in the DNA refrigerator in the appropriate extract storage box. Indicate on the extraction sheet and tracking sheet the storage location.

2. Place extraction sheet in the appropriate area and notify the rotation supervisor that the samples are ready for quantitation.

Revision History:

January 12, 2009 – Added a chilling step in the High Sensitivity DNA Extraction Digestion method. All other changes are associated to the addition of the use of Fish Sperm DNA. See Approval Form.

February 16, 2009 – Moved “Magattract DNA Extraction for Bloodstains and Buccal Swabs” to Section 2B. Renamed this section to “2A. Manual DNA Extraction.”
3. MICROCON YM100 DNA CONCENTRATION AND PURIFICATION

Microcon YM100 filter membranes have a pore size that retains all DNA fragments greater than 100bp. This filtration device can be used to concentrate a low-DNA sample (e.g., when the quantitation reads less than 7.5 pg/µL) by simply removing excess liquid, or to purify a sample from low molecular weight contaminants (e.g., if the rtPCR shows that an amplification inhibitor may be present). After the liquid reduction, the volume may be as low as 2 to 5 µL. It is, therefore, necessary to bring the volume back up by adding TE⁻⁴.

In order to allow duplicate amplifications, the final volume should not be lower than 50 µL. However, dependent on the case type and test kits used, the final volume could be as low as 20 µL.

1. Label a sufficient number of blue Microcon YM100 sample reservoirs and insert each into a labeled collection tubes.

2. Pipette 100 µL of TE⁻⁴ solution into each labeled sample reservoir including the negative control.

3. Fill out a Microcon worksheet. Process 50 µL of TE⁻⁴ solution as a Microcon negative control. Make sure to use the same lot that will be used to dilute the samples, and don’t forget to label the final negative control tube with the Microcon date and time.

4. Spin each DNA sample briefly. Add each sample (0.4 mL maximum volume) to the buffer in the reservoir. Don’t transfer any Chelex beads, or in case of an organic extraction sample, any organic solvent! Seal with attached cap. Avoid touching the membrane with the pipette tip!

5. Return the original extraction tubes to their storage location. Do not discard the empty tubes.

6. Place the Microcon assembly into a variable speed microcentrifuge. Make sure all tubes are balanced! To prevent failure of device, do not exceed recommended g-forces.

7. Spin at 500 x g (2500 RPM, Eppendorf) for 15 minutes at room temperature.
**FOR CONCENTRATION ONLY, SKIP STEP 8 AND PROCEED TO STEP 9**

8. For purification of the DNA sample add 200 µL of TE<sup>-4</sup> solution and repeat Steps 6-7. Do this as often as necessary to generate a clear extract, and then continue with Step 9. When performing multiple wash steps it is necessary to empty the bottom collection tube intermittently.

**NOTE:** When purifying samples with a low DNA concentration it may be advantageous to use several wash steps and to also reduce the volume to achieve both, a cleaner sample and an increased DNA concentration.

9. Remove assembly from centrifuge. Visually inspect each Microcon 100 membrane tube. If it appears that more than 20 µL remains above the membrane, centrifuge that tube for 5 more minutes at 2400 rpm. This process may be repeated as necessary.

10. Open the attached cap using a tube opener and add 20 µL TE<sup>-4</sup>. *Avoid touching the membrane with the pipette tip!* Separate collection tube from sample reservoir.

11. Place sample reservoir upside down in a new labeled collection tube, then spin for 3 minutes at 1000 x g (3500 RPM Eppendorf). Make sure all tubes are balanced!

12. Remove from centrifuge and separate sample reservoir. Measure resulting volume using an adjustable Micropipette, record volume on work sheet; adjust volume to desired level using TE<sup>-4</sup>:
   
a. Clean-up for high DNA concentrations: reconstitute to starting volume.
   
b. Low DNA samples (clean-up and/or concentration): adjust to 20-50 µL (depending on amplification system)

13. Transfer the DNA extracts and the Microcon negative control to newly labeled 1.5mL Eppendorf tubes and store extract for later use. Note storage location on worksheet.

14. Calculate resulting concentration or submit to real-time PCR analysis to find the new DNA concentration.

**ATTENTION:** Do not store the DNA in the Microcon vials! The lids are not tight enough to prevent evaporation.
### Troubleshooting:

Lint, bone dust and other particles can clog the membrane. If the liquid does not go down, collect the sample from the filter and redistribute the supernatant to multiple filters or a new filter. Pipet off the clear supernatant without disturbing the particle pellet. Microcon negative controls should be treated accordingly.

If the problem persists, the specific Microcon lot number might be faulty. Notify the QA Unit and try a different lot number.
ALU-Based Quantitative Real Time PCR on the Rotorgene

A. Paperwork Preparation

The aim of the following steps is to set up an Excel spreadsheet with a list of samples that can be used for quantitation and facilitate PCR set up. LCN (low copy number) samples are contact DNA samples with low expected DNA yields, while HCN (high copy number) samples are body fluid samples.

1. Open the “RG summary sheet” Excel file template in the Rotorgene - RG sheets folder.

2. In cell D3 type in the name of the quantitation assay as follows: RG# and “Q” or the name of the RG, month, day, and year, period, hour and minutes. For example, RG1Q040905.1330 or Gerty051707.1500.

3. Exemplar and evidentiary samples may be quantitated simultaneously. However, exemplar extracts must be diluted prior to performing the assay. In other words, only the aliquots and/or dilutions of the exemplars may be present with the evidentiary samples under the hood.

**NOTE:** Since LCN evidence samples are diluted only when necessary, and since LCN extract volume is limited such that only the two required microliters can be spared for quantitation, extreme care must be used in pipetting the LCN quantitation aliquot in its entirety.

4. Determine which samples require quantitation. Prioritize samples accordingly.

5. Copy/Type sample names from the extraction sheet and/or “to be quanted sheet”, and paste into the Rotorgene “sample sheet” (second sheet of the Excel workbook). For samples requiring dilutions, the dilution factor should be entered in decimal form following a comma after the sample name. For instance, for bloodstain 1A a 1/10 dilution is required. This sample should be entered into the RG sample sheet as “bloodstain 1A, 0.1”. For neat samples, no additional info should be added. For instance, an “N” or a “, 1” is not required.

Controlled versions of Forensic Biology Manual only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>2 OF 31</td>
</tr>
</tbody>
</table>

NOTE: To facilitate import of sample information into the 3130xl software, if sample info is copied or imported at the level of the extraction sheet, the sample info should already adhere to 3130xl software requirements. This would similarly apply to the copying or importation of sample info at the level of the RG sheet. Letters, numbers, and only the following characters: - _ . ()[]+^ may be used. Do not use commas (except to separate sample and dilution info), colons, or quotes. Use the character ^ instead of quotes.

6. Three calibrators and 15 standards are measured with each assay; therefore, 54 samples may be measured on each RG assay.

7. If applicable, enter the initials of the analyst’s to whom paperwork should be directed, the target date, and the top tube label under the “IA”, “target date”, and “tube label” columns, respectively. If not available or not applicable, type a dash in the cell. For quant results going directly to the analyst rather than the auto-aliquot system, enter an “A” in the A column.

8. On sheet one, the “assay sheet”, in cell D4, enter the name of the extraction assay. If multiple extraction sets are being run, enter “misc”.

9. The number of samples that are being measured will be automatically calculated and shown in cell E7 as samples are added to the “sample sheet”. Verify that this number is correct. The spreadsheet will automatically calculate how much of each reagent to aliquot.

10. Save the sheet in the appropriate Rotorgene folder using the quantitation name. (Ex. Quantitation assay RG1Q040905.1300 will be saved in the RG1 folder as “RG1Q040905.1300”.)

11. Print the assay sheet, as well as the sample sheet by clicking File and Print on the menu bar. This step must be repeated for both sheets independently.
B. Personal Preparation

1. Follow gowning protocol procedures. For example, in the LCN laboratory this includes the following:
   a. Put on a mask, lab coat, hair covering and gloves.
   b. Ensure that the cuffs of the lab coat completely cover arms.
   c. Lab coats may be recycled.

2. Do not enter room without appropriate attire. Moreover, never touch any apparatus, bench, etc. with bare hands.

3. Remove gloves when answering the phone and touching door handles in order to maintain a DNA free glove.

C. Work Place Preparation

1. Apply 10% bleach followed by water, and 70% Ethanol to the entire work surface, cap opener, and pipets. All Rotorgene setup steps should be carried out under a hood.

2. Retrieve clean racks, cap openers, Rotorgene 0.1 mL tubes and caps, microcentrifuge tubes, and irradiated GIBCO™ ULTRA PURE™ distilled water from storage or the Stratalinker.
   a. The tube racks and the cap opener may be cleaned with 10% bleach followed by Ethanol. Ensure that the racks are dry before use.
   b. The 1.5 mL microcentrifuge tubes and water aliquots in 1.5 mL tubes must be irradiated for 30 and 45 minutes, respectively.
   c. The Rotorgene tubes and caps are used as packaged.

3. Arrange work place to minimize crossover. For example, the sharps waste for tips should be on one side whereas the fresh filter pipet tips and reagents should be on the opposing side.

4. Position gloves nearby with bleach/Ethanol/water in order to facilitate frequent glove changes and cleaning.
D. Sample Dilution

If necessary, dilute the sample extracts (as with HCN samples).

1. Label microcentrifuge dilution tubes with sample name and dilution.
2. Place each dilution tube directly behind the corresponding extract tube in a rack.
3. Add the appropriate amount of diluant (irradiated water or TE) to each dilution according to Table 1.
   a. Sexual assault semen and saliva samples, scrapings and other samples that are extracted with the “Chelex other” method, and bone samples should be measured with a neat and a 1/100 dilution.
   b. Blood and buccal samples and all burglary samples may be measured with a 1/10 dilution only. This will capture most concentrations. If necessary, a second measurement may be taken with either a neat or a 1/100 dilution.
   c. LCN samples should be measured with a neat dilution. If necessary, a 1/10 dilution may be made if one suspects inhibition.
   d. Pipet tips do not need to be changed to add water/TE to empty tubes. Close all caps.
4. Open only one sample and its corresponding dilution tube at one time.
5. Thoroughly mix each extract, prior to aliquotting.
6. Immediately following each dilution, return the original sample extract tube to its cryobox. Return the original samples to 4°C storage.
7. Once the dilutions are completed, evidentiary samples may join exemplar dilutions under the hood.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

**DATE EFFECTIVE**
06-09-2008

**VERSION**
10.0

**PAGE**
5 OF 31

TABLE 4.1:

<table>
<thead>
<tr>
<th>Sample Type</th>
<th>Submission 1</th>
<th>Submission 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dilution 1</td>
<td>Water or TE</td>
</tr>
<tr>
<td>HCN</td>
<td>Neat</td>
<td>5 µL</td>
</tr>
<tr>
<td>Semen and saliva (amylase positive) samples</td>
<td>0</td>
<td>1/100</td>
</tr>
<tr>
<td>HCN</td>
<td>Neat</td>
<td>5 µL</td>
</tr>
<tr>
<td>Scrapings or “other” extractions</td>
<td>0</td>
<td>1/100</td>
</tr>
<tr>
<td>HCN</td>
<td>Neat</td>
<td>5 µL</td>
</tr>
<tr>
<td>Bone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HCN</td>
<td>1/10</td>
<td></td>
</tr>
<tr>
<td>Exemplars Blood or Saliva</td>
<td>2 µL</td>
<td>18 µL</td>
</tr>
<tr>
<td>HCN</td>
<td>1/10</td>
<td></td>
</tr>
<tr>
<td>Blood Samples</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touched objects and/or LCN Samples</td>
<td>Neat</td>
<td>N/A</td>
</tr>
<tr>
<td>HCN</td>
<td>1/10</td>
<td></td>
</tr>
<tr>
<td>Blood Samples</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Neat LCN samples may be taken from the extract tube and added to the quantitation tube directly (no neat submission tube is necessary). However, 1/10 dilutions should be prepared in advance as specified above.

E. Remove reagents for the master mix from the reagent freezer/refrigerator

1. Retrieve MgCl₂, 10X PCR buffer, BSA, dNTPs, TAQ GOLD, unlabeled “EB1” and “EB2” primers, and SYBR Green I from the freezer, irradiated GIBCO™ ULTRA PURE™ distilled water from the refrigerator, and DMSO from the cabinet.
2. Store reagents, except DMSO and water, in a Nalgene cooler on the bench.
3. Record lot numbers of reagents.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

4. Just before initiating “sample preparation”, place MgCl₂, 10X PCR buffer, BSA, dNTPs, and unlabeled “EB1” and “EB2” primers on a 48-position microcentrifuge rack in order to thaw these reagents.

IMPORTANT: In order to ensure accuracy and to minimize contamination, focus on the task and avoid unnecessary conversations.

F. Standard Curve Preparation

1. Retrieve standard DNA from the freezer labeled 1600 pg/µL and record lot #.

2. Ensure that the contents of the 1600 pg/µL standard DNA tube are thawed and removed from the cap, by centrifuging the tube.

3. Label tubes as follows: 400, 100, 25, 6.25, 1.56, 0.39, and NTC (no template control or 0 pg/µL).

4. Add 15 µL of irradiated water to tubes 400, 100, 25, 6.25, 1.56, 0.39, and the NTC. Pipet tips to not need to be changed to add water to empty tubes. Close all caps.
5. 0.25 Serial dilution
In order to mix each dilution thoroughly, either pipet the dilution up and down several times or vortex each dilution and subsequently centrifuge the tube at no more than 3000 rpm for 3 seconds.
   a. Open only two consecutive standard DNA tubes at once starting with the 1600 and the 400 pg/µL tubes. (Do not open the 0 pg/µL tube for this dilution.)
   b. Mix the DNA solution in the 1600 pg/µL. Take 5 µL of standard DNA at 1600 pg/µL and add to the 400 pg/µL tube, and thoroughly mix the contents.
   c. With a new pipet tip, take 5 µL of standard DNA at 400 pg/µL and add to the 100 pg/µL tube, and thoroughly mix the contents.
   d. With a new pipet tip, take 5 µL of standard DNA at 100 pg/µL and add to the 25 pg/µL tube, and thoroughly mix the contents.
   e. With a new pipet tip, take 5 µL of standard DNA at 25 pg/µL and add to the 6.25 pg/µL tube, and thoroughly mix the contents.
   f. With a new pipet tip, take 5 µL of standard DNA at 6.25 pg/µL and add to the 1.56 pg/µL tube, and thoroughly mix the contents.
   g. With a new pipet tip, take 5 µL of standard DNA at 1.56 pg/µL and add to the 0.39 pg/µL tube, and thoroughly mix the contents.
   h. Do not add anything to the NTC tube.

G. Sample Preparation

1. Remove calibrator: 1500 pg/µL from freezer and record lot number.
   a. Vortex the calibrator thoroughly and centrifuge the tube at 3000 rpm for approximately 3 seconds.
   b. Make three 0.166 dilution (1/6) of the calibrator with 4 µL of the calibrator and 20 µL of irradiated water.

2. Refer to Table 3.1 for sample submission guidelines.

3. Vortex all samples including the standards, NTC, calibrator, and the dilution and/or extract tubes.

4. Centrifuge all samples briefly for 3 seconds at no greater than 3000 rpm; this will prevent the DNA from aggregating at the bottom of the tube.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

5. Witness Step:
   Arrange samples in order according to the sample sheet in a 96 well rack.
   a. Place samples in exactly the same place on the rack as they will appear vertically positioned in the rotor. (The microcentrifuge rack positions A1-H1, A2-H2, A3-H3, A4-H4, A5-H5, A6-H6, A7-H8, and A9-H9. In the newer rotors, the Rotor positions are 1-72. Therefore, rotor position 1 is equivalent to A1 on the rack, B1=2, C1=3, etc. In the older rotors, the rotor positions are A1-A8, B1- B8, C1-C8, D1-D8, E1-E8, F1-F8, G1-G8, H1-H8, and I1-I8. Therefore, A1 for the rotor is equivalent to A1 on the rack, B1=A2, C1=A3, D1=A4, E1=A5, F1=A6, G1=A7, H1=A8, and I1=A9.)
   b. Specifically, standard 1600a will reside in well 1 in the rotor (or A1 in the older rotors) and A1 in the rack. Standard 1600b will reside in 2 on the rotor (or A2 in the older rotors). However, well B1 will be empty, since one will take the duplicate 1600 standard from the first tube. Rotor position 3 (or A3 in older rotors) corresponds to rack well C1, standard 400a, and rotor position 4 (or A4 in older rotors), represents standard 400b in rack well D1 which is empty.
   c. Only the standards 1600 pg/µL - 0.39 pg/µL are duplicated. The no template control (0 pg/µL), the calibrator, and the samples are not duplicated.
   d. In brief, the standards are vertically placed in positions A1 through B4 in a 96 well rack.
   e. The no template control resides in B7, and the calibrator in B8. Samples are located in rotor wells 17-72 and rack positions A3-H9.
   f. Label the top of the sample tubes with rotor well identifier to minimize pipetting errors and sample mix ups.
   g. Have a witness confirm the sample locations.

H. Master Mix preparation

1. Remove the SYBR Green I from the Nalgene cooler and prepare a 1/100 dilution. Take 2 µL of SYBR Green I in 198 µL of irradiated water, vortex, and tap the tube on the bench to consolidate the reagent at the bottom of the tube.
2. Mix each reagent before adding.
   a. After each reagent has thawed, vortex each reagent, with the exception of TAQ GOLD.
   b. Centrifuge reagents in the table top centrifuge at 3000rpm for approximately 3 seconds.

3. Add each reagent in the order as it appears on the worksheet. Thoroughly mix each tube reagent by pipetting up and down, or vortexing briefly. If vortexing, afterwards tap the tube on the bench to prevent the reagent from being trapped in the cap.

4. For total reagent volumes above 20 µL, use a P200 even for multiple dispenses as opposed to one dispense with a P1000. To ensure accurate pipetting, aspirate and dispense the reagent as specified on the run sheet.

5. After adding each reagent, check that it has been added on the quantitation sheet, and place the reagent back in the Nalgene cooler, or for water and DMSO, in the opposite corner of the 48 well microcentrifuge rack.

6. Thoroughly mix the master mix by vortexing. Tap the tube on the bench to prevent the reagent from being trapped in the cap and/or centrifuge briefly for approximately 3 seconds.

7. Add 23 µL of master mix to the appropriate number of Rotorgene tubes. Fill tubes in a vertical fashion (positions 1-16 or A1 to A8, and B1-B8 in older rotors). After adding master mix to 16 tubes, re-vortex the master mix and ensure all of the master mix is consolidated by tapping the tube on the bench and centrifuging briefly for approximately 3 seconds. Use a new pipette tip.

8. In order to track additions, it may be helpful to recite each well position to be oneself.

See below for reagent concentrations, the spreadsheet will calculate amounts for n+10%n samples and will display rounded values for pipetting.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

<table>
<thead>
<tr>
<th>TABLE 4.2:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Concentration</th>
<th>µL# for 1 Rx</th>
</tr>
</thead>
<tbody>
<tr>
<td>Irradiated GIBCO™ ULTRA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PURE™ distilled water</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10X PCR Buffer</td>
<td>10mM Tris/ 50mM KCL</td>
<td>2.5</td>
</tr>
<tr>
<td>25 mM MgCl₂</td>
<td>275 µM</td>
<td>2.8 (2.75)</td>
</tr>
<tr>
<td>5 mg/mL BSA</td>
<td>0.525µg/µL</td>
<td>4.0</td>
</tr>
<tr>
<td>2.5 mM dNTPs</td>
<td>200 µM each</td>
<td>2.0</td>
</tr>
<tr>
<td>DMSO</td>
<td>8%</td>
<td>2.0 (1.96)</td>
</tr>
<tr>
<td>1/100 dilution of 10,000X SYBR Green I</td>
<td>100X</td>
<td>0.3 (0.28)</td>
</tr>
<tr>
<td>20 pmol/µL Primer EB1</td>
<td>0.4 µM</td>
<td>0.5</td>
</tr>
<tr>
<td>20 pmol/µL Primer EB2</td>
<td>0.4 µM</td>
<td>0.5</td>
</tr>
<tr>
<td>5U/µL ABI Taq Gold</td>
<td>1.25U</td>
<td>0.3 (0.25)</td>
</tr>
<tr>
<td>Total volume</td>
<td></td>
<td>23.00</td>
</tr>
</tbody>
</table>

*The spreadsheet calculates the values using two significant figures. However, for the purposes of manual addition, only one significant digit is shown.*

I. Sample Addition

1. In order to avoid the creation of aerosols, thoroughly mix the contents of each tube by pipetting up and down repeatedly.

2. Add 2 µL of each sample, including the standards, NTC, the calibrator dilution, and the sample dilutions and/or extracts, to each tube with master mix.
   a. If necessary, in order to conserve sample, only 1 µL of sample may be measured. Note this in the sample name, and double the resultant value to accurately reflect the sample’s concentration per microliter.
   b. It is helpful to place the sample extract tube in its cryobox or another rack directly after its addition.
   c. Every four reaction tubes, place caps on the tubes. (The caps are attached in sets of four.)
d. Number the first cap in every set of four as they will appear in the rotor. (1 for 1, 2 for 2, etc. For the older rotors, 1 for A1, 5 for A5, 9 for B1 etc.) **DO NOT** label the tube itself, as this may interfere with fluorescent detection.

e. Open the machine. Remove the circular rotor from the instrument by either pressing in the middle silver stem in the RG6000 or unscrewing the center piece in the RG3000. Remove either the silver clip from the RG6000 rotor or the silver ring from the RG3000 rotor. Add tubes to the rotor. Ensure that tube 1 is in position 1, etc. or in older rotors, 1 is in position A1 etc.

f. Ensure that all positions on the rotor are filled (using blanks if necessary).

g. In the RG6000, add the silver clip to the rotor, lock into the Rotorgene, and close machine. In the RG3000, add the silver ring and screw the rotor into the Rotorgene, locking the rotor in place. Ensure the silver ring is in place and sitting securely in the rotor on all sides. Close machine.

J. **Software Operation**

1. Open Excel and the relevant sample sheet to the sheet with the sample names, and then collapse the window.

2. Open Rotorgene 6 software on the desktop.

3. Click File, New, Casework, and click “new”

4. In the wizard
   a. Ensure that the “Rotorgene 72 well rotor” is highlighted
   b. Make sure that the box next to “locking ring attached”, is checked.
   c. Click “Next.”
   d. Type initials for Operator and add any notes (extraction date/time)
   e. Reaction volume should be “25 µL”
   f. Sample layout should be “1, 2, 3,…”
   g. Click “Next.”
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

h. In the RG3000s, click “Calibrate”. In the RG6000, click “gain optimisation”.
   i. “Perform Calibration before 1st acquisition”
   ii. Click on “calibrate acquiring” (RG3000) or “optimize acquiring” (RG6000).
   iii. “This will remove your existing setting for auto gain calibration?”
        The window appears, click YES. A green gain window will open. Click “ok”, then “close”.
   iv. Note selecting “calibrate all” will attempt to calibrate for all channels known by the software whereas “calibrate acquiring” will instead only calibrate those that have been used in the thermal profile defined in the run such as FAM or Green.
   v. Click next in wizard and “start run”.

5. “Save as” the RG#, date and time (for example, “RG1Q112904.0200” for a run on RG1 on Nov 29, 2004 at 2:00) in Log Archive folder.

6. Sample sheet window
   a. Expand the Excel sample sheet window. Copy the sample names.
   b. Paste sample names in the appropriate rows in the Rotorgene sample window by right clicking and selecting paste.
   c. Settings:
      i. Given concentration format: 123,456.78 unit pg/µL
      ii. Type category
         1) Standards: std
         2) Zero standard: NTC
         3) Samples and calibrator: unk
      iii. In all wells with standard, calibrator or sample, select “YES”

You may copy and paste selections by right clicking.
d. Hit “Finish”

See below for cycling parameters that should not be changed:

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>95°C</td>
<td>10 min</td>
</tr>
<tr>
<td>94°C</td>
<td>15 sec</td>
</tr>
<tr>
<td>68°C</td>
<td>60 sec</td>
</tr>
<tr>
<td>72°C</td>
<td>30 sec</td>
</tr>
<tr>
<td>72°C</td>
<td>15 sec</td>
</tr>
</tbody>
</table>

35 cycles

7. Enter run information in the Rotorgene log book.

8. The run will approximately require 1 hour and 40 minutes for completion.
   a. If you are leaving for the day, the machine needs no further assistance.
   b. If you will remain upon completion of the run, and no more runs will be conducted that business day, turn off or log off the computer when the run completes.

9. Following the initial heating to activate the TAQ and the gain calibration, the raw data will appear on the screen. With this information, one can monitor the progress of the run. Fluorescence for the highest standard should be apparent from ~ cycle 15.

10. Previous run files may be examined while the computer is collecting data.
    a. Collapse the window.
    b. Double click on the Rotorgene icon on the desktop.
    c. The computer will prompt that another version of the software is running and ask if you want to run an analysis version only. Click yes.

K. Clean Up

1. Wipe entire work area surface and pipets with bleach followed by water and Ethanol.

2. Soak and/or clean racks, pipets, cap openers, and other equipment that would not be adequately cleaned with the Stratalinker with 10% bleach, 70% Ethanol, and water. (Ensure that bleach is completely removed from the equipment.)
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

3. If necessary, place fresh microcentrifuge tubes in the Stratalinker and apply ultraviolet radiation for the 30 minutes.

4. Turn on the UV lamp in the hood for ten minutes. Do not forget to turn off the light.

5. Return water, dNTPs, MgCl₂, 10X PCR buffer, BSA, DMSO, EBI primer, EB2 primer, TAQ GOLD and water tubes with any remaining reagents to storage.

6. Dispose of all dilution tubes of the standard, calibrator, and SYBR Green I. Sample aliquots may be stored until assay success is confirmed.

L. Sample and Data Storage

1. Store extracts in a cryobox in the DNA refrigerator. For LCN, the extracts should be stored in the DNA refrigerator in the pre-amp room in the designated area.

2. Ensure that the final Rotorgene sheet is stored on the network in the folder labeled “RG sheets” and that the data from the assay is in the folder labeled “RG data” under the appropriate Rotorgene folder.

3. To transfer over the Rotorgene data to the network:
   a. After the run is done, save and exit out of the Rotorgene software.
   a. In the Log Archive, go to the appropriate run folder.
   b. Copy the run onto a flash drive and transfer the run into the appropriate Rotorgene folder under the “RG data” folder on the network. (To remove the flash drive from the computer, click on the green arrow icon on the lower right corner of the computer screen. Click “Safely remove USB Mass Storage Device”.)

4. Pass the assay and sample sheets to the rotation supervisor for review.

Controlled versions of Forensic Biology Manual only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
M. Analysis

1. Analysis may be performed on the instrument computer or any computer that has access to the software.

2. Open Rotorgene software on the desktop. If the computer is not connected to an instrument, when the software indicates that the computer cannot connect to the instrument on serial port COM1, select “run in virtual mode”.

3. Click “Open” and click on the run to be analyzed in the Log Archive folder.

4. Click “Analysis” on the toolbar.
   a. Select “Quantitation”, “Show”.
      i. Three windows will open with the standard curve, the samples, and fluorescence.
      ii. If a “Calculate Automatic Threshold” window will show up, click ok.
      iii. Ensure that “dynamic tube” and “slope correct” are selected on the tool bar.
      iv. Select the tab “more settings”.
         1) Ensure that the NTC threshold is set to 10%.
            a) This permits the exclusion of samples or NTCs, which have a slight drift upwards, due to probe degradation or other non PCR effects. All samples with a change below the NTC threshold of 10% will not be reported in the quantitation screen. The percentage is relative to the largest maximum change found in any tube.
            b) For example, if you have one sample which began at a background of 2 Fl and went to 47 Fl, then 45 Fl represents 100%. An NTC threshold of 10% would consider as noise any sample with a reaction less than 4.5 Fl.
2) The box under the "reaction efficiency threshold" should NOT be selected however.
   a) With this alternative mechanism to exclude noise samples from analysis, all samples will be excluded if they do not have a reaction efficiency of at least the specified level. A level of 0% indicates that, during the exponential phase, no reaction took place. 100% indicates that a completely efficient reaction took place during the exponential phase. Negative percentages indicate that during what has been guessed as the exponential phase, the fluorescent signal declined.
   b) Any sample with a genuine reaction will have some visible exponential phase with some growth. Setting this value higher than 0% will exclude some samples with inefficient, but perceptible growth, whereas setting below 0% will display samples whose reading decreased during the exponential phase, and which should clearly be excluded.
3) Click "okay"
   v. If any of the settings need to be corrected, "auto find threshold" must be performed again. ("Auto find threshold" can be found in the lower right corner of the screen if the “Quantitation Analysis” graph is selected.)

b. Check if any sample curve crosses the threshold at an early cycle due to background fluorescence. The sample in question would have no value, but the normalized data would display a curve that crosses the threshold both at an early and at a later cycle (Figure 4.1A).
   i. Dynamic tube normalization uses the second derivative of each sample trace to determine a starting point for each sample. The second derivative measures the rate of the rate of change. In other words, the increase in fluorescence from cycle to cycle is averaged from cycle 1 up to the where the fluorescence “takes off” or the starting cycle number for each sample. This method gives the most precise quantitation results.
ii. In order to avoid disabling the dynamic tube normalization setting, move the threshold to the right, ignoring the first few cycles, so that the sample does not cross the threshold. This can be achieved by the following:
1) In the normalized data windowpane, on the lower right side, under CT calculation, change the number for “Eliminate Cycles before:” from 0 to 1-5. Choose the smallest number where the threshold does not cross the data curve in question (Figure 4.1B).
2) Alternatively, select the grid immediately to the right of “Eliminate cycles before”. This allows manual manipulation of the starting cycle number of the threshold.
3) Reanalyze the data by selecting “auto find threshold”.

c. One may also manually manipulate the vertical position of the threshold on the standard curves.
i. Select the grid to the right of the threshold value and then click on the red threshold line and adjust the line. Moving this line vertically will make the threshold cross the standards’ curves at different cycles and thus will change the efficiency, Ct, and sample values.
ii. Position the line to optimize the distance between the Ct values of the standards and thus the calibrator values, while maintaining a passing efficiency value.

4. Save experiment as RG#, “Q”, date and time (“RG1Q052506.1100” for example) in the log archive folder.
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>18 OF 31</td>
</tr>
</tbody>
</table>

N. Report

1. On the “Quant results” screen, (by right clicking the table heading with the mouse and un-checking certain columns) only pick the following columns: No., Name, Type, Ct., and Calc.Conc.

2. Select “Reports” from toolbar
   a. Select “Quantitation, cycling A FAM/SYBR”
   b. Select “full report” double click
   c. Generate report
   d. Print at 95%.

3. Submit reaction sheet and full report paperwork to supervisor for review.

Figure 4.1A: Normalization with the dynamic tube method usually does not required one to eliminate early cycles. However, the sample depicted by the red curve above crosses the threshold during the first and the ninth cycle yielding a negative value.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

Figure 4.1B: Eliminating the first four cycles prevented the sample depicted in red from crossing the threshold at an early cycle. Therefore, the value at which the sample crossed the threshold, cycle nine was employed to determine the quantitative value.

O. Value Calculation by Software

1. Fluorescence values are recorded during every cycle and represent the amount of product amplified to that point in the amplification reaction.

2. The more template present at the beginning of the amplification reaction, the less cycles that will be required to obtain sufficient fluorescence signal above background. This point is defined as the Ct and will occur during the exponential phase of amplification.

3. The Rotorgene software scans through all possible threshold levels until the best fit is found for the standard curve.

4. The R value is a number between -1 and 1 which defines how well a line of best fit or a least squares line describes the relationship between two variables. An R-value of zero implies no relationship, whereas an R-value of -1 or 1 indicates that the data values fall directly on the line of best fit.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>20 OF 31</td>
</tr>
</tbody>
</table>

5. The following are calculated:
   a. The slope of a reaction: change in Ct/change in log input, opt -3.322
   b. Reaction efficiency = \[10^{(-1/\text{slope})} - 1\], optimum 1
      A 100% efficient reaction results in a doubling of the amplification
      product each cycle.
   c. exponential amplification = \[10^{(-1/\text{slope})}\], optimum 2

P. Assay Interpretation

Standards and Controls

1. Check the raw data for cycling. (If the raw data graph is not seen, click on
   “Cycling A.Green” in the tool bar and then “Arrange”.) If the fluorescence is
   below 80 RFUs, yet the reaction efficiency is acceptable (see 5), determine if the
   SYBR Green I was thawed more than once. If not, notify QC in order to test
   stock. The assay still passes as long as conditions 2b and 3 are fulfilled.

2. Confirm that the following settings are correct:
   a. standard curve imported “no”
   b. Start normalizing from cycle “1”
   c. noise slope correction “yes”
   d. reaction efficiency threshold “disabled”
   e. normalisation method “dynamic tube normalisation”
   f. digital filter “light”
   g. no template control threshold “10%”

3. Slope optimum: -3.322

4. R² value optimum: 0.999

5. Reaction efficiencies should range from 0.88 to 1.15.
   a. Reaction efficiencies above 1.15 are too high and the run fails.
   b. Reaction efficiencies below 0.88 are too low and the run fails.
   c. Efficiencies are rounded down. (For example, 0.879 fails.)

6. Two of the three calibrator values must be between 400 pg/µL and 100
   pg/µL.
   a. This assay has a potential inherent error of a factor of 0.3.
   b. Therefore, the expected value for the calibrator is between 175 pg/µL and
      325 pg/µL.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

7. **Non template controls or zero standards should be < 0.1 pg/µL.** When the curve of the NTC does not cross the threshold, no value will appear in the concentration column. Assume that the value is zero. However, confirm that the curve from the raw data does curve slightly and is not a flat line. A flat line indicates that inhibition has occurred (refer to Sample Interpretation section 5b.) There will always be some background amplification at the late cycles even the NTC.

8. **The difference between the average Ct values of each consecutive duplicate standard concentration should be approximately two cycles.**

9. **At least one of each duplicate standard concentration should be apparent (“clicked on”).** (If #10 is exercised, at least one of each duplicate standard concentration should be apparent for 5 of the 7 remaining standards.) If one duplicate of a standard does not yield the expected Ct value, but the other duplicate is within the expected range, the aberrant standard may be excluded from the standard curve calculation. Unselect the sample on the right side of the screen, and reanalyze.

10. Similarly, if both replicates of a standard are not within the expected range, they may both be excluded from the standard curve calculation, and if all the other parameters of the assay are satisfactory, the assay passes. **However, no more than two standard pairs may be absent.**

11. Record the reaction efficiency, calibrator and non-template control values, and fail the assay if these values or the standards are unacceptable. The reviewer must sign and date the sheet as well.

12. For LCN, complete an Assay Resolution sheet if necessary and identify the problem, the assay name, and the samples affected, and select a resolution from the drop down menu. Typically, the samples will need to be re-quantitated. For LCN samples, in order to preserve sample, if the quantitation assay fails twice, proceed to amplification without a third quantitation.

13. Initiate retesting of all samples in a failed run. Although a quantitation assay may fail, the resultant values may be used to estimate the need for further dilutions for the re-quantitation assay.

Controlled versions of Forensic Biology Manual only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
TABLE 4.3:

<table>
<thead>
<tr>
<th>Required Settings</th>
<th>Required Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Value</td>
</tr>
<tr>
<td>Start normalizing from cycle</td>
<td>1*</td>
</tr>
<tr>
<td>Noise slope correction</td>
<td>yes</td>
</tr>
<tr>
<td>Reaction Efficiency threshold</td>
<td>Disabled</td>
</tr>
<tr>
<td>Normalization Method</td>
<td>Dynamic tube Normalization</td>
</tr>
<tr>
<td>Digital Filter</td>
<td>Light</td>
</tr>
<tr>
<td>No template control threshold</td>
<td>10%</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* May change if a sample curve crosses the threshold early (refer to Section M.4.b.ii. of this section).

Sample Interpretation

1. Samples that are 1000 pg/µL and above should be requantitated at a 1:100 or a 1:1000 dilution.

2. For LCN samples, if the extraction negative is > 0.2 pg/µL the sample set must be re-extracted prior to LCN amplification. A concentration of 0.2 pg/µL would equate to 1 pg of DNA amplified with Identifiler™ for 31 cycles, which would produce ample alleles to fail the amplification.

3. Similarly, amplification of 1 pg with Identifiler™ reagents for 28 cycles may generate 1 allele which would fail the amplification. Thus, if the extraction negative is > 0.2 pg/µL the sample set must be re-extracted prior to amplification.

4. Since the Cofiler™/Profiler Plus™ 28 cycle systems are less sensitive, the thresholds for amplification are higher. If the extraction negative is > 1 pg/µL or 20 pg/amp for Cofiler/Profiler Plus it will need to be re-quantitated (refer to Table 43 below).
5. When the curve of the extraction negative does not cross the threshold, no value will appear in the concentration column. Assume that the value is zero.

### TABLE 4.4:

<table>
<thead>
<tr>
<th>Amplification System</th>
<th>Sensitivity of Amplication</th>
<th>Extraction Negative Control Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cofiler™/Profiler Plus™/YM1</td>
<td>20 pg</td>
<td>1.00 pg/µL in 20 µL</td>
</tr>
<tr>
<td>Identifiler™ 28 cycles</td>
<td>1 pg</td>
<td>0.20 pg/µL in 5 µL</td>
</tr>
<tr>
<td>Identifiler™ 31 cycles</td>
<td>1 pg</td>
<td>0.20 pg/µL in 5 µL</td>
</tr>
</tbody>
</table>

6. If the no template control is > 0.1 pg/µL, LCN samples may be amplified since there may not be sufficient sample to retest. However, HCN samples must be requantitated.

7. If a sample appears to be inhibited since, the curve initially increases and then plateaus (see Figure 4.2A), purify the sample with a Microcon® 100 and amplify or re-quantify if necessary. (If the raw data graph is not seen, click on “Cycling A.Green” in the tool bar and then “Arrange”.)

   a. Figure 4.2A displays samples that inherently fluoresce. Indicate such samples with an asterisk, “*”, on the sample sheet in the “Comments” column.

   b. For other types of inhibition and/or quenching, the curves will appear as the other curves but then plateau earlier (Figure 4.2B). Note this type of inhibition with a triangle, “Δ”. Although purification of the samples in Figure 4.2B may enhance fluorescence in this assay, since sufficient DNA is present for amplification, the samples produced DNA STR profiles (data not shown). The important factor is whether the samples increase in fluorescence by at least ten fold.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

**Figure 4.2A:** The plateau lines are examples for inhibited samples that have inherent fluorescence. The slopes starting at cycle 15 are the expected DNA value increase.

**Figure 4.2B:** 100 pg of DNA was measured with 0 to 4 µL of denim dye. The addition of denim dye to the samples reduced the amount of recorded fluorescence. However, DNA was still amplified, as evidenced by the increase in fluorescence over time.
8. If the baseline curve of a sample’s raw data is below that of the standards in early cycles, this may suggest the presence of a substance that is quenching fluorescence (i.e., dyes, such as denim, or hemoglobin).

a. This can be confirmed by using the cursor to draw a box around the baseline of the samples in the “Raw Channel (Cycling A. Green)” window, selecting “Zoom” from the pop-up menu and inspecting the RFUs of the samples in the early cycles relative to that of the standards. Refer to Figure 3.

b. If, as in Figure 3, the RFUs of the samples fall below those of the standards, a substance could be present that is quenching the fluorescence of the SYBR Green I dye. Non-sigmoidal curves may or may not also be associated with these samples depending on the amount of the quenching substance in the sample. Additional purification steps may be necessary for these samples as determined by the analyst or rotation supervisor.

Figure 3: Raw data for samples containing a quenching dye. For samples containing 3uL to 5uL of dye, the more dye added to a sample, the lower the RFUs recorded in the early cycles. The RFUs of all samples containing dye showed baseline fluorescence approximately 1-2 RFUs below the standards depending on the amount of dye added.
9. Proceed to amplification and/or purification/concentration for all samples with values according to Table 3.5. If a sample requires purification or purification and concentration re-quantitate following purification. However, samples simply requiring concentration may be amplified directly.

**TABLE 4.5:**

<table>
<thead>
<tr>
<th></th>
<th><strong>Cofiler™/Profiler Plus™ 28 cycles</strong></th>
<th><strong>Identifiler™ 31 cycles</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Desired Template</td>
<td>150.00 pg</td>
<td>^20.00 pg</td>
</tr>
<tr>
<td>Template volume for amp</td>
<td>20 µL</td>
<td>5 µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL</td>
<td>7.5 pg/µL</td>
<td>^4 pg/µL</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning* to 50 µL</td>
<td>1.87 pg/µL</td>
<td>N/A</td>
</tr>
<tr>
<td>Minimum Sample Concentration in 200 µL prior to Microconning** to 20 µL</td>
<td>N/A</td>
<td>0.40 to ^0.10 pg/µL</td>
</tr>
<tr>
<td>For LCN samples: Minimum Sample Concentration in 20 µL</td>
<td>30.00 pg/µL</td>
<td>4.00 to ^1.00 pg/µL</td>
</tr>
</tbody>
</table>

* Sample concentration prior to processing with a Microcon 100 and elution to 50 µL
** Sample concentration prior to processing with a Microcon 100 and elution to 20 µL
^ Samples with less than 20 pg per amplification may be amplified upon referral with the LCN supervisor

Controlled versions of Forensic Biology Manual only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
10. The neat and the value calculated from the 1/100 dilutions of the samples should differ no more by a factor of 2.5. For example, if the neat value is 200, the 1/100 value should be between 0.8 and 5.0, but optimally be 2.0. If the dilutions are not within a factor of 2.5, the samples should be re-quantitated with the following exceptions:
   a. When the more concentrated dilution approaches or is above 1000 pg/µL, the amplification may be saturated and therefore, the dilutions may not be within the specified values. In this instance, the 1/100 value should be used for estimation of the DNA input for amplification.
   b. When quantitation values from both dilutions are close, the more concentrated dilution, the neat dilution for example, may be inhibited and therefore generates a small value. This would be indicated in the raw data as described above. If when preparing a sample for amplification, the 1/100 dilution would be used and showed no inhibition with quantitation, then use this dilution. However, if the neat would be used to prepare a sample for amplification, the sample may require purification. For HCN samples, this purification will occur at the analyst’s discretion. If the 1/10 dilution would be used for submission for amplification, the degree to which the neat dilution was inhibited with the neat dilution will influence whether the sample should be amplified directly or purified.
   c. As a general guide, if the curve of a sample shows background fluorescence only and is not inhibited, the sample may be submitted for amplification using the 1/100 dilution value. This scenario is sometimes observed with semen samples. However, as stated above, if the raw data curve indicates inhibition such as that shown in Figure 4.2B the sample may require purification.
   d. A "**" is assigned to samples which display background fluorescence which is approximately 10% of the total fluorescence. For example, a sample with an RFU background value of 10RFU which eventually plateaus at 100RFUs would be demarcated with a **. This scenario is sometimes observed with semen samples.
   e. The following table summarizes information previously described in this manual which specifies sample interpretation. This list is not all conclusive, but provides general guidelines which apply to most situations. This table delineates which concentration should be selected for entry into the automated macro. This macro determines which concentration of DNA template should be used for submission for amplification and the amount of this dilution required.
### TABLE 4.6:

<table>
<thead>
<tr>
<th>Samples</th>
<th>Resolution</th>
</tr>
</thead>
</table>
| \( N = x \text{ pg/uL} \)  
\( 1/100 = \text{within +/- 2.5x} \) | Select neat value |
| \( N = x \text{ pg/uL} \)  
\( 1/100 = \text{+/- >2.5x} \)  
No indication of inhibition or background fluorescence | Re-quant samples |
| \( N = >1000 \text{ pg/uL} \)  
\( 1/100 = <1000 \text{ pg/uL} \) | Select dilution |
| \( N = >1000 \text{ pg/uL} \)  
Dilution >1000 pg/uL | Requant sample at a greater dilution |
| \( N = <20 \text{ pg/uL}, \text{NO inhibition or fluorescence} \)  
\( \text{dilution within +/- 2.5 fold} \) | Not suitable for amplification with Identifiler 28 |
| \( N = <7.5 \text{ pg/uL}, \text{NO inhibition or fluorescence} \)  
\( \text{Dilution within +/- 2.5 fold} \) | Not suitable for amplification with Cofiler, Profiler Plus, YM1, or Identifiler 28 |
| \( N = <1 \text{ pg/uL}, \text{NO inhibition or fluorescence} \)  
\( \text{dilution within +/- 2.5 fold} \) | Not suitable for amplification with Identifiler 31 |
| \( N = *, **, \text{or } \Delta \)  
\( \text{Dilution NO *, **, or } \Delta \text{ and yields sufficient DNA for HCN amplification} \) | Select dilution |
| \( N = **, \text{dilution **} \) | Select dilution |
| \( N = * \text{ or } \Delta \)  
\( \text{dilution * or } \Delta \) | Send to analyst |
| \( N= <7.5 \text{ pg/uL}, \text{NO }, *, **, \text{or } \Delta \)  
\( \text{Dilution not within 2.5 fold} \) | Not suitable for amplification with Cofiler, Profiler Plus, YM1, or Identifiler 28, no further testing |
| \( N = < \text{ or } \Delta \)  
\( 1/100 \text{ Dilution } <0.1 \text{ pg/uL} \) | Re-quantitate at 1/10 dilution |
| 1/10 dilution only = ** | Amplify if sufficient DNA for HCN DNA testing. |
| 1/10 dilution only = * or \( \Delta \) | If sample quant dictates a greater than 1/10 dilution factor for amp, proceed with amp. Otherwise, send to analyst. |
| Any value less than 0.1 pg/uL | Do not interpret |
Q. Creating a Rotorgene Summary Page

1. Open the Rotorgene summary sheet Excel file for the Rotorgene run being analyzed and reviewed. The run will be saved with the run name in the folder for that instrument, such as RG3Q011707.1100 saved in the RG3 folder. Go to the “Copied Values from Rotorgene” tab.

2. On the Rotorgene Software (main screen after analysis), go to the “Quant. Results - Cycling A…” table (lower left window).

3. Maximize the screen. By right-clicking the table heading with the mouse and un-checking certain columns, eliminate all columns except the following:
   - No
   - Name
   - Ct
   - Calc. Conc.

4. Select all remaining cells (left click and drag across all column headings until all cells are highlighted blue). Then, right-click mouse and select copy.

5. In the Rotorgene summary sheet Excel file in the “Copied values from Rotorgene” sheet, make sure well C1 is selected. Right click on well C1 and paste special as text. In row 1, the column headings should be visible.

6. If the extraction negative does not cross the threshold, the sample is not inhibited, and there is no value, ensure a value of zero is entered into the calculated concentration column.

7. Fill in tube labels for respective cases in column B of the “Copied values from Rotorgene” sheet if applicable. (Enter “-” for standards, negative controls and calibrators.) The tube labels may also be copied and pasted special as “values only” from the “sample sheet” or typed in manually. If using “copy” and “paste special”, make sure the right tube labels correspond to the right cases, especially if certain standards were eliminated during analysis.

8. Enter the target dates and IA initials for the respective cases in column G and H, if applicable. The IAs and the target dates may also be copied and pasted special as “values only” from the “sample sheet” or typed in manually. If using “copy” and “paste special”, make sure the right tube labels correspond to the right cases.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

9. Go to the “Summary Sheet” tab, and check to make sure all sample names fit in respective cells.

10. The RG summary sheet will automatically place an “RQ” next to samples with quant values greater than 1000pg/uL. Inspect these samples to ensure that a requant is in order. If the dilution can be used, right click on the “Comments” cell for that sample and “clear contents”.

11. Schedule samples for re-quantitation if needed, by placing an “RQ” in the comments section next to those samples. Any sample with a lowest dilution quant value of greater than 1000 pg/uL should be re-quantified. Also, any sample pair with values for the neat and diluted samples that do not correlate should also be re-quantified (see #9 in this section for re-quantitation guidelines). Note that although a quantitation assay may fail, the resultant values may be used to estimate the need for further dilutions for the re-quantitation assay.

12. Save.

13. Minimize the summary sheet and inspect the raw data for inhibition and background fluorescence. Inhibited and/or fluorescent samples should be noted in the “Comments” column with a “∆” and/or a “*”, respectively. If a sample exhibits low background fluorescence (defined as below 10 rfus), insert a “**” in the “Comments” section. These symbols and some common combinations of them are included as buttons to the left of the RG Summary sheet in the electronic file. Click on the cell in which you would like to insert these symbols and click the appropriate button. Additional notes may be added manually. (Note: Clicking these buttons will overwrite any info previously in the cell.) Refer to the previous section (section P number 9) for interpretation and scheduling for these samples.

14. For LCN casework, the supervisor may indicate whether a sample requires purification by inserting a “P” in the comments section.

15. Print the summary sheet pages. If the sample batch size is such that all samples are included on page 1, only page 1 requires printing.

16. Copy and Paste all sample info for those samples requiring requantitation into a “post-quantitation resolution sheet”. This sheet is found in the “quant sheets” folder on the main drive in the “requant” sub-folder. This sheet may then be maintained electronically or printed out and used as a hard copy.
4. ESTIMATION OF DNA QUANTITY USING THE ROTORGENE™

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>31 OF 31</td>
</tr>
</tbody>
</table>

17. On the hard copy of the summary sheet note the reaction efficiency and enter any comments pertaining to the run in the “Comments” section. For instance, if two out of three calibrators fail this information may be entered in this section.

18. The reviewer must also sign and date the summary sheet and indicate whether the assay has passed or failed.

R. File Protection and Paperwork Distribution

1. Following assay review, the reviewer must protect the electronic file by designating it as a “read only” file.
   a. In windows explorer, locate the relevant file folder which should be found in the rotorgene folder within the folder for the instrument used.
   b. Right click on this file and select properties. Under attributes, chose “read only” and select “apply” then “ok”.

2. File the full assay report from the Rotorgene and the sample and reagent sheets. Only distribute the Rotorgene summary sheet to analysts.

References:

Nicklas, J. A., Buel, E. Development of an Alu-based, Real-Time PCR Method for Quantitation of Human DNA in Forensic Samples

Nicklas, J. A., Buel, E. Development of an Alu-based, QSY 7-Labeled Primer PCR Method for Quantitation of Human DNA in Forensic Samples
Samples with less than 150pg of DNA are considered Low Copy Number (LCN) samples and may be amplified with Identifiler reagents for 31 cycles. Samples with ≥150pg of DNA are considered High Copy Number (HCN) samples and may be amplified for 28 cycles with Cofiler, Profiler Plus, and/or Y STR reagents.

Due to the increased sensitivity of the Identifiler™ typing kit as compared to that of the Cofiler® and Profiler Plus® typing kit, samples with ≥ 100 pg may be amplified with Identifiler™ reagents for 28 cycles.

The PCR strategy for LCN samples is to do three parallel amplifications which are interpreted together. However, HCN samples are interpreted individually. If duplication is necessary, it may occur concurrently or subsequently, depending upon the workflow.

HCN samples are amplified separately from LCN samples.

The target DNA template amounts are as follows:

- Identifiler 28 cycles - 500 pg in sample aliquot of 5 ul
- Identifiler 31 cycles - 100 pg in sample aliquot of 5 ul
- Cofiler/Profiler Plus - 1000 pg in sample aliquot of 20 ul
- Y STR – 2000 pg in sample aliquot of 26 ul
- PowerPlex16 – 1000 pg sample aliquot in 20 uL
  (PowerPlex 16 is only validated for exemplars and human remains. Do not use for evidence specimens.)

To calculate the amount of template DNA and diluent to add, the following formula is used:

\[
\text{Amt of DNA extract (µL)} = \frac{\text{Target Amount (pg)}}{\text{(sample concentration, pg/µl)(dilution factor)}}
\]

The amount of diluant to add to the reaction (µl) =

\[
\text{volume of sample aliquot (µl)} - \text{amt of DNA extract (µL)}
\]

Do not amplify samples in which insufficient DNA for the target system was detected. These samples may be amplified after a Microcon concentration step.
GENERATION OF AMPLIFICATION SHEETS

Amp sheets are generated by supervisors following review of quantification results. Furthermore, samples may be submitted for amplification through aliquot request sheets. Excel macros may be employed to generate these sheets. Different sheets may be used as described below depending upon the throughput of each team. To determine the appropriate system for amplification of samples, refer to Table 5.1.

TABLE 5.1: PCR amplification input based on RotorGene values

<table>
<thead>
<tr>
<th>RG value at 1:10 dilution pg/μL</th>
<th>RG value neat pg/μL</th>
<th>Amplification Sheet</th>
<th>Dilution</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCN extraction</td>
<td>≥ 0.4 pg/μL</td>
<td>≥ 4.0* to 20 pg/μL</td>
<td>Amplify with ID for 31 cycles*</td>
</tr>
<tr>
<td>LCN/HSC extraction ≥ 2.0 pg/μL</td>
<td>≥ 20 pg/μL</td>
<td>≥ 20 pg/μL</td>
<td>Amplify with ID for 28 cycles</td>
</tr>
<tr>
<td>HSC extraction ≥ 0.7 pg/μL</td>
<td>≥ 7.5 pg/μL</td>
<td>≥ 7.5 pg/μL</td>
<td>Amplify with Cofiler/ProfilerPlus/ Y STR or Microcon and amplify with ID 28</td>
</tr>
</tbody>
</table>

* Samples providing less than 20 pg per amplification can only be amplified with permission of a supervisor.

When a dilution is made to determine DNA concentration, it is preferable to calculate the DNA concentration in the undiluted DNA extract. Then amplify the undiluted DNA extract, not the dilution. *If possible always amplify the optimal target amount.*
5. PCR AMPLIFICATION – GENERATION OF AMPLIFICATION SHEETS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>3 OF 19</td>
</tr>
</tbody>
</table>

A. HSC Team Amp Macro for paperwork preparation from RotorGene values for amplification of evidence samples with Identifiler 28 Cycles and YM1

1. Open the “RGAMP Macro HSC” and the “RG summary sheet” Excel files for samples ready to be amplified. The “RG summary sheet” is saved as the assay name.
   a. If a window stating “…RGAMP Macro HSC.xls” contains macros. Macros may contain viruses…” appear, click “Enable Macros”.
   b. If a window stating “Macros are disabled because the security level is set to High…” appears, do the following: Select Tools in the toolbar. Click Macro, Security, and set the level to Low. The file must be closed and reopened.

2. Copy the sample information (without the standards or calibrators) from the “summary sheet” of the “RG summary sheet” file including the tube label, sample name, Ct value, the calculated concentration, the target date, and the IA, and paste special as values into the corresponding columns of the “RG value” sheet of the “RGAMP Macro HSC” file.

3. In the last column, entitled “Type”, enter the type of amplification according to the following abbreviations next to the samples to be amplified:
   a. “V” for ID28 Evidence
   b. “Y” for YM1 Evidence

Selecting sending neat samples versus diluted samples can be done here. Refer to the Forensic STR Analysis manual for sample amplification requirements.

4. Check the sample names to ensure commas are not located in the wrong areas. There can only be one comma in the sample name. The comma should be located after the full sample name and before the dilution value (i.e. FB01-1234_vag_SF, 0.1).
5. Hit Ctrl+R or click the “Separate dilutions and sample info” button to run the dilution macro. A window asking “Do you want to replace the contents of the destination cell?” will appear. Click “OK”.

The dilution macro will separate the dilution factors from the sample names to facilitate the calculation of the neat concentration of the samples.
   a. If the dilution column does not contain the correct dilutions, the file must be closed and reopened. Make sure to check for commas in the wrong location in the sample names.
   b. If the macro will not run, follow the instructions in the box and select tools, macro, security, and low. The file must be closed and reopened.

6. Hit Ctrl+G or click the “Sort” button to run the sample sorting macro.
   a. The macro will filter and eliminate all values that are less than 20 pg/µL or 7.5 pg/µL for Identifiler 28 or YM1, respectively. The macro will also sort the samples by system/type and sample concentration in the “Sort” sheet.
   b. Inspect the samples sorted in the appropriate columns according to system/type and sample concentration.

For Identifiler 28 samples, proceed to Step 7.
For YM1 samples, proceed to Step 8.

7. For Identifiler 28 samples:
   a. Samples with concentrations between or equal to 20 pg/µL and 100 pg/µL (less than or equal to 500 pg amplified) may be automatically amplified in duplicate; see the concordant analysis policy (section 1).

If you have not done so already, select the samples that require amplification now (ie. amplifying neat sample versus diluted sample). Refer to the Forensic STR Analysis manual for sample amplification requirements.
5. PCR AMPLIFICATION – GENERATION OF AMPLIFICATION SHEETS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>5 OF 19</td>
</tr>
</tbody>
</table>

b. Copy and Paste all samples to be amplified from the appropriate columns on the “Sort” sheet to the associated columns on the “Samples” sheet.

**NOTE:**
- Samples <100pg/µL will be sorted into a different section. Do not forget to copy them into the amp sheet as well.
- Do not forget to copy the Identifiler duplication samples (for samples <100pg/µL) to the “Identifiler 28 Evidence Dup” sections. This amplification sheet may be used for automatic duplication of samples, depending on the team.

**Proceed to step 9.**

8. For YM1 samples:
   a. For samples being sent on for YM1 amplification from P30 values, on the “Samples” sheet, change the Calculated Values column to the appropriate letter associated with the P30 value and sample type:

   For Non-Differential semen or differential swab/substrate remain samples:

<table>
<thead>
<tr>
<th>Orifice swab, P30 value, 2ng subtract</th>
<th>Stains P30 value, 0.05 A subtract</th>
<th>Type this letter in the Calculated Value column</th>
</tr>
</thead>
<tbody>
<tr>
<td>HIGH</td>
<td>HIGH</td>
<td>A</td>
</tr>
<tr>
<td>1.1 - 3.0</td>
<td>1.1 - 3.0</td>
<td>B</td>
</tr>
<tr>
<td>&gt;0 - 1.0</td>
<td>&gt;0 - 1.0</td>
<td>C</td>
</tr>
</tbody>
</table>

   For vaginal swab samples sent for Amylase Positive Extractions, two concentrations must be sent for amplification:

<table>
<thead>
<tr>
<th>Amounts sent to amplification</th>
<th>Type this letter in the Calculated Value column</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Target</td>
<td>TE⁻⁴</td>
</tr>
<tr>
<td>10</td>
<td>16</td>
</tr>
<tr>
<td>26</td>
<td>0</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
b. For samples being sent on for YM1 amplification from Quantification values, the amplification sheet should calculate the appropriate DNA and TE\(^4\) target amount on the amplification sheet.

c. Copy and Paste all samples to be amplified from the appropriate columns on the “Sort” sheet to the associated columns on the “Samples” sheet.

9. Each amplification sheet can hold up to 28 samples. Since there are 54 samples on a full RotorGene run, it is possible more than one amplification sheet is necessary. If this is the case, the overflow samples will automatically be transferred into a second amplification sheet (ie. “ID2”, “ID DUP2” or “YM1 2”).

10. When all samples to be amplified have been organized on the “Samples” sheet, click on the appropriate amplification sheet(s) and check all entries for errors.

All changes, except for the amount of extract submitted during low and high sample submission, should be made in the “Samples” sheet.

11. Save the macro sheet in the “Amp sheets” and “Macro Archive” folder as the same name as the RG run from which it was derived with the addition of “macro” at the end of the title.

**Saving Amplification Sheets on the Network for Additional Samples**

1. Partially full or completed amplification sheets may be saved as independent sheets for subsequent sample additions by clicking the “Samples” and amp sheet tab (via holding the ctrl button down). Both sheets should now be highlighted white. Right click and select “move or copy”.

2. In this window, select “(new book)” in the “to book” window and check “create a copy”. Click “OK”. Go to File, Save As and save into the appropriate folder with the amplification system followed by “waiting for amp” or “ready to amp”.

3. Samples may be manually added to these sheets by individual analysts or copied and Paste Special from re-quantification sheets or consolidated from additional amplification sheets of the same type at the end of each RotorGene run.
5. PCR AMPLIFICATION – GENERATION OF AMPLIFICATION SHEETS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>7 OF 19</td>
</tr>
</tbody>
</table>

4. If any samples need to be submitted to amplification with a DNA amount other than the optimal amount, the analyst can change the amount of DNA submitted by changing the value in the DNA column in the amplification sheet.

Be aware that once the DNA amount is manually added to the amplification sheet, the sheet will not be able to calculate the value from the quantification value.

All other changes should be done in the “Samples” sheet.

5. When a macro amplification sheet is full the analyst may then fill in the amplification date and time in the appropriate blue cell in the “Samples” sheet. This should automatically populate the appropriate cells in the Amplification sheet.

Any changes to the amplification sheet should be done in the “Samples” sheet.

6. Save the sheet as the time and date of the amplification as follows: “ID041207.1100” for Identifiler28 amplifications, or “YV041207.1100” for YM1 amplifications, performed on April 12, 2007 at 11:00am. These completed amplification sheets should be saved in the “Amp Sheets”, “Amp Sheet Archive” folder.

7. A supervisor should review all entries were entered correctly before printing the Amplification sheet.
B. RG Amp Macro for Paperwork preparation for Amplification with Cofiler and Profiler and YM1

1. Open the “RGAMP MACRO HSC” and the RG summary sheet” Excel files for samples ready to be amped. The “RG summary sheet” is saved as the assay name.

2. Copy the information from the “summary sheet” of the “RG summary sheet” file including the tube label, sample name, Ct value, the calculated concentration, the target date, and the 1A, and paste special as values into the corresponding columns of the “RG value” sheet of the “RGAMP macro HSC” file.

3. In the last column, entitled “type”, enter the type of amplification according to the following abbreviations next to the samples requiring amplification:
   a. “CV” for Cofiler Evidence
   b. “CX” for Cofiler Exemplars
   c. “PV” for Profiler Evidence
   d. “PX” for Profiler Exemplars
   e. “YV” for YM1 evidence
   f. “YX” for YM1 Exemplars

4. Hit Ctrl+R or click the “Separate dilutions and sample info” button to run the dilution macro. A window asking “Do you want to replace the contents of the destination cell?” will appear. Click “OK”.
   a. If the macro will not run, follow the instructions in the box and select tools, macro, security, and low. The file must be closed and reopened.
   b. The dilution macro will separate the dilution factors from the sample names to facilitate the calculation of the neat concentration of the samples.

5. Hit Ctrl+G or click the “Sort” button to run the sample sorting macro.
   a. The macro will filter and eliminate all values that are less than 7.5 pg/μL for Cofiler, Profiler and YM1 and sort them by system and sample type in the “Sort” worksheet.
   b. Inspect the samples sorted in the appropriate columns according to system and type of sample and select the samples that require amp. For instance, determine whether you will be using the calculated concentration derived from the neat sample or the dilution. Refer to the current manual for Forensic STR Analysis to select samples requiring amplification.
c. Samples may be added or deleted to or from the columns for each system and sample type following the macro’s execution.

To delete a sample do the following:

i. On the “sort” sheet in the RG AMP MACRO HSC file and locate the columns relevant to the amplification system and sample type.

ii. Select the cells relevant to the sample you would like to delete.

iii. Select edit and clear contents.

iv. Do not simply delete, always use the “clear contents” function.

To add a sample, do the following:

i. Copy sample info from the “RG values revised” sheet in the “RG AMP MACRO HSC” file the tube label, sample name, Ct value, the calculated concentration, the target date, and the IA.

ii. Paste special these values into the appropriate columns for the amplification system of the “samples” sheet in the “RG AMP MACRO HSC” file.

6. Copy and paste all samples to be amped from the appropriate column on the “sort” sheet to the associated column on the “samples” sheet. This is the sheet on which you are building your amp.

7. Once satisfied that all samples to be amped have been organized correctly on the “samples” sheet, select the appropriate amplification worksheet tab and complete the appropriate fields (shaded blue)

The sheet will calculate the dilution factor necessary for the samples as well as the amount of sample and TE^{-4} to add.

8. Save the macro sheet in the “Amp Sheets”-“Macro Archive” folder as the same name as the RG run from which it was derived with the addition of “macro” at the end of the title.
Saving amp sheets on the Network for Additional samples

1. Partially full or completed amp sheets may be saved as independent sheets for subsequent sample additions by right-clicking the corresponding tab and selecting “move or copy”.

2. In this window, select “(new book)” in the “to book” window and check “create a copy”. Click “OK”. Go to File – Save-As and save into the appropriate folder with the amplification system followed by “waiting for amp” or “ready to amp”.

3. Samples may be manually added to these sheets by individual analysts or copied and pasted special from requant sheets or consolidated from additional amp sheets of the same type at the end of each RotorGene run.

4. When a sheet is full the analyst may then fill in the appropriate information and save the sheet as the time and date of the amp as follows: “CV041207.1700” for a Cofiler Evidence Amp performed on April 12, 2007 at 5:00pm. Use the same abbreviations here for amplification system and sample type as used for the sorting macro (see step A3). These completed amp sheets should be saved in the Amp Sheets-Amp Sheet Archive” folder.
C. MACRO X (RG AMP MACRO) for Paperwork Preparation for Amplification with Identifiler 28 and YM1

1. Open the “RGAMP MACRO HSC” or the Macro X for ID 28 and the “RG summary sheet” Excel files for samples ready to be amped. The “RG summary sheet” is saved as the assay name.

2. Copy the information from the “summary sheet” of the “RG summary sheet” file including the tube label, sample name, Ct value, the calculated concentration, the target date, and the 1A, and paste special as values into the corresponding columns of the “RG value” sheet of the “RGAMP macro HSC” file.

3. In the last column, entitled “type”, enter the type of amplification according to the following abbreviations next to the samples requiring amplification:
   - “V” for ID28 evidence
   - “Y” for YM1 evidence
   - “X” for ID28 exemplars

For ID 28 evidence or exemplar amps use MACRO X sheet.

4. Hit Ctrl+R or click the “Separate dilutions and sample info” button to run the dilution macro. A window asking “Do you want to replace the contents of the destination cell?” will appear. Click “OK”.
   a. If the macro will not run, follow the instructions in the box and select tools, macro, security, and low. The file must be closed and reopened.
   b. The dilution macro will separate the dilution factors from the sample names to facilitate the calculation of the neat concentration of the samples.

5. Hit Ctrl+G or click the “Sort” button to run the sample sorting macro.
   a. The macro will filter and eliminate all values that are less than 7.5 pg/μL for Cofiler, Profiler and YM1 and sort them by system and sample type in the “Sort” worksheet.
   b. Inspect the samples sorted in the appropriate columns according to system and type of sample and select the samples that require amp. For instance, determine whether you will be using the calculated concentration derived from the neat sample or the dilution. Refer to the current manual for Forensic STR Analysis to select samples requiring amplification.
c. Samples may be added or deleted to or from the columns for each system and sample type following the macro’s execution.

To delete a sample, do the following:

i. On the “sort” sheet in the RG AMP MACRO HSC file and locate the columns relevant to the amplification system and sample type.
ii. Select the cells relevant to the sample you would like to delete.
iii. Select edit and clear contents.
iv. Do not simply delete; always use the “clear contents” function.

To add a sample, do the following:

i. Copy sample info from the “RG values revised” sheet in the “RG AMP MACRO HSC” file: tube label, sample name, Ct value, the calculated concentration, the target date, and the IA.
ii. Paste special these values into the appropriate columns for the amplification system of the “samples” sheet in the “RG AMP MACRO HSC” file.

6. Copy and paste all samples to be amped from the appropriate column on the “sort” sheet to the associated column on the “samples” sheet. This is the sheet on which you are building your amp.

7. Once satisfied that all samples to be amped have been organized correctly on the “samples” sheet, select the appropriate amplification worksheet tab and complete the appropriate fields (shaded blue).

The sheet will calculate the dilution factor necessary for the samples as well as the amount of sample and TE^-4 or irradiated water to add.

8. Save the macro sheet in the “Amp Sheets”-“Macro Archive” folder as the same name as the RG run from which it was derived with the addition of “macro” at the end of the title.
D. RG Amp Macro HI (High Sensitivity samples) for Paperwork preparation for Amplification with Identifiler 28 and 31

1. Open the current version of the “RGAMP MACRO HI” Excel workbook and the “RG summary sheet” Excel files for samples ready to be amped. These files can be found in the “TEMPLATES IN USE” folder on the High Sens Data drive. The RG Summary Sheets are saved as the assay name in the “RotorGene” folder on the FBiology Main drive.

2. Copy the information for samples and controls only from the “summary sheet” of the “RG summary sheet” file including the tube label (if applicable), sample name, Ct value, the calculated concentration, the target date, and the IA. Paste special as values into the corresponding columns of the “RG value” sheet of the “RG Amp macro” file. The standards and calibrators need not be copied.

3. In the column entitled “type” enter the type of amplification according to the following abbreviations:
   a. “X” for exemplars
   b. “V” for evidence

4. Click the “Separate Dilution and Sample Info” button to run the dilution macro. A window asking “Do you want to replace the contents of the destination cell?” will appear. Click “OK”.
   a. If the macro will not run, follow the instructions in the box and select tools, macro, security, and low. The file must be closed and reopened.
   b. The dilution macro will separate the dilution factors from the sample name to facilitate the calculation of the neat concentration of the sample

5. Click the “Sort Samples” button to run the sample sorting macro.
   a. The sort macro will filter values according to the following specifications which differ depending upon the amount of template DNA.
      i. The macro eliminates all values that are less than 1 pg/μL and greater than or equal to 20 pg/μL for LCN amplification Identifiler™ for 31 cycles.
      ii. All values less than 20 pg/μL are eliminated for HCN amplification with Identifiler™ for 28 cycles.
      iii. Note, for samples with greater than 100 pg/μL and less than 124 pg/μL, the macro will indicate to add 5 μL of template DNA. (In order to avoid pipeting less than 1 μL, slightly more than 500 pg of DNA will be added to the reaction.)
b. The extraction negatives will be sorted independently so that they may be inspected and placed at the top of the list with the associated samples when setting up the amp sheets.

c. Samples will be sorted into groups for ID31 evidence and exemplar amp, ID28 evidence amp, and duplicate ID28 evidence amp. Samples amplified with Identifier for 31 cycles are amplified in triplicate concurrently whereas samples amplified with Identifier for 28 cycles are amplified in duplicate in two separate amplifications.

6. Select samples for amplification and copy and paste those samples to the appropriate column on the “samples” sheet. The sample information is then automatically populated into the amplification and 3130 run sheets. Samples may be also be added or deleted to or from the amp sheets as described below. For example, samples with less than 4 pg/µL or 20 pg/amp require supervisor approval for LCN amplification, and depending upon the case, may not be amplified. Refer to the amplification guidelines and the RG interpretation manual to select samples and the appropriate dilutions to use for amplification calculations.

To delete a sample do the following:

a. Go to the “sort” sheet in the RG AMP MACRO HI file and locate the columns relevant to the amplification system and sample type.
b. Select the cells relevant to the sample you would like to delete.
c. Select edit and clear contents.
d. Do not simply delete, always use the “clear contents” function.

To add a sample, do the following:

a. Copy from the “RG values revised” sheet in the “RG AMP MACRO HI” file the tube label, sample name, Ct value, the calculated concentration, the target date, and the IA.
b. Paste special these values into the appropriate columns for the amplification system of the “samples” sheet in the “RG AMP MACRO HI” file.
c. Alternatively, a sample may be manually added by typing the sample information into the appropriate column in the “samples” sheet.
5. PCR AMPLIFICATION – GENERATION OF AMPLIFICATION SHEETS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>15 OF 19</td>
</tr>
</tbody>
</table>

7. Select the appropriate amplification worksheet, verify the sample information and calculations, and type the name of the amplification in cell B1 as follows: Amonthdateyear.time for example, A011106.1000.
   a. The sheet will automatically calculate the number of samples that are to be amplified. This will populate cell B2 of the worksheet.
   b. The sheet will also calculate the amount of reagents required, and the dilution factor necessary for the samples. Verify these calculations.

8. Save the sheet in the amplification sheets folder and review.

9. Print the amplification sheet. Have the sheet reviewed by a supervisor prior to set-up.

E. RG Amp Macro PC (Property Crimes Samples) for Paperwork Preparation for Amplification with Identifiler 28.

1. Open the “RG Amp MacroPC v1.2” and the “RG summary sheet” Excel files for samples ready to be amplified. The “RG summary sheet” is saved as the assay name.
   a. If a window stating “…RG Amp MacroPC v1.2.xls” contains macros. Macros may contain viruses…” appear, click “Enable Macros”.
   b. If a window stating “Macros are disabled because the security level is set to High…” appears, do the following: Select Tools in the toolbar. Click Macro, Security, and set the level to Low. The file must be closed and reopened.

2. Copy the sample information (without the standards or calibrators) from the “summary sheet” of the “RG summary sheet” file including the tube label, sample name, Ct value, the calculated concentration, the target date, and the IA, and paste special as values into the corresponding columns of the “RG value” sheet of the “RG Amp MacroPC v1.2” file.

3. In the last column, entitled “Type”, enter a “V” for ID28 Evidence.

   The decision to send neat samples versus diluted samples can be done at this point. Refer to the Forensic STR Analysis manual for sample amplification requirements.
5. PCR AMPLIFICATION – GENERATION OF AMPLIFICATION SHEETS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>16 OF 19</td>
</tr>
</tbody>
</table>

4. Check the sample names to ensure commas are not located in the wrong areas. There can only be one comma in the sample name. The comma should be located after the full sample name and before the dilution value (e.g. FB01-1234_bottle_swab, 0.1).

5. Press Ctrl+R or click the “Separate dilutions and sample info” button to run the dilution macro. A window asking “Do you want to replace the contents of the destination cell?” will appear. Click “OK”.

The dilution macro will separate the dilution factors from the samples names to facilitate the calculation of the neat concentration of the samples.

6. If the dilution column does not contain the correct dilutions, the file must be closed and reopened. Make sure to check for commas in the wrong location in the sample names.

7. If the macro will not run, follow the instructions in the box and select tools, macro, security, and low. The file must be closed and reopened.

8. If the macro does not sort, this may be because no samples containing dilutions are available to sort. In this case, clear the Dilution column and try sorting again.

9. Press Ctrl+G or click the “Sort” button to run the sample sorting macro.
   a. The macro will filter and eliminate all values that are less than 19.5 pg/µL for Identifiler28.
   b. Samples will be sorted into four columns, Negative Controls, ID28 samples, ID28 Imemdate Dups, and ID28 Negative.

10. For Identifiler28 samples (Property Crimes):
    a. ALL samples will be amplified twice; once as an initial amplification and the second time as a duplicate amplification.

If you have not done so already, select the samples that require amplification now (i.e. amplifying neat sample versus diluted sample). Refer to the Forensic STR Analysis manual for sample amplification requirements.
5. PCR AMPLIFICATION – GENERATION OF AMPLIFICATION SHEETS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>02-16-2009</td>
<td>10.0</td>
<td>17 OF 19</td>
</tr>
</tbody>
</table>

b. Copy and Paste all samples to be amplified from the appropriate columns on the “Sort” sheet to the associated columns on the “Samples” sheet.

c. Note: Extraction Negatives do not need to be duplicated.

11. Each amplification sheet can hold up to 27 samples. Since there are 54 samples on a full RotorGene run, it is possible more than one amplification sheet is necessary. If this is the case, the overflow samples will spill into the highlighted area of the Samples sheet, prompting you to make a new amplification sheet.

12. Once satisfied that all samples to be amplified have been organized on the “Samples” sheet, check both the initial and duplicate amplification sheets for errors.

All changes, except for the amount of extract submitted during low and high sample submission, should be made in the “Samples” sheet.

Saving Amplification Sheets on the Network for Additional Samples

1. Once complete save the initial amp, IDEV, including the sorting macro, in the Ready to Amp → Initial Amp folder.

2. Select the duplicate amp, IDEV DUP, right click on the tab and select “move or copy”.

3. In this window, select “(new book)” in the “to book” window and check “create a copy”. Click “OK”. Go to File, Save As and save in the Ready to Amp → Dup Amp folder.

4. Samples may be manually added to these sheets by individual analysts or copied and Paste Special from the re-amp submission log or from completed microcon worksheets. This should only be performed by the supervisor on the rotation.
5. If any samples need to be submitted to amplification with a DNA amount other than the optimal amount, the amount of DNA submitted can be adjusted by changing the value in the DNA column in the amplification sheet.

Please be aware once the DNA concentration or dilution value is manually added to the amplification sheet, the sheet will not be able to calculate the volume of DNA needed for amplification from the quantification value.

All other changes should be done in the “Samples” sheet.

F. Aliquot Request and Amp Sheets for HCN evidence and exemplar samples only

Aliquot sheets have been created for evidence and exemplar submission.

1. Open the correct aliquot sheet. The sheet can be found in M:\FBIOLOGY_MAIN\Amp Sheets\ALIQUOT REQUEST FORMS\(either EVIDENCE or EXEMPLAR).
2. Fill out the next empty line. Type the case information in 3130 format.
3. Refer to the appropriate Table in this section of the Manual to determine the volume of extract to be aliquotted, based on DNA concentration and target for amplification. If you want to amp your sample at a condition different than normal (reamp high, low/opt/high, etc.) indicate this in the “Sample Information” section.
4. Save the sheet.
5. The person that aliquotted the samples will type their initials and the date they aliquotted the samples in the last column. That person will email all analysts listed on the sheet indicating that samples have been aliquotted. THAT IS ALL THE INFORMATION THAT WILL BE SENT. It is up to the analyst to check the sheet to determine when their samples were aliquotted.
6. Amplification sheets will now be prepared and/or updated by the person that aliquots the samples.
7. The rotation supervisor is responsible for determining when the samples will be aliquotted and that information that is typed onto the amp sheets is correct.
G. Saving Amp Sheets to the Network for Additional Samples

1. Amp sheets may be saved as independent sheets for subsequent sample additions by right-clicking the corresponding tab and selecting “move or copy”. In this window, select “(new book)” in the “to book” window and check “create a copy”. Click “OK”. Go to File – Save-As and save into the appropriate folder named with the associated amplification system followed by “waiting for amp” or “ready to amp”.

2. Samples may be manually typed into these sheets or copied and pasted special from requant sheets or consolidated from additional amp sheets of the same type at the end of each RotorGene run.

3. When a sheet is full the analyst may fill in the appropriate information (cells shaded blue) and save the sheet as the time and date of the amp as follows: “A041207.1700”.

Revision History:
February 16, 2009 – Revised portions of this section in connection with the revision of Section 1 (highlighted). See Approval Form.
A positive control, an amplification negative control, an extraction negative control, and a female negative control, if applicable, should be included with each batch of samples being amplified to demonstrate procedural integrity. The positive control is a control whose alleles are known to the analyst. Samples that were extracted together should all be amplified together, so that every sample is run parallel to its associated extraction negative control.

Do not forget to indicate on the DNA extract tracking worksheet that a sample has been submitted for amplification.

Follow the general PCR guidelines for handling the tubes and cleaning of the work surface. The following steps have to be performed in the appropriate dedicated areas. Evidence samples and exemplars should not be handled at the same time.

A. Personal Preparation

1. Put on a mask, lab coat, hair covering, and gloves.
   a. Ensure that the cuffs of the lab coat completely cover the arms.
   b. Lab coats may be reused for up to one week.
   c. Masks, hair coverings and gloves may be disposed after one use.

2. **Do not enter room without appropriate attire. Never touch any apparatus, bench, etc. with bare hands.**

3. Do not hesitate to change gloves or at least rinse gloves with bleach followed by ETOH if contamination is suspected or after using the phone in the lab or touching door handles.

B. Work Place Preparation

1. Prepare your workspace before retrieving DNA samples.

2. If using a plate, turn on the heated plate seal apparatus.

3. Apply 10% bleach followed by water, and 70% ETOH to the entire work surface and pipets. All amp setup steps should be carried out under a dead air or ventilated hood.

4. Retrieve clean racks and cap openers, and irradiated microcentrifuge tubes, PCR tubes and/or plates and irradiated water.
6. PCR AMPLIFICATION – SAMPLE PREPARATION

5. If using a PCR plate, place an easy pierce strong seal on top of the plate, and place the plate in the plate adapter on the ABgene heat sealer.
   a. Push the heat sealer on top of the plate for 2 seconds.
   b. Rotate the plate and reseal for 2 additional seconds.

6. Arrange work place to minimize crossover.

7. Position gloves nearby with bleach/ETOH/water in order to facilitate frequent glove changes and cleaning.

C. Preparing DNA aliquots for amplification

1. Samples may be prepared immediately prior to amplification or as part of an aliquot rotation previously depending upon the throughput of specific teams.

2. Obtain reviewed amp worksheet from supervisor or network folder.

3. For each sample to be amplified, label a new tube. Add DNA and TE-4 or irradiated water as specified for the different multiplexes used in the lab. (Samples amplified with Identifiler reagents should be prepared with irradiated water.)

4. Prepare dilutions for each sample, if necessary, according to Table 6.1.

<table>
<thead>
<tr>
<th>Dilution</th>
<th>Amount of DNA Template (µL)</th>
<th>Amount of Irradiated Water (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.25</td>
<td>3 or (2)</td>
<td>9 or (6)</td>
</tr>
<tr>
<td>0.2</td>
<td>2</td>
<td>8</td>
</tr>
<tr>
<td>0.1</td>
<td>2</td>
<td>18</td>
</tr>
<tr>
<td>0.05</td>
<td>2.5</td>
<td>47.5</td>
</tr>
<tr>
<td>0.04</td>
<td>4 or (2)</td>
<td>96 or (48)</td>
</tr>
<tr>
<td>0.02</td>
<td>2 or (1)</td>
<td>98 or (49)</td>
</tr>
<tr>
<td>0.01</td>
<td>2</td>
<td>198</td>
</tr>
<tr>
<td>0.008</td>
<td>4 or (2)</td>
<td>496 or (248)</td>
</tr>
</tbody>
</table>
a. Centrifuge samples at full speed briefly.
b. Label tubes appropriately for dilutions. Add the correct amount of irradiated water or TE-4 (depending upon the system to be amplified) as specified by the amplification sheet.
c. Pipet sample up and down several times to thoroughly mix sample. Avoid vortexing sample and the possible creation of aerosols.
d. Set the sample aside until you are ready to aliquot it for amplification.

**NOTE:** See below in order to manually calculate the aliquot volumes for samples for specific systems.

**D. Sample and Amplification Set-up for Identifiler**

**Samples and Controls**

1. The target DNA template amount for Identifiler™ 28 cycles is 500 pg. The target DNA template amount for Identifiler™ 31 cycles is 100 pg.

To calculate the amount of template DNA and water (diluent) to add, the following formulas are used. The sample concentration is the RotorGene quantitation value:

\[
\text{DNA extract added (µL)} = \frac{\text{Target DNA Template Amount (pg)}}{(\text{sample concentration, pg/µL})(\text{dilution factor})}
\]

The volume of diluant to add (µL) = 5 µL – DNA extract added (µL)

For samples with RotorGene values \( \leq 100 \text{ pg/µL} \) but \( \geq 20 \text{ pg/µL} \) aliquot 5 uL extract.
6. PCR AMPLIFICATION – SAMPLE PREPARATION

2. For an Identifiler™ 28 cycle amplification, make a 0.5 (1/2) dilution of the ABI Positive (A9947) control at 100 pg/µL (5 µL in 5 µL of water).

This yields 50 pg/µL of which 5 µL or 250 pg will be used.

a. If only half a plate of samples are amplified, only one PE is necessary, however to encompass all of the injections required for a full plate of samples, amplify two or more PEs (10 µL in 10 µL of water).

b. The amp sheet will automatically populate these PEs.

3. For an Identifiler™ 31 cycle amplification, make a 0.2 (1/5) dilution of the ABI Positive (A9947) control at 100 pg/µL (2 µL in 8 µL of water).

This yields 20 pg/µL of which 5 µL or 100 pg will be used.

4. Irradiated water will serve as an amplification negative control.

5. Arrange samples in a 96 well rack in precisely the positions they appear on the sheet.

6. Witness step. Ensure that your samples are properly positioned.

Master Mix Preparation

1. Retrieve Identifiler™ primers and reaction mix from the refrigerator, Taq Gold from the freezer, and store in a Nalgene cooler on bench. Record the lot numbers of the reagents.

2. Vortex or pipet the reagents up and down several times to thoroughly mix the reagents. After vortexing, centrifuge reagents at full speed briefly to ensure that no sample is trapped in the cap. Do not vortex TAQ GOLD as it may degrade the enzyme.
3. Consult the amplification sheet for the exact amount of Identifiler™ Primers, Reaction mix, and TAQ GOLD, to add. The amount of reagents for one amplification reaction is listed in Table 6.2.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primer mix</td>
<td>2.5 µL</td>
</tr>
<tr>
<td>Reaction mix</td>
<td>5 µL</td>
</tr>
<tr>
<td>AmpliTaq Gold DNA Polymerase (5U/µL)</td>
<td>0.5 µL</td>
</tr>
<tr>
<td>Mastermix total:</td>
<td>8 µL</td>
</tr>
<tr>
<td>DNA</td>
<td>5 µL</td>
</tr>
</tbody>
</table>

Reagent and Sample Aliquot

1. Vortex master mix to thoroughly mix. After vortexing, tap or briefly centrifuge master mix tube on bench to ensure that no reagent is trapped in the cap.

2. Add 8 µL of the Identifiler™ master mix to each tube or well of the 96 well plate that will be utilized, changing pipette tips and remixing master mix as needed.

   NOTE: Use a new sterile filter pipette tip for each sample addition. Open only one tube at a time for sample addition.

3. Prior to immediately adding each sample or control, pipet each sample or control up and down several times to thoroughly mix. The final aqueous volume in the PCR reaction mix tubes will be 13 µL. After addition of the DNA, cap each sample before proceeding to the next tube.

4. Sealing the plate
   a. If using a PCR plate, place a super pierce strong seal on top of the plate, and place the plate in the plate adapter on the ABgene heat sealer.
   b. Push the heat sealer on top of the plate for 2 seconds.
   c. Rotate the plate and reseal for 2 additional seconds.
   d. Label the plate with “A” for amplification and the date and time. (A011104.1300)
5. After all samples have been added, return DNA extracts to storage and take the rack or plate to the amplified DNA area for Thermal Cycling (continue section F).

E. Sample and Amplification Set-up for PowerPlex 16, Cofiler, Profiler Plus, YM1

PowerPlex 16 is only validated for exemplars and human remains. Do not use it for evidence specimens.

Sample and Control Preparation for PowerPlex 16

TABLE 6.3: PCR amplification input based on RotorGene values

<table>
<thead>
<tr>
<th>RG value at 1:10 dilution</th>
<th>RG value neat</th>
<th>Amplification Sheet</th>
<th>Dilution</th>
</tr>
</thead>
<tbody>
<tr>
<td>HSC extraction ≥ 0.7 pg/μL</td>
<td>≥ 7.5 pg/μL</td>
<td>Amplify with PowerPlex 16</td>
<td>As appropriate</td>
</tr>
</tbody>
</table>

TABLE 6.4: Control samples for the PowerPlex 16 multiplex

<table>
<thead>
<tr>
<th>Sample</th>
<th>DNA</th>
<th>TE&lt;sup&gt;4&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>PowerPlex 16 Kit positive control</td>
<td>10 μL</td>
<td>10 μL</td>
</tr>
<tr>
<td>Extraction negative control</td>
<td>20 μL</td>
<td>---</td>
</tr>
<tr>
<td>Amplification negative control</td>
<td>---</td>
<td>20 μL</td>
</tr>
</tbody>
</table>

In order to manually calculate the aliquot volumes for PowerPlex 16 samples:

The target DNA template amount for PowerPlex 16 is 1 ng (1000 pg).

To calculate the amount of template DNA and TE<sup>4</sup> (diluent) to add, the following formulas are used. The sample concentration is the RotorGene quantitation value:

\[
\text{DNA extract added (μL)} = \frac{\text{Target DNA Template Amount (pg)}}{\text{(sample concentration, pg/μL)(dilution factor)}}
\]

The volume of diluant to add (μL) = 20 μL – DNA extract added (μL)

For samples with RotorGene values ≤ 50 pg/μL but ≥ 7.5 pg/μL aliquot 20 μL extract.
Sample and Control Preparation for Cofiler and Profiler Plus

TABLE 6.5: PCR amplification input based on RotorGene values

<table>
<thead>
<tr>
<th>RG value at 1:10 dilution</th>
<th>RG value neat</th>
<th>Amplification Sheet</th>
<th>Dilution</th>
</tr>
</thead>
<tbody>
<tr>
<td>HSC extraction ≥ .7 pg/μL</td>
<td>≥ 7.5 pg/μL</td>
<td>Amplify with Cofiler/Profiler Plus</td>
<td>As appropriate</td>
</tr>
</tbody>
</table>

TABLE 6.6: Control samples Cofiler and Profiler Plus Kits

<table>
<thead>
<tr>
<th>Sample</th>
<th>DNA</th>
<th>TE⁻⁴</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABI kit amplification positive control</td>
<td>10 μL</td>
<td>10 μL</td>
</tr>
<tr>
<td>Extraction negative control</td>
<td>20 μL</td>
<td>---</td>
</tr>
<tr>
<td>Amplification negative control</td>
<td>---</td>
<td>20 μL</td>
</tr>
</tbody>
</table>

In order to manually calculate the aliquot volumes for Cofiler/Profiler Plus samples:

The target DNA template amount for Cofiler and Profiler Plus is 1 ng (1000 pg).

To calculate the amount of template DNA and TE⁻⁴ (diluent) to add, the following formulas are used. The sample concentration is the RotorGene quantitation value:

\[
\text{DNA extract added (μL)} = \frac{\text{Target DNA Template Amount (pg)}}{(\text{sample concentration, pg/μL})(\text{dilution factor})}
\]

The volume of diluant to add (μL) = 20 μL – DNA extract added (μL)

For samples with RotorGene values ≤ 50 pg/μL but ≥ 7.5 pg/μL aliquot 20 μL extract.
Sample and Control Preparation for Y STR multiplex YM1

The amplification of exemplars, sperm cell fractions of samples extracted by differential lysis and semen stains, where no epithelial cells were seen during the differential lysis, is based on the quantitation results. Semen positive swabs taken from female individuals that were extracted using the non-differential semen extraction and the swab remains fractions of differential lysis samples are amplified using the amounts specified in Table 6.7.

**TABLE 6.7: PCR amplification input based on RotorGene values**

<table>
<thead>
<tr>
<th>RG value at 1:10 dilution pg/µL</th>
<th>RG value neat pg/µL</th>
<th>Amplification Sheet</th>
<th>Dilution</th>
</tr>
</thead>
<tbody>
<tr>
<td>HSC extraction</td>
<td>≥ 0.7 pg/µL</td>
<td>≥ 7.5 pg/µL</td>
<td>Amplify with YSTR <strong>As appropriate</strong></td>
</tr>
<tr>
<td><strong>Add TE⁻⁴ to a final volume of 26 µL.</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The target DNA template amount for Y STR is 2 ng (2000 pg).

To calculate the amount of template DNA and TE⁻⁴ (diluent) to add, the following formulas are used. The sample concentration is the RotorGene quantitation value:

\[
\text{Target DNA Template Amount (pg)} = \frac{\text{DNA extract added (µL)}}{(\text{sample concentration, pg/µL})(\text{dilution factor})}
\]

The volume of diluant to add (µL) = 26 µL – DNA extract added (µL)

For samples with RotorGene values ≤ 50 pg/µL but ≥ 7.5 pg/µL aliquot 26 µL extract.
6. PCR AMPLIFICATION – SAMPLE PREPARATION

**Table 6.8** Increased amount of DNA extract from a non-differential semen extraction or from the swab/substrate remains fraction of a differential lysis sample to be amplified for YM1. Never amplify less than 2 ng of DNA based on P30 or sperm search results.

<table>
<thead>
<tr>
<th>P30 result for the 2ng subtraction (Body cavity swabs)</th>
<th>P30 result for the 0.05A units subtraction (Stains or penile swabs)</th>
<th>DNA Volume (µL) to be amplified</th>
<th>TE&lt;sup&gt;-4&lt;/sup&gt; (µL)</th>
<th>Range of Volumes (µL) which can be amplified</th>
</tr>
</thead>
<tbody>
<tr>
<td>≥ 1.1</td>
<td>≥ 1.1</td>
<td>10</td>
<td>16</td>
<td>2 - 26*</td>
</tr>
<tr>
<td>&gt; 0 - 1.0</td>
<td>&gt; 0 - 1.0</td>
<td>26</td>
<td>0</td>
<td>5 - 26*</td>
</tr>
<tr>
<td>Sperm Seen</td>
<td>Sperm Seen</td>
<td>10</td>
<td>16</td>
<td>2 - 26*</td>
</tr>
<tr>
<td>Not sent to P30</td>
<td>Not sent to P30</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Add TE<sup>-4</sup> to a final volume of 26 µL.

**Table 6.9 – Amount of DNA extract to be amplified for Amylase positive samples.**

<table>
<thead>
<tr>
<th>Type of item</th>
<th>DNA Target Volume (µL)</th>
<th>TE&lt;sup&gt;-4&lt;/sup&gt; (µL)</th>
<th>Range (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaginal swab</td>
<td>Initially try two amounts</td>
<td>10</td>
<td>16</td>
</tr>
<tr>
<td>Dried secretions swab (External)</td>
<td>Based on Quantitation result</td>
<td>26</td>
<td>0</td>
</tr>
<tr>
<td>Stain</td>
<td>Based on Quantitation result</td>
<td>10</td>
<td>16</td>
</tr>
</tbody>
</table>

* Add TE<sup>-4</sup> to a final volume of 26 µL.

**Table 6.10 – Control samples Y STR multiplex YM1**

<table>
<thead>
<tr>
<th>Sample</th>
<th>DNA</th>
<th>TE&lt;sup&gt;-4&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>In house amplification positive control</td>
<td>20 µL</td>
<td>6 µL</td>
</tr>
<tr>
<td>Extraction negative control</td>
<td>20 µL</td>
<td>6 µL</td>
</tr>
<tr>
<td>Amplification negative control</td>
<td>---</td>
<td>26 µL</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
6. PCR AMPLIFICATION – SAMPLE PREPARATION

**Master Mix and/or Master Mix Tube Preparation - PowerPlex16, Cofiler, Profiler Plus, YM1**

1. For each system fill out the amplification worksheet and record the appropriate lot numbers.

2. Determine the number of samples to be amplified, including controls and label a PCR reaction mix tube for each sample.

3. Ensure that the solution is at the bottom of each PCR reaction mix tube by tapping the tube down onto a clean work surface or by centrifuging briefly. Label the side of the PCR Reaction Mix tubes near the top or use white labels. Make sure that labels are unique (i.e., tube labels 1A1 and VSSF are too generic- try to use both numbers and letters) Open caps using the microcentrifuge tube de-capping tool or a new Kimwipe. **Avoid touching the inside surface of the tube caps.**

**Make sure that tube labels are unique. Try to incorporate part of the case number and the type of sample. Also, try not to make tube labels longer than 5 characters.**

4. For PowerPlex 16 the reaction mix has to be prepared fresh. Prepare enough for N+1 samples and mix before using:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>1 sample</th>
<th>10 samples</th>
<th>30 samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>PowerPlex 16 10x primer mix</td>
<td>2.5 µL</td>
<td>25 µL</td>
<td>75 µL</td>
</tr>
<tr>
<td>Gold Star 10x buffer</td>
<td>2.5 µL</td>
<td>25 µL</td>
<td>75 µL</td>
</tr>
<tr>
<td>AmpliTaq Gold DNA Polymerase (5U/µL)</td>
<td>0.8 µL</td>
<td>8 µL</td>
<td>24 µL</td>
</tr>
</tbody>
</table>
Reagent and Sample Aliquot - PowerPlex16, Cofiler, Profiler Plus, YM1

1. According to the multiplex that is being amplified the following reagents must be added to each tube:

<table>
<thead>
<tr>
<th>SYSTEM</th>
<th>PowerPlex 16</th>
<th>Y STR YM1</th>
<th>Cofiler, Profiler Plus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reagent</td>
<td>5.8 µL mastermix</td>
<td>4 µL of MgCl₂</td>
<td>10 µL of specific primer mix</td>
</tr>
</tbody>
</table>

2. Pipet carefully in the solution at the bottom of the tube. Use a fresh sterile pipette tip for each tube. Close all of the tubes. At this stage have another analyst witness the sample set-up.

3. **Note:** Use a new sterile filter pipette tip for each sample addition. Open only one tube at a time for sample addition. The final aqueous volume in the PCR reaction mix tubes will be 50µL for Profiler Plus, Cofiler and YM1. Transfer the DNA aliquot prepared earlier to the labeled PCR reaction mix tubes. After the addition of the DNA, cap each sample before proceeding to the next tube. Do not vortex or mix.

4. After all samples have been added take the rack to the amplified DNA area.
F. Thermal Cycling - all amplification systems

1. Turn on the ABI 9700 Thermal Cycler. (See manufacturer's instructions).

2. Choose the following files in order to amplify each system:

<table>
<thead>
<tr>
<th>Identifiler 28</th>
<th>Identifiler 31</th>
</tr>
</thead>
<tbody>
<tr>
<td>user: hisens or casewk</td>
<td>user: hisens or casewk</td>
</tr>
<tr>
<td>file: id28</td>
<td>file: id31</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>YM1</th>
<th>Cofiler</th>
<th>Profiler Plus</th>
<th>PowerPlex16</th>
</tr>
</thead>
<tbody>
<tr>
<td>user: casewk</td>
<td>user: casewk</td>
<td>user: casewk</td>
<td>user: casewk</td>
</tr>
<tr>
<td>file: ym1</td>
<td>file: profiler/cofiler</td>
<td>file: profiler/cofiler</td>
<td>file: powerplex</td>
</tr>
</tbody>
</table>

3. The following tables list the conditions that should be included in each file. If the files are not correct, bring this to the attention of the Quality Assurance Manager and a supervisor.

**PCR Conditions for the Applied Biosystems GeneAmp PCR System 9700**

<table>
<thead>
<tr>
<th>Identifiler 28 or 31</th>
<th>9700</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Identifiler file is as follows:</td>
<td></td>
</tr>
<tr>
<td>user: hisens or casewk</td>
<td>Soak at 95°C for 11 minutes</td>
</tr>
<tr>
<td>file: id28 or id31</td>
<td>: Denature at 94°C for 1 minute</td>
</tr>
<tr>
<td></td>
<td>28 or 31 Cycles : Anneal at 59°C for 2 minutes</td>
</tr>
<tr>
<td></td>
<td>: Extend at 72°C for 1 minute</td>
</tr>
<tr>
<td></td>
<td>60 minute incubation at 60°C.</td>
</tr>
<tr>
<td></td>
<td>Storage soak indefinitely at 4°C</td>
</tr>
</tbody>
</table>
## 6. PCR AMPLIFICATION – SAMPLE PREPARATION

<table>
<thead>
<tr>
<th>Date Effective</th>
<th>Version</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>13 OF 17</td>
</tr>
</tbody>
</table>

### PCR Conditions for the Perkin Elmer GeneAmp PCR System 9700

#### PowerPlex16
- **User:** casewk
- **File:** powerplex

The PowerPlex file is as follows:
- Soak at 95°C for 11 minutes
- Soak at 96°C for 1 minute
  - Ramp 100% : Denature at 94°C for 30 seconds
  - Ramp 29% : Anneal at 60°C for 30 seconds
  - Ramp 23% : Extend at 70°C for 45 seconds for 10 cycles then
  - Ramp 100% : Denature at 94°C for 30 seconds
  - Ramp 29% : Anneal at 60°C for 30 seconds
  - Ramp 23% : Extend at 70°C for 45 seconds for 22 cycles
- 30 minutes incubation at 60°C.
- Storage soak indefinitely at 4°C

#### Cofiler/Profiler Plus
- **User:** casewk
- **File:** cofiler/profiler

The Cofiler/Profiler Plus file is as follows:
- Soak at 95°C for 11 minutes
  - 28 Cycles: : Anneal at 59°C for 1 minute
  - : Extend at 72°C for 1 minute
- 45 minute incubation at 60°C.
- Storage soak 90 minutes at 25°C
- Storage soak indefinitely at 4°C

#### YM1
- **User:** casewk
- **File:** ym1

The YM1 file is as follows:
- Soak at 95°C for 10 minutes
  - : Denature at 94°C for 45 seconds
  - 30 Cycles: : Anneal at 58°C for 58 seconds
  - : Extend at 72°C for 1 minute 15 seconds
- 30 minute incubation at 60°C.
- Storage soak indefinitely at 4°C
6. PCR AMPLIFICATION – SAMPLE PREPARATION

9700 Instructions

1. Place the tubes in the tray in the heat block (do not add mineral oil), slide the heated lid over the tubes, and fasten the lid by pulling the handle forward. Make sure you use a tray that has a 9700 label.

2. Start the run by performing the following steps:

3. The main menu options are RUN CREATE EDIT UTIL USER. To select an option, press the F key (F1…F5) directly under that menu option.

4. Verify that user is set to “casewk.” If it is not, select the USER option (F5) to display the “Select User Name” screen.

5. Use the circular arrow pad to highlight “casewk.” Select the ACCEPT option (F1).

6. Select the RUN option (F1).

7. Use the circular arrow pad to highlight the desired STR system. Select the START option (F1). The “Select Method Options” screen will appear.

8. Verify that the reaction volume is set to 50µL (25µL for PowerPlex 16) and the ramp speed is set to 9600 (very important).

9. If all is correct, select the START option (F1).

10. The run will start when the heated cover reaches 103°C. The screen will then display a flow chart of the run conditions. A flashing line indicates the step being performed, hold time is counted down. Cycle number is indicated at the top of the screen, counting up.

11. Upon completion of the amplification, remove samples and press the STOP button repeatedly until the “End of Run” screen is displayed. Select the EXIT option (F5). Wipe any condensation from the heat block with a Kimwipe and pull the lid closed to prevent dust from collecting on the heat block. Turn the instrument off.
NOTE: Place the microtube rack used to set-up the samples for PCR in the container of 10% bleach container in the Post-Amp area in Room 714A.

Turn instruments off **ONLY** when the Main Menu is displayed, otherwise there will be a “Power Failure” message the next time the instrument is turned on. If this happens, it will prompt you to review the run history. Unless you have reason to believe that there was indeed a power failure, this is not necessary. Otherwise, press the STOP button repeatedly until the Main Menu appears.

In case of an actual power failure, the 9700 thermal cycler will automatically resume the run if the power outage did not last more than 18 hours. The history file contains the information at which stage of the cycling process the instrument stopped. Consult the Quality Assurance Unit and/or the Technical Leader on how to proceed.

After the amplification process, the samples are ready to be loaded on the fluorescent instruments. They may be stored in the appropriate refrigerator at 2-8°C for a period of up to 6 months.
G. Amplification Troubleshooting

PROBLEM: No or only weak signal from both the positive control and the test samples

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mistake during the amplification set up such as not adding one of the components or not starting the thermal cycler</td>
<td>Prepare new samples and repeat amplification step</td>
</tr>
<tr>
<td>Thermal cycler defect or wrong program used</td>
<td>Check instrument, notify QA team, prepare new samples and repeat amplification step</td>
</tr>
</tbody>
</table>

PROBLEM: Positive control fails but sample signal level is fine

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mistake during the amplification set up such as not adding enough of the positive control DNA</td>
<td>Prepare new samples and repeat amplification step</td>
</tr>
<tr>
<td>Positive control lot degraded</td>
<td>Notify QA team to investigate lot number, prepare new samples and repeat amplification step</td>
</tr>
</tbody>
</table>

PROBLEM: Presence of unexpected or additional peaks in the positive control.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contamination by other samples, contaminated reagents</td>
<td>Notify QA team to investigate the amplification reagents, prepare new samples and repeat amplification step</td>
</tr>
<tr>
<td>Non-specific priming</td>
<td>Notify QA team to check thermal cycler for correct annealing settings, prepare new samples and repeat amplification step</td>
</tr>
</tbody>
</table>
PROBLEM: Strong signal from the positive controls, but no or below threshold signal from DNA test sample.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The amount of DNA was insufficient or the DNA is severely degraded.</td>
<td>Amplify a larger aliquot of the DNA extract.</td>
</tr>
<tr>
<td></td>
<td>Re-extract the sample using a larger area of the stain or more biological fluid to ensure sufficient high molecular DNA is present.</td>
</tr>
<tr>
<td></td>
<td>Concentrate the extracted DNA using a Microcon 100 ultrafiltration device as described in the Microcon section.</td>
</tr>
<tr>
<td>Test sample contains PCR inhibitor (e.g. heme compounds, certain dyes).</td>
<td>Amplify a smaller aliquot of the DNA extract to dilute potential Taq Gold polymerase inhibitors.</td>
</tr>
<tr>
<td></td>
<td>Re-extract the sample using a smaller area of the stain to dilute potential Taq Gold polymerase inhibitors.</td>
</tr>
<tr>
<td></td>
<td>Re-extract the samples using the organic extraction procedure.</td>
</tr>
<tr>
<td></td>
<td>Purify the extracted DNA using a Microcon 100 ultrafiltration device as described in the Microcon section.</td>
</tr>
</tbody>
</table>

The decision on which of the above approaches is the most promising should be made after consultation with a supervisor.
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

7. GENERAL GUIDELINES FOR FLUORESCENT STR ANALYSIS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>1 OF 2</td>
</tr>
</tbody>
</table>

**Batch processing**

1. Exemplars and evidence samples must be handled separately at all times. These samples must never be together on the same sample tray.

2. For the ABI 3130xl, it is acceptable to load one exemplar and one evidence tray in the same instrument. Two trays are the equivalent of two consecutive runs.

3. Samples from one amplification sheet should be processed together, so that each sample is accompanied by the appropriate controls.

4. Use the correct worksheet for the specific sample type, and make sure the sample preparation set-up is witnessed properly.

5. Samples that need to be rerun must be loaded on a run with the appropriate sample type. For samples rerun at the same injection parameters, it is not necessary to rerun the controls for the repeated sample. For samples rerun at different injection parameters, the controls must be rerun at the most sensitive parameters. Controls need not be rerun at lower injection parameters if they pass at higher injection parameters.

**ATTENTION:** Each capillary run that is performed must have at least one correct positive control.

**Sample handling**

1. Prior to loading on the capillary, the amplified samples are stored at +4°C in the amplified DNA area. The tubes containing the amplified product must never leave the amplified DNA area.

2. Amplified samples that have been loaded on an instrument should be stored until the electrophoresis results are known. After it has been determined that the amplified samples do not require repeated testing, they may be discarded.
7. GENERAL GUIDELINES FOR FLUORESCENT STR ANALYSIS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>2 OF 2</td>
</tr>
</tbody>
</table>

Instrument and computer maintenance

1. Be gentle with all instrument parts and instruments. Keep everything clean.
2. It is good practice to monitor initial instrument performance. This enables the user to detect problems such as leaks, air bubbles or calibration issues.
3. PCs need to be maintained through regular defragmentation.
4. Delete data files and other non-essential files from the hard disk at least once a week.
5. Notify the Quality Assurance Unit if any problems are noted.
A. Personal Preparation

1. Don protective attire only designated for the post-amplification room including lab coat and gloves. **Do not enter room without appropriate attire.**
   
a. Ensure that the cuffs of the lab coat completely cover arm.

b. Lab coats may be reused for up to one week.

2. Remember to change gloves directly prior to handling samples.

B. Workplace preparation

1. Turn on the heat blocks and/or thermocyclers for the denature/chill step.

2. Apply 10% bleach followed by 70% Ethanol and water to the entire work surface, pipets and cap openers.

3. Retrieve clean racks and cap openers, microcentrifuge tubes and/or plates, and irradiated water.

   **NOTE:** Only use filtered tips for pipetting.

4. Arrange work place to minimize crossover.

5. Position gloves nearby with bleach/Ethanol/water in order to facilitate frequent glove changes and cleaning.

C. Setting Up A 3130x/ Run

1. Collect amp sheets that are ready to run. Evidence and exemplars must be run on separate plates.

2. Turn on or restart the computer attached to the instrument.

3. Press “CTRL-ALT-DEL” to login.

4. User should be “Administrator”, password should be left blank.
8. STR ANALYSIS ON THE ABI 3130x/GENETIC ANALYZER

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>2 OF 48</td>
</tr>
</tbody>
</table>

5. Press “OK”.

6. Open the 3130x/ Data Collection v3.0 software by double clicking on the desktop Icon or select Start > All Programs > AppliedBiosystems > Data Collection > Run 3130x/ Data Collection v3.0 to display the Service Console.

By default all applications are off indicated by the red circles. As each application activates, the red circles (off) change to yellow triangles (activating), eventually progressing to green squares (on) when they are fully functional.

NOTE: This process could take several minutes. The Service Console must not be closed or it will shut down the application.

Once all applications are running, the Foundation Data Collection window will be displayed at which time the Service Console window may be minimized.
### 8. STR ANALYSIS ON THE ABI 3130x1 GENETIC ANALYZER

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>3</td>
</tr>
</tbody>
</table>

7. Check the number of injections on the capillary in the 3130x1 binder and in the **Foundation Data Collection** window by clicking on the `ga3130x1 > instrument name > Instrument Status`. If the numbers are not the same, update the binder. If the number is ≥140, notify QC. Proceed only if the number of injections you are running plus the usage number is ≤150.

![Foundation Data Collection Screenshot](image)

8. Check the binder to see when the POP4 was last changed. If it is >7 days, proceed with POP4 change (See Part M of this Section) and then return to Step 11.

9. Check the level of POP4 in the bottle to ensure there is enough for your run (~450 µL for 6 injections). A full piston chamber is approximately 200ul. If not enough, proceed with POP4 change (See Part M of this Section) and then return to Step 10.
10. If you are the first run on the instrument of the day, proceed with step 11-20. If a run has already been performed on the instrument that day and the “buffer changed” column has been checked off in the binder, skip to “Creating a Plate Record through Excel”.

11. Close the instrument doors and press the tray button on the outside of the instrument to bring the autosampler to the forward position.

12. Wait until the autosampler has stopped moving and then open the instrument doors.

13. Remove the three plastic reservoirs in front of the sample tray and anode jar from the base of the lower pump block and dispose of the fluids.

14. Rinse and fill the “water” and “waste” reservoirs to the line with deionized water such as GIBCO®.

15. Make a batch of 1X buffer (45 ml Gibco® water, 5 ml 10X buffer) in a 50 mL conical tube. Record the lot number of the buffer, date of make, and initials on the side of the tube. Rinse and fill the “buffer” reservoir and anode jar with 1X running buffer to the lines.
16. Dry the outside and inside rim of the reservoirs/septa and outside of the anode jar using a Kimwipe and replace the septa strip snugly onto each reservoir. If these items are not dry arcing could occur thus ruining the capillary and polymer blocks.

17. Place the reservoirs in the instrument in their respective positions, as shown below:

<table>
<thead>
<tr>
<th>Water Reservoir (Waste)</th>
<th>Water Reservoir (Rinse)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cathode reservoir (1X running buffer)</th>
<th>Empty</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

18. Place the anode jar at the base of the lower pump block.

19. Close the instrument doors.

   a. In the binder, check the “buffer changed” column.
D. Creating a Plate Record through Excel

3130Macro for HSC and Exemplar Teams

1. Open the 3130Macro and the amp sheets ready to be run.

2. On the amp sheets, copy only the following columns:
   - Label
   - Sample Name
   - pg/μL
   - Dilution
   - DNA
   - H2O/TE
   - IA

   Copy from the controls to the last sample waiting to be run.

On the Cofiler/Profiler Plus amp sheets, do NOT copy the Target Date column.

On the Y STR amp sheets, do NOT copy the Target Date column if present.

3. On the 3130Macro “Samples” tab, “Paste Special” “Values” the copied information from the amp sheets in the appropriate injection.

   Special information concerning each sample (ie. reason for rerun, etc.) can be entered into the Comments column.

   If samples need to be rerun:
   - In the Samples tab, type in the necessary information.
   - For reruns, click on the buttons available in the Samples tab to describe reason for rerun in the 3130sheet Comments column.

   In Comment1 column, type the run name which the sample is being rerun from.
8. STR ANALYSIS ON THE ABI 3130xl GENETIC ANALYZER

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>7 OF 48</td>
</tr>
</tbody>
</table>

In **Comment2C** column, type in the dilution (if applicable) or click one of the buttons available for reason of rerun.

In **Comment3** column, click one of the buttons available for reason of rerun if not already done.

(Note: If “Stars01-1234CoA” was entered in **Comment1C**, “0.1” was entered in **Comment2C**, and the “rerun at a dilution” button was clicked in **Comment3C**, then “Stars01-2345CoA, 0.1 dil” will show up in the 3130sheet.)

Make sure the correct cell is selected before clicking the buttons.

**Table 8.1 Rerun Legend:**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Δ</td>
<td>Rerun to confirm off ladder</td>
</tr>
<tr>
<td>dil</td>
<td>Rerun at a dilution</td>
</tr>
<tr>
<td>#</td>
<td>Rerun due to bad size standard</td>
</tr>
</tbody>
</table>

- Any other comments can be manually typed in the comment column.
- For rerun normal samples, fill up the end of the injection for normal reruns before starting a new injection.
- Rerun high samples should have a separate injection from samples run under normal conditions.

Samples cannot contain more than 50 characters or sheet will not import.

Any changes made to the Tube Label, Sample Description, IA, or Comments columns MUST be done on the “Samples” tab.
8. STR ANALYSIS ON THE ABI 3130xl GENETIC ANALYZER

4. Go to the 3130Macro “3130Sheet” tab:

Type the sample sheet name in cell D1.

HSC casework sample sheets should be named indicating the instrument, the year, and the consecutive run number for the multiplex. For example: “Mendel06-021Co-009Pro” or “Kastle07-058ID-014Y.”

Sample sheet names cannot be more than 50 characters or sheet will not import.

5. Save the sample sheet by selecting File, Save As in the format of yoursamplesheetname.xls. Save in the appropriate Samples Sheets folder.

6. On the “3130Sheet” tab, type the appropriate System into the “Sys” column of the first row of the injection. Once the first row of the injection is filled, the rest of the injection should automatically populate with the same System code.

Table 8.2

<table>
<thead>
<tr>
<th>Amplification System/Cycle</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler 28</td>
<td>Normal</td>
<td>I</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>IR</td>
<td>5 kV for 20 sec</td>
</tr>
<tr>
<td>Cofiler</td>
<td>Normal</td>
<td>C</td>
<td>3 kV for 10 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>CR</td>
<td>3 kV for 20 sec</td>
</tr>
<tr>
<td>Profiler Plus</td>
<td>Normal</td>
<td>P</td>
<td>3 kV for 10 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>PR</td>
<td>3 kV for 20 sec</td>
</tr>
<tr>
<td>YM1</td>
<td>Normal</td>
<td>M</td>
<td>3 kV for 10 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>MR</td>
<td>3 kV for 20 sec</td>
</tr>
</tbody>
</table>
7. In the “Type” column, fill in the appropriate letter(s) for the type of sample:

Table 8.3

<table>
<thead>
<tr>
<th>Sample Type</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Ladder</td>
<td>AL</td>
</tr>
<tr>
<td>Positive Control</td>
<td>PC</td>
</tr>
<tr>
<td>Negative Control</td>
<td>NC</td>
</tr>
<tr>
<td>Sample</td>
<td>S</td>
</tr>
</tbody>
</table>

8. If there are more than two injections of Identifiler/Cofiler/Profiler samples, Allelic Ladder should automatically fill into the first rows (colored in grey) of the injection in the “3130Sheet” tab once samples are added to the injection (cells not grey in color).

To add a second allelic ladder to an injection, the allelic ladder must be typed in the “Samples” tab.

If running a system with no Allelic Ladder (ie.YM1), the first sample can be typed into the grey color row in the 3130Sheet tab.

9. Do a final check of the sample sheet. Make sure to check the following:

- No Tube Label is duplicated.
- All necessary columns are filled out.
- The samples are in correct 3130 format: -_.(){}[]^ only. No spaces, commas, colons or quotes.
If any changes need to be made in the Tube Label, Sample Description, IA or Comments columns, changes MUST be done in the “Samples” tab (with the exception of Allelic ladders in the first row of the injection).

Table 8.4

<table>
<thead>
<tr>
<th>Tube Label</th>
<th>label given to each sample for amplification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Number- Sample Description</td>
<td>sample name.</td>
</tr>
<tr>
<td>Sys.</td>
<td>see #6 for abbreviations</td>
</tr>
<tr>
<td>Type</td>
<td>sample type (see #7 for abbreviations)</td>
</tr>
<tr>
<td>IA</td>
<td>the interpreting analyst assigned to the case</td>
</tr>
<tr>
<td>Comments</td>
<td>(If sample is being rerun) the original run name, and rerun conditions</td>
</tr>
</tbody>
</table>

10. Resave and print out sample sheet.

11. On the 3130Macro “Pre Record” tab, press the “Create Plate Record” button on the top center of the sheet. Macro will automatically jump to the “Plate Record” tab.

12. On the 3130Macro “Plate Record” tab, press the “Remove Empty Rows” button on the top center of the sheet.

13. Staying on the “Plate Record” tab, select File, Save As and do the following:
   a. Change Save as file type to “Text (Tab-delimited)”.
   b. Save in the appropriate Plate Record folder.

14. Click OK to prompt: The selected file type does not support workbooks that contain multiple sheets.

15. Click Yes to prompt: Do you want to keep the workbook in this format?
Macro for PC team: ID28 PC3130Macro v1.2

1. Open the ID28 PC3130Macro v1.2 and the amp sheets ready to be run.

2. On the amp sheets, copy only the following columns:
   - Label
   - Sample Name
   - pg/μL
   - Dilution
   - DNA
   - H2O
   - IA

   Copy everything from the controls to the last sample waiting to be run.

3. On the “Samples” tab, Paste Special → Values the copied information from the amp sheets into the appropriate injection. The positive control must be the first sample in each odd numbered injection. It is possible that an amplification set will spill over into the second injection—the workbook will automatically adjust the controls on the run sheet if this happens.

   If reruns are to be added to the run sheet:
   - In the Samples sheet, copy and paste the information from the re-run log. This includes the tube label, sample description, IA, and original run.
   - The “re-run param” can either be copied and pasted from the re-run log, or the buttons with re-run codes in the Samples sheet can be used. This information will automatically be carried over.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>∆</td>
<td>Rerun to confirm off ladder</td>
</tr>
<tr>
<td>0.1</td>
<td>Rerun at a 0.1 dilution</td>
</tr>
<tr>
<td>#</td>
<td>Rerun due to bad size standard</td>
</tr>
</tbody>
</table>

   Any other comments can be manually typed in the comment column.
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

8. STR ANALYSIS ON THE ABI 3130xl GENETIC ANALYZER

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>12 OF 48</td>
</tr>
</tbody>
</table>

4. In the cell next to “Prepared By:” type the initials of the person preparing the run sheet (cell K1). This information will be carried over to the Run sheet, and will prompt the user with instructions regarding how many samples can be loaded in each injection. **This is an important step to prevent samples from being left off the final run sheet.**

Samples names cannot contain more than 50 characters or sheet will not import.

Any changes that need to be made to the Tube Label, Sample Description, IA or Comments columns MUST be done on the “Samples” tab.

5. Go to the “ID28V_3130Sheet” tab:

Type in the sample sheet name in cell D1.
PC sample sheets should be named indicating the instrument, the year and the consecutive run number for the multiplex.

For example: Newton08-012ID

Sample sheet names cannot be more than 50 characters or sheet will not import.

6. Save the sample sheet by selecting File, Save As in the format of yoursamplesheetname.xls. Save in the appropriate Samples Sheets folder.

7. On the “ID28V_3130Sheet” tab, type the appropriate System into the “Sys” column of the first row of the injection. Once the first row of the injection is filled, the rest of samples in the injection should automatically populate with the same System code.

Table 8.6

<table>
<thead>
<tr>
<th>Amplification System/Cycle</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier 28</td>
<td>Normal</td>
<td>I</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>IR</td>
<td>5 kV for 20 sec</td>
</tr>
</tbody>
</table>
8. In the “Type” column, each sample should automatically fill with the appropriate letter for the type of sample:

Table 8.7

<table>
<thead>
<tr>
<th>Sample Type</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Ladder</td>
<td>AL</td>
</tr>
<tr>
<td>Positive Control</td>
<td>PC</td>
</tr>
<tr>
<td>Negative Control</td>
<td>NC</td>
</tr>
<tr>
<td>Sample</td>
<td>S</td>
</tr>
</tbody>
</table>

9. In the “Run” column, type in the injection number that corresponds to each injection. This column should automatically fill as well when the first sample is entered.

10. Allelic Ladder and positive control should automatically fill into the first two rows of each injection (colored in grey) as soon as sample is added to an injection in the samples tab.

To add a second allelic ladder to an injection, the allelic ladder must be typed in the “Samples” tab.

11. Do a final check of the sample sheet. Make sure to check the following:

- No Tube Label is duplicated.
- All necessary columns are filled out.
- The samples are in correct 3130 format: -_.(){}[]+^ only. No spaces, commas, colons or quotes.

Any changes made in the Tube Label, Sample Description, IA or Comments columns, changes MUST be done in the “Samples” tab.
Table 8.8

<table>
<thead>
<tr>
<th>Tube Label</th>
<th>label given to each sample for amplification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Number- Sample Description</td>
<td>sample name.</td>
</tr>
<tr>
<td>Sys.</td>
<td>see #6 for abbreviations</td>
</tr>
<tr>
<td>Type</td>
<td>sample type (see #7 for abbreviations)</td>
</tr>
<tr>
<td>Run</td>
<td>the injection number</td>
</tr>
<tr>
<td>IA</td>
<td>the interpreting analyst assigned to the case</td>
</tr>
<tr>
<td>Reinjection/Comments</td>
<td>eg if sample is being rerun: the original run name, and rerun conditions</td>
</tr>
</tbody>
</table>

12. Resave and print out sample sheet.

**Note:** The “Plate Set Up” should be initialed by the person aliquoting the samples into the plate. The “Run Set Up” should be initialed by the person importing the plate onto the 3130xl.

13. On the “ID28V Pre Record” tab, press the “Create Plate Record” button on the top center of the sheet. The macro will automatically jump to the “Plate Record” tab.

14. On the “ID28V Plate Record” tab, press the “Remove Empty Rows” button on the top center of the sheet.

15. Staying on the “Plate Record” tab, select File, Save As and do the following:

   a. Change Save as file type to “Text (Tab-delimited)”.
   b. Save in the appropriate Plate Record folder.

16. Click OK to prompt: The selected file type does not support workbooks that contain multiple sheets.

17. Click Yes to prompt: “Do you want to keep the workbook in this format?”

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
3130xl Sample Sheet and Plate Record Macro For High Sensitivity Team

This Excel sheet will be imported into the 3130xl Data Collection v3.0 software.

1. Transfer the workbook containing the amplification to be run to the 3130xl instrument that will be used. This can be done with a USB jump drive.

2. Open the 3130xl sample sheet associated with the amplification, it can be found as a tab labeled with the amplification type (i.e. ID28V for Identifiler 28 evidence) and “3130 sheet” in the appropriate RGAmpl Macro workbook of the associated amplification date and time. All information from the amplification will have been automatically imported into the 3130xl sheets. However, if changes need to be made to the sheet or samples manually added or moved, follow the instructions below:

   a. The negative controls may be set up in a separate injection from the samples, and injected using “high” run parameters so that they only need to be run once.

   b. For ID31, samples with less than 20 pg amped may be injected high immediately to reduce the number of reruns necessary.

   c. For ID28, samples with less than 200 pg amped may be injected at rerun parameters immediately as well.

NOTE: When using Excel worksheets, DO NOT “copy” and “paste”. You MUST “copy” and “paste special” “values” as/when needed.
3. Below is a description of the fields in the sample sheet:

Table 8.9

<table>
<thead>
<tr>
<th>Tube Label</th>
<th>label given to each sample for amplification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Number- Sample Description</td>
<td>sample name</td>
</tr>
<tr>
<td>Sys.</td>
<td>Identifiler (see #6 for abbreviations and associated injection parameters)</td>
</tr>
<tr>
<td>Type</td>
<td>sample type (see #7 below)</td>
</tr>
<tr>
<td>Run</td>
<td>the injection or run number</td>
</tr>
<tr>
<td>RA</td>
<td>the reporting analyst assigned to the case</td>
</tr>
<tr>
<td>Amplification</td>
<td>the corresponding amplification date and time</td>
</tr>
<tr>
<td>Reinjection</td>
<td>if the plate is reinjected, the original or previous run name</td>
</tr>
</tbody>
</table>

4. Name the sample sheet as follows: **Instrument name & date_Run folders** for example: Athena042407_70-76. If the plate is being reinjected, the original plate name is recorded underneath the new sample sheet name.

5. Sample information will automatically populate from amp sheets into the “Tube Label”, “Case Number-Sample Description”, “IA”, and “Amplification” columns. Allelic Ladders and Positive Controls will populate the first, second, ninth and tenth wells of each injection. It is mandatory that there be a ladder and Positive Control included with each injection set for Identifiler.
6. In the “Sys.” column, fill in the appropriate letter for the correct run or re-run module code:

Table 8.10 – Identifiler Injection Parameters for the High Sensitivity Team

<table>
<thead>
<tr>
<th>Amplification Cycle</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler 31</td>
<td>Low</td>
<td>L</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>N</td>
<td>3 kV for 20 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>H</td>
<td>6 kV for 30 sec</td>
</tr>
<tr>
<td>Identifiler 28</td>
<td>Normal</td>
<td>I</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>IR</td>
<td>5 kV for 20 sec</td>
</tr>
</tbody>
</table>

7. In the “Run” column, fill in the appropriate injection or run number referring to the instrument log. (This number can be verified in later stages by opening “Run View” after linking the plate.)

8. In the “type” column, fill in the appropriate letter/s for the type of the sample:

Table 8.11

<table>
<thead>
<tr>
<th>Sample Type</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Ladder</td>
<td>AL</td>
</tr>
<tr>
<td>Positive Control</td>
<td>PC</td>
</tr>
<tr>
<td>Negative Control</td>
<td>NC</td>
</tr>
<tr>
<td>Sample</td>
<td>S</td>
</tr>
</tbody>
</table>
8. STR ANALYSIS ON THE ABI 3130xl GENETIC ANALYZER

DATE EFFECTIVE | VERSION | PAGE
06-09-2008     | 10.0    | 18 OF 48

9. Proofread your sample sheet, make corrections and re-save as necessary.

IMPORTANT: Remember that all names must consist of letters, numbers, and only the following characters: - . ( ) [ ] ^ . Do not use commas, colons, or quotes. Use the character ^ instead of quotes.

Also, NO SPACES between characters are allowed. If an incorrect character is used in the sample sheet name, you will not be allowed to import the plate record into the 3130xl Data Collection v3.0 software.

Ex. FB06-XXXX_Tshirt_st. IAI or FB06-XXXX_Vag_EC

10. Save the sample sheet by selecting Save As from the File menu and save the sheet in the format of: yoursamplesheetname.xls. Save in D: \AppliedBiosystems\Sample Sheets (xls files.)

11. On the 3130Macro “Pre Record” tab, click the “Create Plate Record” button in the top center of the sheet. The Macro will automatically forward to the “Plate Record” tab, copying all of the run information to that sheet.

12. On the 3130Macro “Plate Record” tab, click the “Remove Empty Rows” button in the top center of the sheet. All rows not containing an instrument protocol will be deleted.

13. Select File, Save As and do the following:
   a. Change Save as file type to “Text (Tab-delimited)”.
   b. Save in the appropriate Plate Record folder.

14. Click OK to prompt: “The selected file type does not support workbooks that contain multiple sheets”.

15. Click Yes to prompt: “Do you want to keep the workbook in this format?”

16. While importing the plate record into the ABI 3130xl software, minimize the Excel file until the record has been successfully imported.

17. After successfully importing the plate record, exit Excel by going to File > Exit. You will be prompted to save again by Excel; this is not necessary select NO.
Creating Plate Records Manually

1. If negative controls are set up in a separate injection from the samples, they may be injected using the “high” run parameters so that they only need to be run once.

   **NOTE:** When using Excel worksheets, **DO NOT** “copy” and “paste”. You **MUST** “copy” and “paste special” “values” as/when needed.

2. Below is a description of the fields in the sample sheet:

   For HSC and Exemplar Teams:

   **Table 8.12**

<table>
<thead>
<tr>
<th>Tube Label</th>
<th>label given to each sample for amplification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Number- Sample Description</td>
<td>sample name.</td>
</tr>
<tr>
<td>Sys.</td>
<td>see #6 for abbreviations</td>
</tr>
<tr>
<td>Type</td>
<td>sample type (see #7 for abbreviations)</td>
</tr>
<tr>
<td>IA</td>
<td>the interpreting analyst assigned to the case</td>
</tr>
<tr>
<td>Comments</td>
<td>eg if sample is being rerun, the original run name, and rerun conditions</td>
</tr>
</tbody>
</table>

   For High Sensitivity and Property Crime Teams:

   **Table 8.13**

<table>
<thead>
<tr>
<th>Tube Label</th>
<th>label given to each sample for amplification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Number- Sample Description</td>
<td>sample name.</td>
</tr>
<tr>
<td>Sys.</td>
<td>Identifiler (see #6 for abbreviations and associated injection parameters)</td>
</tr>
<tr>
<td>Type</td>
<td>sample type (see # 7 for abbreviations)</td>
</tr>
<tr>
<td>Run</td>
<td>the injection or run number</td>
</tr>
<tr>
<td>IA</td>
<td>the interpreting analyst assigned to the case</td>
</tr>
<tr>
<td>Amplification (HI only)</td>
<td>the corresponding amplification information</td>
</tr>
<tr>
<td>Reinjection/Comments</td>
<td>if the plate is reinjected, the original run name (HI)</td>
</tr>
<tr>
<td></td>
<td>eg if sample is being rerun, the original run name, and rerun conditions (PC)</td>
</tr>
</tbody>
</table>
3. Fill in the sample sheet name in cell E3.

HSC, PC, and X-Team Casework sample sheets should be named indicating the instrument, the year and the consecutive run number for the multiplex, e.g.

Crick06-021Co-009Pro or Watson06-004Co or Crick06-015Pro or Crick07-058ID-004Y

HI team sample sheets are named as follows: \textit{Instrument name & date} \textit{Run folders} for example: Athena042407_70-76. If the plate is being reinjected, the original plate name is recorded underneath the new sample sheet name.

This Excel sheet will be imported into the 3130\textsuperscript{xl} Data Collection v3.0 software.

4. Fill in the sample information in the “Case Number-Sample Description” and “Tube Label” columns. Room has already been reserved for the Allelic Ladders and Positive Controls in the first two wells of each injection. For Identifiler, a ladder and a positive control should be included with each injection.

\textbf{IMPORTANT}: When naming in the “Case Number-Sample Description” and “Tube Label” columns, you may use letters, numbers, and only the following characters: \texttt{- _ . ( ) \{\} [] + ^}. Do not use commas, colons, or quotes. Use the character ^ instead of quotes.

Also, \textbf{NO SPACES} between characters are allowed. If an incorrect character is used in the sample sheet name, you will not be allowed to import the plate record into the 3130\textsuperscript{xl} Data Collection v3.0 software.

Ex. FB06-XXXX_Tshirt_st_1A1 or FB06-XXXX_Vag_EC
5. In the “Sys.” column, fill in the appropriate letter for the correct run or re-run module code:

Table 8.14

<table>
<thead>
<tr>
<th>Amplification System/Cycle</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler 31</td>
<td>Low</td>
<td>L</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>N</td>
<td>3 kV for 20 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>H</td>
<td>6 kV for 30 sec</td>
</tr>
<tr>
<td>Identifiler 28</td>
<td>Normal</td>
<td>L</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>IR</td>
<td>5 kV for 20 sec</td>
</tr>
<tr>
<td>Cofiler</td>
<td>Normal</td>
<td>C</td>
<td>3 kV for 10 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>CR</td>
<td>3 kV for 20 sec</td>
</tr>
<tr>
<td>Profiler Plus</td>
<td>Normal</td>
<td>P</td>
<td>3 kV for 10 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>PR</td>
<td>3 kV for 20 sec</td>
</tr>
<tr>
<td>YM1</td>
<td>Normal</td>
<td>M</td>
<td>3 kV for 10 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>MR</td>
<td>3 kV for 20 sec</td>
</tr>
</tbody>
</table>

6. In the “type” column, fill in the appropriate letter/s for the type of the sample:

Table 8.15

<table>
<thead>
<tr>
<th>Sample Type</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Ladder</td>
<td>AL</td>
</tr>
<tr>
<td>Positive Control</td>
<td>PC</td>
</tr>
<tr>
<td>Negative Control</td>
<td>NC</td>
</tr>
<tr>
<td>Sample</td>
<td>S</td>
</tr>
</tbody>
</table>

7. 7. Proofread your sample sheet, make corrections and re-save as necessary.

8. Save the sample sheet by selecting Save As from the File menu in the format of: yoursamplesheetname.xls. Save in D:\AppliedBiosystems\Sample Sheets (xls files.)
9. Click on the tab labeled “Pre Record” in the workbook. There are two steps to take before the final Plate Record is ready to be saved and imported.
   
a. First, in order to copy the information from the “Pre-record” into the “Plate Record”, press Ctrl + the letter designation of the 3130 sheets and plate records for the particular set of run sheets. This will copy the pre-record information into the plate record sheet.
   
b. Second, while on the plate record sheet, clear any spaces or blanks from the Plate Record by pressing Ctrl + E.

10. While on the plate record sheet for the run, select Save As from the File menu and do the following:
    
a. Change Save as file type to “Text (Tab-delimited)”.
   
b. Save in D:\AppliedBiosystems\Plate Records (.plt files.)

11. Click OK (The selected file type does not support workbooks that contain multiple sheets)

12. Click Yes (Do you want to keep the workbook in this format?)

E. Foundation Data Collection (Importing Plate Record)

1. Maximize the Foundation Data Collection window.

2. Click + to expand subfolders in the left tree pane of “ga 3130xf”. All application folders are now visible.

3. Click on “Plate Manager”.

4. In the Plate Manager window click on “Import…”
8. STR ANALYSIS ON THE ABI 3130x/GENETIC ANALYZER

5. Browse for your plate record in D:\AppliedBiosystems\Current Runs. Double click on your file or highlight it and click **Open**.

6. If you followed all the rules and correctly created your Plate Record a window will prompt you that you have successfully imported your plate record. Click **OK**.
If the Plate Record will not import, a window will prompt you where you need to make your changes. Go back to edit your Excel sheet and resave your corrected Plate Record and Sample Sheet with the same file name.

7. Print your Excel Sample Sheet.


F. Preparing and Running the DNA Samples

1. Retrieve amplified samples from the thermalcycler or refrigerator. If needed, as is the case with reruns, retrieve a passing positive control from a previous passing run.

2. If condensation is seen in the caps of the tubes, centrifuge tubes briefly.
Mastermix and Sample Addition for IDENTIFILER 28 CYCLES for HSC and Exemplar teams:

1. Mastermix preparation:
   a. Prepare one mastermix for all samples, negative and positive controls, and allelic ladders as specified in Table 8.16 and on the sample sheet (26.625 µL of HIDI + 0.375 µL of LIZ per sample)

   **TABLE 8.16 – Identifiler 28**

<table>
<thead>
<tr>
<th># Samples + 2</th>
<th>HiDi Form (26.6 µL per sample)</th>
<th>LIZ500 Std (0.375 µL per sample)</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>480 µL</td>
<td>7 µL</td>
</tr>
<tr>
<td>32</td>
<td>906 µL</td>
<td>13 µL</td>
</tr>
<tr>
<td>48</td>
<td>1332 µL</td>
<td>19 µL</td>
</tr>
<tr>
<td>64</td>
<td>1758 µL</td>
<td>25 µL</td>
</tr>
<tr>
<td>80</td>
<td>2184 µL</td>
<td>31 µL</td>
</tr>
<tr>
<td>96</td>
<td>2610 µL</td>
<td>37 µL</td>
</tr>
<tr>
<td>112</td>
<td>3036 µL</td>
<td>43 µL</td>
</tr>
<tr>
<td>128</td>
<td>3462 µL</td>
<td>49 µL</td>
</tr>
</tbody>
</table>

   NOTE: HiDi Formamide must not be re-frozen.

   b. Obtain a reaction plate and label the side with the name used for the Sample Sheet with a sharpie and place the plate in an amplification tray or the plate base.

   c. Aliquot **27 µL of mastermix** to each well

   d. If an injection has less than 16 samples, add 12 uL of either dH2O, formamide, HiDi, buffer or mastermix to all unused wells within that injection.
8. STR ANALYSIS ON THE ABI 3130xL GENETIC ANALYZER

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>26 OF 48</td>
</tr>
</tbody>
</table>

Adding Samples:

a. Arrange amplified samples in a 96-well rack according to how they will be loaded into the 96-well reaction plate. Sample order is as follows: A1, B1, C1, D1... G1, H1, A2, B2, C2...G2, H2, A3, B3, C3, etc. Thus the plate is loaded in a columnar manner where the first injection corresponds to wells A1-H2, the second A3-H4 and so on.

b. Have someone witness the tube setup by comparing the tube labels and positions indicated on the sample sheet with the tube labels and positions of the tubes themselves.

c. For sample sets being run at normal parameters: Aliquot 1 µL of allelic ladder.

d. For sample sets being run at normal parameters: Aliquot 3 µL of the positive control.

e. Aliquot 3 µL of each sample and negative control from the PCR plate or tubes to the reaction plate as previously witnessed and as directed by the sample sheet.

f. When adding PCR product, make sure to pipette the solution directly into the formamide and gently flush the pipette tip up and down a few times to mix it.

g. Skip to Section G: Denature/Chill.
Mastermix and Sample Addition for Identifiler 28 Cycles for High Sensitivity and Property Crime Teams:

1. Retrieve amplified samples from the thermalcycler or refrigerator.

2. If condensation is seen in the caps of the tubes, centrifuge tubes briefly.

3. Arrange amplified samples in a 96-well rack according to how they will be loaded into the 96-well reaction plate. Sample order is as follows: A1, B1, C1, D1... G1, H1, A2, B2, C2...G2, H2, A3, B3, C3, etc. Thus the plate is loaded in a columnar manner where the first injection corresponds to wells A1-H2, the second A3-H4 and so on.

4. Have someone witness the tube setup by comparing the tube labels and positions indicated on the sample sheet with the tube labels and positions of the tubes themselves.

5. Obtain a reaction plate and label the side with the name used for the Sample Sheet with a sharpie and place the plate in an amplification tray or the plate base.

6. The Sample Sheet automatically calculates the amount of HiDi Formamide and LIZ Standard needed per sample. This information can be found at the top of the second page of the Sample Sheet.

NOTE: HiDi Formamide cannot be re-frozen.

Mastermix for 28 CYCLES:

a. Prepare one mastermix for all samples, negative and positive controls, allelic ladders as specified in Table 8.17 and on the sample sheet

   i. Add 26.625 µL of HIDI per sample
   ii. Add 0.375 µL of LIZ per sample
   iii. Aliquot 27 µL of mastermix to each well

b. If an injection has less than 16 samples, add 12ul of either dH2O, buffer or formamide/LIZ mix to all unused wells within that injection.
7. Add samples to the plate, adhering to the following guidelines:

**NOTE:** You may use a multichannel pipette to load samples. If pipetting from a 96 well PCR plate, pierce the seal.

8. **Adding Samples for 28 CYCLES:**

   a. Aliquot **3 µL** of **each sample** and **negative control** and the **positive control** from the PCR plate or tubes to the reaction plate as previously witnessed and as directed by the sample sheet.

   b. Aliquot **0.5 µL** of **positive control** or **1 µL** of 1/2 dilution (4 uL positive control in 4uL of water) into the wells labeled “PEH”. This is the positive for the “high” injection parameters.

   c. Aliquot **0.7 µL** of **allelic ladder**. If a full plate will be used, mix **6 µL** of ladder with **2.4 µL** of water and aliquot 1 µL per ladder well.

   d. Alternatively, **0.5 µL** and **1 µL** of **allelic ladder** can be used for the normal and the rerun parameters for each injection to account for differences in lots of allelic ladder.

      i. For a full plate, add 3.5 µL of ladder to 3.5 µL of water, mix, and aliquot 1 µL of this dilution.

      ii. For a half plate, add 2 µL of ladder to 2 µL of water, mix and aliquot 1 µL of this dilution.

      iii. A P2 pipet must be used to make 0.7 and 0.5 µL aliquots to avoid making dilutions and to conserve ladder.

   e. Skip to Section G: Denature/Chill
TABLE 8.17: 28 CYCLE SAMPLES FOR HIGH SENSITIVITY AND PROPERTY CRIME TEAMS

<table>
<thead>
<tr>
<th>Injection Parameters</th>
<th>Samples and negs</th>
<th>LIZ</th>
<th>HIDI</th>
<th>Allelic Ladder</th>
<th>Positive Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>3 µL</td>
<td>0.375 µL</td>
<td>26.6 µL</td>
<td>1.0 µL or (0.7 µL)*</td>
<td>3 µL</td>
</tr>
<tr>
<td>IR</td>
<td>3 µL</td>
<td>0.375 µL</td>
<td>26.6 µL</td>
<td>0.5 µL or (0.7 µL)*</td>
<td>0.5 µL</td>
</tr>
</tbody>
</table>

* Two amounts of allelic ladder, 1 µL and 0.5 µL, may be used for the normal and the rerun parameters to account for differences in lots of ladder rather than 0.7 µL, which is satisfactory for both parameters in most situations.

Mastermix and Sample Addition for Identifiler 31 for High Sensitivity Team

1. Retrieve amplified samples from the thermalcycler or refrigerator.
2. If condensation is seen in the caps of the tubes, centrifuge tubes briefly.
3. Prepare pooled samples: IDENTIFILER 31 CYCLES ONLY
   a. Centrifuge all tubes at full speed briefly.
   b. Label one 0.2 mL PCR tube with the sample name and “abc” to represent the pooled sample injection for the corresponding sample set.
   c. Take 5 µL of each sample replicate, after mixing by pipeting up and down, and place each aliquot into the “abc” labeled tube.
   d. Place each pooled sample directly next to the third amplification replicate labeled “e” of each sample set.
4. Arrange amplified samples in a 96-well rack according to how they will be loaded into the 96-well reaction plate. Sample order is as follows: A1, B1, C1, D1... G1, H1, A2, B2, C2...G2, H2, A3, B3, C3, etc. Thus the plate is loaded in a columnar manner where the first injection corresponds to wells A1-H2, the second A3-H4 and so on.
5. Have someone witness the tube setup by comparing the tube labels and positions indicated on the sample sheet with the tube labels and positions of the tubes themselves.
6. Obtain a reaction plate and label the side with the name used for the Sample Sheet with a sharpie and place the plate in an amplification tray or the plate base.

7. The Sample Sheet automatically calculates the amount of HiDi Formamide and LIZ Standard needed per sample. This information can be found at the top of the second page of the Sample Sheet.

**NOTE:** HiDi Formamide must not be re-frozen.

8. Mastermix for 31 CYCLES:

   a. Prepare the following mastermix for samples and negative controls as specified in Table 8.18 and on the sample sheet
      i. **44.6 µL** of HIDI per sample
      ii. **0.375 µL** of LIZ per sample
      iii. Aliquot **45 µL** of mastermix to each sample and negative control well

   b. Prepare a separate mastermix for allelic ladders and positive controls
      i. Add **14.6 µL** of HIDI to each AL and PE
      ii. Add **0.375 µL** of LIZ per AL and PE
      iii. Aliquot **15 µL** of mastermix to each Allelic Ladder and Positive Control well

9. If an injection has less than 16 samples, add 12ul of either dH2O, buffer or formamide/LIZ mix to all unused wells within that injection.

10. Add samples to the plate, adhering to the following guidelines:

    **NOTE:** You may use a multichannel pipette to load samples. If pipetting from a 96 well PCR plate, pierce the seal.
11. Adding Samples for Identifiler 31 Cycles:
   
a. Aliquot 5 µL of each sample (including pooled) and negative control from the amplified product into the reaction plate as previously witnessed and as directed by the sample sheet.

b. Aliquot 1 µL of a 1/10 dilution of positive control into each well labeled “PE”. Make the 1/10 dilution by mixing 2 uL of Positive Control with 18 uL water. This is the positive for the “normal” injection parameters.

c. Aliquot 1 µL of a 1/20 dilution of positive control into each well labeled “PEH”. Make the 1/20 dilution by mixing 2 uL of Positive Control with 38 uL water. This is the positive control for the “high” injection parameters.

d. Aliquot 0.5 uL of allelic ladder into each well labeled “AL”. Alternatively, make a 1/2 dilution of ladder and aliquot 1 uL per “AL” well. Make this dilution by mixing 2 uL ladder with 2 uL of water for 1-2 injections, 3 uL ladder with 3 uL of water for 3-4 injections or 4 uL ladder with 4 uL water for 5-6 injections. This is the allelic ladder for the “normal” injection parameters.

e. Aliquot 0.3 uL of allelic ladder into each well labeled “ALH”. Alternatively, make a 3/10 dilution of ladder and aliquot 1 uL per “ALH” well. Make this dilution by mixing 1 uL of ladder with 2.3 uL of water for 1-2 injections, 2 uL of ladder and 4.6 uL of water for 3-4 injections, or 3 uL of ladder with 6.9 uL water for 5-6 injections. This is the allelic ladder for “high” injection parameters.

| TABLE 8.18: 31 CYCLE SAMPLES FOR HIGH SENSITIVITY TEAM |
|-----------------|-----------------|-----------------|-----------------|
| Injection       | Samples and negs| LIZ for samples and negs | HIDI for samples and negs | Allelic Ladder | Positive Control | LIZ for ALs And PEs | HIDI for ALs And PEs |
| Parameters      | and negs        | and negs         | and negs         | 44.6 µL        | 0.5 µL          | 1µL of 1/10 dil     | 0.375 µL          |
| L               | 5 µL            | 0.375 µL         | 44.6 µL          | 0.5 µL         | 1µL of 1/10 dil | 0.375 µL          | 14.6 µL           |
| N               | 5 µL            | 0.375 µL         | 44.6 µL          | 0.5 µL         | 1µL of 1/10 dil | 0.375 µL          | 14.6 µL           |
| H               | 5 µL            | 0.375 µL         | 44.6 µL          | 0.3 µL         | 1µL of 1/20 dil | 0.375 µL          | 14.6 µL           |

12. Proceed to Section G: Denature/Chill

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
Mastermix and sample addition for Cofiler, Profiler+, and Y STR

Refer to the tables below to determine the amount of HiDi Formamide and appropriate standard to use for the number of samples you have (tables list reagent amount for n+2 samples; thus extra will remain in the tube). To prepare mix for (n+2) samples: For Cofiler/Profiler/YM1: 9.5 μL of HiDi Formamide + 0.5 μL of GS500 Rox Standard or Liz Standard is mixed per sample.

Table 8.19 (a) and (b)

<table>
<thead>
<tr>
<th>Cofiler &amp; Profiler</th>
<th>YM1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td># Samples + 2</td>
</tr>
<tr>
<td></td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>96</td>
</tr>
<tr>
<td></td>
<td>112</td>
</tr>
<tr>
<td></td>
<td>128</td>
</tr>
</tbody>
</table>

1. For Cofiler/Profiler/YM1, aliquot 10 μL of the formamide/standard mixture into each well being used on the 96-well reaction plate.

2. If an injection has less than 16 samples, add 12ul of either dH2O, buffer or formamide/standard mix to all unused wells within that injection.

3. Rerun “high” samples cannot be on the same injection as non rerun samples.
Rerun “normal” samples may be integrated with non rerun samples.

4. Have someone witness the tube setup by comparing the tube labels and positions indicated on the sample sheet with the tube labels and positions of the tubes themselves.
5. Add samples to the plate, adhering to the following guidelines:

For samples being run at normal parameters for Cofiler/Profiler/YM1:
   a. add 1 μL of allelic ladder (Cofiler and Profiler only)
   b. add 2 μL of PCR product (including the positive control)

For samples being rerun normal at a 1/10 dilution:
   a. add 2 μL of a 1/10 dilution

For samples being run at rerun high parameters:
   a. add 4 μL of a 1/10 dilution of the positive control and/or allelic ladder
   b. add 4 μL of PCR product

6. When adding PCR product, make sure to pipette the solution directly into the formamide and gently flush the pipette tip up and down a few times to mix it.

7. Proceed to section G for denature/chill.

G. Denature/Chill - For All Systems After Sample Addition:

1. Once all of the samples have been added to the plate, place a new 96-well Septa over the reaction plate and firmly press the septa into place.

2. Spin plate in centrifuge at 1000 RPM for one minute.

3. For Denature/Chill:
   a. 9700 Thermocycler
      i. Place the plate on a 9700 thermocycler (Make sure to keep the thermocycler lid off of the sample tray to prevent the septa from heating up.)
      ii. Select the “denature/chill” program.
      iii. Make sure the volume is set to 12 μL for Cofiler/Profiler/YM1, 30 μL for Identifiler 28, and 50 μL for Identifiler 31.
iv. Press Run on the thermocycler. The program will heat denature samples at 95°C for 5 minutes followed by a quick chill at 4°C (this will run indefinitely, but the plate should be left on the block for at least 5 minutes).

v. While the denature/chill is occurring, you can turn on the oven.

b. Heat Block

i. Place the plate on a 95°C heat block for 5 minutes.

ii. Place the plate on a 4°C heat block for 5 minutes.

H. Turning the Oven on and Setting the Temperature

1. In the tree pane of the Data Collection v3.0 software click on GA Instrument > ga3130xl > instrument name > Manual Control

2. Under Manual Control “Send Defined Command For:” click on Oven.

3. Under “Command Name” click on “Turn On/Off oven”.

4. Click on the “Send Command” button.

5. Under “Command Name” click on “Set oven temperature” and Under “Value” set it to 60.
6. Click on the “Send Command” button.

7. Once denatured, spin the plate in centrifuge at 1000 RPM for one minute before placing the reaction plate into the plate base. Secure the plate base and reaction plate with the plate retainer.

**IMPORTANT:** Damage to the array tips will occur if the plate retainer and septa strip holes do not align correctly.  

Do not write on the septa with pen, markers, sharpies, etc.  Ink may cause artifacts in samples.  Any unnecessary markings or debris on the septa may compromise instrument performance.
I. Placing the Plate onto the Autosampler (Linking and Unlinking Plate)

1. In the tree pane of the Foundation Data Collection v3.0 software click on GA Instrument > ga3130xl > instrument name > Run Scheduler > Plate View

2. Push the tray button on the bottom left of the machine and wait for the autosampler to move forward and stop at the forward position.

3. Open the doors and place the tray onto the autosampler in the correct tray position, A or B. There is only one orientation for the plate. (The notched end faces away from you.)

4. Ensure the plate assembly fits flat in the autosampler. Failure to do so may allow the capillary tips to lift the plate assembly off of the autosampler.

When the plate is correctly positioned, the plate position indicator on the Plate View window changes from gray to yellow. Close the instrument doors and allow the autosampler to move back to the home position.

**NOTE:** When removing a plate from the autosampler, be careful not to hit the capillary array. Plate B is located directly under the array, so be especially careful when removing this tray.
8. STR ANALYSIS ON THE ABI 3130xL GENETIC ANALYZER

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>37</td>
</tr>
</tbody>
</table>

Linking/Unlinking the Plate Record to Plate

5. Type the exact plate name in the Plate ID window and click “Search.” Or, click the “Find All” button and select the desired plate record.

**NOTE:** If you do not type the plate name correctly, your plate will not be found. Instead, you will be prompted to create a new plate. Click “No” and retype the plate name correctly.

Click the plate position indicator corresponding to the plate position in the instrument. The plate position (A or B) displays in the link column.

**NOTE:** It may take a minute for the plate record to link to the plate depending on the size of the sample sheet.

If two plates are being run, the order in which they are run is based on the order in which the plates were linked.

6. The plate position indicator changes from yellow to green when linked correctly and the green run button becomes active.
8. STR ANALYSIS ON THE ABI 3130xl GENETIC ANALYZER

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>38 OF 48</td>
</tr>
</tbody>
</table>

7. To unlink a plate record just click the plate record you want to unlink and click “Unlink”.

J. Viewing the Run Schedule

1. In the tree pane of the Foundation Data Collection software, click GA Instruments > ga3130xl > instrument name > Run Scheduler > Run View.

2. The RunID column indicates the folder number(s) associated with each injection in your run (e.g. Run_Venus_2006-07-13_0018-0019). These folder number(s) should be recorded in the 3130xl Usage Log binder along with the run control sheet name.

3. Click on the run file to see the Plate Map or grid diagram of your plate on the right. Check if the blue highlighted boxes correspond to the correct placement of the samples in the injections.

NOTE: Before starting a run, check for air bubbles in the polymer blocks. If bubbles are present, click on the Wizards tool box on the top and select “Bubble Remove Wizard”. Follow the wizard until all bubbles are removed.

4. Click on green Run button in the tool bar when you are ready to start the run. When the Processing Plate dialog box opens (You are about to start processing plates…), click OK.
8. STR ANALYSIS ON THE ABI 3130xl GENETIC ANALYZER

5. To check the progress of a run, click on the Capillary Viewer or Cap/ArrayViewer in the tree pane of the Foundation Data Collection software. The Capillary Viewer will show you the raw data of the capillaries you select to view whereas the Cap/Array Viewer will show the raw data of all 16 capillaries at once.

IMPORTANT: Always exit from the Capillary Viewer and Cap/Array Viewer windows. During a run, do not leave these pages open for extended periods. This may cause unrecoverable screen update problems. Leave the Instrument Status window open.

The visible settings should be:
- EP voltage 15kV
- EP current (no set value)
- Laser Power Prerun 15 mW
- Laser Power During run 15mW
- Laser Current (no set value)
- Oven temperature 60°C

Expected values are:
- EP current constant around 120 to 160μA
- Laser current: 5.0A ± 1.0
It is good practice to monitor the initial injections in order to detect problems.

Table 8.20

<table>
<thead>
<tr>
<th></th>
<th>I/L</th>
<th>IR</th>
<th>N</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oven Temp</td>
<td>60°C</td>
<td>60°C</td>
<td>60°C</td>
<td>60°C</td>
</tr>
<tr>
<td>Pre-Run Voltage</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
</tr>
<tr>
<td>Pre-Run Time</td>
<td>180 sec</td>
<td>180 sec</td>
<td>180 sec</td>
<td>180 sec</td>
</tr>
<tr>
<td>Injection Voltage</td>
<td>1 kV</td>
<td>5 kV</td>
<td>3 kV</td>
<td>6 kV</td>
</tr>
<tr>
<td>Injection Time</td>
<td>22 sec</td>
<td>20 sec</td>
<td>20 sec</td>
<td>30 sec</td>
</tr>
<tr>
<td>Run Voltage</td>
<td>15 kV</td>
<td>15 kV</td>
<td>15 kV</td>
<td>15 kV</td>
</tr>
<tr>
<td>Run Time</td>
<td>1500 sec</td>
<td>1500 sec</td>
<td>1500 sec</td>
<td>1500 sec</td>
</tr>
</tbody>
</table>

Table 8.21

<table>
<thead>
<tr>
<th></th>
<th>C/P/M</th>
<th>CR/PR/MR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oven Temp</td>
<td>60°C</td>
<td>60°C</td>
</tr>
<tr>
<td>Pre-Run Voltage</td>
<td>15.0 kV</td>
<td>15.0 kV</td>
</tr>
<tr>
<td>Pre-Run Time</td>
<td>180 sec</td>
<td>180 sec</td>
</tr>
<tr>
<td>Injection Voltage</td>
<td>3 kV</td>
<td>3 kV</td>
</tr>
<tr>
<td>Injection Time</td>
<td>10 sec</td>
<td>20 sec</td>
</tr>
<tr>
<td>Run Voltage</td>
<td>15 kV</td>
<td>15 kV</td>
</tr>
<tr>
<td>Run Time</td>
<td>1500 sec</td>
<td>1500 sec</td>
</tr>
</tbody>
</table>

K. Converting Run for GeneScan Analysis

When a run is complete, it will automatically be placed in D:/AppliedBio/Current Runs folder, properly labeled with the instrument name, date and runID (e.g. Run_Venus_2006-07-13_0018). Proceed to Section 7 for instructions on how to convert this data for GeneScan analysis.
L. **Reinjection Plates**

1. Plates should be reinjected as soon as possible, preferably the same day.

2. If a plate is being re-injected the same day on which it was originally run, it does not require an additional denature/chill step before being re-run.

3. Create a new sample sheet and plate record using the original sample sheet as a guide. Select only those samples that need to be re-run by re-assigning “sys”. For example, assign “IR” for an ID28 sample that needs to be re-run high.

   **NOTE:** See Section 5 for information on which controls need to be run.

4. Next to **Sample Sheet**, type the new run name. Next to **Original Plate Name**, insert the original run name (e.g. Venus041706_35-39).

5. Under **Reinjection** insert the original run date and run number (e.g. Venus041706_35).

6. Follow the instructions for saving a sample sheet and creating a plate record. Re-import the plate record.

7. Re-denature/chill the plate (if needed) as described in Section G or set-up a new plate as described in Section F.
M. Water Wash and POP Change

Refer to Section C for schematic of 3130/ while proceeding with the water wash and POP change procedure.

1. Remove a new bottle of POP4 from the refrigerator.
2. Select Wizards > Water Wash Wizard
3. Click “Close Valve”
4. Open instrument doors and remove the empty POP bottle.
5. With a dampened Kimwipe® wipe the polymer supply tube and cap. Dry.
6. Replace POP bottle with the water bottle filled to the top with Gibco® Water.
7. Remove, empty, and replace the anode buffer jar on the lower polymer block.
8. Click “Water Wash.” This procedure is will take approximately 4 minutes.
9. When the water wash is finished click “Next”
10. Select “Same Lot” or “Different Lot”
11. Remove water bottle from the lower polymer block. Dry supply tube and cap with a Kimwipe®.
12. Replace with a new bottle of room temperature POP.
13. Click “Next.”
14. Click “Flush.” This will take approximately 2 minutes to complete.
15. Inspect the pump block, channels, and tubing for air bubbles.
16. Click “Next.”
17. Carefully inspect the pump blocks and pump channels for bubbles.
   a. If there are bubbles click “Yes, Bubbles are present” and the “Remove bubbles” icon. Wait approximately one minute. Repeat until all bubbles are removed.
   b. If bubbles are not present click “No, All bubbles are gone” and click “Next.”
18. Flush the array port by loosening the knob 1 turn counterclockwise.
19. Click “Flush Array Port.” Repeat if necessary.
20. When all the bubbles are gone, tighten the array port knob clockwise until it is flush against the pump block.

21. Click “Bubbles are gone” icon then “Next.”

22. Close instrument doors and wait for steady green light.

23. Click “Fill Array.” Filling the array will take approximately 2 minutes.

24. When this is completed, remove the anode buffer jar, empty, and fill with 1x TBE Buffer (~15 mL).

25. Close instrument doors and wait for the steady green light.

26. Click “Finish.”

N. Cleanup Database Utility

1. Open the Foundation Data Collection Window of the 3130 software.
2. In the left hand panel, click on “GA Instruments”.
3. Click on “Database Manager”.
4. Click the “Cleanup Processed Plate” button.
5. This will erase the database and reset the run number to 0. Therefore, the next plate run after this process will be labeled run number 1. Verify this information for the usage log.
TROUBLESHOOTING GUIDE

This section is provided as a guide. The decision on which of the recommended actions is the most promising should be made after consultation with a supervisor.

PROBLEM: Many artifacts in sample

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary structure present. Sample not denatured properly</td>
<td>1. Clean pump block and change polymer to refresh the urea environment.</td>
</tr>
<tr>
<td></td>
<td>2. Denature chill samples.</td>
</tr>
</tbody>
</table>

PROBLEM: Decreasing peak heights in all samples

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poor quality formamide or sample environment very ionic.</td>
<td>Realiquot samples with fresh HIDI</td>
</tr>
</tbody>
</table>

PROBLEM: Individual injections run at varying speeds. For example, the scan number where the 100 bp size standard appears significantly differs from one injection to another, usually appearing earlier.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warm laboratory temperatures.</td>
<td>1. Redefine size standard.</td>
</tr>
<tr>
<td></td>
<td>2. If this fails, reinject.</td>
</tr>
</tbody>
</table>
### 8. STR ANALYSIS ON THE ABI 3130xl GENETIC ANALYZER

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>46 OF 48</td>
</tr>
</tbody>
</table>

**PROBLEM:** Loss of resolution of peaks

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss of resolution of peaks</td>
<td>1. Clean pump block and change polymer to refresh the urea environment.</td>
</tr>
<tr>
<td></td>
<td>2. Denature chill samples.</td>
</tr>
</tbody>
</table>

**PROBLEM:** An off ladder peak appears to be a pull up, but it is not exactly the same basepair as the true peak.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Matrix over-subtraction. Usually in the green channel, the true peak is overblown and is split.</td>
<td>Remove off ladder peaks as matrix over-subtraction</td>
</tr>
<tr>
<td>2. Pull up peaks appear in the blue and the red channels.</td>
<td></td>
</tr>
<tr>
<td>3. In the yellow channel, there is a negative peak at the base pairs of the true peak, however immediately to the right and to the left are off ladder peaks.</td>
<td></td>
</tr>
</tbody>
</table>

**PROBLEM:** Peaks overblown and running as off ladder alleles

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>More than 100 pg of sample amplified.</td>
<td>1. Rerun samples at lower injection parameters</td>
</tr>
<tr>
<td></td>
<td>2. Or rerun samples with 1 or 3 µL</td>
</tr>
</tbody>
</table>
## 8. STR ANALYSIS ON THE ABI 3130xl GENETIC ANALYZER

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>47 OF 48</td>
</tr>
</tbody>
</table>

### PROBLEM: Pull up peaks

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors bleeding into other colors</td>
<td>Run a spectral</td>
</tr>
</tbody>
</table>

### PROBLEM: Spikes in the electropherogram

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystals in the polymer solution due to the polymer warming and congealing from fluctuations in the room temperature.</td>
<td>Change the polymer.</td>
</tr>
</tbody>
</table>

### PROBLEM: Spikes in electropherogram and artifacts

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arcing: water around the buffer chambers</td>
<td>Clean chambers; beware of drops accumulating around the septa.</td>
</tr>
</tbody>
</table>

### PROBLEM: Split peaks

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower pump block is in the process of burning out due to the formation of a bubble.</td>
<td>Clean the block.</td>
</tr>
</tbody>
</table>

### PROBLEM: Increasing number of spurious alleles

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extraneous DNA in reagents, consumables, or instrument</td>
<td>1. Stop laboratory work under advisement of technical leader.</td>
</tr>
<tr>
<td></td>
<td>2. Implement a major laboratory clean-up.</td>
</tr>
</tbody>
</table>
## 8. STR ANALYSIS ON THE ABI 3130xl GENETIC ANALYZER

<table>
<thead>
<tr>
<th>Problems</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. 3130xl not cooperating</td>
<td>2. Restart collection software.</td>
</tr>
<tr>
<td></td>
<td>4. Call Service</td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
A. Converting Run for GeneScan Analysis

Prior to importing *.fsa files into GeneScan, the files must have been converted using the HIDDyeBUtility conversion tool.

1. On the desktop, click on the shortcut for the RJW conversion program.

2. On the top of the RJW conversion program window click on the “Choose Starting Directory” button.

3. Browse the Current Runs Folder for your run folder(s) (e.g. Run_Venus_2006-07-13_0018).
4. Double click on your run folder(s) then hit Open. The run folder(s) are now converted and are now ready to be analyzed in GeneScan.

B. Archiving Converted Data and Sample Sheets

The external analysis stations for 3130xl data are on the OCME network, but the 3130xl computers are not. The data from the 3130xl’s must be copied to a flash drive and moved onto the network for analysis.

For the HSC, PC, and Exemplar Teams:

1. When a run is finished, locate the injection folders on the 3130xl instrumental computer that were generated during the course of the run. These folders are in the Current Runs folder that is located on the desktop of the instrumental computer.

2. Create and organize a new folder for each amplification system used (e.g., coffiler, profiler plus) to contain the injection folders. Name this folder(s) with the filename according to your sample sheet (e.g., Stripes04-009Co). This new folder will be referred to as the common runs folder(s).

Keep in mind that when two or more different amplification systems are used, several common runs folders will be needed (see examples below).

Example #1: A Coffiler and a Profiler Plus amplification set were run on Stars with the following sample sheet name: Stars04-008Co-003Pro. Two common run folders will need to be created with the following names: Stars04-008Co and Stars 04-003Pro.
Example #2: Two Cofiler amplification sets were run on Stars with the following sample sheet name: Stars04-010Co. Only one common run folder needs to be created with the same name (Stars04-010Co) even though following analysis, two Genotyper files will be generated with names corresponding to each amplification set as follows: Stars04-010CoA and Stars04-010CoB.

**Note:** Be sure to also include a copy of the run’s sample sheet in the common runs folder. Sample sheets are located in the sample sheet folder on the desktop. It is necessary to save only the .xls file (not the .plt file). If more than one common runs folder is created, then each should contain a copy of the sample sheet.

3. Insert a flash drive into the USB port of the instrumental computer.

4. Copy the common runs folder(s) onto the flash drive by clicking and dragging the common runs folder(s) onto the flash drive icon located on the desktop.

5. Eject the flash drive from the instrumental computer and take it over to the network computer, and ‘Drag-and-drop’ files directly from the flash drive onto the STR analysis drive on the network. Once saved to the network, delete the files from the flash drive and return the flash drive to the 3130xl instrumental computer.

6. Proceed with the project and Genotyper analysis according to the protocol described in the STR Analysis on the 3130xl Capillary Electrophoresis Genetic Analyzer and Genotyper sections of the STR manual.

7. After analysis is completed and Genotyper files have been saved in the Common run folder, copy the Common run folder to the Archive folder. These folders are organized on each analysis station according to the following hierarchy:

   - Archive folder
   - Instrument folders (e.g., Stars, Stripes; located in the Archive folder)
   - Amplification system folders (e.g. Cofiler, Profiler Plus; located in the instrument folders)
For the High Sensitivity Team:

1. When an injection is complete, the data will automatically be placed in the D:/AppliedBio/Current Runs folder, properly labeled with the instrument name, date and runID (e.g. Run_Venus_2006-07-13_0018).

2. After conversion of the data in each run folder (described above in section A), copy the relevant run folders as well as the sample sheets to a USB jump drive.

3. Transfer the run files from the USB jump drive to the appropriate data drive on the network.
   a. The run folders should be stored on the network in the run folder of the instrument on which they were run.
   b. The sample sheets should be stored on the network in the sample sheets folder of the instrument on which they were run.

4. After confirming that the files are on the network, delete the files from the jump drive.

5. Follow the analysis procedure as outlined in Chapter 8A of the Forensic STR Analysis Protocol.

   NOTE: When analyzing in Genescan, the size standard column must be changed from HID Fragment Analysis to the respective system the samples were typed in.

C. Backup of Data

All of the 3130x data, once loaded on the network drive, will be backed up in a process by DoITT, and stored in archives on and off site of the OCME building.
Prior to importing *.fsa files into GeneScan, the files must have been converted using the conversion tool. Refer to the “STR Data Conversion and Archiving” Section of this manual. For a regular 3130xl run, all collected data will have been auto analyzed based on the default settings (see below).

The following steps show how manual analysis can be done if the auto analysis did not take place.

A. Access to GeneScan

1. Click on the GeneScan shortcut located on the desktop of the analysis station computer.

2. Create a new GeneScan project by clicking **File Æ New (Ctrl+N)**. A dialog box with several icons will pop up. Click on the project icon.

An untitled Analysis Control window opens.
3. To add sample files to the open analysis control window, click on Project from the menu options and select Add Sample Files.

4. When the Add Sample Files dialog window appears, find the Current Run folder containing the injection folders with the samples that you want to add to the project. Find the specific injection folder(s) that you have previously documented on your sample sheet and open by double-clicking on the folder icon of interest. At this point you will see icons representing each individual sample, all belonging to one injection.
To add samples to a project, take the following action:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a single sample file</td>
<td>Double-click the file OR select the file and click Add</td>
</tr>
<tr>
<td>Select all the sample files</td>
<td>Click Add All</td>
</tr>
<tr>
<td>Add a continuous list of sample files</td>
<td>a. Click the first sample that you want to add.</td>
</tr>
<tr>
<td></td>
<td>b. Press the Shift key and click the last sample you want to add. Click Add.</td>
</tr>
<tr>
<td></td>
<td>All the files between the first and last file are selected.</td>
</tr>
<tr>
<td>Add a discontinuous list of samples</td>
<td>a. Click the first sample that you want to add</td>
</tr>
<tr>
<td></td>
<td>b. Press the Control key and then click on the other sample(s) you want to add. Click Add.</td>
</tr>
<tr>
<td></td>
<td>All the files you selected will be highlighted and selected.</td>
</tr>
</tbody>
</table>

5. Click Finish when you have added all of the samples.

B. Analysis Settings

The Analysis Control window shows in separate columns the dye lanes, sample file names, size standard options, and analysis parameters to choose for each lane. Boxes for the red or orange dye lane should be marked with diamonds to indicate that this is the color for the size standard.

The samples have been auto analyzed and the matrix was installed during collection. The 3130xl GeneScan Software does not place check marks in the dye lane boxes to indicate that the sample has been analyzed. Normally it is not necessary to reanalyze the samples.
The auto analysis should have been performed using the following predefined files:

<table>
<thead>
<tr>
<th>System</th>
<th>Size Standard File</th>
<th>Analysis Parameter File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cofiler</td>
<td>GS500All.szs</td>
<td>GS500Analysis.gsp</td>
</tr>
<tr>
<td>Profiler Plus</td>
<td>GS500All.szs</td>
<td>GS500Analysis.gsp</td>
</tr>
<tr>
<td>YM1</td>
<td>Ystr.szs</td>
<td>YM1.gsp</td>
</tr>
<tr>
<td>Identifiler</td>
<td>LIZ-250-340.szs</td>
<td>LIZAnalysisParameters.gsp</td>
</tr>
<tr>
<td>PowerPlex 16</td>
<td>ILS600.szs</td>
<td>ILS600.gsp</td>
</tr>
</tbody>
</table>

1. **Identifiler Analysis Parameters**
   Do not change any of the settings except the range or the peak amplitude threshold for Orange (O) which may be lowered to 25 rfu.
2. **Cofiler and Profiler Plus Analysis Parameters**

Do not change any of the settings except the range or the peak amplitude threshold for Red®.
3. **YM1 Analysis Parameters**  
Do not change any of the settings except the range or the peak amplitude threshold for Orange (O).

![YM1 gsp]

C. **Analysis**

To ensure that all the sizing results are correct, check the labeling of the size standard peaks for each sample.

1. To view the analysis results, select **Windows** from the main menu and click on **Results Control**. The analyzed colors for each lane are shown in dark grey. The white squares mean that this color has not been analyzed.

2. The raw data can be seen in up to 8 display panels, by changing the # of panels to 8. To view each color separately, check **Quick Tile to On**.
3. Select the first 8 size standard dye lanes by clicking on them and then click **Display**. Each sample standard will be displayed in its own window. To view all 8 standards, you must scroll through all of the windows. Make sure that all peaks are correctly labeled. Continue checking your size standard for the entire tray by going back to the **Results Control** window, clicking on **Clear All** and selecting the next 8 samples. Repeat these steps until all of the sample size standards have been checked.

**IMPORTANT:** For ABI 3130 runs, the 250bp fragment in the Identifiler LIZ Orange Size Standard may not be labeled as 250. However, for PowerPlex ILS600, the 250bp fragment must be labeled as such. In Identifiler, the 340bp fragment is also not labeled.

**Identifiler LIZ Orange Size Standard**

![Size Standard](image1)

**Profiler Plus/Cofiler ROX GS500**

![Size Standard](image2)

**YM1 STRs LIZ GS500**

![Size Standard](image3)
PowerPlex16 ILS600:

Before proceeding with the Genotyper analysis, under **File** select **Save Project As**. The project will be named according to the Sample Sheet name. This file will save as a *.prj file in the run folder.

**D. Analysis Troubleshooting**

The error message for a failed analysis is: “Analysis failed on Dye B, G, Y, R. Repeat the above choosing another scan range.”

If the sample fails to be analyzed, select the sample and under **View Æ Raw**. Alternatively, double click on the sample name. If there is no evidence of size standard peaks, the sample fails. Note on the editing sheet that the sample needs to be re-injected.

If peaks are present take the following steps:

1. Check the height of the size standard.
   
   a. **Examining the Raw Data** to check the peak height of the size standard fragments.
   
   b. **Access Analysis Parameters** and lower the size standard threshold for red (R) or orange (O), depending on the system, to 25.
   
   c. Reanalyze samples.
2. Change the analysis parameters
   a. It is also possible, that the run was either to fast or to slow. The analysis range may need to be changed. Look at raw data by highlighting a sample and under **Sample** choose **Raw data**.
   b. Observe where the first size standard is located in the sample and change the analysis parameters to approximately 25 bp less than that datapoint. Under **Settings** go to **Analysis Parameters** and extend the range.
   c. Alternatively, in the sample list, go to the Parameter drop down menu (click on arrow) and select “Analysis Parameters” instead of the default analysis parameter file for the system. Change the range and reanalyze the samples.

   **Do not change the settings in the template parameter files; do not create any new parameter files.**
   d. If the auto-analysis did not work for the whole sample set, it is possible that “auto analysis” was not selected before the collection or that the wrong .gsp file was attached. In the sample list, go to the **Parameter** drop down menu (click on arrow) and select the appropriate analysis parameter file for your project (see Table above). Reanalyze samples.

   **NOTE:** For Identifiler, if the last two orange size standards, 490 and 500, are not visible, change the size call range to “this range” and adjust the maximum to 450. At least the 100 -450 bp size standards must be apparent.

3. If the baseline of the size standard is noisy, raise the RFU threshold of the red or orange to above the noise level.
   a. Alternatively, **redefine the size standard**. Select the size standard column in the sample and Define new. The size standard peaks will appear and at the appropriate peak, type the label in the column (see above for correct values).
b. Save the standard as the name of the sample for example.

c. If the software crashes, close the project and open the size standard project and define the standard according to the relevant sample and save the redefined standard in the size standard folder. From the Analysis control window, go to the Size Standard column and click on the small arrow on the right side of the cell of one of your samples, click on it and go to Define New.

d. From here a window displaying that samples size standard will appear. Label all necessary peaks as shown above.

NOTE: For runs using GS500 size standard, skip the 250bp peak since it may not be labeled as 250. For Identifiler LIZ runs do not define the 250 bp and the 340bp size standards. If you label these peaks with a value, your analysis will FAIL.

e. When you are done defining the new size standard, click the “X” in the upper right corner of the box and save the new standard that you defined by clicking on “Save”. Name the size standard whatever you wish. Select this size standard for the analysis of all the failed samples.

ATTENTION: all re-analysis results and parameter changes are automatically written to the individual sample files, even if the changes to the project are not saved. Do not re-analyze casework data without a reason.
11. GENOTYPER ANALYSIS

For 3130x/ instruments, multiple sets of amplifications can be run in one tray. If the amplifications were done in different multiplex systems, it is necessary to perform the Genotyper analysis separately using the appropriate template. For two amplifications in the same system it is optional to process them together or separately.

I. COFILER, PROFILER PLUS, YM1, AND POWERPLEX 16

A. Open the Genotyper macro for the desired amplification system by clicking on the appropriate Genotyper shortcut on the desktop of the analysis station computer. Under File go to Import and select From GeneScan File. If the Current Runs folder does not already appear in the window, scroll to find it from the pull-down menu and double-click on it. Double-click on the folder containing the project that you created in GeneScan. Click Add or double-click on the project icon to add the project for analysis. When the project has been added, click Finish.

B. Under View select Show Dye/Lanes window you will see a list of the samples you have imported from GeneScan analysis. If samples need to be removed, highlight the lanes for these samples and select Cut from the Edit menu.

C. Change the name of the Genotyper template to your initials and the casework run file name (under File select Save As).

For example: “Stripes04-Co001 LAR” for Cofiler runs, “Stars05-Pro001 EL” for Profiler Plus runs, “Stars08-Y001 JLS” for YM1 runs, or “Stars08-PP16001 CMK” for PowerPlex 16 runs

D. After importing the project and saving the Genotyper file run the first Macro by simultaneously press Control key and the number 1, or double clicking "kazam".
11. GENOTYPER ANALYSIS

E. The plot window will appear automatically when the macro is completed. For Cofiler, Profiler Plus and PowerPlex 16 check to make sure that the ladders that were run match the appropriate allele sequences shown below. Also check the results for the positive control for all systems, including YM1. The plots will also display either orange or red size standard (dependent on the system).

Table 11.1

<table>
<thead>
<tr>
<th>Multiplex System</th>
<th>Necessary ROX GS500 standard peaks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cofiler</td>
<td>10 fragments from 75 - 350 bp</td>
</tr>
<tr>
<td>Profiler Plus</td>
<td>11 fragments from 75 - 400 bp</td>
</tr>
<tr>
<td>YM1</td>
<td>9 fragments from 139-400 bp</td>
</tr>
<tr>
<td>PowerPlex 16</td>
<td>21 fragments from 80-600</td>
</tr>
</tbody>
</table>

Necessary LIZ GS500 standard peaks

Necessary ILS600 standard peaks
Table 11.2 The genotype of the Cofiler Positive Control

<table>
<thead>
<tr>
<th></th>
<th>D3S1358</th>
<th>D16S539</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Label</td>
<td>14, 15</td>
<td>11, 12</td>
</tr>
<tr>
<td>Green Label</td>
<td>X</td>
<td>8, 9.3</td>
</tr>
<tr>
<td>Yellow Label</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(D3S1358 and D16S539 values in basepairs correspond to an ABI 3130xl capillary run.)
11. GENOTYPER ANALYSIS

Table 11.3 The genotype of the Profiler Plus Positive Control

<table>
<thead>
<tr>
<th>Labeled</th>
<th>D3S1358</th>
<th>VWA</th>
<th>FGA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Label</td>
<td>14, 15</td>
<td>17, 18</td>
<td>23, 24</td>
</tr>
<tr>
<td>Green Label</td>
<td>Amelogenin</td>
<td>D8S1179</td>
<td>D21S11</td>
</tr>
<tr>
<td>13</td>
<td>30</td>
<td>15, 19</td>
<td></td>
</tr>
<tr>
<td>Yellow Label</td>
<td>D5S818</td>
<td>D13S317</td>
<td>D7S820</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>10, 11</td>
<td></td>
</tr>
</tbody>
</table>

(Basepair sizes in the figure above correspond to an ABI 3130xl capillary run.)
11. GENOTYPER ANALYSIS

Table 11.4 The genotype of the positive control for YM1

<table>
<thead>
<tr>
<th></th>
<th>DYS19</th>
<th>DYS389 I</th>
<th>DYS389 II</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow label</td>
<td>14</td>
<td>13</td>
<td>29</td>
</tr>
<tr>
<td>Blue label</td>
<td></td>
<td>DYS390</td>
<td></td>
</tr>
<tr>
<td></td>
<td>24</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
11. GENOTYPER ANALYSIS

Table 11.5 The genotype of the PowerPlex 16 Positive Control is:

<table>
<thead>
<tr>
<th></th>
<th>D3S1358</th>
<th>THO1</th>
<th>D21S11</th>
<th>D18S51</th>
<th>Penta E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Label</td>
<td>14, 15</td>
<td>8, 9.3</td>
<td>30</td>
<td>15, 19</td>
<td>12, 13</td>
</tr>
<tr>
<td>D5S818</td>
<td>D13S317</td>
<td>D7S820</td>
<td>D16S539</td>
<td>CSF1PO</td>
<td>Penta D</td>
</tr>
<tr>
<td>Green Label</td>
<td>11</td>
<td>11</td>
<td>10, 11</td>
<td>11, 12</td>
<td>10, 12</td>
</tr>
<tr>
<td>vWA</td>
<td>D8S1179</td>
<td>TPOX</td>
<td>FGA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yellow Label</td>
<td>17, 18</td>
<td>13</td>
<td>8</td>
<td>23, 24</td>
<td></td>
</tr>
</tbody>
</table>
F. For Cofiler, Profiler, and PowerPlex 16, if the alleles for the positive control are shifted one step towards a higher allele number, this is an indication that the first allele of the allelic ladder has been assigned incorrectly (see troubleshooting). For PowerPlex 16 only, check the allelic ladder (paying special attention to FGA alleles 18.2, 19.2, 20.2, 21.2, 22.2) and click on the 0.2 peaks that were not labeled by the macro. (The ladder has worked correctly but a default filter has removed those labels. You are replacing those labels.)

Cofiler Allelic Ladder:
Forensic Biology Protocols for Forensic STR Analysis

11. Genotyper Analysis

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.
PowerPlex 16 Allelic Ladder
11.   GENOTYPER ANALYSIS

Table 11.6

<table>
<thead>
<tr>
<th>System</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cofiler</td>
<td>90 to 330</td>
</tr>
<tr>
<td>Profiler Plus</td>
<td>90 to 360</td>
</tr>
<tr>
<td>YM1</td>
<td>120 to 410</td>
</tr>
<tr>
<td>Power Plex 16</td>
<td>90 to 480</td>
</tr>
</tbody>
</table>

To compare the red or orange electropherograms with the other color lanes, hold down the shift key and either click on the red “R” box or orange “O” box in the upper left hand corner, or under edit go to select +red or +orange. Before printing the plots the red or orange electropherograms must be deselected, and the other three colors re-selected as above.
K. For all instrument platforms, fill out the Genotyper Editing Sheet for each sample number and note the reason for removal of a peak using the number code above. Refer to the editing section for the criteria for peak removal.

L. At this stage it is also necessary to make decisions about samples that should be rerun with either more or less amount of amplification product. Refer to the Section V Re-injection Guidelines.

M. After the editing has been finished scroll through the plot window to double-check.

N. Create a table by running the Create Table Macro.

1. Simultaneously press Control key and the number 2, table will open.

2. Compare the sample information in the table with the amplification and the run control sheet. If an error is detected at this point it can be corrected as follows:
   a. Open the dye/lane window or “sample info box”
   b. Place the cursor in the sample info box and correct the text
   c. Clear the table by going to Analysis on the main menu, select Clear Table
   d. Select the appropriate colors by shift clicking on the dye buttons or using edit
   e. Run Create Table Macro again

Continue to Step Q and print the controls according to the directions. After the printing has finished, continue with next step.

O. Peak height labels are to be added to evidence-sample runs only. When processing, select the controls and case samples separately in order to add peak height labels to the evidence sample electropherograms. Follow the direction below for the different types of samples:
EVIDENCE SAMPLE RUNS

1. Open the Dye Lane Window (under View) and select blue and yellow for YM1 and blue, green, and yellow for Cofiler, Profiler Plus, and PP16 for all lanes containing controls (allelic ladder for Co, Pro and PP16, positive control, and all negative controls). In order to select multiple labels it is necessary to hold down the Control-key while clicking on the lanes. The controls might not all be at the beginning of the run, do not forget any microcon samples placed elsewhere. Go to View and open the Plot Window.

Under Analysis select Change Labels. A dialogue box appears giving you the option of labels to assign to the peaks. Select Size in bp and Category name. Click ok. Continue to Step Q and print the controls according to the directions. After the printing has finished, continue with next step.

2. After the printing has finished, open the Dye Lane Window again (under View) and select blue and yellow for YM1 and blue, green, and yellow for Cofiler, Profiler, and PP16 for all lanes containing casework-samples. In order to select multiple labels it is necessary to hold down the Control-key while clicking on the lanes. For a large sample sheet, it may be easier to select all samples and de-select the controls. Go to View and open the Plot Window.

Under Analysis select Change Labels. A dialogue box appears giving you the option of labels to assign to the peaks. Select Size in bp, Peak Height, and Category name. Click ok. Continue to Step Q and print the controls according to the directions.

EXEMPLAR SAMPLE RUNS

Under Analysis select Change Labels. A dialogue box appears giving you the option of labels to assign to the peaks. Select Size in bp and Category name. Click ok. Continue to Step Q and print according to the directions.
11. GENOTYPER ANALYSIS

P. Before printing the results make sure the file is named properly, including initials. Set Plot window zoom range as shown below. The active window will be printed so open Table and Plot as needed.

NOTE: The Genotyper printout for YM1 should have a standard format: yellow lanes, then blue lanes. The table should have 2 rows for each locus.

Default settings for YM1: Dye lane sorting:
1. Lane number-ascending
2. Dye color - descending

Q. WINDOWS: Go to File > Print. Click OK. Click Properties. Select orientation. Click More. Change scaling as indicated below. Click OK, OK, OK.

<table>
<thead>
<tr>
<th>Table 11.7 Cofiler print parameters:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table</strong></td>
</tr>
<tr>
<td>Orientation</td>
</tr>
<tr>
<td>Scale</td>
</tr>
<tr>
<td>Zoom range</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 11.8 Profiler Plus Print out parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table</strong></td>
</tr>
<tr>
<td>Orientation</td>
</tr>
<tr>
<td>Scale</td>
</tr>
<tr>
<td>Zoom range</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 11.9 YM1 Print out parameters:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table</strong></td>
</tr>
<tr>
<td>Orientation</td>
</tr>
<tr>
<td>Scale</td>
</tr>
<tr>
<td>Zoom range</td>
</tr>
</tbody>
</table>
Table 11.10 Powerplex 16 Print out parameters

<table>
<thead>
<tr>
<th></th>
<th>Table</th>
<th>Plot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td>Landscape</td>
<td>Portrait</td>
</tr>
<tr>
<td>Scale</td>
<td>70%</td>
<td>90%</td>
</tr>
<tr>
<td>Zoom range</td>
<td>n/a</td>
<td>90 - 480</td>
</tr>
</tbody>
</table>

R. After the printing is finished, under **file, quit** Genotyper. **Click save.** Normally the software will place the Genotyper file to the folder from which the data were imported. Make sure that the Genotyper is saved in the appropriate **Common runs folder**.

S. Archive data as described in the archiving section.

T. Initial all Genotyper pages. Pull the rerun samples and list on the appropriate rerun sheet. Have a supervisor review the analyzed gel and get a signature on the editing sheet.

For **Troubleshooting** see the last section.
II. IDENTIFILER

The Genotyper step will assign allele calls to the labeled peaks based on the category list and the allelic ladder off-sets.

A. Importing data and allele call assignment

1. Open the Identifiler 28 macro for HCN samples and the HS Identifiler 10% Macro for LCN samples by clicking on the Genotyper shortcut on the desktop of the analysis station computer.

2. Under File→Import and select From GeneScan File. If the Current Runs folder does not already appear in the window, scroll to find it from the pull-down menu and double-click on it. Double-click on the folder containing the project that was created in GeneScan.

3. Click Add or double-click on the project icon to add the project for analysis. When the project has been added, click Finish.

4. In order for the macro to run more quickly, if the category window is not collapsed such that each offset is visible, adjust the following: while in the main window view in the category window, click in a category and Ctrl+A to select all categories. Then, under View, select Collapse Categories.

5. If samples need to be removed, go to View→Show Dye/Lanes window and you will see a list of the samples you have imported from GeneScan analysis. If samples need to be removed, highlight the lanes for these samples and select Cut from the Edit menu.

6. After importing the project and saving the Genotyper file run the first Macro by pressing Ctrl+9, or double click the following according to the macro:

   a. ID 28: Identifiler 28
   
   b. ID 31: HS Identifiler 10%.
7. Under File→Save As, save the Genotyper template as the sample sheet name plus your initials. For high sensitivity testing, however, save file as the plate record, the run folder and injection parameter as follows: Venus042507_25L, N, H, I or IR as appropriate.

For Identifiler 28 cycles the parameters are I (normal conditions) and IR (re-run conditions). For Identifiler 31 cycles, the parameters are L (low injection), N (normal injection) and H (high injection).

8. The plot window will appear automatically when the macro is completed. Check to make sure that the ladders that were run match the allele sequence shown below. Also check the results for the positive control.

<table>
<thead>
<tr>
<th>Multiplex System</th>
<th>Necessary LIZ GS500 standard peaks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifiler™</td>
<td>12 fragments from 75 - 450 bp</td>
</tr>
</tbody>
</table>
TABLE 11.12 IDENTIFILER™ POSITIVE CONTROL

<table>
<thead>
<tr>
<th></th>
<th>D8S1179</th>
<th>D21S11</th>
<th>D7S820</th>
<th>CSF1PO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue (6-FAM)</td>
<td>13, 13</td>
<td>30</td>
<td>10, 11</td>
<td>10, 12</td>
</tr>
<tr>
<td>D3S1358</td>
<td></td>
<td>TH01</td>
<td>D13S317</td>
<td>D16S539</td>
</tr>
<tr>
<td>Green (VIC)</td>
<td>14, 15</td>
<td>8, 9.3</td>
<td>11, 11</td>
<td>11, 12</td>
</tr>
<tr>
<td>D19S433</td>
<td>VWA</td>
<td>TPOX</td>
<td>D18S51</td>
<td></td>
</tr>
<tr>
<td>Yellow (NED)</td>
<td>14, 15</td>
<td>17, 18</td>
<td>8, 8</td>
<td>15, 19</td>
</tr>
<tr>
<td>Red (PET)</td>
<td>X</td>
<td>11, 11</td>
<td>22, 24</td>
<td></td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

11. GENOTYPER ANALYSIS

DATE EFFECTIVE
06-09-2008

VERSION
10.0

PAGE
18 OF 34

IDENTIFILER™ ALLELIC LADDER

Amelogenin
D6S818

FRA

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
B. **Modifying the allelic ladder category**

If you receive the error message “Could not complete your request because the labeled peak could not be found,” it means that the allelic ladder failed. Before the macro is rerun, the following two parameters of the ladder categories can be modified:

1. Open the categories window to see where the ladder failed.
2. Confirm this with the plot window.
3. Expand the offset of the first allele in the ladder to include the peak in the ladder.
   a. In the category window, highlight the category.
   b. Category → Edit category → type in expanded offset → Replace
   c. View → show main window → select the calculate offset for the relevant locus to confirm that expanding the offsets was beneficial.
4. Alternatively, if the baseline is noisy the RFU for the ladder must be raised in order to assign the correct allele.
   a. Category → Edit category → select the box with height of at least and type in appropriate height → Replace
   b. Rerun the macro.
C. Viewing samples

1. Check all lanes or Under Views→Show Main Window and highlight the appropriate samples. Under View→Show Plot Window (Ctrl+Y) or click on the plots icon to view the electropherogram.

2. The plot scan range for Identifiler is approximately 2800 – 7000 or 90 bp to 370 bp. To set this in the plots window, under Views→Zoom To… type 90 and 370 in the dialog box.

3. For samples that need to be viewed in triplicate by color (31 cycles only) under Views→Dye Lane Sorting, the first precedence should be set to Dye Color and the second to File Name, both in ascending order.

4. Labels for extra peaks can be manually deleted by placing the cursor on the peak above the baseline and clicking.

Shortcut: If you mistakenly delete a label, before you do anything else, press the Ctrl+Z and the allele name label will reappear (the command apple or ctrl key +Z only undoes the last action).

5. To determine the size in bp for the editing documentation, mouse over the peak and read the bp size indicated in the upper left quadrant of the screen. Alternatively, click on the peak to remove the allele label. Click again to re-label with size in bp and then click again to finally remove the label. Use the zoom functions to get a close look at certain peaks (for instance if you have an allele with two labels which are very close to each other) by using the Zoom submenu under the Views menu.

6. Holding the left mouse click down draw a box around the desired area. Under View go to Zoom, select Zoom In (selected area).

Shortcut: Zoom in by holding down the left mouse click button and dragging the cursor across the area you want to zoom in on. Then, simultaneously press Ctrl+R or Ctrl ++ to zoom in on that region. To zoom out in a stepwise fashion, press Ctrl+-.
D. Editing of Genotyper files

Peaks can be removed if they meet one of the criteria listed in the editing section. This removal must be documented on an editing sheet.

At this stage it is also necessary to make decisions about samples that should be rerun with either more or less amount of amplification product. Refer to the Section III Re-injection Guidelines.

E. Click History

1. This command will display all peaks that were manually removed.

2. Under View→Plot Options→Label options, a dialog box will open, check the first box “show labels that they were manually removed” and click OK. All peaks that were edited out will now appear in the electropherogram with a hatch mark.

F. Printing Samples

1. Display all samples and the positive and negative controls with basepairs, peak heights, and category names. The relevant allelic ladder is labeled with basepairs and category names only.

2. Highlight all samples except the Ladder and under Analysis→Change Labels. Select peak heights, basepairs, and category names.

3. Highlight the relevant Allelic Ladder under Analysis→Change Labels. Select basepairs and category names.

Ensure that the view is set to 90 to 370 bp prior to printing.
11. GENOTYPER ANALYSIS

DATE EFFECTIVE  
06-09-2008

VERSION  
10.0

PAGE  
22 OF 34

4. Print the electropherogram for the controls as follows:
   a. In the main view window, highlight the ladder, and all the controls.
   b. Highlight all colors including orange.
   c. Make sure that the view is set to 90-370.
   d. Under File ➔ Print ➔ Properties button ➔ Finishing tab ➔ Document Options ➔ Pages per Sheet ➔ select “2 pages per sheet” ➔ Orientation ➔ click on “Portrait” ➔ click OK ➔ OK
   e. File ➔ print ➔ OK ➔ OK

5. Once printed, ensure that all alleles in the ladder are labeled. Manually enter the basepair size if necessary and initial and date.

6. To print the electropherograms for 28 cycle samples, select all samples and print following steps 2-5.

7. To print the electropherograms for 31 cycle samples, select each sample (triplicates (a, b, c) and pooled (abc)) and sort by Dye Color, then File Name. Each sample will have to be printed separately. Follow steps 2-5.

G. Printing Genotyper Tables for Identifiler 28 samples

1. A table may be created in Genotyper and printed:
   a. The Genotyper table should have four alleles per locus. Select all samples in the main window and click on 3130 Allele Table in the macro window.
   b. Print the table following the instructions in 4d, with the “Pages per Sheet” set to 4 and with the orientation set to landscape.
2. **Alternatively**, after saving the Genotyper file, one can create an excel table and print, file, and store only this excel table in place of the Genotyper table.
   
a. Select all relevant samples in the main window
   
b. Under Analysis→Clear table
   
c. Under Table→Set up table. A new window opens. Next to “Labels” click on “Options”. Set the number of peaks per category to “6”. Next to “Text if >N”, click on “Options”. Set the number of peaks to “6” and the text to “Overflow”
   
d. Click OK→OK. Under Table→Append to table.
   
e. Under Edit→Select All, copy and paste into the “ID28 Profile Generation table-STR” Excel workbook. Refer to the specific instructions on the first tab of that workbook for creation of the profile table. Print the table and store with the electropheragram.

**H. Printing STR Tables for Identifiler 31 samples**

1. Create a Genotyper table with six Alleles per Locus
   
a. Ensure that all relevant samples are selected in the main window
   
b. Select Analysis→Clear table
   
c. Select Table→Set up table→Labels Options
   
d. Set the number of peaks per category to 6
   
e. OK→OK→Table→Append to table
   
f. Views→Show Table Window
   
g. Edit→Select All→Edit→Copy
2. Open the Profile Generation spreadsheet macro found in:
HIGHSENS\TEMPLATES IN USE\ID31 Profile Generation Sheet-STR.

3. Paste into cell A12 of “extra sheet” and delete rows containing the PE and
the Allelic Ladders.

   a. Starting at row 12, ensure that samples are in the following order:
      i. Sample info and Loci names
      ii. Amp Negatives
      iii. Extraction negatives and Microcon negatives (triple amps)
      iv. Samples being in row 18 (triple amp plus pooled).
      v. Sample triplicates and pooled samples should be
         consecutive.

   b. Make appropriate adjustments by selecting Insert or Delete row(s).
      Ensure that two rows are skipped between each sample. For
      instance, if the first sample is in row 15-18, rows 19 and 20 are
      skipped, and the second sample is in rows 21-24, and so on.

   c. Alternatively, sample info may be copy and pasted directly into the
      appropriate rows in the “Copy Geno Triple” sheet of the Excel
      workbook.

   d. The workbook contains 29 sample sheets.
      i. The first two sheets accommodate the amp and ext
         negatives.
      ii. Sheets 3-29 are sample sheets for up to 27 samples. Due to
         the inclusion of the pooled, and the required adjustments to
         the current macro, one macro can accommodate only 14
         samples. Therefore, use two macros for a sample set of 27.
         For the second macro, leave the first six row blanks where
         the negatives would usually be placed.
4. Compilation of triple amplifications
   a. On the “extra sheet”, Edit→select all→copy
   b. Paste into cell A1 of the copy geno triple sheet. (The geno db sheet is for double amplifications that would not be utilized for casework.)

5. “NIKE” macros to filter and sort
   a. Macro 4: Select the control and the “n” keys to filter sample sheets 1-14.
   b. Macro 4b: Select the control and the “i” keys to filter sample sheets 15-29.
   c. Profiles macro: Select the control and the “k” keys to sort sample sheets 1-14.
   d. ProfilesB macro: Select the control and the “e” keys to sort sample sheets 15-29.

6. Arrow to the right to the triple chart.
   a. Each amplification replicate is shown in the white rows, and the composite profile containing alleles that repeat in two of the three amplifications is in the row below the 3 amplifications. Specify the injection parameter with an L, N, or H as appropriate.
   b. The pooled injection is located beneath the composite profile.
   c. Loci with more than 6 alleles will not be accurately reflected. However, the word “overflow” will appear in the cell as a signal to check the alleles on the electropheragram. Additional alleles may be manually entered into the cell.
11. GENOTYPER ANALYSIS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>26 OF 34</td>
</tr>
</tbody>
</table>

d. For STR analysis, the table may now be printed, stored, and distributed with the electropherogram.

7. Archive data as described in the archiving section. The electronic data for the table should be saved in the folder containing the raw data and the GeneScan project.

8. Have a supervisor review the analyzed run and get a signature on the editing sheet.

9. The supervisor must go back to the Genotyper file to review the size standard. This review shall be documented on the Editing Sheet.

10. For Troubleshooting see the last section.

III. Re-injection guidelines

A. Complete an assay resolution sheet if a complete injection set requires re-injection. If only select samples should be re-injected, note these samples on the editing sheet, their original run folder name, and their re-injection requirements on a re-run sheet.

1. For samples amplified with Identifiler, all controls must be re-injected for all rerun conditions that are at a higher parameter. For reruns that are lower than the original injection, only a positive control must be re-injected.

2. All samples must be rerun if no allelic ladder is of sufficient quality to run the macro or if the electrophoresis control, a positive control, fails. If a positive control or allelic ladder fails in one injection, one may import an allelic ladder and/or positive control from another injection from the same plate or a plate loaded at the same time on the same instrument and proceed with analysis.
3. If the amplification positive or negative controls fail and an electrophoresis problem is suspected as the cause for the failure, the controls can be rerun to test them again. Refer to the “STR Results Interpretation” Section for additional details. An amplification sample set can pass, if the amplification positive control and the negative controls pass the rerun.

4. For additional guidelines with respect to controls, refer to the “STR Results Interpretation” Section.

5. If the lack of a red or orange size standard for a sample is noted during GeneScan analysis and can be confirmed on the Genotyper level, these samples MUST be rerun. For 3130xl runs these samples can be spotted easily since the Genotyper print out will state: “No Data Available.” The lack of a red or orange size standard can be either a failed injection or a post amplification sample prep mistake.

6. If a sample displays allele peaks just below the instrument detection threshold there is a distinct possibility that the alleles can be identified after a repeated run with increased amplification product or higher injection parameters. Place the sample on a rerun sheet. For Cofiler, Profiler Plus, and YM1, use 4μL of amplified sample with the Rerun Module (3KV for 20 sec).

For Identifiler 28 and 31 refer to the following table:

<table>
<thead>
<tr>
<th>Amplification Cycle</th>
<th>Specification</th>
<th>Run Module Code</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Low</td>
<td>L</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>N</td>
<td>3 kV for 20 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>H</td>
<td>6 kV for 30 sec</td>
</tr>
<tr>
<td>Identifiler 28</td>
<td>Normal</td>
<td>I</td>
<td>1 kV for 22 sec</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>IR</td>
<td>5 kV for 20 sec</td>
</tr>
</tbody>
</table>
11. GENOTYPER ANALYSIS

7. Over-amplified samples often have peak heights between 5000 and 7000 RFU’s and are characterized by a plateau shaped or misshaped peaks and contain numerous labeled stutter peaks and artifacts (refer to STR Results Interpretation). In this instance, peaks may be removed and the sample deemed inconclusive for this injection. The sample should be slated for re-injection at a dilution or at a lower parameter.

8. Mixed samples which contain loci with peaks that are ≥7000 RFU’s (overblown) must be rerun at lower injection parameters or with less DNA.

For mixed samples amplified in Identifiler 31 or samples amplified in Identifiler 28 and run with the 5kV/20sec injection parameter (such as those in the High Sensitivity Team), data from loci which are not overblown may be used. However, the overblown peaks as well as peaks from loci within the same basepair range in the different colors should be removed. For example:

a. If a small loci such as D3 is overblown in Identifiler at the 5kV/20sec injection parameter, but large loci such as CSF and FGA are visible and below 7000 RFUs, one may remove a range of peaks from all of the small loci in the range of D3. This would includes D8, D19, Amelogenin, and D5. Those loci would be deemed inconclusive while retaining data from the larger loci.

b. The sample must also be injected at a lower parameter or at dilution where the small loci may be accurately determined.

c. Data from both injections may be used for interpretation. For consistency, confirm that the injections at different parameters generate overlapping loci.

For High Copy Number mixed samples [i.e., samples amplified in Identifiler 28 and run with the 1kV/22sec injection parameter (1), and samples amplified using Cofiler, Profiler Plus, or YM1], the sample will be deemed inconclusive and rerun with less DNA.

9. In order to accurately determine the ratio of heterozygote pair of alleles for a locus, both alleles must be below 6000 RFUs.
10. For Identifiler 31 samples only, the following applies:

   a. If all the samples are very overblown or very low, do not edit the electropherogram, but simply complete a resolution sheet and indicate that all samples will be rerun with modified loading and/or injection conditions. (See below) If only some samples are overblown, edit the run, but remove all peaks for the samples that must be re-injected.

      i. For LCN samples, if is often sufficient to just re-inject with low parameters. For very overblown samples one may make a 0.1 dilution and re-inject.

      ii. However, if an LCN sample is overblown at only one homozygote locus, for example, in blue or green causing it to run off ladder, it is often necessary to re-aliquot 1 µL or 2 µL of the sample and inject with 1 kV for 22 seconds.

   b. For mixtures, peaks must be below 6000 RFUs in Genotyper in order to accurately determine the ratio of two alleles at a locus. Moreover, alleles must be present in all three amplifications and be within 50% of one another in two of the three amplifications to be assigned to the major component. If additional information will alter the allelic assignment, slate samples for re-injection accordingly.

11. If a locus displays a distinct unlabeled peak this could be a “new” allele that is outside the defined allele range. Especially if the other loci show a proper amplification signal, this possibility must be considered (but also see Troubleshooting Section). The presence of a possible “new” allele must be pointed out to a DNA supervisor for confirmation. The "new" allele will not be automatically reported in the Genotyper table, but will be visible on the electropherogram. Click on the unlabeled peak in order to label it with the size in bp, which is necessary for allele identification and reporting.

   All “new” alleles must be rerun once to eliminate the possibility of an electrophoresis shift.
IV. Multiplex Kit Troubleshooting

A. If you get an Error Message when you try to run the Genotyper Macro 1 that reads: “Could not complete your request because no dye/lanes are selected”.

Make sure you have actually imported the ladder from the project. Make sure “ladder” is spelled correctly in the dye/lanes window. If there is a misspelling or the sample information for the ladder is absent, the macro will not recognize the ladder and will not be able to complete the procedure. Correct the spelling and rerun the macro.

B. If you get an Error Message when you try to run the Genotyper Macro 1 that reads: “Could not complete your request because the labeled peak could not be found”.

This message indicates that the ladder cannot be matched to the defined categories. There are four possibilities:

1. The wrong ladder is being typed, (i.e., you are trying to type a Cofiler ladder in the Profiler Plus Genotyper or vice versa).

   **Solution:** Close your Genotyper template, start the correct one and re-import your GeneScan project.

2. There may be peaks in the ladder that are too low to be recognized by the program.

   **Solution:** You have two options:

   a. **One:** If another ladder in the run is more intense, alter or delete the name of the first ladder in the Genotyper Dye/Lane window and rerun Macro 1. Now the macro will use the first backup ladder for the offset calculation.
11. GENOTYPER ANALYSIS

b. **Two:** You can lower the **minimum peak height** in the categories window. To do this, open the categories window by going under Views and selecting **Show Categories Window.** In the “offset” categories the first allele is defined with a scaled peak height of 200 or higher. The high value is meant to eliminate stutter and background.

Change this to 75 for the 3130x/l by clicking on the first category that highlights it. In the dialogue box locate the **Minimum Peak Height** and change it to the appropriate value, click **Add,** and then click **Replace** when given the option. You must do this for each locus. Do not use values less than the instrument threshold.

**DO NOT CHANGE THE MINIMUM PEAK HEIGHT FOR ANY OTHER CATEGORY EXCEPT THE OFF-SET.**

It is important, after you rerun the macro, to make sure the ladder begins with the correct allele and that the first allele is not assigned to a stutter which might precede the first peak.

3. The first ladder peak of each locus is outside of the pre-defined size range window.

**Solution:** You can expand the search window in the categories window. To do this, open the categories window by going under Views and selecting **Show Categories Window.** In the “offset” categories the first allele is defined with a certain size +/- 7bp. Change the 7 to 10 or higher, by clicking on the first category which highlights it. In the dialogue box locate the +/- **box** and change the value, click **Add,** and then click **Replace** when given the option. You must do this for each locus that gives you the error message.

4. There are no peaks at all in any of the allelic ladders.

**Solution:** Rerun all samples with freshly prepared Allelic Ladders.
C. Off Ladder (OL) allele labels

1. If you have a run with a large number of samples you may find that the samples toward the end of the run have a high incidence of OL allele labels. This is due to a shift during the run.

In order to improve the number of correctly called alleles, try to reanalyze the run by using the second allelic ladder as the off-set reference. This is done by removing the word “ladder” from the name of the first ladder in the dye lane window. This way this ladder is not recognized by the macro program. Rerun Macro 1 and evaluate the results. Determine which one of both allelic ladders causes fewer “OL allele?” labels. Complete the Genotyping process using this ladder. Any remaining samples displaying OL alleles have to be rerun.

2. If all or most of your samples have “OL allele?” labels it may be that your samples were automatically analyzed with an ill-defined size standard. In this case it is necessary to reanalyze your run using the correct or a redefined size standard (see GeneScan analysis for 3130xl).

D. Incorrect positive control type

1. The Genotyper has shifted allele positions during the category assignment to the ladder.

a. Check the ladder and make sure the first assigned allele is assigned to the first real peak and not to a stutter peak, which may precede it. If the stutter peak is designated with the first allele name, you must raise the peak height in the categories window in order to force the software to skip the stutter peak and start with proper allele.

i. First determine the height of the stutter peak by placing the cursor on the peak in question (as if you are editing). The information displayed on the top of the window refers to the peak where the cursor is located and contains the peak height. Make a note of the peak height.
11. GENOTYPER ANALYSIS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>33 OF 34</td>
</tr>
</tbody>
</table>

ii. Open the categories window (under views on the menu) and highlight the first allele in the offset category (e.g. 18 o.s.) of the polymorphism that needs to be corrected.

iii. In the dialogue box change the height for the minimum peak height to a few points above the determined height of the stutter.

iv. Rerun the macro and then check to make sure everything is correct by looking at the first allele in each locus in the ladder and by comparing the result for the positive control.

2. You have a sample mix-up and you have to rerun and/or to re-amplify your samples.

E. Lining up unlabeled peaks

In order to place samples next to each other for comparison purposes, mark them by double clicking. A black bullet appears in front of the lane number. If this happens accidentally, a lane can be unmarked by either double clicking on it again or, under Edit, selecting unmark. NOTE: unsized peaks cannot be placed according to size on the electropherogram. Therefore, when comparing an unlabeled allele (unlabeled because it is too low to be sized, but high enough to be detected visually) to a labeled allele (e.g. in the ladder) you cannot determine the allele type and size by visual comparison while the results are viewed by size. To be able to align an unlabeled allele with a labeled allele in the same run you must select View by Scan from under the View menu!

F. Too many samples

If you see the same sample listed several times in the dye/lanes window or you see more samples than you have imported, you have most likely imported your samples more than once or you have imported your samples into a Genotyper template that already contained other samples. Under Analysis select Clear Dye/Lanes window and also under Analysis select Clear Table. Re-import your file(s).
11. GENOTYPER ANALYSIS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>34 OF 34</td>
</tr>
</tbody>
</table>

G. Typographical error in the sample information and/or sample comment

If you detect a mistake in the sample information, this can be corrected for the Genotyper file by opening the dye lane list window, highlighting the lane, and retyping the sample information for all colors. The short sample name cannot be changed here. It can only be changed on the sample sheet level.

H. Less samples in Table than in Plots

Samples with the same sample information are only listed once in the Table. Add modifier to the sample information (see above) of one of the samples and rerun Macro.

I. Too many background peaks labeled

If peaks are still labeled in the plot even though they are listed as having been removed or they appear to be below the stutter filter threshold, the following mistake could have happened: instead of choosing Change labels from the Analysis drop down menu, the analyst clicked Label peaks. The Change labels command is supposed to label the valid peaks with the allele name and the size in basepairs prior to printing the plot. The Label peaks command will label all peaks above threshold independent of any Macro stutter and background filters. This command will also re-label peaks that were edited out. To fix this, rerun the macro, repeat the documented editing steps and reprint the Table and the Plot.
12. STR RESULTS INTERPRETATION

I. Allele Calling Criteria

Results are interpreted by observing the occurrence of electropherogram peaks for the loci that are amplified simultaneously. The identification of a peak as an allele is determined through comparison to the allelic ladder or for YM1 by the Genotyper categories. An allele is characterized by the labeling color of the locus specific primers and the length of the amplified fragment. See the Appendix for a listing of each locus in each multiplex.

For each locus an individual can be either homozygous and show one allele, or heterozygous and show two alleles. In order to eliminate possible background and stutter peaks, only peaks that display intensity above the minimum threshold based on validation data – 75 Relative Fluorescent Units (RFU’s) – are labeled as alleles.

A. Computer program processing steps for raw data:

1. Recalculating fluorescence peaks using the instrument-specific spectral file in order to correct for the overlapping spectra of the fluorescent dyes.

2. Calculating the fragment length for the detected peaks using the known in-lane standard fragments.

3. For YM1 (a system without an allelic ladder) – labeling of all sized fragments that are >75 RFU fall within the locus size range and match to an allele size average within a ± 1.0bp tolerance window. Labels are automatically removed from minor peaks based on the background and stutter filter functions outlined in the YM1 Genotyper section.

4. For Identifiler 28, Identifiler 31, Cofiler, and Profiler Plus (systems with an allelic ladder) – comparing and adjusting the Genotyper allele categories to the sizing of the co-electrophoresed allelic ladder by calculating the off sets (the difference between the first allele in a category and the first allele in the allelic ladder at each locus).
5. For Identifiler 28, Identifiler 31, Cofiler, and Profiler Plus – labeling of all sized fragments that are above threshold and fall within the locus specific size range (see Appendix). Removing the labels from minor peaks (background and stutter) according to the filter functions detailed in the appendix of this manual.

II. Manual Removal of Non Allelic Peaks

Additional non-allelic peaks may occur under the following instances (Clark 1988, Walsh et al. 1996, Clayton et al. 1998), which may be manually edited. Make sure not to remove any labels for potential DNA alleles. All edits must have a reference point on the editing sheet. When in doubt leave the peak labeled for review. Mixture samples must be edited conservatively and only electrophoresis artifacts can be eliminated. Peaks in stutter positions cannot be edited for mixtures, except when masked, (see D4).

A. Pull-up

1. Pull-up of peaks in one color may be due to very high peaks in another color. Pull-up is a spectral artifact that is caused by the inability of the software to compensate for the spectral overlap between the different colors if the peak height is too high.

2. The label in the other color will have a basepair size very close to the real allele in the other color. The peak that is considered an artifact or “pull up” will always be shorter than the original, true peak. It is possible to for a particularly high stutter peak in for example blue or green, to create pull up in red or orange.

3. Spectral artifacts could also be manifested as a raised baseline between two high peaks or an indentation of a large peak over another large peak. Labels placed on such artifacts can be removed and is known as “spectral over-subtraction”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
B. Shoulder

Shoulder Peaks are peaks approximately 1-4 bp smaller or larger than main alleles. Shoulder Peaks can be recognized by their shape; they do not have the shape of an actual peak, rather they are continuous with the main peak.

C. Split peaks (“N” Bands)

Split peaks are due to the main peak being split into two peaks caused by the Taq polymerase activity that causes the addition of a single “A” to the terminus of the amplified product (“N+1” band). Since allele calling is based on N+1 bands, a complete extra “A” addition is desired.

1. Split peaks due to incomplete non nucleotide template A addition should not occur for samples with low amounts of DNA

2. Split peaks can also be an electrophoresis artifact and attributed to an overblown allele. Additional labels can be edited out.

3. Split peaks may occur in overblown samples or amplicons due to matrix over-subtraction. For example, an overblown green peak may dip at the top where a pull up peak is present in blue and in red. The yellow peak will also display over-subtraction with a dip at the peak’s crest.

D. Stutter – 4bp smaller than the main allele
(Peaks one repeat unit longer or multiple units shorter than the main allele may be stutter, but is rare.)

1. The Genotyper macro for each system has an automated stutter filter for each locus (see appendix for stutter values)

2. In addition, for single source samples, potential stutter peaks may be removed if they are within 15% of the larger peak for Cofiler, Profiler Plus, and YM1, and 20% of the larger peak for Identifiler.

3. Identifiler 31 samples have been shown to occasionally display peaks 4 bp longer than the main allele.

4. If the main allele has an additional label prior to the main allele label (e.g. a shoulder peak, 1bp less in size) this peak will be used for stutter
percentage calculation and the stutter might not have been automatically removed. In this case, the stutter peak can also be removed for mixtures.

5. Peaks that are overblown with RFUs above 7000 (and thus their peak height has plateaued), will often have a stutter peak that will be more than 20% of the main peak. If the sample is not a mixture, the stutter peaks for the alleles above 7000 RFUs may be removed.

E. Non specific artifacts

This category should be used if a labeled peak is caused by a not-previously categorized technical problem or caused by non-specific priming in a multiplex reaction. These artifacts are usually easily recognized due to their low peak height and their position outside of the allele range.

F. Elevated baseline

Elevated or noisy baseline may be labeled. They do not resemble distinct peaks. Sometimes, an elevated baseline may occur adjacent to a shoulder peak.

G. Spikes

1. Generally, a spike is an electrophoresis artifact that is usually present in all colors.

2. Spikes might look like a single vertical line or a peak. They can easily be distinguished from DNA peaks by looking at the other fluorescent colors, including red or orange. For Identifiler™, a spike may appear in the red or green, but not be readily apparent in the other colors. However, you can zoom in and confirm the spike.

3. Spikes may be caused by power surges, crystals, or air bubbles traveling past the laser detector window during electrophoresis.
H. Dye Artifacts

1. Constant peaks caused by fluorescent dye that is not attached to the primers or is unincorporated dye-labeled primers. These "color blips" can occur in any color. Dye artifacts commonly occur in the beginning of the green, blue, and the yellow loci right after the primer peaks (Applied Biosystems 2004 a and b).

2. These artifacts may or may not appear in all samples, but are particularly apparent in samples with little or no DNA such as the negative controls.

I. Removal of a range of alleles

Mixed samples which contain overblown peaks must be rerun. Refer to the Genotyper Analysis Section (Part III) for more information.

All manual removals of peak labels must be documented on the editing sheet. This sheet also serves as documentation for the technical review. Check the appendix for the correct peak assignments to each allelic ladder and the expected genotype of the positive control.

III. Detection of Rare Alleles

A. A peak will be labeled “OL allele?” if the peak is outside the defined allele range or is not present in the allelic ladder. This peak might be a “new,” previously unreported allele or an electrophoresis artifact.

B. If an OL allele could be a true allele, the sample should be rerun. These reruns can be performed with different injection parameters.

C. All alleles assigned by the software as “off-ladder” (OL) that cannot be manually removed according to the listed criteria must be rerun. These reruns can be performed with different injection parameters. If multiple samples from the same case within the same run all show the same OL allele, only one sample needs to be rerun to confirm the OL allele. This can also be achieved by amplification of a locus in overlapping systems.
12. STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>04-06-2009</td>
<td>10.0</td>
<td>6 OF 33</td>
</tr>
</tbody>
</table>

1. Off-ladder alleles that are within the range of the ladder and are called by the software need not be rerun (i.e., a “19.2” at FGA). Only those peaks designated as “OL” must be rerun. In addition, if an assigned allele is either larger or smaller than the smallest or largest allele in the ladder, it should be rerun.

2. For samples amplified in Cofiler/Profiler Plus, YM1, and Low Copy Number DNA Samples, use the following table for guidance if off-ladder alleles occur in samples that are injected with different parameters:

<table>
<thead>
<tr>
<th>Injection 1</th>
<th>Injection 2 at higher injection parameter</th>
<th>Course of Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allele called</td>
<td>Allele labeled as “OL”</td>
<td>No rerun necessary; report called allele.</td>
</tr>
<tr>
<td>Allele labeled as “OL”</td>
<td>Allele called</td>
<td>No rerun necessary; report called allele.</td>
</tr>
<tr>
<td>Allele not called</td>
<td>Off Ladder</td>
<td>Rerun high</td>
</tr>
</tbody>
</table>

3. If, after the second rerun, the allele is still off-ladder, examine the allele closely. If it is not at least one basepair from a true allele, it is likely not a real off-ladder allele. In this case, a third injection on another instrument may be done to rule out the possibility of migration. If the locus is small and the peak heights are high, the sample may be re-aliquotted and re-injected.
IV. Interpretation of STR Data

A. Allele Table

1. After the assigning of allele names to the remaining labeled peaks the software prepares a result table where all peaks that meet the above listed criteria are listed as alleles. The allele nomenclature follows the recommendations of the International Society for Forensic Haemogenetics (ISFH), (DNA recommendations, 1994) and reflects the number of 4bp core repeat units for the different alleles. Subtypes displaying incomplete repeat units are labeled with the number of complete repeats and a period followed by the number of additional bases.

2. The Y chromosome allele nomenclature is also based on the number of 4bp core repeats and follows the nomenclature suggested in (Kayser et al 1997) and the one used in the European Caucasian Y-STR Haplotype database (Roewer et al 2001).

B. Electropherograms

1. Printouts of capillary electrophoresis runs containing case specific samples are part of each case file. The Results table reflects the number and allele assignments of the labeled peaks visible on the Plot print out. The printouts are the basis for results interpretation. The plot will display peak height information, unlabeled peaks, intensity differences that may indicate the presence of a mixture, and will show all peaks at each locus. Looking at the plots also serves as a control for the editing process.

2. In certain instances it may be necessary to view the electropherogram electronically:
   a. No peak is above the minimum threshold but unlabeled peaks are visible.
If these unlabeled peaks need to be compared to a previous amplification (see reporting rules) it is important to remember that peaks below the threshold are not sized by the software and cannot be displayed by size. They are randomly placed on the plot and their types cannot be inferred! In order to make a visual allele interpretation one must reopen the corresponding Genotyper file and change the viewing mode from **View by Size** to **View by Scan** (refer to Genotyper section).

b. High peaks and very minor peaks present in the same color lane

Since the RFU scale of the electropherogram is based on the highest peak in each color, alleles at weak loci will not be clearly visible if the loci are imbalanced. For mixture interpretation or allelic dropout detection, it is helpful to access the archived file and in the **View** menu enter a fixed y-scale for **Plot Options, Main Window Lower Panel**. Print pages. Do not save changes.

c. Plot states “no size data”

This means that none of the peaks were above threshold and it is possible that the original data which may be visible in GeneScan, displays visible peaks below the sizing threshold.

d. Distinct unlabeled peak in locus with similar height as “homozygous” allele

If a sample has only one allele assigned at a locus, however another distinct peak with the same height is visible outside the previously reported size range, this sample could have a “new” allele (see Interpretation of complex STR results). In this case the analyst might have to look at the original electropherogram in GeneScan for example in order to get the size in bp for this peak.
V. **Interpretation of controls**

The failure of control samples can be caused by laboratory steps following the extraction and amplification that do not affect the quality of the sample data. In order to identify such problems and avoid unnecessary sample consumption, the control samples should be retested before failing a sample set.

A. **Amplification Positive Control**

1. A Positive control is amplified with each batch of samples to demonstrate that amplification and electrophoresis was successful, and that data analysis was performed properly.

2. Evaluation of the Positive Control

   a. The positive controls must give the expected result for an amplification to be valid. See analysis section for each multiplex for the correct genotype for the positive control. The positive control can be tested with a dilution and with lower injection conditions than the samples, and the amplification will pass. However, for the amplification to pass, the positive control should not be concentrated or run at higher injection parameters than the associated samples.

   b. If the positive control has been shown to give the correct type, this confirms the integrity of the amplification. If individual samples from this amplification set need to be re-analyzed on a second CE run the positive control does not have to be repeated, if another positive control is included in the run.
c. **An injection set consisting only of re-injections still needs to have one positive control.** A set of samples with a failed positive control can only pass without repeating all samples, if a.) reloading could show that the positive control amplified correctly and if b.) the set of samples is accompanied by a second positive control, that can serve as the electrophoresis control. This is often the case for CE runs where two amplification sets are run and another positive control from the same plate or another plate loaded on the same instrument at the same time may be imported into the analysis software.

d. **For runs** with only one positive control the retesting strategy needs to include the samples. If it is unclear if the positive control will pass the rerun test, it is often easier to just retest the control alone first and then rerun the complete set later. If the control does show amplification product at a significant peak height and the problem is most likely a separation problem, the set should be run together. The separation problem might also have affected the samples.

e. **Retesting Strategies:**

<table>
<thead>
<tr>
<th>Result</th>
<th>Course of action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No red size standard in lane</td>
<td>Will result in “No Data available” on the 3130xl. Sample must be rerun to test if amplification yielded expected alleles</td>
</tr>
<tr>
<td>No amplification product but red size standard correct</td>
<td>Rerun separately to check for loading errors, if still no signal detected, all samples must be reamplified</td>
</tr>
<tr>
<td>Incorrect genotype</td>
<td>Reanalyze sample, if not able to resolve, rerun amplification product</td>
</tr>
<tr>
<td>- Could be caused by ill-defined size standard or other Genotyper problems</td>
<td></td>
</tr>
</tbody>
</table>

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
12. STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>Result</th>
<th>Course of action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incorrect genotype</td>
<td>Rerun amplification product, if type is still wrong all samples must be reamplified</td>
</tr>
<tr>
<td>- Could be caused by sample mix-up</td>
<td></td>
</tr>
<tr>
<td>OL alleles</td>
<td>Indicates a Genotyper problem, rerun amplification product</td>
</tr>
<tr>
<td>Rerun fails to give correct type</td>
<td>All samples must be resubmitted to amplification.</td>
</tr>
</tbody>
</table>

B. Extraction Negative and Amplification Negative Controls

1. The extraction negative control and amplification negative control are a check for the possible contamination of the reagents in the STR test by other human DNA or by amplified STR alleles. These negative controls contain no added DNA and are extracted or amplified with corresponding sample sets.

2. Controls amplified with Cofiler, Profiler Plus, YM1, PowerPlex 16, and Identifiler 28 cycles
   a. If peaks attributed to DNA are detected in an extraction negative control, the control must be retested to determine if the extract is truly contaminated or if something occurred during a later stage. This sample can either be retested by re-electrophoresis or re-amplification. If the peaks are just background, it is possible to rerun the extraction negative in order to show that the sample is actually clean. Normally an extraction negative control should be reamplified as the first test. Only if DNA peaks are still present following the second amplification, then all samples have to be re-extracted.
b. If peaks attributed to DNA are detected in an amplification negative control, all samples in that amplification are inconclusive and have to be repeated. The only exception is, if the peaks might be have been caused by a problem during electrophoresis sample set-up or spill over from an adjacent sample and the amplification negative can be shown to be clean by repeating the electrophoresis step.

<table>
<thead>
<tr>
<th>Result</th>
<th>Course of action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No red size standard in lane or “no data available” on 3130x/</td>
<td>Must be rerun, no data were analyzed and decision if control was clean cannot be made</td>
</tr>
<tr>
<td>Misshaped red size standard peaks</td>
<td>STR data were not properly sized but have been analyzed, therefore control can pass if no blue/green/yellow peaks are present</td>
</tr>
<tr>
<td>Run artifacts such as color blips or spikes</td>
<td>Can be edited out. A rerun of the control is necessary if the artifacts are so abundant that amplified DNA might be masked.</td>
</tr>
<tr>
<td>Alleles detected – Initial Run</td>
<td>The extraction negative should be rerun.</td>
</tr>
<tr>
<td>Alleles detected – Rerun</td>
<td>Reamplify control</td>
</tr>
<tr>
<td>Reamplification still displays peaks</td>
<td>Extraction fails and all samples must be reextracted.</td>
</tr>
</tbody>
</table>
12. STR RESULTS INTERPRETATION

Table 12.2 Retesting Strategy for Amplification negative controls amplified with Cofiler, Profiler Plus, PowerPlex 16, YM1 and Identifiler 28.

<table>
<thead>
<tr>
<th>Result</th>
<th>Course of action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No red size standard in lane or &quot;no data available&quot; on 3130xl</td>
<td>Must be rerun, no data was analyzed and decision if control was clean cannot be made</td>
</tr>
<tr>
<td>Misshapen or a few missing size standard peaks</td>
<td>STR data was not properly sized but has been analyzed, therefore Control can pass if no peaks are present</td>
</tr>
<tr>
<td>Run artifacts such as color blips or spikes</td>
<td>May be edited out. A rerun of the control may be necessary if the artifacts are so abundant that amplified DNA might be masked.</td>
</tr>
<tr>
<td>Peaks detected – Initial Run</td>
<td>The control should be re-run. Otherwise the amplification fails and all samples must be resubmitted for amplification.</td>
</tr>
<tr>
<td>Peaks detected – Rerun</td>
<td>Control cannot be tested for a third time. Amplification fails and all samples must be resubmitted for amplification.</td>
</tr>
</tbody>
</table>

3. Negative controls amplified with Identifiler reagents for 31 cycles

Negative controls can display spurious allele peaks and still pass, unless:

a. The allele occurs in two of the two or three amplifications, which indicates potential contamination instead of drop-in. If this happens for only one or two loci, the affected loci must be evaluated for all samples. The locus is inconclusive for samples that display the same allele, which is present in the negative control, at this locus.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
b. If more than two repeating peaks are present in a negative control, the amplification or extraction fails.

c. Even if none of the spurious allele peaks repeat in two amplifications, a control fails if too many spurious alleles are present. The cut off is > 9 drop-in peaks distributed over at least two of the three amplification aliquots for three amplifications.

d. If a negative control fails, it must be realiquotted and rerun at the same injection conditions to confirm failure. If the realiquot still fails, the control (either the original aliquot so one can re-inject the sample plate) or the second aliquot must be re-injected with a lower injection parameter.

e. If a negative control fails following injection with “high” parameters but passes with injections at “optimal” or “low” parameters, data from samples in the amplification set injected with “high” parameters fails accordingly, whereas data from samples injected with “optimal” or “low” parameters passes.

f. Refer to the table 12.3 to determine whether data for ID28 and ID31 samples may be used with respect to the pass/fail status of the associated controls at ID28 and ID31 injection parameters.
12. STR RESULTS INTERPRETATION

| Table 12.3 Interpretation of samples and Retesting Strategies for Extraction/Microcon Negative Controls amplified with Identifiler 31. |
|---|---|---|---|
| Treatment of E-Neg/M'con Negative Controls | Result | Course of action | Interpretation |
| Amplified in Identifiler 31; Run on H parameters | PASS | None | Identifiler 31, Identifiler 28, Cofiler, Profiler Plus, and YM1 (any parameter). |
| Amplified in Identifiler 31; First run on H parameters | FAIL | Controls should be re- aliquoted and injected at H parameters again | N/A |
| Amplified in Identifiler 31; Second run on H parameters | FAIL | Controls should be re-injected at N parameters | N/A |
| Amplified in Identifiler 31; Run on N parameters | PASS | None | Identifiler 31 injected at N or L, Identifiler 28 injected at I or IR, Cofiler, Profiler Plus, and YM1 |
| Amplified in Identifiler 31; Run on N parameters | FAIL | Controls should be re-injected at L parameters | N/A |
| Amplified in Identifiler 31; Run on L parameters | PASS | None | Identifiler 31 injected at L, Identifiler 28 injected at I, Cofiler, Profiler Plus, and YM1 |
| Amplified in Identifiler 31, Run on L parameters | FAIL | Controls may be amped in Identifiler 28, Cofiler, Profiler Plus, or YM1 if volume available | N/A |
| Amplified in Identifiler 31, Run on L parameters | FAIL | Controls may be amped in Identifiler 28, Cofiler, Profiler Plus, or YM1 if volume available | N/A |

H = High injection for Identifiler 31 samples at 6 kV 30 sec
N = Normal injection for Identifiler 31 samples at 3 kV 20 sec
L = Normal injection for Identifiler 31 samples at 1 kV 22 sec

---

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.
TABLE 12.4 Interpretation of samples and Retesting Strategies for Extraction/Microcon
Negative Controls amplified with Identifiler 28.*

<table>
<thead>
<tr>
<th>Treatment of E-Neg/M'con Negative Controls</th>
<th>Result</th>
<th>Course of action</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplified in Identifiler 28; Run on IR Parameters</td>
<td>PASS</td>
<td>None</td>
<td>Samples may be amped/run in: Identifiler 28 injected at I or IR, Cofiler, Profiler Plus, and YM1 samples</td>
</tr>
<tr>
<td>Amplified in Identifiler 28; <strong>First</strong> run on IR Parameters</td>
<td>FAIL</td>
<td>Controls should be re- aliquoted and injected at IR again</td>
<td>N/A</td>
</tr>
<tr>
<td>Amplified in Identifiler 28; <strong>Second</strong> run on IR Parameters</td>
<td>FAIL</td>
<td>Controls should be re-injected at I</td>
<td>N/A</td>
</tr>
<tr>
<td>Amplified in Identifiler 28; Run on I Parameters</td>
<td>PASS</td>
<td>None</td>
<td>Identifiler 31 and Identifiler 28 injected at IR</td>
</tr>
<tr>
<td>Amplified in Identifiler 28; Run on I Parameters</td>
<td>FAIL</td>
<td>Controls may be amped in Cofiler, Profiler Plus or YM1 as needed.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

IR = High injection for Identifiler 28 samples at 5 kV 20 sec
I = Normal injection for Identifiler 28 samples at 1 kV 22 sec
* If a negative control is amplified in Identifiler 28 initially, there may not be enough volume for Identifiler 31 amplification
VI. Reporting Procedures

In the Identifiler 28 system, evidence samples with \( \geq 20 \text{ pg/ul} \) and less than \( 1000 \text{ pg} \) in the total extraction volume (e.g., calculate total yield by multiplying DNA concentration by the 200 \( \mu \text{L} \) in a Chelex extraction) will be automatically duplicated by two separate Identifiler amplifications. For evidence samples that contain greater than \( 1000 \text{ pg} \) in the total extraction volume and/or are amplified with \( 100 \text{ pg/ul} \) or more DNA, mixtures of DNA will be duplicated in Identifiler according to the Concordant analyses and “duplicate rule” (See Section 1). Cofiler, Profiler Plus, Powerplex 16, and Y STR samples will be duplicated according to the Concordant analyses and “duplicate rule.” However, the Property Crimes and High Sensitivity teams may automatically duplicate evidence samples regardless of DNA concentration. For mixed samples duplicated consecutively, the duplicate amplification may be performed with 1000 pg of DNA if available. Note that often single source samples are overblown when amplified with 1000 pg. However, this is not the case, regarding mixtures, since the 1000 pg is divided amongst the components.

A. Guidelines for Reporting Allelic Results

1. Items listed in allele typing tables should be limited to samples that are used to draw important conclusions of the case. Genotypes are not reported and should not be inferred, i.e., if only a “7” allele is found; it should be reported as 7. Alleles and/or peaks are listed in the results tables regardless of intensity differences, based on the reporting criteria below.

2. If an allele meets the above reporting thresholds and fulfills the concordant analyses and the duplicate rule as stated in the General PCR Guidelines, then the allele will be evaluated for the report and/or summary table in the file.

3. In cases where a mixture sample was re-amplified in the same multiplex system consult table 12.5 about how to report the alleles:

4. If no alleles are detected in a locus, then the locus is reported as “NEG” (no alleles detected).
12. STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>04-06-2009</td>
<td>10.0</td>
<td>18 OF 33</td>
</tr>
</tbody>
</table>

B. Previously unreported rare alleles

1. A distinct peak of the same labeling color outside the allelic range could be a rare new allele for this locus. This possibility should be considered if:
   a. The overall amplification for the other loci displays distinct peaks >75 (or 100 if applicable) and does not show artifacts,
   b. The same color locus closest to the new size peak does not have more than one allele peak, and
   c. The new size peak is also detected in the duplicate run.

2. For STR systems with an allelic ladder (Identifiler, Profiler Plus, Cofiler, PowerPlex 16), all alleles that are not present in the allelic ladder should be identified by their relative position to the alleles in the allelic ladder. The peak label should show the length in basepairs and this value can be used to determine the proper allele nomenclature. A D7S820 allele of the length 274 bp in Identifiler, is located between alleles 10 (271 bp) and 11 (275) and has to be designated 10.3. The off-ladder allele should be reported using this nomenclature.

3. Off-ladder alleles which fall outside the range of the allelic ladder at that locus should be reported as < or > the smallest or largest allele in the ladder. For example, a FGA allele of 322 bp is longer than the longest allele in the Profiler Plus FGA allelic ladder (30 - 269bp) and has to be designated >30. A TPOX allele with a size of 208bp in Cofiler is shorter than the smallest Cofiler TPOX ladder allele (6 - 212 bp) and has to be designated <6.

4. New alleles observed for YM1 where no allelic ladder is available should be reported with their rounded basepair size. The basepair value should also appear in the footnotes, e.g. 128 = Allele is reported as size in basepairs.
C. Use "*" to indicate that an extract was not tested for this locus. This symbol is defined as "Typing not attempted."

D. If extra peaks are visible that can’t be accounted for by any editing categories, then the presence of this peak is reported as "**". This symbol is defined as "Additional peaks were detected which did not meet laboratory criteria for allele identification; therefore, these additional peaks are not reported."

### TABLE 12.5

<table>
<thead>
<tr>
<th>Results in one amplification</th>
<th>Results for the other amplification</th>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak labeled as an allele</td>
<td>Peak also labeled</td>
<td>Allele</td>
</tr>
<tr>
<td>Peak labeled as an allele</td>
<td>Peak not labeled but visible</td>
<td>Allele</td>
</tr>
<tr>
<td>Peak labeled as an allele</td>
<td>Peak not present at all; locus that drops out in amp</td>
<td>Allele</td>
</tr>
<tr>
<td>Peak labeled as an allele</td>
<td>Peak not present at all; other alleles called at locus</td>
<td>**</td>
</tr>
<tr>
<td>Peak not labeled but visible</td>
<td>Peak not labeled but visible</td>
<td>**</td>
</tr>
<tr>
<td>Peak not labeled but visible</td>
<td>Peak not present at all</td>
<td>**</td>
</tr>
</tbody>
</table>

NOTE: The table above does not apply to reanalysis by repeated electrophoresis or to single source samples that are amplified in varying DNA amounts.

E. Other symbols or reporting procedures will be used if necessary depending on the details of the case.

F. The following samples must be deemed, and should be reported, as inconclusive ("INC") and should not be interpreted or used for comparisons:

1. Samples with two or more loci, each having more than six called alleles. These samples are inconclusive mixtures with at least four contributors.

2. Samples with a sum of less than eight called alleles in total, or samples with called alleles at less than four autosomal loci (for samples amplified with 31 cycles with Identifiler reagents, at least six loci should be apparent). These samples do not contain enough information to allow conclusions.
VII. Guidelines for interpretation of Results

Occasionally typing results may appear markedly different from the standard patterns. Such results could be due to a procedural error, mixtures of DNA (multiple contributors to the sample), or DNA degradation.

**Non-Mixtures**

A locus may be assigned a “Z” to indicate that another allele may be present, particularly for potential false-homozygote.

1. The possibility of allelic dropout should be considered for low peak heights, especially when below 200 RFUs. This is particularly important for samples amplified with less than 250pg and/or show a pattern of degradation.

2. Loci that are usually affected in samples that are degraded or otherwise compromised are the larger loci. In Identifiler, these loci are: CSF1PO, D2S1338, D18S51, FGA, and sometimes TH01 and D16S539.

3. Moreover, for degraded samples, the last labeled loci of each color may be a potential false homozygote. For example, in Identifiler, if no alleles in CSF were labeled, and only one allele is labeled and visible at D7S820, this allele could be a false-homozygote.

4. For samples injected with higher parameters or at a dilution, false-homozygote peaks could be higher than 200 RFUs. Additional caution must be used when interpreting these samples.
Mixtures of DNA

1. General Mixtures

   a. Evidence samples may contain DNA from more than one individual. The possibility of multiple contributors should be considered when interpreting STR typing results. For HCN DNA samples for any typing system in which heterozygous genotypes are analyzed, the detection of more than two alleles in at least two loci indicates a mixed sample.

   b. In Cofiler and Profiler Plus, the peak height ratio for the two alleles of a heterozygote locus has been shown to be >70% (Holt et al, 2002). Therefore, the presence of a peak imbalance of more than 30% is indicative of the presence of a mixture. In Identifiler validation studies, heterozygote peak height imbalance was measured at 67% (OCME validation) and was noted to go as low as 61% (Collins, et al, 2004); however, greater peak height imbalance has been observed in casework.

   c. Degradation or primer binding site mutations are other possible causes for peak height ratio imbalance. Low DNA amounts are more likely to show uneven heterozygote peak heights due to stochastic effects. For this reason, mixtures resulting from amplifications with low amounts of DNA (<200 pg), or with RFU values below 200 (when injected normal) should be interpreted with caution.

   d. A single locus might not be helpful in detecting a mixture. Even though a mixture is present, a locus might only reveal two alleles. For example, in a 1:1 mixture there is a possibility that a phenotype (e.g. VWA 15, 17), is a mixture of a homozygous 15, 15 individual and a homozygous 17,17 individual. Other possible combinations that would result in a two allele pattern are mixtures of individuals with 15,15 + 15,17 or 17,17 + 15,17. In these cases, the electropherogram should reveal unequal peak heights caused by the triplicate presence of one of the alleles. It is, therefore, best to use the results for all tested loci to determine the presence of a mixture.
12. STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>04-06-2009</td>
<td>10.0</td>
<td>22 OF 33</td>
</tr>
</tbody>
</table>

- Results for all tested loci, other than Identifiler locus D2, should be interpreted in order to determine the presence of a mixture.

2. Mixtures with different levels of starting DNA

Another scenario that could lead to unequal peak heights is the presence of unequal amounts of heterologous DNA in a sample (Gill et al. 1995, Clayton et al., 1998). A vWA typing profile 18>16>14 can be caused by unequal amounts of 14,16 and 18,18 but also by a mixture of two individuals with 14, 18 and 16, 18. Here, different scenarios must be considered:

a. Mixture has a known component (e.g. a vaginal swab), or a component that may be inferred within the context of the case

i. After identifying the alleles that could have come from the victim, it can be stated that the remaining alleles must have come from the unknown DNA source. To deduce the complete allele combination of the foreign DNA, the results and allele peak heights must be taken into consideration for each locus:

ii. If two foreign alleles of similar peak height are present at a locus, these two alleles are likely to comprise the genotype of the unknown contributor.

iii. If the alleles foreign to the victim constitute the major component of a mixture, the allele combination can be deduced by combining all major allele peaks (also see section (2) below). All peak height inconsistencies for heterozygote loci should be accounted for by overlap with the known component.
iv. If the alleles foreign to the victim are the minor component and only one foreign allele is visible at a locus, it might not be possible to determine the complete allele composition for this STR. The foreign type might either be homozygous or heterozygous with one allele overlapping with the known component. For heterozygous types of the known component, peak height differences between the two alleles indicate the presence of an overlapping allele in the minor component. For homozygous patterns and very small peak height differences a decision cannot be made. In these cases it is possible to indicate that a second allele might be present without identifying the allele.

b. The major and the minor component of the mixture can clearly be distinguished

i. Using a locus where four alleles are present, it is possible to determine the ratio of the two DNA components in a mixture. This ratio can then be used to interpret the amount of copies of each allele that must be present at other loci with less than four alleles. Therefore, if there is a large difference in peak heights, the genotype of the major component can be inferred without having one known contributor and without four alleles being present at each locus. Be careful to eliminate the possibility of more than two contributors before interpreting the mixture.

ii. It might not be possible to unambiguously deduce the DNA type for the minor component. See above for a discussion of the limitations.
3. **Very small additional allele peaks are detected at only a few loci**
   
a. The major DNA profile can be interpreted. The presence of additional alleles should be noted, but deduction of the minor component should not be attempted.

b. If sufficient DNA is available, and based on the peak heights of the major alleles, consider concentrating the sample or amplifying the mixture sample with more DNA.

4. **Possible mixture components masked by -4bp stutter**
   
a. Due to enzyme slippage when replicating repetitive DNA stretches, an additional peak of a length exactly -4bp shorter than the main allele peak is a frequent occurrence for STR polymorphisms (Gill et al. 1995, Walsh et al 1996, Holt et al 2002). Some of the STR loci are very prone to stutter and almost always show stutter peaks e.g. DYS19 or VWA. The Amelogenin locus is not based on a repetitive STR sequence and doesn’t show any stutter.

b. Over all loci the average stutter peak height ranges from 2.5% to 9.5%, with maxima from 17.4% - 24.1% (in house validation for HCN DNA samples). Therefore peaks in a -4bp position from a main peak and less than a certain percentage (differs per locus, see Appendix) of the main peak’s height are not reported as true alleles.

c. In a mixture the -4bp stutter could mask a real mixture component. Therefore individuals cannot be excluded from being a minor contributor to a mixture if their alleles are in the -4bp position of an allele from another individual.
VIII. Partial Profiles: not all loci display allele peaks

A. Degradation

1. DNA degradation is the process of a very long (>40,000 bp) DNA double strand being broken down into smaller pieces. With increasing degradation, the DNA fragments get very short, until the target sequences for the PCR reaction which at least have to contain both primer annealing sites are also broken down. For example, Profiler Plus contains alleles from 100bp (Amelogenin) to 337bp (D18S51). Other multiplexes contain even longer alleles [e.g. Identifiler with FGA (350bp) and YML with DYS389II (362-386bp)].

2. The longer alleles are more likely not to be present in partially degraded DNA (Gill et al. 1995, Sparkes et al. 1996, Holt et al 2002). A Profiler Plus result that displays only D3S1358 and Amelogenin but none of the higher molecular weight loci, can be explained as being caused by DNA degradation. A profile with no D3S1358 result but callable FGA alleles cannot be caused by degradation but must have other reasons (e.g., see the following paragraph).

3. Due to the allele size differences within a locus, degradation can also cause partial profiles for heterozygous DNA types, e.g., for the FGA type 19, 29, allele 19 (220 bp) can be present while allele 29 (260 bp) drops out. Parallel to the disappearing of the larger size allele, an imbalanced peak height with the larger allele peak being smaller, can be explained by DNA degradation.

4. The possibility of an allelic drop out has to be considered especially for amplification with low DNA input, degraded DNA, or low peak heights (200 RFU’s or below with the normal injection parameters).
5. For degraded samples amplified in Identifiler 31 or amplified in Identifiler 28 and run with the 5kV/20sec injection parameter (such as those in the High Sensitivity Team), small loci may be overblown in order to visualize larger loci. In these instances, use the data from an injection with lower parameters for the small loci whereas data from injections with higher parameters may be used for allelic assignments for larger loci. In this manner, a complete or near complete profile may be assigned. Regarding the small loci at high injection parameters, remove the peaks if they are overblown and consider the locus inconclusive at the high injection parameters.

B. Detection limit

Due to the different detection sensitivity of the dyes, the yellow peaks are generally lower than the blue and green peaks. If the DNA sample is at the lower limit of the testing sensitivity it is therefore possible to get a partial profile where one or all of the yellow loci are missing. Additionally, blue is slightly more sensitive than the green dye, so that it is possible to see more blue loci than green loci above the detection threshold.

IX. Guidelines for reporting samples amplified with Identifiler for 31 cycles

All allele calls are confirmed by evaluating both or all three amplifications. An allele is only considered a duplicated part of the DNA profile if it occurred in at least two of the three amplifications (“repeating peaks”). For duplicate amplifications, an allele must occur in two of the two amplifications. Peaks that are seen only in one of the amplifications can be real alleles, low-level mixture peaks, or PCR or electrophoresis artifacts. These peaks are called spurious alleles or drop-ins (Gill et al 2000). An allele that is known to be present at a heterozygote locus but is not detected is called a dropout.

A. LCN DNA Profile Production

For each case file, a final profile generation sheet should be created from the profile generation sheet(s) from the relevant STR runs. This may include injections from different runs particularly if a replicate sample had required re-injection due to a failed size standard for example.
12. STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>04-06-2009</td>
<td>10.0</td>
<td>27 OF 33</td>
</tr>
</tbody>
</table>

1. The three individual amplifications and the composite profile should be copied from the STR table for each sample from the case.
   a. The abc or pooled injections do not need to be copied.
   b. If a sample was re-injected due to a poor injection, only include the data from the successful run.
   c. If a sample was injected with low, normal and/or high parameters, but the high or low injection yielded the better profile for all loci, the normal injection does not need to be placed in the table.
   d. However, if some loci, for example small loci, were apparent in the normal injection but were deemed inconclusive in the high injection whereas other longer loci were not apparent in the normal injection but were evident in the high injection, the table should include data from all injections.
   e. If the composite profile from the both the normal and the high injections is included in the table, another row should be inserted entitled “combined composite” and the locus with the most alleles determined from either injection parameter should be assigned to this combined composite profile.

2. In the row beneath the composite or the combined composite profile, termed the “assigned alleles or major, 3 amps” list alleles from the composite profile that can be assigned to the single source profile or to the major component of the mixture profile. The macro cannot generate the assigned alleles; rather this must be calculated manually. Refer to the section of the manual entitled “Allele Confirmation and Profile Determination” for detailed instructions regarding profile generation. If the composite profile is the same as that of the assigned major profile, then only the composite profile should be shown.
3. The macro will automatically calculate the number of inconclusive, negative, total, clean, mixed, and partial loci for both CODIS loci and all amplified loci.

4. Copy the chart sheet to a new file.
   a. Right Click on the triple chart sheet
   b. Select Move or Copy, create a copy, and under “To book” select “newbook”.
   c. Save the Newbook with the case number to the profile sheets folder in the case management folder within the Highsens data folder on the network.

5. Add this sheet to the sample’s case file.

6. Save this sheet to the appropriate folder that contains profile generation sheets.

B. Profile Confirmation

1. Samples with less than six apparent composite loci not including the Amelogenin locus will not be interpreted or used for comparison. Samples with several loci in the composite profile with more than 6 alleles will also not be used for comparison. Consider whether the repeating peaks appear to be true alleles or are PCR artefacts.

2. The first step is the decision whether the sample is a mixture or can be treated as a clean type.
   a. Samples with 3 or more repeating minor peaks must be interpreted as mixtures.
12. STR RESULTS INTERPRETATION

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>DATE REVISED</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>04-06-2009</td>
<td>10.0</td>
<td>29 OF 33</td>
</tr>
</tbody>
</table>

b. A sample may be considered to have three or more contributors if five or more repeating alleles are present at at least two loci. Consider whether the repeating peaks appear to be true alleles or are PCR artifacts.

c. Samples with less than 3 repeating minor peaks are interpreted as clean profiles.

d. In some cases, a sample could be a mixture if it has less than 3 repeating minor peaks. Look for inconsistencies at a locus among replicate amplifications.

3. Mixed samples with apparently equal contribution from donors can only be used for comparison. Examination of the profile from the injection of the pooled amplification products is often indicative of the mixture ratio.

4. A locus may be assigned a “Z” to indicate that another allele may be present, particularly for potential false homozygotes.

a. Non-mixtures are treated as follows:

i. The heterozygote type for a locus with two repeating alleles is determined based on the two highest repeating peaks in two amplifications. The heterozygote peaks do not have to show a specific peak balance with the following exceptions:

- When a repeating allele is in the plus or minus 4 bp stutter position, and is less than 30% of the major peak in two out of three amplifications, the possibility of a homozygote must be considered, and a Z is assigned. The potential stutter peak should not be more than 50% of the main allele in the third amplification.

- If two repeating peaks are clearly major peaks, any additional repeating alleles, which are consistently minor, are not considered in the profile.
12. STR RESULTS INTERPRETATION

- If only two repeating peaks are present, and one of the two peaks is <30% of the major peak in all three amplifications, the possibility of a homozygote must be considered.

ii. However, homozygote types must be interpreted carefully.

- An allele must appear in all three amplifications to be considered a homozygote.

- The presence of an additional allele in one of the three amplifications can be indicative of allelic dropout.

- But if one peak if clearly the major peak and the minor peaks (even if they repeat) are less than 30% of the major peak in all three amplifications, an allele can be considered a true homozygote.

- Alternatively, if the non-repeating minor drop-in is >30% of the repeating peak, allelic drop out should be suspected and the locus is marked with a Z, to indicate the possible presence of a second allele.

- Similarly, if the non-repeating minor drop-in is in the stutter position and is >50% of the repeating peak, allelic dropout should be suspected, and the locus is marked with a Z to indicate the presence of a second allele.

- Based on validation data, allelic dropout and a Z are always considered for the following:
  
  - High molecular weight or less efficient loci: CSF1PO, THO1, D16S539, D2S1338, D18S51, and FGA if only one peak could be called.
  
  - The largest loci apparent in each color in two of three amplifications in a degraded sample.
iii. If alleles in one of three amplifications are completely different from the 1st two amplifications, the locus is inconclusive. For example,

- locus is INC when
  1\textsuperscript{st} amp = 8, 8
  2\textsuperscript{nd} amp = 8, 8
  3\textsuperscript{rd} amp = 11, 12

- BUT locus is 8, Z if
  1\textsuperscript{st} amp = 8, 8
  2\textsuperscript{nd} amp = 8, 8
  3\textsuperscript{rd} amp = 11

b. Mixture deduction rules are as follows:

i. Major alleles can be assigned to a major component if they appear in all three amplifications and if they are the major peaks in two out of the three. A heterozygote pair can be called if two out of the three amplifications show a peak balance $\geq 0.5$.

ii. Homozygote types have to be deduced carefully. If one peak is clearly the major peak and the minor peaks (even if they repeat) are less than 30\% of the major RFU in all three amplifications, an allele can assigned as a true homozygote.

iii. In between cases, where the second allele is between the 30 and 50\% heterozygous peak balance, it cannot be concluded if the major component is heterozygote or homozygote. In this case, a major peak can be assigned to the major component with a Z.
iv. If only one peak could be called, based on validation data, allelic dropout and a Z are always considered for the following:

- High molecular weight or less efficient loci such as CSF1PO, THO1, D16S539, D2S1338, D18S51 and FGA
- The last evident locus of a particular color in two of three amplifications in a degraded sample
- TPOX, a locus prone to primer binding mutations, which is relevant for mixtures that contain a homozygote and a heterozygote which share the same allele.

5. Note that mixture ratios may vary between the smaller and the larger loci and in some cases larger loci may not be resolvable particularly if only two alleles are apparent.

6. Peaks that have RFU values above 6000 may be assigned to the major component. However, when a peak is within 50% of a peak which is over 6000 RFUs in two replicates, the sample should be rerun low or with a dilution in order to deduce both alleles, if applicable, of the major component.

7. When none of the alleles can be assigned to the major component, the locus is not deduced and made inconclusive.

8. Minor components from non-intimate samples are not deduced. However, alleles that are confirmed but do not belong to the major component may be designated. These alleles must occur in two of the three amplifications.

9. Samples amplified with less than 20 pg have been shown to have more allelic dropout and all loci with only a single repeating peak are deemed potentially false homozygotes and are assigned a Z.
10. Partial profiles can be compared to known samples but might not be database eligible.

11. Pooled samples are only interpretable in conjunction with the triplicate amplifications; alleles can only be assigned if they are confirmed by the composite profile.

Revision History:
February 16, 2009 – Revised portions of this section in connection with the revision of Section 1 (highlighted). See Approval Form.
April 3, 2009 – Added section regarding the identification of possible false-homozygotes in non-mixtures (highlighted). See Approval Form.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.
13. SAMPLE COMPARISONS

Comparison of Samples Based on STR Results

A. Determine whether it is likely that a sample contains a mixture of DNA (i.e. more than two alleles for a locus, intensity differences between alleles within a locus, or a reproducible pattern of visible but unlabeled peaks). State in the report if a sample contains a mixture or possible mixture of DNA. Determine the minimum number of individuals who could have contributed to a mixture and the likely source of each component of the mixture.

B. Compare all possible evidence and exemplar pairs and all possible evidence pairs to determine inclusions and exclusions.

C. Assuming a single physiological fluid donor, two samples could derive from a common biological source (inclusion) if all the alleles in the evidence sample are accounted for by the alleles in the exemplar sample. If however a mixture is possible in the evidence sample, there may be alleles that are not accounted for by the exemplar sample. If an inclusion requires the presence of more than one physiological fluid donor, this must be stated in the report [i.e., Hum THO1 (S) 7; (V) 6,9 vaginal swab sperm fraction 7, 8 (7 > 8)]. Assuming a single semen donor, the suspect can be eliminated as the semen donor. However if there is more than one semen donor, the suspect cannot be eliminated as a possible semen donor.

D. Statistics are calculated for evidence samples only where: (1) The sample is apparently unmixed. (2) The sample appears to be a mixture of two components and the source of one component is known. (i.e., when vaginal epithelial cells are present in the sperm fraction from a vaginal swab). (3) There is a large difference in peak heights between the major and minor components and then the genotype of the major component is easily inferred. The minor component genotype can be determined if four alleles are present at a locus. If less than four alleles are present one has to be very careful because other alleles of the minor component may be masked by the major component alleles. A deduction may be possible based on peak height imbalances. See below for the calculation of statistics. (4) When one (or more) component of a mixture must be assumed in order to interpret the mixture, state the assumption directly in the report.
-offs. 43. 34. 27. 13. E. Statistics are not calculated for expected inclusions such as vaginal epithelial cells from a vaginal swab, panties or (for non blood only) the victim’s own bedding.

NOTE: Do not forget to evaluate the significance of a match for epithelial cell fractions for items not connected to the victim such as condoms or the suspect’s clothes.

F. Reporting partial profiles

Duplicated alleles at single loci can be used for comparison purposes even if not all loci could be typed for this sample.

If only one allele meets the reporting criteria at a locus and the second allele is visible but too weak to be called, the evidence DNA extract can be rerun with more amplification product or if possible should be re-amplified using a higher amount of DNA. If it is not possible to improve the result for the weaker peak, the callable allele can be used for comparison purposes. Then the presence of the weaker allele in the exemplar does not exclude this individual.

G. Reporting previously unreported rare alleles

A match based on the presence of a new size allele in both the exemplar and the evidence DNA can be reported. The new allele should not be included in the statistical evaluation of a match.

An exclusion only based on the presence of a new size allele, where there is a match for all other tested polymorphisms, has to be reported as inconclusive.

H. Samples with High Background Levels

A sample which has more than two allele peaks per locus and a high background with multiple extra peaks of unknown origin outside of the allelic range has to be interpreted extra carefully and can be typed as inconclusive.
13. SAMPLING COMPARISONS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>3 OF 5</td>
</tr>
</tbody>
</table>

1. If all peak heights in a sample with a high background level are low, the background is probably caused by degradation artifacts (Sparkes et al. 1996). In this case it might not be possible to ever obtain the true genotype. A degraded sample should be amplified with more DNA e.g. after Microcon concentration.

2. Sometimes high background is caused by over-amplification where the main allele peaks are so high that they reach fluorescence saturation level. Common observations for over-amplified samples are: peaks are not pointed but rather resemble narrow plateaus, peaks are not pointed but show multiple jagged edges and split peaks, peaks cause major pull-ups in other colors, peaks resemble plateaus and show an elevated stutter peak in the -4bp position.

In order to fully resolve components of mixtures with peak heights above 6000 RFU’s, samples must be repeated because it is not possible to reliably determine the ratio of two DNA components with one component being close to the saturation limit. This reanalysis is not always necessary for clean DNA samples if, in spite of the peak heights, all peaks show the proper shape and no major background is present. If the above-described background is present the sample should be repeated. The repeat analysis does not have to start with the amplification but can be achieved by rerunning a lower amount or a 1/10 dilution of the amplified product.

For consistency, confirm that the injections at different parameters generate overlapping loci.
I. Discrepancies for overlapping loci in different multiplex systems

The primer-binding site of an allele may contain a mutation, which renders the annealing phase of its amplification less efficient, or if the mutation is near the 3’ end completely blocks the extension (Clayton et al. 1998). This may result in a pseudo-homozygote type, which is reproducible for the specific primer pair. These mutations are extremely rare, approximately estimated between 0.01 and 0.001 per locus (Clayton et al. 1998). A comparison between evidence and exemplar samples based on a locus where both samples were amplified with the same primer sequence is no problem. If the same locus is amplified using different multiplex systems (especially Powerplex 16 versus the AmpFISTR kits) it is possible to obtain a heterozygote type in one multiplex and the pseudo-homozygote in the second, because the primer sequences for the same loci may differ. The heterozygote type should be the correct type and should be reported. It is important to have typing results for evidence and exemplars based on the same multiplex.

J. Profile Comparison and Statistical evaluation for Samples Amplified with Identifiler reagents for 31 cycles

1. Based on the triple amplifications, only repeating alleles in the composite profile will be used for database entry. All allelic assignments are part of the most likely DNA type for the DNA source.

2. Samples, including major components of samples, must contain at least six apparent loci in order to be used for comparisons.

3. Consider all possible evidence and exemplar samples to determine inclusions and exclusions.

4. For comparisons, the amount of DNA amplified, the number of contributors to the sample, the loci characteristics which were empirically defined, and the length of the repeat in question should be considered as well as electronic data.
13. SAMPLE COMPARISONS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>5</td>
</tr>
</tbody>
</table>

**a.** Allelic dropout caused by stochastic effects is a common occurrence for low copy number DNA samples, and a mismatch between a heterozygote exemplar and an apparent homozygote locus is not necessarily an exclusion, even if no Z was assigned (a second allele may be present).

**b.** For example, a comparison sample cannot be excluded from an evidentiary sample if all alleles in the comparison sample are either called or can be explained by uncalled peaks or dropouts.

**c.** Regarding inclusions, one should evaluate whether a particular mixture is what you would expect to see had a comparison sample contributed to the mixture. For example, the comparison sample’s alleles may be apparent in all of the replicates of loci that are designated in the composite profile.

5. In some cases, the presence or absence of a contributor to a mixture may be inconclusive.

6. Non-mixtures or deduced major components may be used for a statistical evaluation. For loci assigned a Z, only one allele is entered in the calculation spreadsheet. In this manner, the locus is not treated as a true homozygote whose statistical values are determined by multiplying the frequency of the allele in the database by itself ($p^2$). Rather Z loci utilize the probability only of the one assigned allele ($2p$).
For Y-chromosome specific polymorphism, a male individual will display one allele for DYS19, one allele DYS390, and two allele peaks for DYS389. For DYS389 one primer pair amplifies two polymorphic STR stretches in this region, the shorter fragment (DYS389I) is the product of an internal second annealing site of the forward primer and the reverse primer, the longer fragment (DYS389II) includes the DYS389I stretch and a second polymorphic tetrameric STR stretch. The true number of STR repeats for the DYS389II stretch can be determined by subtracting DYS389I from DYS389II. This is only necessary for the determination of the separate allele frequencies, and does not change the frequencies of the allele combinations (Kayser et al. 1997).

All STRs in Y Multiplex 1 are located outside of the pseudoautosomal region, the alleles are therefore not subject to recombination (ref Jobling and Tyler-Smith 1995, Kayser et al. 1997). The allele combination is a haplotype that is inherited through the paternal germline. The frequency of a specific Y STR allele combination cannot therefore be assessed by the product rule.

Since no allele will be amplified for female DNA, a DNA mixture with female and male contributors will only display the alleles of the male components (Prinz et al. 1997.). Mixtures of more than one male contributor are likely to display more than one allele peak for at least one locus. It has been observed that allele duplication at DYS19 or DYS390 creates a two-allele pattern for these systems for a single male individual (Kayser et al. 1997, Santos et al. 1996). In this case the two allele peaks will be of similar height.

1. **Mixtures of male DNA**: more than one haplotype present in the DNA sample.
   
   A. **General Mixtures**

   The occurrence of more than one allele peak of similar height at one or more loci of the Y M1 haplotype indicates the presence of a mixture of male DNAs, where the different components are present in equal ratios. If only either DYS19 or DYS390 displays two alleles, and the other three loci show single peaks, the presence of an allele duplication event has to be considered.
B. Mixtures with different level of starting DNA

Mixtures of male DNA with different levels of starting DNA will lead to unequal peak heights for the different alleles for one system. If the ratio of the lower peak to the higher peak is consistent for all loci with two allele peaks, the haplotypes of the major and minor component can be inferred. If this is not the case, the possible presence of three contributors must be considered.

C. Possible mixture component masked by -4bp stutter

Peaks within a -4bp position from a main peak and less than 20% of the peak height are not reported as true alleles. In a mixture the -4bp stutter could mask a real mixture component. Therefore individuals cannot be excluded from being a minor contributor to a mixture if their alleles are in the -4bp position of an allele from another individual.

For the following, see the “Interpretation of Complex Autosomal STR Results” section. Follow the procedures outlined in the appropriate section.

2. Partial Profiles: not all four loci display allele peaks

3. Detection Of Previously Unreported Rare Alleles

4. Samples with High Background Levels
To interpret the significance of a match between genetically typed samples, it is necessary to know the population distribution of alleles at the locus in question. For example, if the STR alleles of the relevant evidence sample are different from the alleles of the suspect’s reference sample, then the subject is “excluded,” and cannot be the donor of the biological evidence being tested. An exclusion is independent of the frequency of the alleles in the population.

If the subject and evidence samples have the same alleles, then the subject is “included”, and could be the source of the evidence sample. The probability that another, unrelated, individual would also match the evidence sample is equal to the frequency of the alleles in the relevant population. Population frequencies are calculated separately for the Asian, Black, Caucasian and Hispanic populations. Additional population frequencies may be used for other population groups. If a source contains more than one frequency for a single population group, than the highest frequency is used for calculations. Allele frequencies are used for all calculations. Locus frequencies are calculated according to the National Research Council report entitled *The Evaluation of Forensic DNA Evidence* (National Academy Press 1996, pp. 4-36 to 4-37).

The overall frequency is reported as occurring in 1 out of x individuals (i.e. 1/overall frequency). The overall frequency can be reported to two significant digits or rounded down to the closest factor of 10 for autosomal STR systems. For example, 1 out of 12,345 (spread sheet value 1.2E + 04) can be reported as “1 in 12,000” or “one in greater than 10,000.”

Values that are greater than 1 out of 1,000,000,000,000 (spread sheet value 1.0 + 12) are not reported in their order of magnitude. The report should state “one in greater than a trillion”.

Spreadsheets are used to automate the calculation of the racial specific loci and overall frequencies. The spreadsheets are located in the “popstat” subdirectory on the network and explanations for their use are included with the spreadsheets.

The population frequencies of the 13 core CODIS loci are derived from the OCME Database.
I. **Autosomal STR’s**

In the standard scenario, for each group, homozygotes are calculated using the formula \( p^2 + p(1-p)\theta \) for \( \theta = 0.03 \) and heterozygotes are calculated using the formula \( 2pq \). The overall frequency for each group is calculated by multiplying the individual locus frequencies if the loci are unlinked. If the loci are linked then only the locus with the lowest locus frequency is used in the calculation. In addition, locus frequencies are calculated for "evidence and subject from the same subgroup (isolated village)" and for relatives using the formulas in the National Research Council Report and \( \theta = 0.03 \). Overall frequencies are calculated as described above.

Unless there is reason to suspect that the "evidence DNA and subject are from the same subgroup" or a relative of the subject left the biological sample (and the relative is unavailable for testing), only the standard scenario, overall frequency for each group with \( \theta = 0.03 \) is listed in the report. The other calculations and allele frequencies are retained in the casefile for referral at a later date if necessary.

II. **Y STR’s**

Since all the loci are linked on the Y chromosome, they are not independent and only a haplotype frequency can be calculated. The frequency for the Y STR haplotype is calculated by counting the number of times the haplotype occurs in each of the racial databases. This is commonly referred to as the “counting method”.

e.g. A haplotype that has been seen 5 times in the Asian database is reported as “1 in 39 Asians”

A haplotype that has been seen 1 time would be reported as “1 in 196 Asians,” or for samples that have not been previously observed in the database “less than 1 in 196 Asians.”

The haplotype frequency can also be calculated for partial profiles. This calculation, however, can only be done manually. The spreadsheets are not accurate with partial Y profiles.
See page 2 of the spread sheet for the exact Y database values. Print this page for the casefile.

If both autosomal and Y STR’s are typed for a sample, than the overall frequency can be calculated by multiplying the overall autosomal frequency for each racial group by the larger of either a) the Y haplotype frequency or b) the Y haplotype frequency assuming 1 count in the database.
16. PATERNITY ANALYSIS

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
Exclusions occur when either 2 or more loci exclude in a parent/child comparison, or when the CPI < 0.1.

Inconclusive occurs when the CPI is between 0.1 and 10, and for individual loci in mixtures of parent/child combinations when there are other peaks visible which could potentially exclude or include but can not be genotyped by the software.

Inclusions occur when either 0 or 1 loci exclude in parent/child combinations, and when for all cases the CPI > 10. The analyst should bear in mind and report the strength of the inclusion based on the CPI. When the CPI is greater than 2000 (probability of paternity > 99.95%, 50% prior probability), the hypothesis of kinship should be accepted (considered proven). When the CPI is between 100 and 2000, the hypothesis is supported by the data. When the CPI is between 10 and 100, the hypothesis should not be rejected, and should be considered a weak inclusion.
Extraction and Quantitation


Nicklas, J. A., Buel, E. Development of an Alu-based, Real-Time PCR Method for Quantitation of Human DNA in Forensic Samples

Nicklas, J. A., Buel, E. Development of an Alu-based, QSY 7-Labeled Primer PCR Method for Quantitation of Human DNA in Forensic Samples

Office of Chief Medical Examiner, Histology Procedure Manual.


17. REFERENCES

Fluorescent STR technology: methods and validations


17. REFERENCES


**Genetic markers and theoretical background**


17. REFERENCES

DATE EFFECTIVE  VERSION  PAGE
06-09-2008  10.0  5 OF 5


High Sensitivity Testing


Kinship and Paternity testing


DNA-View is a software created by Dr. Charles Brenner and is used for the purposes of paternity, kinship analysis, and mass disasters for DNA identification. The following instructions are guidelines as to the use of DNA-View and interpretation of the results.

**Creating a DNA-View Worksheet and Import Record**

1. **Open up the DNA-View template (Microsoft Excel file)\(^1\) (M:\FINOTECH\FBIOLOGY_MAIN\MPERSONS\DNAVIEW\DVIEWTEM.xls)**

2. **On the DNAView Worksheet, fill in a 5-digit Case ID in cell D3 (i.e., if your case is FB04-1345, then the case ID will be 41345).**

3. **Fill in Name section with sample names (start in cell B6). Don’t use quotes because DNA-VIEW will place double quotes around those sample names at the import step.**

4. **Assign a Relation to each sample using the designation codes from the Paternity and Kinship tables at the right of the spreadsheet, see arrows on screen capture above (i.e., if the person is a mother, enter M for relation. If the person is a sibling, enter U for relation, if there are additional siblings, enter A, then B. There are only a standard number of designation codes for each relationship. If additional sibling relationships are required, for example, use the designations for Other: X, Y, Z, as needed. This convention also holds true for other relationships in the table).**

---

\(^1\) Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
5. Enter the DNA profiles for each sample. For both homozygote and heterozygote profiles, enter both alleles at each locus, separated by a space, not a comma. If profile is partial, leave the locus blank.

6. Once the sheet is completely filled out, save it in the WRKST folder (M:FBIOLOGY_MAIN\MPERSONS\DNAVIEW\WRKST). Use the case ID as the file name and “save as” type Microsoft Office Excel Workbook. See below:
7. Click on the **Import** tab in the bottom left corner of the worksheet. Ensure that all data entered on original worksheet is present. See below for import sheet example:
8. Save the import sheet in the **IMPORT** folder (M:\FBIOLOGY_MAIN\MPERSONS\DNAVIEW\IMPORT). Use the **case ID** as the file name and “Save As” type **Text (Tab delimited)**. See below:

9. A Microsoft Excel alert will pop-up stating “The selected file type does not support workbooks that contain multiple sheets”. Click **OK**.
10. Another Microsoft Excel alert will pop-up asking if you want to keep the workbook in text (tab delimited) format. Click Yes.

11. Exit from Microsoft Excel. Another Microsoft Excel alert will pop-up asking if you want to save the changes. Click No.

Creation of the import sheet is complete.
18. DNA-VIEW FOR PATERNITY AND KINSHIP ANALYSIS

Importing profiles into DNA-View

YOU CAN ALWAYS RETURN TO THE MAIN MENU FROM ANY STAGE OF THE PROGRAM (AND WITHOUT LOSING MUCH INFORMATION) BY HITTING Ctrl+C KEYS SIMULTANEOUSLY. THIS MAY COME IN HANDY IF YOU MISTYPE ANY ENTRY.

USING THE MOUSE TO SELECT FROM THE MENU IS VERY PROBLEMATIC. SCROLL USING KEYBOARD ARROWS OR TYPE IN COMMANDS.

1. Open DNA-View, select Import/Export (by either typing it in the Command field or clicking it with a mouse), hit Enter.
2. At next screen, there is field that says **Which Import/Export option?** select **Genotyper import**, hit **Enter**.

3. In the field that says “What subdirectory?”, a path (`\FBIOLO~3\MPERSONS\DNAVIEW\IMPORT\`) will already be specified. Hit **Enter**.

   *If the field is blank, see the Troubleshooting section for specifying the subdirectory.*
4. Select Case ID from list, hit Enter.

5. At the following window, path with selected Case ID will appear, hit Enter.
6. Now that Case ID has been selected, screen will say **Initializing a new membrane.** Date of run will default to the current date, hit Enter.

7. Membrane # or brief id will list the selected Case ID in the format of ######.txt. Hit Enter.
8. You will be asked, **Is the above information correct?** Verify the **Date of run** and the **Case ID** and hit Enter.

9. You will be asked **Who are you?** The program defaults to **099 Genotyper**. Hit Enter.
10. The following window displays the entered loci, hit **End** or **Esc**, not **Enter**.

![DNAVIEW window with entered loci]

11. Wait for a few seconds for the DNA profiles to import.

![DNAVIEW window with importing process]
12. Note: A screen may appear that says “There are some samples id’s...”. At the bottom of this screen, the program asks Proceed with generation? (N=modify parameters, Y=proceed). Y will appear, hit Enter. If this screen does not appear, do not be alarmed, the import will still work.

If you will be using “paternity” instead of “kinship,” answer “N” to modify the parameters and type in “paternity”. If the order of races are incorrect, or if you only want to test one race, you can change the order here or type in one letter for the race.
18. DNA-VIEW FOR PATERNITY AND KINSHIP ANALYSIS

13. A green screen will appear, indicating a successful import. At this step, unique identifiers (circled below) are also added to each profile. Hit Esc to quit viewing this screen, and Esc again to get back to main menu.
Performing Paternity or Kinship Analysis

1. Select Casework, hit Enter.

2. Select Paternity case, hit Enter. (This will be used whether a paternity or a kinship case is being done).
3. **Select case** should be highlighted. Hit **Enter**.

4. At the next screen, at the field **Case # (0 to exit)** look for the 5 digit **Case ID** that was imported. If it is there, Hit Enter. If it is not there, the import step needs to be repeated (Refer to *Importing profiles into DNA-VIEW*).
5. Select immigration/kinship, hit Enter. Verify that the imported case information is correct such as the Case ID and all sample information, including relationships (if not, see Troubleshooting DNA-VIEW on how to change case language), and that, in the race(s): field, bcha is indicated. Go to step 8. If bcha is not indicated, the race list needs to be edited. See steps 6-8 for editing race list.

“bcha”: Abbreviation for Blacks, Caucasians, Hispanics, Asians
6. Use arrow keys to select **edit race list** in green menu on lower right corner of screen. Hit **Enter**.

7. Type **bcha** in the **race(s):** field. Hit **Enter**. The changes will be saved.
8. After editing race list, select immigration/kinship, hit Enter.

9. Estimate likely relationships should be highlighted already. If not, select it and then hit Enter.
10. Wait for program to obtain allele frequencies for the four races.

11. The **Estimate likely relationships** screen will display the following information:

   a. DNA profiles for each sample with a corresponding legend (alleles are expressed in letters).

   b. A green *likely relationships* table (circled in the next table) that lists PI (paternity indices) and SI (sibship indices) generated from calculations comparing every pair of individuals in the case. The numbers in each cell evaluate the corresponding pair of people as potential parent-children (PI), and as potential siblings (SI). Numbers are omitted if very small. (As per Dr. Charles Brenner’s DNA-VIEW Newsletter #17, [http://dna-view.com/news17.htm](http://dna-view.com/news17.htm))

   c. After viewing this information, Hit **Enter**.
Select **Add relationship est to report**, hit **Enter** to add the **likely relationships table** to the final report that will be placed in the casetile.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.
All printed versions are non-controlled copies.
13. Select **Type in** (or edit) scenario 1, hit **Enter**.

14. In the blue field, enter a kinship or maternity/paternity statement that expresses two hypotheses (or ways people are related), then hit **Esc**, not **Enter**. See below for examples of Kinship and Paternity scenarios.

   a. In the case example featured in the screen captures, there is a typed femur, **V**, that may or may not be from the mother of the typed daughter, **D**, son **S**, and son **T**.

      The format for this KINSHIP case is as follows:

      i. **D,S,T:V/Other+Pa** (as seen in screen capture below)

      ii. This means daughter, **D**, son, **S**, and son, **T** are a product of the typed femur donor, **V**, or another unknown individual, **Other**, and some untested man, **Pa**.
b. Another option is a case of with a trio of typed individuals, a child, C, a mother, M, and a tested man that may or may not be the father, F.

i. The format for this PATERNITY case is as follows:

a) C:M+F/Other

b) This means that the child, C, is a product of the typed mother, M, and the tested man, F, or another unknown man, Other.
15. Select **Calculate & report LRs, 4 races**, hit Enter.
16. Wait for the program to collect allele frequencies and calculate kinship equations. A series of screens will appear, see examples below.

Keep waiting…
17. A table with cumulative LR for each race will appear. These are the statistics that will be presented in the Forensic Biology report. **In the field that says Ascii file name for posting (blank if none)**, ensure that this field is blank by deleting any numbers or letters that appear, then hit **Enter**.

![DNAView Table]

<table>
<thead>
<tr>
<th>Race</th>
<th>Cumulative LR</th>
<th>Posterior Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>41.666</td>
<td>99.99999%</td>
</tr>
<tr>
<td>Caucasian</td>
<td>12.789</td>
<td>100%</td>
</tr>
<tr>
<td>Hispanic</td>
<td>4.331</td>
<td>99.99999%</td>
</tr>
<tr>
<td>Asians</td>
<td>20.859</td>
<td>100%</td>
</tr>
</tbody>
</table>

Displayed in this screen capture is the following:

- **cumulative LR**
  - This is a likelihood ratio, also known as the combined kinship index (CKI) or combined paternity index (CPI) which evaluates the assumptions spelled out in the proposed kinship or paternity scenarios from step 14 and determines which is more genetically likely.

- **Posterior probability**
  - *Posterior probability* is also the **relative chance of paternity** (mentioned in Forensic Biology paternity report)

- **Prior probability**
  - *Prior probability* is always 50% (both hypotheses equally plausible) for paternity and kinship cases (mentioned in Forensic Biology paternity report)
18. Select Quit from Immigration (should already be highlighted) and hit Enter.

19. Select print report, hit Enter.
20. Select Laserjet, and hit Enter.

21. The following screens will appear, this is normal. Just wait for the file to print.
Keep waiting…A second screen will appear.

22. After you obtain printed report, hit Ctrl+C to get back to the main menu. Select Quit DNA-VIEW and hit Enter. If report is not printing, see Section IV for troubleshooting.
Troubleshooting DNA-View

1. **Printing problems**
   Re-establish communication between DNA-View and the printer
   a. Go to **My Computer** from the Start menu or the desktop icon.
   b. Double click on **M:** drive.
   c. Double click on **FBiology_1** folder.
   d. Double click on the **DnaView Casework** folder.
   e. Double click on the **Printers** folder.
   f. A list of MS-DOS batch files appears, see below:

   ![Printers folder contents]

   g. Double click on the file that corresponds with your printer. (i.e., If you are trying to print to the printer by Room 1204 at the DNA Building 12th floor, click on **Print DNABldg_dna_12fl_1204_hp4350_LPT2**)

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
h. A black screen will appear and disappear quickly, this is normal. See below:

```
M:\FBIOLGY_1\DnaView Casework\Printers>net use LPT2: /D
LPT2 was deleted successfully.

M:\FBIOLGY_1\DnaView Casework\Printers>net use lpt2: \ocnednahcpr01.csc.nycen
or\dna_12fl_1213_hpcolor /persistent:yes
```

i. Communication has now been established successfully and printing should work.

j. Go back to DNA-View. In the main menu, select **Reprint the last report** and hit **Enter**. Wait for the report to print.
2. Changing Language from Kinship to Paternity
   a. This is useful for paternity cases where C is indicated as Sibling #4, instead of Child and F is indicated as Father instead of Tested Man
   b. Change case language from kinship to paternity
      i. After selecting case in step III.3., a menu will appear. Use arrows to select language is: kinship. Hit Enter.
      
      A field will appear that says Use the language of? and four options will appear. Use arrows to select Paternity, then hit Enter.
iii. Relationships have now been changed from Sibling #4 to Child and Father to Tested Man.

iv. Language will now be changed to paternity until the next user changes it to kinship.
3. Deleting records from DNA-View (in case of import problems, etc.)

a. Hit Ctrl+C to get to the main menu, select Casework, hit Enter.

b. Select Membrane, hit Enter.
c. Use arrows to highlight case that you want to delete, hit **Delete**. Screen will say **Trying to delete** membranes. A list will appear with a blank field that says **Delete**, select altogether-- D +R+ definition, hit Enter.

d. Wait for data to be deleted. When successful, a screen that says **Trying to delete membranes** (highlighted in blue) and **expunged** (in green) will appear, then disappear quickly.

e. The import list will then display (not pictured). The case that was deleted will no longer be in the import list. Hit **Esc** or **Ctrl-C** to get back to the main menu.
4. Designating a subdirectory if the subdirectory field is blank

   a. Normally, the subdirectory field contains the following pathway:

   b. In order to specify a subdirectory for the screen below, hit Enter.
c. On the next screen, a list of folders will appear. You will be asked **Which file? (Esc if done)** Select FBIOLO~3 from the list. Then hit **Enter**.

d. At this screen, hit **Esc**.
e. A list of folders contained in the main Forensic Biology folder will appear. Select MPERSONS\ and then hit Enter.

f. This folder has now been added to the path. Hit Esc.
g. A list of folders in the MPersons folder will appear. Select DNAVIEW then hit Enter.

h. This folder has now been added to the path. Hit Esc.
i. A list of folders in the DNAVIEW folder appears. Select "IMPORT" and hit Enter.

j. This folder has now been added to the path. Hit Esc.
18. DNA-VIEW FOR PATERNITY AND KINSHIP ANALYSIS

k. The folder has now been added and the subdirectory path is complete. It will be automatically saved by the program. Hit Esc. Hit Esc again to return to the main menu.

5. Interpretation of DNA-View Report

Page 1 features (see sample on next page):

a. Case number
b. Sample names with one letter relation code (i.e., M), relationship (i.e., mother), unique identifier, typed subject’s name
c. DNA profiles. Alleles are displayed in letter format. The letters are decoded in succeeding legend.
d. Likely relationships table displays paternity and sibling indices (PI and SI) to numerically evaluate plausible relationships between each tested subject
e. Kinship/Paternity scenario contains the tested assumption and an alternate hypothesis
f. LR/CPI/CKI is cumulative likelihood ratio (also known as combined paternity index or combined kinship index) or the genetic odds in favor of paternity or kinship. This number will be indicated in Forensic Biology paternity and kinship reports for all 4 races (Blacks, Caucasians, Hispanics, and Asians).
g. Posterior and prior probabilities. Posterior probability is also known as the relative chance of paternity. Prior probability is always 50% (meaning that both hypotheses are equally plausible). Both relative chance of paternity and prior probability are indicated in Forensic Biology paternity reports.
18. DNA-VIEW FOR PATERNITY AND KINSHIP ANALYSIS

<table>
<thead>
<tr>
<th>DATE EFFECTIVE</th>
<th>VERSION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>06-09-2008</td>
<td>10.0</td>
<td>41 OF 43</td>
</tr>
</tbody>
</table>

Office of the Chief Medical Examiner -- DNA-VIEW Casework

Case 6494 kinship analysis

- a. case #
- b. Sample names (blanked out)
- c. Profiles in letter format with legend below
- d. Likely Relationships Table, also known as Plausible Relationship Chart
- e. Kinship/Paternity scenario
- f. LR/CPI/CKI
- g. Posterior and prior probabilities

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
Page 2 (see sample below):

Case 61494 kinship analysis

Black

D3S1358 3p STR 0.396 (1+3r) / (4q+12qq+12qr+48qqq)
VWA 12p13.3 STR 1.01 (r+s) / (r+s+16rrs)
POG 4q STR 9.99 2 / (p+3pp+pq)
D8S1179 STR 7.44 (1+3p+3r) / (4p+4pp+12ppr)
D211STR 7.05 (1+3p+r) / (4p+4ppr)
D18511 18q21.33 STR 0.831 1 / (4r+12rr)
D58816 STR 4.16 (2+6p) / (1+3p+3s+6+2pss)
D138117 STR 2.15 1 / 4pq
D7S820 7q11 STR 6.96 (1+3p+3s) / (4p+12pp)
D165539 16q24 STR 3.79 (1+3t) / (4p+4pp+16pt)

TH01 11p15.5 STR 4.34 (1+3p+3s) / (4p+4pp+12ppq)
TPOX 2p25-p24 STR 28.3 1 / 4pq
CSF1PO 5q33-34 STR 8.2 (1+3r) / (4p+4pp+16pt)

cumulative LR 41.666
Posterior probability=99.999998% assuming prior=50% 2006/9/22 16:

Caucasian

D3S1358 3p STR 0.598 (1+3r) / (4q+12qq+12qr+48qqq)
VWA 12p13.3 STR 2.34 (r+s) / (r+s+16rrs)
POG 4q STR 7.7 2 / (p+3pp+pq)
D8S1179 STR 9.72 (1+3p+3r) / (4p+4pp+12ppr)
D211STR 7.35 (1+3p+r) / (4p+4ppr)
D18511 18q21.33 STR 1.72 1 / (4r+12rr)
D58816 STR 2.16 (2+6p) / (1+3p+3s+6+2pss)
D138117 STR 2.51 1 / 4pq
D7S820 7q11 STR 8.21 (1+3p+3s) / (4p+12pp)
D165539 16q24 STR 7.74 (1+3t) / (4p+4pp+16pt)

TH01 11p15.5 STR 13.7 (1+3p+3s) / (4p+4pp+12ppq)
TPOX 2p25-p24 STR 37.3 1 / 4pq
CSF1PO 5q33-34 STR 54.4 (1+3r) / (4p+4pp+16pt)

cumulative LR 12.769
Posterior probability=100% assuming prior=50%

Hispanic

D3S1358 3p STR 0.411 (1+3r) / (4q+12qq+12qr+48qqq)
VWA 12p13.3 STR 1.76 (r+s) / (r+s+16rrs)
POG 4q STR 8.41 (p+3pp+pq)
D8S1179 STR 12.7 (1+3p+3r) / (4p+4pp+12ppr)
D211STR 10.3 (1+3p+r) / (4p+4ppr)
D18511 18q21.33 STR 1.46 1 / (4r+12rr)
D58816 STR 3.32 (2+6p) / (1+3p+3s+6+2pss)
D138117 STR 3.24 1 / 4pq
D7S820 7q11 STR 6.85 (1+3p+3s) / (4p+12pp)
D165539 16q24 STR 3.35 (1+3t) / (4p+4pp+16pt)

TH01 11p15.5 STR 11.9 (1+3p+3s) / (4p+4pp+12ppq)
TPOX 2p25-p24 STR 34.5 1 / 4pq
CSF1PO 5q33-34 STR 33.6 (1+3r) / (4p+4pp+16pt)

cumulative LR 4.338
Posterior probability=99.9999998% assuming prior=50%
Page 3 (see sample below):

### Case 61494 kinship analysis

**2006/9/22 16:2**

#### Asians

- **D3S1358** 3p STR: 0.389 (1+3r) / (4q+12qq+12qr+48qqr) q=0.312 r=0.217
- **VWA 12p13.3 STR**: 9.43 (r+s) / (4rs+16rrs) r=0.0277 s=0.174
- **PFA**: 6.47 2 / (p+3pp+pq) p=0.178 q=0.206
- **D8S1179 STR**: 9.54 (1+3p+3r) / (4pr+4pr+12ppr) p=0.178 r=0.178
- **D21S11 STR**: 18.9 (1+3p+r) / (4pr+12ppr) p=0.0632 r=0.253
- **D18S51 18q21.33 STR**: 1.15 1 / (4r+12rr) r=0.15
- **D5S818 STR**: 2.99 (2+6p) / (8+3ps+3ss+12pss) p=0.0198 s=0.332
- **D13S317 STR**: 6.93 1 / 4pq p=0.277 q=0.13
- **D7S820 7q11 STR**: 6.04 (1+p+3s) / (4ps+12pss) p=0.0156 q=0.32
- **D16S539 16q24 STR**: 3.89 (1+3t) / (4pr+16ppt) p=0.0533 r=0.253
- **TH01 11p1.5 STR**: 11.9 (1+3p+3q) / (4pq+4ppq+12ppr) p=0.024 q=0.0909
- **TPOX 2p25-p24 STR**: 25.2 1 / 4pq p=0.189 q=0.502
- **CSF1PO 5q33-34 STR**: 29 (1+3r) / (4pt+16ppt) p=0.0190 r=0.277

#### cumulative LR

20.8e9

Posterior probability=100% assuming prior=50%

### RAW FRAGMENT SIZES

membrane: 06/09/22 c0000 => 61494.TXX

<table>
<thead>
<tr>
<th>Locus</th>
<th>Rfr Read</th>
<th>Lane 1</th>
<th>Lane 2</th>
<th>Lane 3</th>
<th>Lane 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>D3S1358ST</td>
<td>99 1981 15,16</td>
<td>16,17</td>
<td>16,17</td>
<td>16,17</td>
<td></td>
</tr>
<tr>
<td>VWA ST</td>
<td>99 1991 15,16</td>
<td>13,15</td>
<td>15,16</td>
<td>15,16</td>
<td></td>
</tr>
<tr>
<td>PFA ST</td>
<td>99 1994 23</td>
<td>23,24</td>
<td>23</td>
<td>23,24</td>
<td></td>
</tr>
<tr>
<td>AmelogenX</td>
<td>99 1990 X</td>
<td>X</td>
<td>X</td>
<td>X,Y</td>
<td></td>
</tr>
<tr>
<td>D8S1179ST</td>
<td>99 1992 12,14</td>
<td>12,14</td>
<td>14</td>
<td>12,14</td>
<td></td>
</tr>
<tr>
<td>D21S11ST</td>
<td>99 1983 28,30</td>
<td>28</td>
<td>28</td>
<td>28,30</td>
<td></td>
</tr>
<tr>
<td>D18S51ST</td>
<td>99 1984 16,19</td>
<td>14,16</td>
<td>16</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>D5S818ST</td>
<td>99 1985 11</td>
<td>8,11</td>
<td>8,11</td>
<td>8,11</td>
<td></td>
</tr>
<tr>
<td>D13S317ST</td>
<td>99 1986 11,12</td>
<td>11,13</td>
<td>11,13</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>D7S820ST</td>
<td>99 1987 8,11</td>
<td>8,11</td>
<td>8,11</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>D16S539ST</td>
<td>99 1985 9,11</td>
<td>9,13</td>
<td>9,13</td>
<td>11,13</td>
<td></td>
</tr>
<tr>
<td>TH01 ST</td>
<td>99 1995 7,8</td>
<td>7,8</td>
<td>7,8</td>
<td>7,8</td>
<td></td>
</tr>
<tr>
<td>TPOX ST</td>
<td>99 1987 7,8</td>
<td>8,11</td>
<td>7,9</td>
<td>7,11</td>
<td></td>
</tr>
<tr>
<td>CSF1PO ST</td>
<td>99 1989 8,12</td>
<td>8,10</td>
<td>8,10</td>
<td>10,12</td>
<td></td>
</tr>
</tbody>
</table>
YM1 Genotyper Categories Table for ABI 3130x/  

**DYS19**  
12 Highest peak at 180.70 ± 1.00 bp in yellow with height ≥75  
13 Highest peak at 184.70 ± 1.00 bp in yellow with height ≥75  
14 Highest peak at 188.80 ± 1.00 bp in yellow with height ≥75  
15 Highest peak at 192.60 ± 1.00 bp in yellow with height ≥75  
16 Highest peak at 196.70 ± 1.00 bp in yellow with height ≥75  
17 Highest peak at 200.50 ± 1.00 bp in yellow with height ≥75  
18 Highest peak at 204.50 ± 1.00 bp in yellow with height ≥75  

**DYS389 I**  
10 Highest peak at 238.60 ± 1.00 bp in yellow with height ≥75  
11 Highest peak at 242.60 ± 1.00 bp in yellow with height ≥75  
12 Highest peak at 246.50 ± 1.00 bp in yellow with height ≥75  
13 Highest peak at 250.70 ± 1.00 bp in yellow with height ≥75  
14 Highest peak at 254.70 ± 1.00 bp in yellow with height ≥75  
15 Highest peak at 258.70 ± 1.00 bp in yellow with height ≥75  

**DYS389 II**  
26 Highest peak at 356.60 ± 1.00 bp in yellow with height ≥75  
27 Highest peak at 360.60 ± 1.00 bp in yellow with height ≥75  
28 Highest peak at 364.60 ± 1.00 bp in yellow with height ≥75  
29 Highest peak at 368.50 ± 1.00 bp in yellow with height ≥75  
30 Highest peak at 372.40 ± 1.00 bp in yellow with height ≥75  
31 Highest peak at 376.40 ± 1.00 bp in yellow with height ≥75  
32 Highest peak at 380.50 ± 1.00 bp in yellow with height ≥75  
33 Highest peak at 384.40 ± 1.00 bp in yellow with height ≥75  

**DYS390**  
20 Highest peak at 197.90 ± 1.00 bp in blue with height ≥75  
21 Highest peak at 201.90 ± 1.00 bp in blue with height ≥75  
22 Highest peak at 205.80 ± 1.00 bp in blue with height ≥75  
23 Highest peak at 209.90 ± 1.00 bp in blue with height ≥75  
24 Highest peak at 213.90 ± 1.00 bp in blue with height ≥75  
25 Highest peak at 217.90 ± 1.00 bp in blue with height ≥75  
26 Highest peak at 221.90 ± 1.00 bp in blue with height ≥75  
27 Highest peak at 225.90 ± 1.00 bp in blue with height ≥75  

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet.  
All printed versions are non-controlled copies.
## Identifiler loci and approximate size range

<table>
<thead>
<tr>
<th>Identifiler locus</th>
<th>Color</th>
<th>Size Range 3130x/ GS500 Std.</th>
<th>Allele range in Ladder</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8S1179</td>
<td>Blue</td>
<td>123.0bp ± 0.5bp To 169.0 ± 0.5bp</td>
<td>8 to 19</td>
</tr>
<tr>
<td>D21S11</td>
<td>Blue</td>
<td>185.0bp ± 0.5bp To 216.0 ± 0.5bp</td>
<td>24 to 38</td>
</tr>
<tr>
<td>D7S820</td>
<td>Blue</td>
<td>255.0bp ± 0.5bp To 291.0 ± 0.5bp</td>
<td>6 to 15</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>Blue</td>
<td>305.0bp ± 0.5bp To 342.0 ± 0.5bp</td>
<td>6 to 15</td>
</tr>
<tr>
<td>D3S1358</td>
<td>Green</td>
<td>112.0bp ± 0.5bp To 140.0 ± 0.5bp</td>
<td>12 to 19</td>
</tr>
<tr>
<td>THO1</td>
<td>Green</td>
<td>163.0bp ± 0.5bp To 202.0 ± 0.5bp</td>
<td>4 to 13.3</td>
</tr>
<tr>
<td>D13S317</td>
<td>Green</td>
<td>217.0bp ± 0.5bp To 244.0 ± 0.5bp</td>
<td>8 to 15</td>
</tr>
<tr>
<td>D16S539</td>
<td>Green</td>
<td>252.0bp ± 0.5bp To 292.0 ± 0.5bp</td>
<td>5 to 15</td>
</tr>
<tr>
<td>D2S1338</td>
<td>Green</td>
<td>307.0bp ± 0.5bp To 359.0 ± 0.5bp</td>
<td>15 to 28</td>
</tr>
<tr>
<td>D19S433</td>
<td>Yellow</td>
<td>102.0bp ± 0.5bp To 135.0 ± 0.5bp</td>
<td>9 to 17.2</td>
</tr>
<tr>
<td>vWA</td>
<td>Yellow</td>
<td>154.0bp ± 0.5bp To 206.0 ± 0.5bp</td>
<td>11 to 24</td>
</tr>
<tr>
<td>TPOX</td>
<td>Yellow</td>
<td>222.0bp ± 0.5bp To 250.0 ± 0.5bp</td>
<td>6 to 13</td>
</tr>
<tr>
<td>D18S51</td>
<td>Yellow</td>
<td>262.0bp ± 0.5bp To 345.0 ± 0.5bp</td>
<td>7 to 27</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>Red</td>
<td>106.0bp ± 0.5bp To 112.0 ± 0.5bp</td>
<td>X and Y</td>
</tr>
<tr>
<td>D5S818</td>
<td>Red</td>
<td>134.0bp ± 0.5bp To 172.0 ± 0.5bp</td>
<td>7 to 16</td>
</tr>
<tr>
<td>FGA</td>
<td>Red</td>
<td>214.0bp ± 0.5bp To 355.0 ± 0.5bp</td>
<td>17 to 51.2</td>
</tr>
</tbody>
</table>
Profiler Plus loci and approximate size range

<table>
<thead>
<tr>
<th>Profiler Plus</th>
<th>Color</th>
<th>Size Range 3130x/ GS500 Std.</th>
<th>Allele range in Ladder</th>
</tr>
</thead>
<tbody>
<tr>
<td>D3S1358</td>
<td>Blue</td>
<td>111±0.5bp to 140±0.5bp</td>
<td>12 to 19</td>
</tr>
<tr>
<td>vWA</td>
<td>Blue</td>
<td>154±0.5bp to 195±0.5bp</td>
<td>11 to 21</td>
</tr>
<tr>
<td>FGA</td>
<td>Blue</td>
<td>216±0.5bp to 264±0.5bp</td>
<td>18 to 30</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>Green</td>
<td>X:103±0.5bp; Y:109±0.5bp</td>
<td>X and Y</td>
</tr>
<tr>
<td>D8S1179</td>
<td>Green</td>
<td>123±0.5bp to 170±0.5bp</td>
<td>8 to 19</td>
</tr>
<tr>
<td>D21S11</td>
<td>Green</td>
<td>187±0.5bp to 240±0.5bp</td>
<td>24.2 to 38</td>
</tr>
<tr>
<td>D18S51</td>
<td>Green</td>
<td>270±0.5bp to 341±0.5bp</td>
<td>9 to 26</td>
</tr>
<tr>
<td>D5S818</td>
<td>Yellow</td>
<td>131±0.5bp to 169±0.5bp</td>
<td>7 to 16</td>
</tr>
<tr>
<td>D13S317</td>
<td>Yellow</td>
<td>205±0.5bp to 233±0.5bp</td>
<td>8 to 15</td>
</tr>
<tr>
<td>D7S820</td>
<td>Yellow</td>
<td>256±0.5bp to 292±0.5bp</td>
<td>6 to 15</td>
</tr>
</tbody>
</table>

The above values may expand if additional alleles are discovered for the various loci.
### Cofiler loci and approximate size ranges

<table>
<thead>
<tr>
<th>Cofiler</th>
<th>Color</th>
<th>Size Range 3130xl GS500 Std</th>
<th>Allele range in Ladder</th>
</tr>
</thead>
<tbody>
<tr>
<td>D3S1358</td>
<td>Blue</td>
<td>111 ± 0.5bp to 140 ± 0.5bp</td>
<td>12 to 19</td>
</tr>
<tr>
<td>D16S539</td>
<td>Blue</td>
<td>229 ± 0.5bp to 270 ± 0.5bp</td>
<td>5 to 15</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>Green</td>
<td>X:103 ± 0.5bp; Y:109 ± 0.5bp</td>
<td>X and Y</td>
</tr>
<tr>
<td>THO1</td>
<td>Green</td>
<td>166 ± 0.5bp to 187 ± 0.5bp</td>
<td>5 to 10</td>
</tr>
<tr>
<td>TPOX</td>
<td>Green</td>
<td>215 ± 0.5bp to 243 ± 0.5bp</td>
<td>6 to 13</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>Green</td>
<td>280 ± 0.51bp to 317 ± 0.5bp</td>
<td>6 to 15</td>
</tr>
<tr>
<td>D7S820</td>
<td>Yellow</td>
<td>256 ± 0.5bp to 292 ± 0.5bp</td>
<td>6 to 15</td>
</tr>
</tbody>
</table>

The above values may expand if additional alleles are discovered for the various loci.
## Powerplex 16 loci and approximate size ranges

<table>
<thead>
<tr>
<th>Powerplex 16</th>
<th>Color</th>
<th>Size Range 3100 ILS 600 Std.</th>
<th>Allele range in Ladder</th>
</tr>
</thead>
<tbody>
<tr>
<td>D3S1358</td>
<td>Blue</td>
<td>109±0.5bp to 142±0.5bp</td>
<td>12 to 20</td>
</tr>
<tr>
<td>THO1</td>
<td>Blue</td>
<td>152±0.5bp to 190±0.5bp</td>
<td>4 to 13.3</td>
</tr>
<tr>
<td>D21S11</td>
<td>Blue</td>
<td>198±0.5bp to 255±0.5bp</td>
<td>24 to 38</td>
</tr>
<tr>
<td>D18S51</td>
<td>Blue</td>
<td>284±0.5bp to 358±0.5bp</td>
<td>8 to 27</td>
</tr>
<tr>
<td>Penta E</td>
<td>Blue</td>
<td>375±0.5bp to 472±0.5bp</td>
<td>5 to 24</td>
</tr>
<tr>
<td>D5S818</td>
<td>Green</td>
<td>113±0.5bp to 150±0.5bp</td>
<td>7 to 16</td>
</tr>
<tr>
<td>D13S317</td>
<td>Green</td>
<td>172±0.5bp to 204±0.5bp</td>
<td>7 to 15</td>
</tr>
<tr>
<td>D7S820</td>
<td>Green</td>
<td>212±0.5bp to 244±0.5bp</td>
<td>6 to 14</td>
</tr>
<tr>
<td>D16S539</td>
<td>Green</td>
<td>262±0.5bp to 302±0.5bp</td>
<td>5 to 15</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>Green</td>
<td>317±0.5bp to 354±0.5bp</td>
<td>6 to 15</td>
</tr>
<tr>
<td>Penta D</td>
<td>Green</td>
<td>168±0.5bp to 439±0.5bp</td>
<td>2.2 to 17</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>Yellow</td>
<td>X:104±0.5bp; Y:110±0.5bp</td>
<td>X and Y</td>
</tr>
<tr>
<td>vWA</td>
<td>Yellow</td>
<td>122±0.5bp to 170±0.5bp</td>
<td>10 to 22</td>
</tr>
<tr>
<td>D8S1179</td>
<td>Yellow</td>
<td>202±0.5bp to 246±0.5bp</td>
<td>7 to 18</td>
</tr>
<tr>
<td>TPOX</td>
<td>Yellow</td>
<td>261±0.5bp to 289±0.5bp</td>
<td>6 to 13</td>
</tr>
<tr>
<td>FGA</td>
<td>Yellow</td>
<td>320±0.5bp to 444±0.5bp</td>
<td>16 to 46.2</td>
</tr>
</tbody>
</table>

The above values may expand if additional alleles are discovered for the various loci.
### Genotyper Macro Filter functions

<table>
<thead>
<tr>
<th>Locus</th>
<th>Allele Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Stutter Filter 3130x/l (ABI default)</td>
</tr>
<tr>
<td>D8S1179</td>
<td>12%</td>
</tr>
<tr>
<td>D21S11</td>
<td>13%</td>
</tr>
<tr>
<td>D7S820</td>
<td>9%</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>9%</td>
</tr>
<tr>
<td>D3S1358</td>
<td>11%</td>
</tr>
<tr>
<td>THO1</td>
<td>6%</td>
</tr>
<tr>
<td>D13S317</td>
<td>10%</td>
</tr>
<tr>
<td>D16S539</td>
<td>13%</td>
</tr>
<tr>
<td>D2S1338</td>
<td>15%</td>
</tr>
<tr>
<td>D19S433</td>
<td>17%</td>
</tr>
<tr>
<td>vWA</td>
<td>11%</td>
</tr>
<tr>
<td>TPOX</td>
<td>6%</td>
</tr>
<tr>
<td>D18S51</td>
<td>16%</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>none</td>
</tr>
<tr>
<td>D5S818</td>
<td>10%</td>
</tr>
<tr>
<td>FGA</td>
<td>11%</td>
</tr>
</tbody>
</table>
## 19. APPENDIX

<table>
<thead>
<tr>
<th>Identifier 28 cycles</th>
<th>Allele Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Locus</td>
</tr>
<tr>
<td>D8S1179</td>
<td></td>
</tr>
<tr>
<td>D21S11</td>
<td></td>
</tr>
<tr>
<td>D7S820</td>
<td></td>
</tr>
<tr>
<td>CSF1PO</td>
<td></td>
</tr>
<tr>
<td>D3S1358</td>
<td></td>
</tr>
<tr>
<td>THO1</td>
<td></td>
</tr>
<tr>
<td>D13S317</td>
<td></td>
</tr>
<tr>
<td>D16S539</td>
<td></td>
</tr>
<tr>
<td>D2S1338</td>
<td></td>
</tr>
<tr>
<td>D19S433</td>
<td></td>
</tr>
<tr>
<td>vWA</td>
<td></td>
</tr>
<tr>
<td>TPOX</td>
<td></td>
</tr>
<tr>
<td>D18S51</td>
<td></td>
</tr>
<tr>
<td>Amelogenin</td>
<td>none</td>
</tr>
<tr>
<td>D5S818</td>
<td></td>
</tr>
<tr>
<td>FGA</td>
<td></td>
</tr>
</tbody>
</table>
### 19. APPENDIX

<table>
<thead>
<tr>
<th>Profiler Plus</th>
<th>Allele Filters</th>
<th>Ladder lanes only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locus</td>
<td>Stutter Filter 3130x1 (ABI default)</td>
<td>Background Filter (All platforms ABI default)</td>
</tr>
<tr>
<td>D3S1358</td>
<td>11%</td>
<td>20%</td>
</tr>
<tr>
<td>vWA</td>
<td>11%</td>
<td>25%</td>
</tr>
<tr>
<td>FGA</td>
<td>11%</td>
<td>30%</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>none</td>
<td>40%</td>
</tr>
<tr>
<td>D18S51</td>
<td>16%</td>
<td>10%</td>
</tr>
<tr>
<td>D21S11</td>
<td>13%</td>
<td>20%</td>
</tr>
<tr>
<td>D8S1179</td>
<td>12%</td>
<td>30%</td>
</tr>
<tr>
<td>D5S818</td>
<td>10%</td>
<td>25%</td>
</tr>
<tr>
<td>D13S317</td>
<td>10%</td>
<td>25%</td>
</tr>
<tr>
<td>D7S820</td>
<td>9%</td>
<td>25%</td>
</tr>
</tbody>
</table>
### 19. APPENDIX

<table>
<thead>
<tr>
<th>Locus</th>
<th>Allele filter</th>
<th>Ladder lanes only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cofiler</td>
<td>Allele filter</td>
<td>Ladder lanes only</td>
</tr>
<tr>
<td>Locus</td>
<td>Stutter Filter 3130x/ (ABI default)</td>
<td>Background Filter (All platforms ABI default)</td>
</tr>
<tr>
<td>D3S1358</td>
<td>11%</td>
<td>20%</td>
</tr>
<tr>
<td>D16S539</td>
<td>13%</td>
<td>15%</td>
</tr>
<tr>
<td>Amelogenin</td>
<td>None</td>
<td>25%</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>9%</td>
<td>25%</td>
</tr>
<tr>
<td>THO1</td>
<td>6%</td>
<td>25%</td>
</tr>
<tr>
<td>TPOX</td>
<td>6%</td>
<td>25%</td>
</tr>
<tr>
<td>D7S820</td>
<td>9%</td>
<td>25%</td>
</tr>
</tbody>
</table>

The Amelogenin category for both Cofiler and Profiler Plus does not have a stutter filter because it is not a repeat. However, it does have a locus filter of 3%.

See Y M1 Genotyper section for Y M1 filter functions.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the OCME intranet. All printed versions are non-controlled copies.
# PROTOCOLS FOR FORENSIC STR ANALYSIS

**VERSION 10.0**

Effective date: June 9, 2008

<table>
<thead>
<tr>
<th>TITLE</th>
<th>PRINT NAME</th>
<th>SIGNATURE</th>
<th>DATE</th>
</tr>
</thead>
</table>